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PREFACE

Since early 2000, the use of computers has grown so rapidly that it is diffi cult to think of an area where 

computers are not being used. This means that whether you are a school or college student, an offi ce 

or factory employee, a housewife, or an even a retired person, it is very desirable that you have good 

knowledge about computers and its common applications. This is, exactly, the purpose behind writing 

this book. Designed for an average user, this book gives a detailed and yet a simple explanation of how 

to use a PC for basic needs. The only pre-requisite for the reader is the ‘ability to read’, and hence 

the book has been kept extremely simple. Easy to follow step-by-step instructions accompanied by 

appropriate illustrated screenshots make the learning an easy experience. 

The book is designed in such a way that you do not need to read it from the beginning to the end—

you may easily skip a topic and jump to a new topic of your choice and, if required, come back to the 

skipped topic later.

Salient Features of the Book

∑ Simple and step-by-step explanation with screen shots for better understanding

∑ Latest version of Windows 7 and Microsoft Offi ce 2010

∑ Latest Web Browsers: Internet Explorer 11, Google Chrome and Mozilla Firefox

∑ Introduction to social networking sites like Facebook, Google+

∑ Updated Information on ‘How to protect your computer’

∑ Pedagogy includes 

 552 Illustrations

 Short Tips and Notes

Highlights of the Book

∑ No prior knowledge assumed

∑ Detailed yet simple explanation on how to use Microsoft Windows, Word, Excel, Access, 

PowerPoint, Internet and web browsers

∑ Separate chapter on Tally ERP.9

Chapter Organization

The book contains 9 chapters. Chapter 1 starts with introduction to computers, their architecture and 

applications. Then it goes on to explain basic computer terms, such as hardware, software, operating 

system, computer languages, application programs, open source software, etc. Finally, it explains the 

Personal Computer (PC), its components and how to setup and start a PC. Chapter 2 explains Windows 

7 in detail. Besides describing how to use Windows 7 on a PC or Laptop, it also explains the new 

features, such as Windows Flip, Aero Peak, Aero Snap, and Aero Shake, as well as Windows utilities, 

such as Notepad, WordPad, Paint, Calculator, Snipping Tool and Sticky Notes. 
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Chapter 3 to 6 describe Microsoft Word, Microsoft Excel, Microsoft Access and Microsoft 

PowerPoint, the Microsoft Offi ce 2010 programs in detail. Chapter 7 describes how to use the

Tally.ERP 9 program. Chapter 8 discusses all aspects of the Internet and web browsers, including 

how to use the common web browser, such as Internet Explorer, Mozilla Firefox and Google Chrome, 

search engines, downloading and uploading fi les, audio and video on the web, as well as using the 

Internet in Indian languages. Chapter 9 describes all aspects of emailing, including description of 

common email programs, such as Outlook, Hotmail, Yahoo! Mail, Outlook.com and Google Mail 

(Gmail). This chapter also discusses common instant messaging programs, such as Windows Live 

Messenger, Yahoo! Messenger, Skype and Google Talk, and social media sites. Microsoft Family 

Safety, a useful program for parents, is also described in detail in this chapter. 

Web Supplements

Following material can be accessed at http://www.mhhe.com/taxali/cc

∑ Additional material and tips about topics covered in the book.

∑ New or changed features for the programs discussed in the book.

∑ Exercises/review questions for existing topics.

∑ Additional topics.
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1
WHAT IS A COMPUTER?

In this chapter, we will discuss the following topics:

Introduction and history of computers �

Generation of computers  �

Classifi cation and application of computers �

Computer architecture and organization �

What are hardware and software �

What is an operating system and the popular operating systems �

Computer languages, application programs and custom software  �

Shareware, freeware, public domain and open source software �

Networking concepts and computer numbering systems �

What is a personal computer and other types of computers �

Input and output devices used with PCs �

Setting up and starting the PC �
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1.1 INTRODUCTION 

The term ‘computer’ has been borrowed from compute that means—to calculate. Whereas initially 

computers were used to perform arithmetic calculations at fast speed, now they are used in nearly every 

fi eld. You can use computers for banking applications, Word processing, desktop publishing, weather 

forecasting, railway ticket reservations, control of machines or robots in factories, scientifi c research, 

etc. In brief, a computer may be defi ned as a device that receives some kind of data, analyzes it, and 

then applies a predefi ned set of instructions to it to produce some kind of output. For instance, when you 

go to a railway ticket reservation counter, the operator feeds your request for a ticket reservation into 

the computer. The computer then analyzes the data fed by the operator and makes a reservation. Then 

it prints a ticket for you. The ticket is the output generated by the computer based on the reservation 

request (input) entered by the operator. It is also said that the computer is a data processor, because 

it can receive, store, process and retrieve any kind of data. For instance, you can store the names and 

addresses of all employees working in a company in a computer fi le. Later, you can ask the computer 

to print a list of only those employees who work in the Accounts department. 

1.1.1 Characteristics of a Computer

The following are the characteristics of a typical computer:

1. Speed: Present-day computers operate at very high speeds. A computer can perform several million 

instructions (calculations) in one second. There are several different types of computers and they 

all have different speeds ranging from high to very-very high. Typically, the speed of computers 

is specifi ed in MIPS (Million Instructions per Second), FLOPS (Floating-Point Operations per 

Second) or MFLOPS (Million Floating-Point Operations per Second). 

2. Accuracy: Computers perform with a very high degree of consistent accuracy. Nowadays, 

computer technology is well stabilized, and the chances of a computer giving inaccurate results 

are very rare. Sometimes computers do make mistakes. This may happen if there is an undetected 

fl aw in the design of the computer (that is very rare nowadays.) Most of the time, computers make 

mistakes if they are not programmed correctly or if the input data is inaccurate, e.g. if you try to 

divide a number by 0. 

3. Diligence: When human beings are required to work continuously for a few hours, they become 

tired and start losing concentration. On the other hand, a computer can continue to work for hours 

(or even days) at the same speed and accuracy. It does not show signs of tiredness or lack of 

concentration when made to work continuously. Because of this property, computers are generally 

used in all such situations where the same or similar task has to be repeated a number of times, 

e.g. preparing the salary slip for 10,000 employees of a company, or printing dividend cheques for 

10,000,000 shareholders of a large company. 

4. Versatility: Computers are very versatile. The same computer can be used for various applications. 

For instance, you can use a Personal Computer (PC) to prepare a letter, prepare the balance sheet 

of a company, store a database of employees, produce a professional-looking advertisement, send 

or receive fax messages, etc. For a computer to perform a new job, all it needs is a program. (A 

program is a set of instructions that enables a computer to do a particular task.) Thus, if you want 

a computer to perform a new task, all you need to do is to write a new program for that task. 

5. Data storage: A computer can store huge amount of data in its memory. Almost any type of data, 

such as a letter, picture, sound, etc., can be stored in a computer. We can recall the stored data 

from the computer whenever we need it. For instance, when we type a letter, you can save it. Or, 
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if you want to send a similar letter to another person, you can recall that letter from the computer’s 

memory, modify it and print a new letter. The information can be stored accurately in a computer’s 

memory for several years. 

6. Unintelligent: A computer has no intelligence of its own. It cannot think or apply its judgement. It 

gets its power from the program that it runs. It will do only what it is asked to do. It has to be told 

what to do, and in what sequence. Therefore, the program that the computer runs determines what 

task it will perform. Thus, if you run a Word processor program on a computer, it becomes a Word 

processor and if you run a Desktop Publishing (DTP) program, it becomes a desktop publisher. So, 

a computer does not take its own decisions—it simply follows the instructions of the programmer 

or the user. 

7. Without emotions: Computers are not living beings. Hence, they do not have any emotions. They 

do not have any heart or soul. Human beings often take some decisions based on emotions, taste, 

feelings, etc.; however, computers always take decisions based on the program that they run. 

1.2 HISTORY OF COMPUTERS 

When the human race began involving in trade, it felt the need for a calculating device. An early manual-

calculating device called abacus was developed for this purpose as shown in Fig. 1.1. The abacus that 

was used more than 2000 years ago is still in use in many countries such as China and Japan. Blaise 

Pascal developed the fi rst mechanical adding machine in 1642. About 30 years later, in 1671, a German 

mathematician developed a calculating machine that could add, subtract, multiply, divide, and even 

extract the square root. Then, around 1800, a mechanical desk calculator was developed. 

Fig. 1.1 Abacus

In the next phase of development, machines that could calculate and print results were developed 

around 1890. Around the same period, Dr. Herman Hollerith came out with the concept of punched 

cards to store data. These punched cards were used extensively as input media in modern digital 

computers. 

In 1833, Professor Charles Babbage of Cambridge University, England, who is considered the father 

of the modern digital computer, proposed a machine. He named this machine the analytical engine. 

Professor Charles Babbage spent much of his life in building this machine but could not succeed, as 

the precision engineering required to build it was not available at that time. However, the principles he 

established were used later in the design of digital computers. 

Most of the work on the development of early digital computers was done between 1937 and 1957. 

Some of the well-known early computers are discussed briefl y in the following sections.
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1.2.1 Mark I Computer (1937–1944)

The Mark I computer, also called the Automatic Sequence Controlled calculator, was the fi rst fully- 

automatic calculating machine. This computer was developed by Professor Howard Aiken of Harvard 

University in collaboration with International Business Machines Corporation (IBM). Mark I was not 

an electronic computer. Rather, it was an electromechanical computer. The size of this computer was 

huge and its design was very complex, but it was quite reliable. It could perform the fi ve basic arithmetic 

operations—addition, subtraction, multiplication, division and table reference. 

1.2.2 Atanasoff Computer (1935–1942)

The fi rst electronic computer was developed by Dr John Vincent Atanasoff, a professor of physics and 

mathematics. He did most of the work on his prototype during 1935–1942. 

1.2.3 ENIAC (1943–1946)

The Electronic Numerical Integrator and Calculator (ENIAC) was the fi rst electronic computer. ENIAC 

was built at Moore School of Electrical Engineering, University of Pennsylvania, USA, by a team led 

by Professor J Presper Eckert Jr. and John W Mauchly. The ENIAC used about 19,000 vacuum tubes 

and was housed in a room of about 800 square feet. It could do around 300 multiplications per second 

but had a shortcoming—it could not store the operating instructions internally; these were fed through 

externally wired plug boards. 

1.2.4 EDSAC (1947–1949)

A team of scientists led by Professor Maurice Wilkes at Cambridge University, UK, developed the 

fi rst ‘stored instruction’ computer—the EDSAC (Electronic Delay Storage Automatic Computer). The 

demonstration of the fi rst program on EDSAC was held in 1949. 

1.2.5 EDVAC (1946–1952)

The Electronic Discrete Variable Automatic Computer (EDVAC) project was the fi rst effort to develop 

a stored instruction computer. It was developed by a team led by Professor J Presper Eckert Jr. and 

John W Mauchly, University of Pennsylvania, USA. The design concepts were based on Dr John Von 

Neumann’s idea that both data and instructions can be stored in the binary form, instead of the decimal 

number system used by human beings (Binary number system is discussed later in this chapter.).

1.2.6 UNIVAC I (1951)

The fi rst Universal Automatic Computer (UNIVAC) became operational at the Census Bureau, USA in 

1951. This computer was used at the Census Bureau for about a decade. General Electric Corporation 

acquired UNIVAC I in 1954 and used a computer for a commercial purpose for the fi rst time. 

1.3 GENERATIONS OF COMPUTERS 

1.3.1 First Generation (1951)

The early electronic computers, such as ENIAC, EDSAC, EDVAC, UNIVAC I, etc., used vacuum tubes to

control the fl ow of electronic signals. These computers used thousands of vacuum tubes. Vacuum tubes 

are big in size (about the size of a small electric bulb) and produce a lot of heat. Because of this, the 

‘fi rst generation’ computers were too bulky in size and used to produce a lot of heat. Therefore, they 

needed air-conditioning. Besides, the vacuum tubes used to burn out frequently resulting in failure 
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of the computer. Therefore, these computers could not be used continuously and had to be stopped 

frequently. 

Fig. 1.2 Vacuum tubes used in a computer

1.3.2 Second Generation (1959)

The computers of the ‘second generation’ were introduced around 1959. These were made of transistors, 

a smaller and more reliable component invented in 1947. A transistor is very small compared to the 

vacuum tube and produces very little heat. The use of transistors in computers made the second-

generation computers faster, smaller and reliable.

Fig. 1.3 A transistor used in the second generation computers 

1.3.3 Third Generation (1964)

The introduction of Integrated Circuits (ICs), also known as chips, opened the door for the development 

of the ‘third generation’ computers. A very large number of circuit elements—transistors, diodes, 

resistors, etc., could be integrated into a very small (less than 5 mm square) surface of silicon (hence the 

name IC). ‘Third-generation computers’ were based on the IC technology. The System/360 introduced 

by IBM in 1964 was the fi rst third-generation computer. Third-generation computers were smaller, 

faster and more reliable than second-generation computers. Though the fi rst third-generation computer 
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by IBM was introduced in 1964, some manufacturers continued to manufacture the second-generation 

computers as late as 1975.

Fig. 1.4 An Integrated Circuit (IC) used in the third generation computers

1.3.4 Fourth Generation (1971)

Initially, about 10–20 components were contained in an IC. This technology was called small-

scale integration (SSI). Later, with the advancement in IC design and manufacturing technology, it 

became possible to integrate up to 100 components in an IC. This technology was called medium-

scale integration (MSI). Later, it became possible to integrate over 10,000 components in one IC. This 

technology was called large-scale integration (LSI). With the advancement of IC technology, now it 

is possible to integrate over 100,000 components in a very large-scale integration (VLSI) chip. The 

‘fourth-generation’ computers that were introduced around 1971 were based on LSI chips. Ted Hoss

of Intel Corporation, USA introduced the fi rst microprocessor (the brain of a computer) Intel 4004,

and early fourth-generation computers were based on this microprocessor. Later Intel and other

companies introduced microprocessors that were thousands of times powerful than the fi rst 

microprocessor. Figure 1.5 displays an Intel Pentium microprocessor. Because of the very small size of 

the ICs used in fourth generation computers, they are very small, very powerful, fast and cheap. That is 

why an ordinary person can own a computer. 

In 1970s, various companies introduced several types of small computers, called home or personal 

computers, but these were not compatible with each other. The standardization in the personal computers 

fi eld started with the introduction of an IBM PC by IBM in 1981, which was based on an Intel 8088 

microprocessor. Soon, all major home computer 

manufacturers abandoned their models and switched to 

IBM PC; however, one company, Apple Inc., co-founded 

by Steve Jobs in 1977, didn’t. In 1970s, it made the 

popular Apple PC and in 1980s made Lisa and Macintosh 

(Mac) PCs which, though not compatible with IBM PC 

were very popular with some section of users due to ease 

of use because of its excellent graphical user interface 

(GUI), not available initially in IBM PC. In 2013, Apple 

continues to manufacture the Macintosh computer, which 

has gained popularity since 2006.

Scientists are working on the development of fi fth-

generation computers that will have massive computing 

power, intelligence, and ability to reason and learn, 

knowledge of the real world, and which can understand 

and talk in natural language. 

Fig. 1.5  An Intel Pentium microprocessor

with heat sink
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1.4 CLASSIFICATIONS OF COMPUTERS 

Computers are used for several applications in almost all fi elds of modern life. Different types

of applications require different types of computers. For instance, for desktop applications, such 

as Word processing, you may require a small computer. On the other hand, a large company may 

require a large and powerful computer. Computers can be classifi ed based on size, application, speed,

technology, etc. 

One of the most commonly used classifi cations of computers is based on its size. In the beginning, 

the computers were divided into three categories—large (mainframe), mini and micro. Later, 

another category, supercomputers was added, which are very powerful large computers. The fi rst 

supercomputer CDC-6600 was developed by Control Data Corporation (CDC) in 1964. Later, CDC 

introduced other popular supercomputers, such as Cray-1 and Cray-2. Personal Computers (PCs) that 

you use fall into the micro category. Small microcomputers that were used for personal applications 

in homes in the 1980s were called home computers. Large companies, banks, airlines, etc., normally 

use large (mainframe) computers. Mini computers fall between the mainframes and microcomputers. 

With the rapid advancements in the computer hardware and software technology in the last decade, 

the dividing line between mini and microcomputers has become fuzzy. The present microcomputers 

have more computing power than those of mini computers of the last decade. During the last two 

decades, PCs have evolved into other subcategories, such as notebooks/laptops, palm computers and 

tablet computers. These will be discussed later in this chapter. 

Computers can also be classifi ed as analog and digital. PC is a digital computer. The computers 

used in offi ces and homes are generally digital. Digital computers operate directly on numbers that 

are expressed as digits. Digital computers are more accurate than analog computers. They can be 

used for data processing as well as for scientifi c, engineering and industrial applications. On the other 

hand, analog computers that are normally used in the process industry or in measuring instruments can 

directly measure physical parameters, such as voltage, current, pressure, temperature, length, weight 

and fl ow. However, nowadays, digital computers are also being used for industrial applications. 

1.5 APPLICATIONS OF COMPUTERS 

The use of computers is increasing at such a rate that there is hardly any fi eld where computers are not 

used. The following list describes some of the applications of computers:

• In offi ces and homes for preparing documents and to perform other data processing jobs

• To prepare salary slips and salary cheques in offi ces and factories

• To maintain accounts and transfer funds in banks

• To store and retrieve large amount of information in offi ces

• To send and receive electronic mail/fax

• To search and retrieve information from other computers

• To reserve tickets in the transportation sector, e.g., railways, airlines, etc.

• To regulate traffi c lights on roads and to control machines and robots in factories

• To design automobiles, buildings and dams and to forecast weather

• To create animation/cartoon movies, compose music and play games

• To control modern automobiles, trains, airplanes, etc.

• To control electronic appliances, such as air-conditioners, TVs, VCRs, vacuum cleaners, etc.

• To do on-line banking, buy and sell merchandise, shares, bonds, etc.
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• To control and simulate industrial and defence equipment

• For scientifi c and industrial research

1.6 COMPUTER ARCHITECTURE AND ORGANIZATION 

You might be using computers for various applications; however, if you carefully analyze the tasks 

computers perform, all computers perform fi ve basic operations. Let us have a look at these operations 

with reference to ticket bookings at the railway ticket reservation counter.

1. Input: Computers receive data from outside. For example, when the ticket reservation clerk types 

your ticket-booking request, the computer accepts these details. We feed data (e.g., reservation 

details) as well as instructions into computers. Instructions tell computers what to do with the data. 

There are a number of devices that are used to receive data and instructions from the outside world. 

The keyboard on your PC is one of the most commonly used input devices. 

2. Storage: When you enter data or instructions into the computer, these are stored somewhere in the 

computer system. Because a computer cannot process or analyze all input data instantaneously, it 

has to store the data. The computer will retrieve the data/instructions from the storage unit when it 

has to process it. It may also have to store data to do additional processing later. For instance, the 

Railway Reservations Computer requires the booking details again to prepare reservation charts 

on the date of departure of the train. 

3. Processing: Computers process (analyze) the input data available in its storage unit in order to get 

some useful output. For instance, it may process the request for booking of a seat in a particular 

train on a particular date, and check if a seat is available on the requested date. 

4. Outputting: After the computer has processed the input data, it provides useful information 

(result) to the user. For example, the Railway Reservation Computer may print the ticket or show 

on the computer screen that the seat is not available on the requested date. This process is called 

outputting. 

5. Control: All computers have a control unit that controls the manner and sequence of operations. For 

example, the Railway Reservations Computer has to do the operations—input, storage, processing 

and outputting—in the correct sequence in order to make a reservation and print a ticket. This is 

controlled by the control unit of the computer.

All computer systems perform the above fi ve functions. Figure 1.6 illustrates the functional 

organization of a computer.

Fig. 1.6 Functional organization of a computer
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1.6.1 Input Unit

Computers need to receive data and instructions in order to solve any problem. Therefore, we need to 

put the data and instructions into the computers, and the input unit perform this task. The input unit 

consists of one or more input devices. The keyboard of your computer is one of the most commonly 

used input devices; other devices include mouse, fl oppy disk drive, hard disk drive, CD-ROM, scanner 

and magnetic tape. Regardless of the type of input device used in a computer system, all input devices 

perform the following functions:

• Accept data and instructions from the outside world

• Convert it to a form that the computer can understand

• Supply the converted data to the computer system for further processing

1.6.2 Storage Unit

The storage unit of the computer holds the data and instructions that you enter through the input unit 

before these are processed. It preserves the intermediate and fi nal results before these are sent to the 

output devices. It is also used to preserve the data for later use, e.g., you may like to save a letter you 

type today for printing after one week. The various storage devices used in computer systems are 

classifi ed into two categories—primary and secondary.

1. Primary Storage: The primary storage, also called the primary memory or internal memory. The 

CPU can store data in this memory and read information stored there very fast as it can directly 

access the primary memory. The primary storage or memory can be of two types—Read Only 

Memory (ROM) or RAM (Random Access Memory). The Read Only Memory is a memory whose 

contents cannot be changed. ROM usually stores the basic set of instructions that computer needs 

to execute when it is turned on. In PC, these basic set of instructions is called the basic input-output 

system (BIOS). Though there are two types of RAM, static and dynamic, dynamic memory is 

normally used in PCs. The RAM memory is the main memory used by the computer to hold data 

and the program currently being executed in the computer; the data being received from the input 

unit and the intermediate and fi nal results of the program. The information stored in RAM memory 

can be accessed in any order and data stored at any address in the RAM memory can be erased or 

re-written with new data. 

  Most computers use semiconductor memory as primary storage. Semiconductor memory is very 

fast and can be accessed in random manner. The primary memory generally loses its contents 

when we switch off the computer. Therefore, if we need to preserve the results or the input data, 

we have to transfer it to the secondary storage. The cost of the primary storage is more compared 

to the secondary storage. Therefore, most computers have limited primary storage. 

2. Secondary Storage: The secondary storage (memory) is used like an archive. It may store several 

programs, documents, databases, pictures, music fi les, etc. The program that you want to run on 

the computer is fi rst transferred to the primary memory before it can run. Similarly, after running 

the program, if you need to save the results, you will transfer them to the secondary storage. As 

CPU cannot access the secondary memory directly, it is slower than the primary memory. Some 

of the commonly used secondary memory devices are hard disk, USB fl ash drive, fl oppy diskette, 

zip diskette, magnetic tape and recordable CD, DVD or Blu-ray disk.

Memory Size All digital computers use the binary number system. In the binary number system, 

bit (acronym for binary digit) represents the smallest information that can be 0 or 1. All information 

that is stored in the memory is made of bits. Each alphanumeric character, e.g., ‘a’, ‘b’, ‘1’, etc., is 
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represented by a code composed of 8 bits. This set of 8 bits is called a byte, and each byte stores one 

character. 

The size of the primary storage is usually specifi ed in kilobyte (KB), megabyte (MB) or gigabyte 

(GB). 1 KB is equal to 1024 bytes, 1 MB is equal to 1024 KB and 1 GB is equal to 1024 MB. The 

size of the primary storage in a typical low-end PC usually starts at 1GB. PCs with 2 GB, 4 GB,

8 GB are quite common. Figure 1.7 displays an 8 GB memory card. On the high-end PC, we may fi nd 

16 GB, 32 GB, 64 GB, 128 GB and higher memory. 

Fig. 1.7 8 GB memory card module used in PCs

1.6.3 Output Unit

The output unit of a computer provides the information and results of a computation to the outside 

world. As you know, computers do not work in the decimal system; they work in the binary system. 

Therefore, if required, the output unit also converts the binary data into a form that users can understand. 

Printer and Video Display Unit (VDU; also called Display Screen or monitor) are common output 

devices. Other commonly used output devices are hard disk drive, USB fl ash drive, fl oppy disk drive 

and magnetic tape drive. In the earlier generation computers, paper tape punch units and card punch 

units were also used as output devices. 

1.6.4 Arithmetic-Logic Unit

All calculations are performed in the Arithmetic-Logic Unit (ALU) of the computer. ALU also does 

comparisons and takes decisions. Whenever any calculation is performed, the control unit (discussed 

in the next section) transfers the required data from the storage unit to the ALU. To hold the data 

transferred into ALU, it contains a few special-purpose storage locations called registers. The number of 

registers varies among computers. The ALU can perform basic operations such as addition, subtraction, 

multiplication, division, etc. The ALU can also do logical operations, e.g., it can check if the number 

A is less than, equal to or greater than the number B. After the ALU has performed the calculation or 

the logical operation, depending on the instruction the result is either stored in a register or transferred 

to the storage unit. 

ALU is capable of performing a fi xed set of instructions. For instance, it may be able to do add, 

subtract, multiply and divide two numbers. It does not have capability to do any operation outside 

these predefi ned instructions, called the instruction set. Different ALUs (or CPUs, discussed later) 

have different instruction sets. If the instruction set of an ALU does not include a particular operation, 

software programs try to do it indirectly. For instance, one can multiply two numbers by repeated 

additions or divide two numbers by repeated subtraction.

1.6.5 Control Unit

The control unit controls all other units in the computer. The input unit does not know when to receive 

data and where to put the data in the storage unit after receiving it. It is the control unit that gives the 

necessary instructions to the input unit. Similarly, the control unit instructs the input unit where to store 
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the data after receiving it from the user. In the same way, it controls the fl ow of data and instructions 

from the storage unit to ALU. It also controls the fl ow of the results from ALU to the storage unit. The 

control unit also controls what should be sent to the output unit and when. In brief, the control unit is 

the central nervous system of the computer that controls and synchronises its working. 

1.6.6 Central Processing Unit

The control unit and ALU of the computer are together known as the Central Processing Unit (CPU). In 

most modern computers, a single IC does the job of controlling all units of the computer. The same IC 

also contains the ALU. The CPU is like a computer’s brain which performs the following functions:

• Performs all calculations 

• Takes all decisions

• Controls all units of the computer

Your PC may have a CPU IC, such as Intel 8088, 80286, 80386, 80486, Celeron, Pentium, Pentium 

Pro, Pentium Pro 2, Pentium 3, Pentium 4, Pentium D, Core i3, Core i5, Core i7, AMD K6, Xeon, Dual 

Core Xeon, AMD Duron, AMD Athlon, AMD Phenom, AMD Fusion, etc. Each CPU operates at fi xed 

speed. Most PC advertisements mention CPU IC name or number and the speed, e.g., Intel Pentium 

4 at 1.8 GHz or Intel Pentium 4 at 2.8 GHz. This speed, also called the processor speed or CPU clock

frequency gives the base timing for all operations CPU does. For example, 1 GHz (Giga Hertz) comes 

to the base timing (cycle) of 1 nanosecond. Sometimes we say that CPU clock cycle is 1 nanosecond. 

Internally, CPU needs a fi xed number of clock cycles to perform each operation. For instance, if it needs 

three cycles to add two numbers, it will need 3 nanoseconds to add these numbers if it is operating at 

1 GHz. On the other hand, a CPU operating at 2 GHz may be able to do the same operation in half the 

time. Therefore, as a thumb rule, higher the CPU clock frequency, faster the programs run. However, it 

does not mean that if you switch from Pentium 4 at 1.2 GHz to Pentium 4 at 2.4 GHz, your programs 

will start operating at double the speed. This is so because other devices in the faster PC, such as hard 

disk or CD-ROM may not be able to operate at higher speed.

1.7 HARDWARE AND SOFTWARE 

You see several physical devices such as the monitor, fl oppy disk drive, hard disk drive, keyboard, 

printer(s), CD-ROM, etc., in your PC. These physical devices are called hardware. The hardware 

does various operations in your PC, such as accepting and storing data, performing calculations and 

displaying or printing results. 

The physical devices or the hardware in a PC cannot work on their own. To make the hardware 

work, you require a set of programs. A set of programs associated with the operation of a computer 

is called software. Different types of software (also called software programs) are used with PCs. 

Software can be classifi ed into the following major categories:

1. Operating systems such as DOS, Windows 95, Windows 98, Windows 2000, Windows XP, 

Windows Vista, Windows 7, Windows 8, OS/2, Mac OS, UNIX, Linux, Android, etc.

2. Programming languages such as Basic, FORTRAN, COBOL, C++, Perl, Java, PHP, etc.

3. Application programs/packages such as Word processors, Spreadsheet, Database Management 

Systems (DBMS), etc.

4. Other application programs doing a specifi c job, e.g., accounting, payrolls, billing, weather 

forecasting, ticket reservation, etc.
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1.8 WHAT IS AN OPERATING SYSTEM? 

The operating system (OS) is a collection of programs that controls all hardware and other resources in 

the computer system. Without it, the ‘bare’ computer system is useless. It is the operating system that 

operates and controls the CPU, memory, various I/O devices such as the keyboard, the mouse, the video 

display unit, the printers, etc. It is responsible for the smooth and effi cient operation of the computer. 

When we want to run a program, for instance, a Word processor or a spreadsheet program, the PC has 

to perform the following jobs:

1. Locate the program fi le(s) required to run the program on the fl oppy or the hard disk drive.

2. Find out the vacant space in the memory where the program fi le(s) may be loaded.

3. Load the program fi le(s) in the memory.

4. While the program is running, keep the resources required by the program reserved on permanent 

or a time-sharing basis. 

5. Manage and control the user’s interaction with the I/O devices. 

All these tasks are done by the operating system. For instance, when you press a key on the keyboard, 

it is the operating system that accepts the key and provides it to the Word processor. 

Nowadays, operating systems are very complex. Besides controlling and managing the computer’s 

resources, the operating system also does the following jobs:

1. The operating system creates and manages the directory system on the secondary storage devices. 

It also contains commands to copy, rename, move and delete fi les and directories on the secondary 

storage devices. 

2. It contains a text editor that can be used to create simple text fi les. 

3. Enables the computer to run multiple tasks simultaneously, e.g., to run Word processor and 

spreadsheet programs simultaneously. 

4. It maintains an internal real-time clock known as the system clock. This clock is used to display the 

current date and time. This clock is also used to mark the date and time of creation or modifi cation 

of fi les. This is also called time stamping of fi les. 

5. It acts as an interface between the user and the computer. It accepts commands and instructions 

from the user and executes them, and displays suitable error messages, if required. 

6. It includes several tools and utility programs to help the user to do routine jobs and control the 

behavior of the computer systems. For instance, the operating system may have tools to manage 

memory, defragment disk, check the surface of a disk for errors, and to back up fi les from hard disk 

to fl oppy disks, play audio/video fi les, etc. 

1.8.1 Popular Operating Systems for PCs

The following are popular operating systems for PCs:

1. Disk Operating System (DOS), FreeDOS and Windows 3.1

2. Windows 95/98

3. Windows 2000/Me

4. Windows XP

5. Windows Vista

6. Windows 7 

7. Windows 8
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8. Windows NT

9. OS/2

10. Unix and Linux

11. Mac OS/OS X

Among the above, Windows 3.1 (or 3.11) is not an operating system. It is a program that runs on 

DOS to create an operating environment. That is, Windows 3.1 is not an operating system but only an 

operating environment. To use Windows 3.1 environment, you fi rst need to load DOS. After loading 

DOS, you can load Windows 3.1. 

The Disk Operating System (DOS) was the fi rst operating system developed for the IBM PC by 

Microsoft Corporation. This was called DOS because, in the beginning when DOS was introduced, 

all program fi les required to start this operating system were stored on a fl oppy diskette. To load the 

operating system in the PC, it was necessary to put the fl oppy disk containing DOS in the fl oppy disk 

drive at the time of switching on the PC. Now, of course, most PCs are equipped with a hard disk and 

DOS or other operating system (OS) program fi les are kept on the hard disk. When you switch on the 

PC, the operating system is loaded from the hard disk. 

Compared to a DOS-based PC, all Windows operating systems bring two additional capabilities to 

the PC:

1. The video display unit can display characters in different shapes and sizes, and it can also display 

graphics. In other words, it converts the ‘character based’ interface to a ‘graphical user interface’ 

(GUI). 

2. The PC can run more than one program simultaneously. In other words, compared to DOS that 

could run only a single task, Windows is a multi-tasking operating system/environment. 

Windows 95 and Windows NT are two other popular operating systems for PCs from Microsoft 

Corporation. Windows 95 is an updated and enhanced version of Windows 3.1 operating environment. 

Compared to Windows 3.1, it is easy to use and learn. It is also well suited to run multiple programs. 

Microsoft Corporation released Windows 98, the updated version of Windows 95 in 1998. Windows 

2000 is another operating system from Microsoft released in 2000. 

Windows XP, released in 2002 is a popular and one of the most stable operating system

from Microsoft. “XP” is short for experience, symbolizing the rich and extended user experiences 

offered by the operating system. Microsoft released Windows Vista in January 2007 and its latest 

operating system, Windows 7 in October 2009. Windows 8, the successor to Windows 7 was released 

in October 2012.

Windows NT too is a standalone operating system and does not run on the top of DOS. Windows 

NT was released in 1992. Windows NT provides many security features, and it is very diffi cult for any 

program to corrupt and crash this operating system. However, it did not become very popular because 

it required more hardware resources to run. Developers who want a reliable and protected operating 

environment generally prefer Windows NT. 

With each new release of its Windows operating system, Microsoft has tried to improve the GUI, 

improved security and introduce new features. This is particularly true for Windows Vista. However, 

newer operating system usually also demands more hardware resources, i.e., more powerful CPU, 

more hard disk space and more RAM memory. Due to these limitations, many users continue to use 

older Windows operating system.

One major difference between Windows 95/98 and Windows NT/2000/XP/ME/Vista/7/8 operating 

systems is the fi le system. While Windows 95 and Windows 98 use the FAT (File Allocation Table) 
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fi le system, Windows NT, 2000, XP, Vista and other new OS use NTFS (Windows NT File System).

The NTFS fi le system provides improved performance, reliability and better disk space utilization. 

Another useful feature available in Windows Me, Windows XP, 7, 8 and Vista is System Restore that 

allows rolling back of system fi les and installed programs to previous state if the computers starts 

failing or malfunctioning after installing a new program or software update.

OS/2, FreeDOS, Linux and UNIX are other operating systems that are used on PCs, though on a 

limited scale. IBM developed OS/2. FreeDOS is a free and open-source operating system that anyone 

is free to use and modify. UNIX, which is one of the most popular operating systems on mainframe and 

mini computers, is also sometimes used on high-end PCs, particularly on a Local Area Network (LAN). 

Linux, an open-source operating system, is also slowly becoming popular. Mac OS and Mac OS X are 

used on Apple’s Macintosh (Mac) computers, which are different from PCs. 

1.9 COMPUTER LANGUAGES 

Computers are machines and unfortunately, they cannot understand natural languages like Hindi, 

English, Tamil, etc., that human beings speak and understand. Therefore, in order to give instructions to 

computers, different languages have been developed. These languages are called computer languages. 

To get a particular work done by computers, programmers write instructions using these computer 

languages. Each computer language has its own vocabulary. The vocabulary of a computer language 

is very limited compared to that of a natural language of a human being. Each natural language has 

its rules of grammar. Similarly, each computer language too has its set of rules that are called syntax 

rules. Since computers have a different set of languages, we have to use the exact syntax rules of the 

computer language whenever we write any computer program. Otherwise, the computer will not be 

able to understand our instructions. 

Over the last few decades, several computer languages have been developed. Different computer 

languages are suitable for different applications. For example, COBOL (Common Business Oriented 

Language) may be more suitable for business applications, whereas FORTRAN may be more suitable 

for scientifi c or engineering applications. We can classify all computer languages into the following 

three major categories: 

 1. Machine Language

 2. Assembly Language

 3. High-Level Language

1. Machine Language: Machine language is the only language the computer understands. It is the 

fundamental language of the computer. We may use different languages to program a computer. 

However, each computer program written in other computer languages is translated to machine 

language before running that program. That is, even if we write a program in an assembly or a high 

level language, ultimately, it is the machine language that instructs the computer. 

  In machine language, instructions are written as strings of binary 1s and 0s. For example, the 

instruction 00001000 may represent addition of two numbers. Similarly, the instruction 01001010 

may represent multiplication of two numbers. Each type of computer has its own machine language. 

It is directly related to the CPU used in that computer. Thus, 00001000 may represent addition in 

one computer, and it may mean some other operation in another computer.

  As machine language is the language of the CPU, programs written in this language are 

executed very fast. However, writing programs in machine language is very time consuming 
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and error prone. The programmer has to remember all available instructions and also needs to 

know how each instruction affects the memory and registers in the CPU. Also, modifying and 

testing programs written in machine language are very diffi cult. Another disadvantage of programs 

written in machine language is that these programs are not portable. Because each CPU has its 

own machine language, a program written in machine language for one particular CPU will not 

work on another computer that uses a different CPU. Because of these limitations, programs are 

rarely written in machine language nowadays. 

2. Assembly Language: Assembly language is one level above the machine language. It uses certain 

pre-defi ned symbolic codes instead of binary codes. These symbolic codes are called mnemonics. 

For instance, we can use the ADD mnemonic in place of 00001000 in the program written in 

assembly language. Remembering mnemonics is easier that binary codes. For instance, it is easy 

to remember ADD (for addition) than remembering 00001000. Therefore, writing programs in 

assembly language is easier and less time consuming compared to writing programs in the machine 

language.

  Assembly language closely resembles machine language and both are considered low-level 

languages. Like machine language, assembly language is also CPU specifi c. However, making 

modifi cations in an assembly language program is relatively easy. Also, an assembly language 

program is easy to document. 

What is an Assembler? As we have already mentioned, computers understand only machine 

language. Therefore, to run a program written in assembly language, it has to be translated into 

machine language before you can run it. The translation of an assembly language program into a 

machine language program is done by another program known as the assembler. The assembler 

converts all instructions written using mnemonics into binary codes. Because each CPU has its 

own machine language, you require different assemblers for different CPUs. For instance, there is 

a separate assembler for a PC using 80486 CPU and a different assembler program for a PC using 

the Pentium CPU. 

3. High Level Languages: We have seen that writing a program in machine language and assembly 

language is diffi cult and time consuming. Further, these programs are CPU specifi c and therefore, 

are not portable. Moreover, it is time-consuming to modify programs written in machine or 

assembly language. High level languages overcome these limitations to a large extent. 

  While writing a program in a high level language, the programmer need not know the internal 

structure of the computer. That is, he/she need not know the instructions the CPU can execute or 

how to address memory or I/O devices. Thus, instead on concentrating on the internal structure of 

the computer, the programmer concentrates on the logic of the problem. In high level languages, 

the program can be written using simple English words and common mathematical symbols. For 

example, consider the following program.

INCOME = 80000

TAX_RATE = 20

INCOME_TAX = INCOME * TAX_RATE/100

PRINT INCOME_TAX

  In this program, the fi rst statement creates a variable INCOME and stores 80000 in it. Similarly, 

the next statement stores 20 in the TAX_RATE variable. The next statement calculates the income 

tax and stores it in the variable INCOME_TAX. Finally, the last statement prints the result on the 
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screen. While writing this program, the programmer is not concerned with where the CPU will 

store these values or what instructions are required to perform these operations. 

We use computers for different types of applications, such as business, scientifi c, engineering, etc. 

On the same lines, different high-level languages have been developed to effi ciently handle different 

applications. Some of the common high-level languages are BASIC, FORTRAN, COBOL, PL/1, 

Pascal, ADA, RPG, LISP, ALGOL, C, C++, PHP, Java, etc. Each high-level language is suitable for a 

particular type of application. For instance, COBOL that is normally used in business applications may 

not be suitable for scientifi c or engineering applications. 

As you know, computers understand only machine language. Therefore, to run a program written 

in a high-level language, we need to convert it to machine language. Translation programs do this job. 

There are two types of translation programs—interpreters and compilers. 

Interpreters and Compilers There is a minor difference between an interpreter and a compiler. 

The interpreter translates the program written in a high level language into machine language at 

the time of executing that program, instruction by instruction. That is, it reads the fi rst instruction 

written in the program and converts that into equivalent machine language instructions. Then the 

CPU executes those machine language instructions. After that, the interpreter reads and translates the 

next instruction and so on. On the other hand, the compiler translates the entire high level language 

program into the machine language program before executing it. This optimizes the use of machine 

language instructions in the translated program. Therefore, normally compiled programs run faster 

than interpreted programs. The original high level language program is called the source program. The 

compiled program, i.e., the machine language program generated by the compiler after translation, is 

called the object program. 

Each high level language uses different instructions to do the same job. Therefore, you require a 

different compiler and/or interpreter for each high-level language, even for the same computer. That 

is, the BASIC compiler cannot be used to compile a COBOL program and vice versa. 

High level languages enable you to run a program on computers running different operating systems 

with no or very minor modifi cations. To do so, all you need is to make minor OS specifi c changes, 

if required and compile it under the new operating system. Thus, high level languages help to make 

programs portable. 

1.9.1 Fourth Generation Languages (4GLs) 

4GLs are special programming languages that are one level above the high level languages such 

as COBOL, FORTRAN, Basic, etc. (These high level languages are also called third generation 

languages.) The third generation languages are procedural languages. Here, the programmer instructs 

‘what’ is to be done, as well as ‘how’ it is to be done. On the other hand, 4GLs are non-procedural 

languages. In 4GLs, the program or the user only instructs ‘what’ is to be done, not how it is to be 

done. For example, the user may simply select the type of report required. The user will not enter the 

instructions required to prepare that report. That job will be done by the 4GL itself. There are different 

types of 4GLs, such as Database query languages, Report generators and Application generators. Some 

of the common 4GLs are SQL (Structured Query Language), Oracle Reports, RPG-II, LINC, Ingress, 

Sybase, Focus and FoxPro. Developing a program in a fourth generation language is generally faster 

and requires fewer lines of code, compared to a third generation language.
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1.10 APPLICATION PROGRAMS AND CUSTOM SOFTWARE 

For solving a particular problem, programmers develop programs using programming languages. Many 

times, different organizations want to solve the same (or almost same) problem using computers. For 

instance, the process of generating payrolls is same in all offi ces of the Central Government. Similarly, 

if two branches of a bank want to computerize the fi xed deposit accounts, they will end up developing 

almost the same program. In the past, lots of programming efforts were wasted in duplicating the same 

programs. To avoid this duplication, some software development houses started developing application 

programs (also called application packages). Now, thousands of application programs are available 

for applications such as word processing, payrolls, inventory controls, accounts, invoicing, ticket 

reservations, banking, income tax planning, education, engineering design, etc. 

Sometimes, the requirements of a particular organization are such that a general-purpose application 

program cannot meet these. In that case, that organization has two options. First, it can develop the 

programs in-house. Second, it can ask some software development company to develop a program 

that can meet its special requirements. When a software development company develops software to 

meet the specifi c requirements of a particular organization, it is called custom software or custom-built 

software. 

1.10.1 Shareware, Freeware, Public Domain and Open Source Software

When you need to use a new software program on your PC, you need to load it on. Most software 

programs developed by large and medium software companies are available for purchase in software 

stores or on their websites. Packaging software programs and selling through software stores requires 

huge investment that small companies and individual software developers cannot afford. They try 

to distribute their programs through their websites as shareware or freeware. As the name freeware 

suggests, it is absolutely free. The user can just download the program from the website and use it. 

Shareware programs are slightly different from freeware programs. They are available on the Internet 

for download and for free trials. At the end of the free trial period, if you like the program, you are 

required to register the program and pay a small fee to the software developer. When you pay the fee 

and register, the software developer may send you the latest version of that software. If you do not like 

the program, you need not register and need not pay anything. Some shareware programs automatically 

stop functioning when the free trial period ends, whereas others continue to work forever. Sometimes, 

some options in the shareware program may work only after you pay for it. 

Nowadays, commercially available software packages cost a lot of money. Many a times, cost of the 

software exceeds the cost of the hardware. This is one of the reasons for high level of software piracy 

in some countries. To enable users to get quality software for free, some software developers as well 

as organizations put their work in public domain, i.e., everyone is welcome to use it. Basically, public 

domain software and freeware are free to use. However, the term freeware is normally used with small 

software programs which are usually offered without the source code, whereas public domain software 

is usually associated with operating systems, programming languages, database management systems, 

servers, etc., usually offered with source code. Sometimes, public domain software is also called free 

domain software. 

Some of the popular quality software are available in public domain include Linux operating 

system, PHP, Perl, Java, Apache web server, MySQL Database Management System, WordPress, 

Drupal, Apache OpenOffi ce, LibreOffi ce, etc. Many of the software in public domain were initiated by 

University students as projects and later other software developers continued to develop these projects. 
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Linux and Perl fall in this category. These kinds of software are also called open source software, 

because the software source code is open to anyone for viewing, modifi cations and improvement. 

You can download public domain software from the corresponding website for free, however, some 

companies package and sell this software for a price. Linux operating system, one of the most prominent 

examples of the development of an open source initiative, is packaged and sold for a reasonable price 

by several commercial companies. Usually commercial organizations that need technical support and 

training buy the packages public domain software.

1.11 NETWORKING CONCEPTS 

Initially, when big organizations started using computers, these were standalone. However, as the 

use of computers started increasing, people felt the need to connect different computers to exchange 

information and to share costly resources, such as high-speed printers, disk drives, high-speed card 

readers, etc. In the beginning, different computers located in different fl oors or building in the same 

campus were interconnected. The communication lines used to interconnect the computers were 

private. This kind of network of computers that uses a fast private communication link is called local 

area network (LAN). Usually a LAN is restricted to a small area up to a radius of 10 kilometres. In a 

LAN, the computers may be connected in different confi gurations, such as ring, star, multidrop or fully 

interconnected. The LAN may use different communication media, such as twisted-pairs cable, coaxial 

cable, fi ber-optic cable, microwave link, etc. 

When computers that are physically located in different parts of a city or even in different cities or 

countries are connected together, they usually use a public telecommunication network (e.g., phone 

lines). This kind of network that connects widely spread computers is called wide area network (WAN). 

Like LAN, WAN can also use different communication media, such as telephone lines, fi ber-optics 

lines, microwave links, and satellite links. 

The Internet is a worldwide network of computers, where different computers communicate to each 

other using a common protocol. The concept of Internet is discussed in detail in Chapter 8. An internal 

network of a company that has an interface similar to Internet is called Intranet. 

1.12 COMPUTER NUMBERING SYSTEMS 

The human beings feel comfortable in working in the decimal number system. However, when the 

scientists started designing digital computers, they opted for binary number system. In binary number 

system, there are only two states—0 and 1. These are also called binary digits or bits. It is very easy to 

design a two-stage system, e.g., a switch is closed or open; a light bulb is on or off; current is fl owing 

through a circuit or not, so on and so forth. Now, one of these two states may be called 0 and the other 

1. The use of binary number system in digital computers has made the design of digital computers very 

simple. Since all digital computers use the binary number system, let us understand this numbering 

system. 

In the binary numbering system, all numbers are represented using zeros and ones. We use 0 and 

1 in binary number system to represent decimal numbers 0 and 1, respectively. How do we represent 

decimal number 2 in binary form? In binary number system, 2 is represented by ‘10’ and 3 by ‘11’. 

Table 1.1 displays binary equivalents for a few decimal numbers.
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Table 1.1 Binary equivalents of a few decimal numbers 

DECIMAL NUMBER BINARY NUMBER

0 0

1 1

2 10

3 11

4 100

5 101

6 110

7 111

8 1000

Besides the binary number systems, other numbering systems used in computers include octal 

(base 8), binary-coded decimal (BCD) and hexadecimal (base 16, 0 – 9, A, B, C, D, E and F). The 

hexadecimal number system is a human-friendly representation of binary coded data, e.g., 10101001 is 

represented by A9 in the hexadecimal numbering system.

American Standard Code for Information Interchange (ASCII) is a standard for interchanging 

information between computers or between a computer and peripherals, such as printer or terminal. 

The ASCII codes use 7-bit or 8-bit binary number to represent different characters. The standard ASCII 

codes use 7-bit code, which gives 128 combinations. These combinations include all uppercase and 

lowercase letters, the numbers 0 through 9, punctuation marks, and special characters used in English. 

However, 128 combinations do not include several letters used in other languages and graphic symbols. 

To include additional 128 combinations, ASCII codes were expanded to use 8-bit codes. These codes 

are called Extended ASCII. Most modern computers and peripherals support Extended ASCII.

1.13 PERSONAL COMPUTER 

A typical personal computer (PC), shown in Fig. 1.8 consists of the following units: 

1. CPU Box (System Unit) 

2. Keyboard and Mouse

3. Video Display Unit (Monitor)

4. Floppy Disk Drive(s) 

5. Hard Disk Drive(s) 

6. Compact Disk (CD)/DVD Drive

Normally, a PC also has a printer. Your PC may also have other devices such as scanner, speakers, 

webcam, etc. 

The computer shown in Fig. 1.8 is called a desktop PC. For people, who want to carry their PC with 

them; the lighter version is called a Laptop. The Laptop, also called the Notebook PC, uses special 

lightweight components that consume less power so that it can run on a battery. The laptop uses a 

build-in LCD (Liquid Crystal Display) and keyboard, though one can attach external display units and 

keyboard. Figure 1.9 displays a typical laptop. 
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Fig. 1.8 A typical personal computer

 

 Fig. 1.9 A typical laptop Fig. 1.10 A typical Netbook PC

For people who do not need all the features offered by a typical laptop, a scaled-downed version 

called the Netbook PC is available. The Netbook PC contains a small size screen and usually does not 

contain the CD-ROM drive. However, it is good for most typical PC uses, including word processing, 

web-surfi ng, emailing, etc. A typical Netbook PC is shown in Fig. 1.10. In case of laptops and netbook 

PCs, all hardware components are housed in a single unit, whereas in the case of a typical desktop, they 

are in separate units. 

1.13.1 CPU Box (System Unit)

The CPU box, also known as the System Unit houses the heart and brain of the computer. All electronic 

circuits, power supply, fl oppy drive(s) and hard disk drive(s) are housed in this box. The shape and size 

of the box may differ from computer to computer. However, they all have the similar electronic circuits 

and parts inside. The main printed circuit board (PCB) that contains the CPU, graphics controller, 

other input-output (I/O) controllers and slots for installing memory and other cards is called the mother 

board. These boards are not visible from the outside. The CPU box also houses hard disk drive(s) 

and the fl oppy disk drive(s) that form the secondary memory. Compact Disk (CD-ROM) drive is also 
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generally kept in the CPU box. The back and/or front of the CPU box contain connectors to connect the 

keyboard, mouse, printers, monitors, etc. 

1.13.2 Keyboard

The keyboard of a computer looks quite similar to the keyboard of a typical typewriter. The computer 

keyboard may have 84, 101 or 104 keys. A typical PC keyboard is shown in Fig. 1.11. The keys on 

the computer keyboard are arranged in the same order as on the keyboard of an ordinary typewriter. 

However, there are a few additional keys on the computer keyboard as explained below.

Ctrl The Ctrl (Control) key is normally located on the left-bottom corner of the keyboard. This key 

is also called the super-shift key. Its function is quite similar to that of the Shift key, i.e., if you press 

and hold Ctrl key and then press another key, your computer may type a different keystroke or perform 

a special function. This key is used extensively with most programs, including Microsoft Word and 

Excel. The Ctrl key is usually represented by the ̂  symbol, i.e., ̂ B means—press and hold the Ctrl key, 

press B, and then release both keys. 

Fig. 1.11 PC Keyboard 

Alt The Alt key is normally located on the left side of the spacebar key or the Shift key. As its name 

suggests, it is an alternate shift key. This key is used in combination with other keys to perform a 

specifi c function. For instance, Alt can be used to reset your PC, if you press it in combination with Ctrl 

and Del keys. Alt can also be used to type special symbols, such as ¥,© and ™. 

Tab The Tab key found on the keyboard of the PC is similar to the Tab key used on the ordinary 

typewriter, and is used for the same purpose. When you press this key, it moves the cursor in the 

forward direction to the next tab stop position. (Cursor is explained later in this section.) 

Function Keys There are 10 or 12 function keys located on the top or the left side of the keyboard. 

These are numbered as F1 through F12. The function keys are programmable keys and each application 

(e.g., Word, Excel and FoxPro) can use these keys for a specifi c purpose. For instance, the F7 key may 

be used to spell check the document. 

Caps Lock The Caps Lock key is used to automatically type all alphabets in upper case without 

pressing the Shift key. Usually, the keyboard provides a visual indication through a light emitting diode 

(LED) when you select the Caps Lock mode. To cancel the Caps Lock mode and to bring the keyboard 

back to the normal mode, press the Caps Lock key again. 
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Enter The Enter key is analogous to the carriage-return lever on the typewriter keyboard, except 

that it takes the cursor to the next line on the Video Display Unit of the PC. This key is sometimes also 

called the Return key. On some keyboards, this key is also marked as  . 

Del and Backspace The Del and Backspace keys are used to delete keystrokes. 

Ins and Esc The Ins key is used to select the insert or the overtype modes in the keyboard. The Esc 

key is a special key that may have different functions in different programs. 

Numeric Keypad The computer keyboard has an extra numeric keypad located on the right-hand 

side. This keypad contains keys to enter numbers. The same keys can also be used as direction keys to 

move the cursor. If you want to use this keypad to enter numbers, press the Num Lock key to select the 

Num Lock mode. To cancel the Num Lock mode and to use these keys to move the cursor, press the 

Num Lock key again. 

Direction Keypad The direction keypad is usually located on the left side of the numeric keypad. 

This keypad contains keys to move the cursor in a particular direction or to the beginning or end of the 

page (screen).

Windows Keys If you are using a Windows keyboard, your PC may have some special keys, such 

as the Windows Logo key and the Properties key. These keys have special functions in Windows, e.g., 

to open the Start menu and to display the right-click menu. 

1.13.3 Video Display Unit (VDU)/Monitor)

Video Display Unit (VDU) which is commonly known as monitor 

is used by CPU to display a wide variety of information, such as 

text, pictures, graphics, video, animations, icons, etc. (Icons are 

little pictures that represent commands, application program, fi les, 

folders, printer, etc.) There are two types of monitors—a cathode-

ray tube (CRT) similar to that used in an ordinary television and slim 

liquid-crystal display (LCD) monitor. The CRT monitors are fast 

become obsolete and most new PCs and Laptop/Netbook PCs use 

LCD monitors. Monitors are available in various sizes ranging from 

8 inches to 50 inches. Some monitors have built-in TV tuner and can 

also work as a TV. An LCD monitor is shown in Fig. 1.12.

The amount and quality of information you can see on a monitor 

depends on its dot pitch, pixel (picture element) and the video adapter 

card used in PC. Since 2000, most computer monitors are SVGA 

(Super Video Graphics Array) color or better. The SVGA monitor 

has a resolution of 800 pixels by 600 rows, commonly referred to by 800 × 600 and displays up to 16 

colors. These days most monitors can display thousands of colors and have a resolution of 1024 x 768 

or higher. A higher resolution monitor is recommended for graphic applications.

Cursor When you use a monitor to display a text document being typed, it displays the current 

typing position through a special character, called the cursor. The cursor can have different shapes in 

different programs. However, its usual shape is a blinking/non-blinking vertical I beam, the underscore 

character (_) or the solid rectangle. The cursor is shown on the monitor where the next typed (keyed-

in) character will be accepted and displayed. When you type a character, it is displayed at the cursor 

position and the cursor advances to the next position on the monitor. 

Fig. 1.12 An LCD monitor
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Mouse The mouse is a device that is used extensively in Windows-

based programs. The mouse acts as an interface between the PC and 

the user. You can use the mouse as an alternative to entering commands 

through the keyboard—to start a program, open a document, move 

the cursor, select options and to execute commands. The mouse can 

have different shapes and sizes. A typical mouse is shown in

Fig. 1.13. A mouse may have two or three buttons and is connected to 

a Serial or USB (Universal Serial Bus) port of the PC. 

The mouse is kept on a fl at surface. When you move the mouse 

on the surface, the mouse pointer also moves in the same direction on your monitor. Thus, you can 

move the mouse pointer on the desired command or option displayed on your monitor. To select the 

command or option, press the corresponding mouse button and then release it. Pressing the mouse 

button is also called clicking. At most times, the left button is used to select commands or options. The 

right button is usually used by programs to display a shortcut menu to choose an option.

For starting (launching) a program, closing an open window, opening a directory or to select a word, 

you may be required to double-click the mouse button. Double clicking requires pressing the left button 

rapidly twice. You might require some practice to get the feel of double-clicking the mouse. Usually 

the mouse also contains a scroll wheel in the center which may be used to quickly scroll a document 

displayed on the screen.

Usually, a mouse is connected through a wire to your PC; however, wireless mouse is also available. 

In early 2000s, a typical mouse used to be of mechanical type, which contained a rubber ball on the 

bottom. When the mouse was moved, the ball rolled in the same direction, which in turn moved other 

mechanical components in the mouse to generate electrical signals. However, after some use, dust 

enters inside the mouse and mouse movement becomes jerky, requiring periodic cleaning to make the 

mouse work properly. However, these days, most PCs use an optical mouse that uses light-emitting 

diodes (LEDs) and special optical components to detect mouse movement. An optical mouse can be 

used on a variety of surfaces with ease. 

The mouse is generally not used with Laptop/Netbook PCs, which have a special area called 

touchpad. When the user moves a fi nger on the touchpad, it moves the pointer on the monitor in a 

relative manner. The touchpad area also has buttons to serve like the standard mouse buttons. Besides, 

you may also be able to click or double-click by tapping the touchpad surface by your fi nger.

Floppy Disk Drive and Diskette Until 2008, the fl oppy disk drive was an important input/

output (I/O) device in the PC. (The I/O device is used for inputting (reading) and storing (writing) 

information.) The PC may contain one or more fl oppy disk drives. The fl oppy disk drive is a storage 

device. It stores information (documents) on the fl oppy diskette that is inserted in the fl oppy disk drive. 

The fl oppy diskette is usually called fl oppy disk or disk. The PC stores all types of information, such 

as letters, computer programs, spreadsheets, databases, etc., on fl oppy disks. When the PC requires 

the information stored on fl oppy disks, it reads the information back through the fl oppy disk drive. In 

other words, the fl oppy disk drive is a storage or reading/writing device and the fl oppy disk is storage 

medium. If you do not need the information stored on a disk any more, you can erase it. In this way, 

you can make room for new information on the same disk. 

The fl oppy disk is a fl exible plastic disk that has a magnetic coating on one or both sides. This plastic 

disk is enclosed inside another square plastic jacket. Two types of fl oppy disks are used in PCs:

1. 5.25≤ Floppy Disk (Mini Floppy Disk)

2. 3.5≤ Floppy Disk (Micro Floppy Disk)

Fig. 1.13 A typical mouse
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A mini fl oppy disk is shown in Fig. 1.14 and a micro fl oppy disk in Fig. 1.15. As micro fl oppy disks 

are more reliable, the mini fl oppy disks have now become obsolete. Even, micro fl oppy disks are rarely 

used on new PC these days.

 

 Fig. 1.14 A 5.25” mini fl oppy disk Fig. 1.15 A 3.5” micro fl oppy disk

Hard Disk Drive Unlike a fl oppy disk that is fl exible and 

removable, the hard disk drive used in the PC is permanently 

fi xed. When hard disk drives were initially used in PCs in 

1980s, their storage capacity was about 10 MB (10,000,000 

bytes or characters). The hard disk storage capacity have has 

increased steadily since then. These days, most PCs have hard 

disk capacity of at least 80 GBs. (Giga Bytes; 1GB = 1000 

MB). Nowadays, hard disk capacities of 160 GB, 320 GB, 500 

GB, 640 GB and 1000 GB (1 TB) and higher are common. The 

data transfer rate between the CPU and the hard disk is much 

higher compared to that between the CPU and the fl oppy disk 

drive. The CPU can use the hard disk to load programs and data 

as well as to store data. The hard disk is a very important input/

output (I/O) device. It does not require any special care except 

that one should operate the PC in a dust-free and cool room 

(preferably air-conditioned). Modern hard disk drives are very 

compact, just 2.5–3.5 inches wide with recording surfaces and 

tiny heads inside a sealed box. Figure 1.16 displays an opened 

500 GB hard disk with its recording surface and head exposed. 

The hard disk shown in Fig. 1.16 is also called internal hard 

disk drive as it is mounted inside the CPU box or laptop. 

Besides, there is another type of hard disk drive, called external 

hard disk drive, which is kept outside the CPU box/laptop and 

is connected to it though a USB cable. The external drives have 

storage capacities of 500GB and higher, and are normally used 

to backup data from the internal hard disk and other sources. 

Figure 1.17 displays a 3 TB (Terabyte) capacity external hard 

disk drive. 

Fig. 1.16 An open hard disk drive

Fig. 1.17 An external hard disk drive
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Compact Disk Drives—CD and DVD You have used compact disk (CD) to listen to audio 

music. CDs are also used in a PC in to store data. Data CDs used in a PC are similar in shape and size 

to the audio CD. Unlike fl oppy disks that use the magnetic technology to store data, the CD uses the 

laser optical (laser) technology. Due to the laser technology, CDs can hold huge amount of data in the 

range of 650 to 700 MB. The computer CD is used to load computer programs and other data into the 

hard disk of a PC. You can also use CD to store audio and video information. Most of the new computer 

programs are now available only on CDs. Sometimes, programs are directly run from the CD. The PC 

may also directly read the data stored on the CD at the time of running a program. The drive in your PC 

that reads information from a CD is called CD-ROM (Read Only Memory) drive. These devices were 

called CD-ROM because initially when these drives were introduced in PCs, they could only read CDs 

and had no writing capabilities. So, these drives were used as an input device. 

Around 2001, recordable CDs (called CD-Rs) started becoming common for use in PCs. You can 

record data only once on a CD-R. The other type of CD that allows you to write several times is called 

compact disk rewritable (CD-RW). The drive that can record or write data on a CD-R or CD-RW is 

called CDRW-ROM drive. Unlike a fl oppy disk, you cannot erase data from a CD-R and write new 

data. However, as CD-Rs are quite cheap and they offer huge data storage capacity, their use in PC as 

data storage and backup has become quite common. As CD-Rs have become quite common and even 

the cost of CDRW-ROM drives have come down signifi cantly, most new PCs come equipped with a 

CDRW-ROM drive. A CDRW-ROM drive acts like an I/O device in the PC. A CD-ROM/CDRW-

ROM drive can also play regular audio CDs. These drives have a built-in jack for an earphone so that 

you can listen to audio CDs even if your PC does not have external speakers. 

Since 2004, most new PCs offer a DVD (Digital Versatile Disc/Digital Video Disc) drive that can 

use a DVD disk. The DVD disk offers a data storage capacity of 4.7 GB, which is almost nine times 

of the data storage capacity of a CD. Besides storing data on recordable DVD disks, the DVD drive 

available on a PC may also be used to watch regular DVD movies and other programs on the PC.

Fig. 1.18 A DVD/CD rewritable drive

Your PC may have separate CD and DVD drives or a two-in-on drive that can play/record CDs as 

well as DVDs. Figure 1.18 displays a DVD/CD rewritable drive that can read and record CDs as well 

as DVDs. The drive is mounted inside the CPU box and only the front part of the drive is visible from 

outside. 

Blu-ray Drives and Disks The Blu-ray disks are very high capacity optical storage medium. 

They are similar to DVDs and CDs in physical dimensions but have storage capacity of 25 to 100 GB. 

These are called Blu-ray because a blue-violet color laser is used in the read-write head in the drive. 

In the beginning, these were used for playing very high quality feature fi lms, however, as reasonably 

priced recordable Blu-ray disks appeared, PC manufacturers started using them in PCs to play high 

quality video as well to store large amount of data. The PC may have a built-in Blu-ray drive or there 
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may be an external Blu-ray drive connected through an USB cable. Figure 1.19 displays a Blu-ray drive 

and disk.

Fig. 1.19 A Blu-ray drive and disk

1.14 OTHER TYPES OF COMPUTERS 

Personal Digital Assistant (PDA), also known as palmtop computer, Tablet computer and E-book reader 

are other types of computers preferred by those who want to carry their computers with them. PDA is 

a small handheld device which has productivity software applications, such as contact list, calendar, 

notepad and calculator. The PDA lacks several common software applications found on a typical PC; 

therefore, it has limited use. Figure 1.20 displays a PDA. 

 

 Fig. 1.20 A Personal Digital Assistant (PDA) Fig. 1.21 iPad, a tablet computer

A tablet computer is a smaller version of a laptop PC. Though tablet PCs have been around for 

many years, in 2010, Apple Inc. revolutionized the tablet market by introducing a new product called 

iPad, shown in Fig. 1.21. The tablet computer has a fl at touch screen also works as an on-screen 

virtual keyboard. By removing other hardware, such as CD-ROM drive and mouse touch pad, iPad 

became quite light, thin and easy to carry. The iPad and other similar devices introduced later by other 
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manufacturers are quite powerful and can serve the typical needs, such as web browsing, emailing 

and document-editing of a common user with ease. Aakash developed under the Government of India 

initiative also falls under the tablet computer category. 

An e-book reader is a special type of tablet computer that has been optimized for readability in 

bright light and long battery life up to a month or more. While originally, these devices were developed 

for the sole purpose of reading books, the new generation e-book readers have capability to browse the 

Internet, play music, send and receive emails and open PDF and Word documents. An e-book reader 

is shown in Fig. 1.22.

These days, smartphones have become so powerful and user-friendly that they are being used to 

perform several tasks, such as contact lists, calculator, calendar, emailing and web browsing, which 

were, until a few years ago done on a typical PC. Smartphones are improved versions of PDAs and 

offer the same features, besides also having the capability of making phone calls. Therefore, PDAs are 

gradually becoming obsolete. Figure 1.23 displays a typical smartphone.

   

 Fig. 1.22 An E-book reader Fig. 1.23 A smartphone

1.15 OTHER INPUT/OUTPUT DEVICES USED WITH PCS 

There are several other input/output devices, such as USB Flash drive, printer, zip drive, webcam, 

scanner, trackball, joystick, speakers, microphone, modem, router and card reader. Some of these 

devices are commonly used with PCs whereas others are used for specifi c applications. These input/

output devices are explained in brief in this section.

1.15.1 USB Flash Drive

USB fl ash drive, commonly known as USB memory has replaced 

fl oppy disks because of their compact size, light weight, high data 

storage capacity and reasonable price. A USB fl ash drive, shown in 

Fig. 1.24 contains a semiconductor fl ash memory data storage device 

and a USB interface. USB fl ash drives come in various capacities 

ranging from a few MB to 64 GB. It is expected that in the near 

future, even higher capacities USB fl ash memories will be available. 

USB memories have reasonably fast data transfer speed; therefore, Fig. 1.24 A USB fl ash drive
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transferring fi les to and from these devices does not take a long time. USB fl ash memories are fast 

becoming a preferred device for data backup for home and small business PCs. 

1.15.2 Printer

The printer is an output device that is used to print documents on paper. Various kinds of printers are 

used with PCs. A few years ago, the Dot Matrix Printer (DMP) was the most commonly used printer 

with PCs because of its low cost and reasonably good speed. The print head in a DMP contains a few 

tiny needles. There are 7 or 9 needles in a low quality DMP and up to 24 needles in a high quality DMP. 

At the time of printing, as the head moves from one end of the paper to the other, these needles are fi red 

selectively to print different characters or graphics. Dot Matrix Printers usually have a printing speed 

of 100 to 500 characters per second.

Nowadays, InkJet/BubbleJet printers are also the popular choice for use with PCs. These printers 

offer good print quality and noiseless operation. These are non-impact printers that print characters 

and graphics by spraying very tiny drops of ink directly onto paper. The print quality of these

printers is much better compared to DMPs. The typical print quality of these printers is from 300 dots 

per inch (DPI) to 4800 DPI. Most of these printers can also print in color. An inkjet printer is shown 

in Fig. 1.25.

 

 Fig. 1.25 InkJet printer Fig. 1.26 Laser printer

Laser printers are also being commonly used with high-end PCs; particularly those used for Desktop 

Publishing (DTP). They provide very high quality printout, typically in the range of 300 DPI to 2400 

DPI; however, these are costlier than DMP and InkJet printers. The typical printing speed of laser 

printers is between 3 to 30 pages per minute. High-end laser printers can also print in color. A laser 

printer is shown in Fig. 1.26.

Line printers, drum printers and chain printers are some other types of impact printers. These printers 

are high-speed printers that can print up to 6000 lines per minute. These printers are generally used 

with mini or mainframe computers, and are not as popular with PCs. 

Each printer has its own style of loading paper and ribbon/ink cartridge in it. If you face any problem 

in loading paper or ribbon/ink cartridge, refer to the printer manual or contact your printer supplier/

vendor. Printers are connected to PCs through serial, parallel or USB interface. Some printers may 

offer more than one interface. 
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1.15.3 Scanner

The scanner is an input device that is capable of 

recognizing text or graphics on the input document. The 

most common scanner used with a PC is called the fl atbed 

scanner (see Fig. 1.27). In this scanner, the document is 

placed facing down on a fl at sheet of glass. A laser-based 

scanning mechanism moves under the glass from one end 

to the other to scan and convert the document into a digital 

form. You can use a scanner to convert a photograph or 

drawing into a computer fi le. After an image has been 

converted into a fi le, it can be printed or used along with 

some other document. For instance, you can scan the logo 

of a company in a graphics fi le. Later, you can print it at 

the top of letters. Though generally not used with PCs, 

scanners are also used for various applications, such as:

1. As bar code readers to identify a product. Bar code readers are 

commonly used in supermarkets and big retail stores at sale 

counters. As these scanners are normally held in hand, they are 

called handheld scanners. A typical handheld scanner is shown 

in Fig. 1.28. 

2. As magnetic-ink character recognizers (MICR) to sort bank 

cheques.

3. As optical mark readers (OMR) to automatically evaluate 

objective-type answer sheets.

4. As optical character readers (OCR) to automatically convert text 

printed on a sheet into computer text fi les. OCR uses special 

software that matches scanned character shapes with stored set 

of characters to convert scanned document into computer text. 

1.15.4 Multi-Function Printers

Multi-function printers can perform other jobs 

besides printing. For instance, a multi-function 

printer may include a scanner. By printing 

the scanned document, the printer can act as 

a copier. Faxing capability is another useful 

function available in some of the multi-function 

printers. The printer may include a dial pad to 

enable the user to send the fax. Of course, the 

printer can easily print the received faxes since 

it already has the printing capability. A laser 

multi-function printer is shown in Fig. 1.29 

that can copy, scan and fax.

Fig. 1.27 Flatbed scanner

Fig. 1.28 Handheld scanner

Fig. 1.29  A laser multi-function printer with scan, copy 

and fax features
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1.15.5 Zip Drive

The zip drive, an I/O device, is a modifi ed fl oppy drive. The size of the zip 

fl oppy disk is the same as that of an ordinary micro fl oppy disk, though 

it is slightly thicker. The storage capacity of a zip diskette is several 

times that of a micro fl oppy diskette. Zip diskettes are available with 

different storage capacities, such as 100 MB, 250 MB and even 750 MB.

Zip drives, which were popular in 1990s, are rarely used these days. 

Figure 1.30 shows a 750 MB zip fl oppy disk.

1.15.6 Webcam and Video Cameras

Webcam (short for Web Camera) is a small digital camera that can take 

still as well as video images. Figure 1.31 displays a typical webcam. The 

use of a webcam is limited only by your imagination. You can use it to 

take pictures that you can include in a document or email pictures to 

your friends. Webcams are also used to web cast events live or for video 

chat. Some webcams also have zoom feature. Webcams are also used to 

record video for surveillance purpose. Most Laptop, Netbook and tablet 

computers have a built-in camera.

Nowadays, most regular digital/video cameras are PC compatible. 

They have all the capabilities of a webcam, have better resolution picture 

quality, are easy to use and can be operated away from PC. You can record 

a video indoors or outdoors and then transfer it to your PC’s hard disk. 

1.15.7 Trackball

Trackball is a pointing device, which is functionally similar to a typical 

mouse. Trackball is commonly used with laptop computers. A trackball, 

shown in Fig. 1.32 contains a plastic ball that rests on two rollers. These 

rollers are positioned at right angles to each other. When the user moves 

the ball with his/her fi ngers, it moves the rollers whose motion gets 

converted into electrical signal to move the mouse pointer on the screen. 

Like mouse, the trackball also has buttons for left and right clicking. 

Trackball is functionally similar to mouse, the only difference being how 

the ball is moved. Whereas in trackball, the ball is directly moved by hand, 

in mouse, the ball gets moved when mouse is moved on the mouse pad. 

Though both trackball and mouse are used for similar purpose, pointer 

movement is more precise in trackball. 

1.15.8 Joystick 

Joystick is a pointing device that is generally used for playing games on 

PC and other video game machines. Other applications of joystick include 

control of industrial machines, e.g., cranes. A typical joystick is shown in 

Fig. 1.33. In a joystick, a vertical stem is attached to a square, rectangular 

or oval base. The stem, which is held by hand, can be moved in all 

directions. The control buttons are located at the base or sometimes at the 

top of the stem. As the stem is moved, the pointer or object moves in the same direction on the screen. 

When the stem is released, the pointer or object stops moving. The control buttons have different effects 

in different applications, e.g., pressing a button may fi re a gun. 

Fig. 1.30 Zip fl oppy disk

Fig. 1.31 Webcam

Fig. 1.32 Trackball

Fig. 1.33 Joystick
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1.15.9 Microphone and Speakers

In the modern multimedia PC, microphone 

(mike) and speakers play an important role. 

Speakers are used to play audio-clips, songs, 

etc., and the microphone helps to record an 

audio sound for online audio chat or making 

phone calls using the Internet. Both these 

devices are connected to the back of the 

PC through cables and jacks. Usually the 

speakers also have an amplifi er to boost the 

sound. A set of speakers and microphone 

are shown in Fig. 1.34. Most laptops, 

netbooks and tablet computers have built-in 

microphones and speakers.

Headphone and Microphone If you want to listen to 

music without disturbance from external noise, you have use a 

headphone, which come in all sorts of quality and price range. 

As computers are also used for making phone calls, several 

headphones come with a built-in microphone. Figure 1.35 

displays a typical headphone with built-in microphone. 

1.15.10 Modem, Network Card and Router

It is diffi cult to imagine a modern PC that is not able access the Internet. A PC can access the Internet 

in many different ways, such as through LAN (Local Area Network), telephone line, TV cable, or 

through a wireless connection. The fi rst device that you need to be able to connect to the Internet is the 

Modem (from modulator-demodulator) that acts an as interface between the PC and the outside signal 

carrier. Depending on the type source you want to connect to, there are different types of modems, 

such a dial-up modem card, DSL (Digital Subscriber Line) modem, Cable modem, etc. A modem may 

be installed in the PC as a card, or your PC may use an external modem. An internal modem card is 

shown in Fig. 1.36. This card is installed in the PC and the telephone line is plugged into this modem 

card. The internal modem card has a speed of up to 56 Kilo bauds (bits/second) and is used for dial-up 

telephone connections. 

Fig. 1.36 56K Internal FAX modem card

Fig. 1.34 Microphone and speakers used with PCs

Fig. 1.35  Headphone with built-in 

microphone
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For high speed Internet connection, usually an external modem device is used. These external modem 

provide the output signal as per the Ethernet standard, therefore, your PC must have a corresponding 

Network card, also called Network Adapter/Interface card. A typical PCI (Peripheral Component Inter-

connect) Network card, shown in Fig. 1.37 has an Ethernet (RJ45) connector to connect to the modem 

through an Ethernet (RJ45) cable. The Ethernet cable is also called the Network cable. Your PC may 

be connected to a LAN; in that case, you may be able to connect to Internet through LAN.

Fig. 1.37 PCI network card

In a typical home or a small offi ce environment, we have multiple PCs and would like to provide the 

Internet access on each PC. Instead of connecting each PC to a separate signal source and modem, the 

preferred solution is to get a high-speed Internet connection and modem. Then, the modem is connected 

to a device called Router that allows a single internet connection to be shared with several PCs. For best 

convenience, it is recommended to get a wireless router that enables PCs to be connected in wired as 

well as wireless mode. A wireless router is shown in Fig. 1.38. A typical scheme of connecting PCs to 

internet through a modem and router is illustrated in Fig. 1.39. Notice that to connect a PC to a router 

through wireless, it must have a wireless network card. A wireless network card is usually built-in in a 

laptop and Netbook PC.

Fig. 1.38 A wireless router
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Fig. 1.39 Connecting multiple PCs to the Internet using a modem and router

1.15.11 Card, Keypunch Machine and Card Reader 

Though cards (also called punched cards) are almost obsolete, however, until 1970s these were 

commonly used to feed data and programs into computers. A typical card is made of thick paper and is 

about 3 inches in height and 7 inches long. Each card has 80 columns and 12 rows. By pouching holes 

in different row positions, each column can represent a specifi c number, letter or symbol. Basically, 

each card can be used to store up to 80 characters of data or program. To prepare (punch) these 

cards, a special machine called the keypunch machine was used. This machine is similar to an electric 

typewriter. When the user presses a key on the keyboard, it punches holes in required rows at the 

required column position. To read data punched on cards for processing, a machine known as card 

reader is used. 

1.15.12 Digitizer

A digitizer is an electronic device, which is used to extract information from paper drawings or maps, 

or convert them into electronic form. For example, it can be used to fi nd distance between two points 

from a construction blueprints drawing. Typically, the drawing or map is placed on digitizer’s surface. 

When you position the electronic pen at any point on the drawing, the micro-grid of X-Y coordinates 

on the digitizer’s surface translates that point into its X-Y coordinates. Thus, you can get coordinates 

for any point on the drawing. Now if you provide the drawing scale to the digitizer, it can provide the 

real distance between any two points. The digitizer software can help you to convert paper drawing 

into electronic forms. Digitizers are available in different resolutions and sizes, such as 24 × 36≤ or

36 × 48≤. 
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1.16 WHAT IS INSIDE A CPU BOX? 

If you have been following through the chapter, you have fairly good idea what is inside the CPU box 

of a PC. In brief, the CPU box contains a Power Supply Unit, Floppy Disk drive, Hard disk drive, CD 

drive, DVD drive and electronic boards. The main electronic board, which is called the mother board, 

has connectors for connecting internal as well as external devices. The mother board contains the main 

CPU IC and controllers for controlling most common I/O devices, such as keyboard, monitor, printers, 

USB devices, etc. To cool the CPU IC, usually a heat sink and a cooling fan is mounted on the CPU IC. 

For installing RAM memory and other custom hardware, the mother board has spare slots. Thus, one 

can install the required amount of RAM memory by installing additional memory boards or installing 

a different set of memory cards. A typical mother board is shown in Fig. 1.40. Notice that the mother 

board contains a set of connectors that enable external devices, such as keyboard, mouse, monitor, 

printers, microphone, speakers, webcam, etc., to be connected. The mother board is installed in such a 

way that most of the connectors are available at the back of the CPU box, though some USB connectors 

may also be available at the front for the ease of use. Since the electronic components inside the CPU 

box are very delicate and may easily get damaged even when just touched by bare hands due to the 

static electricity, opening and servicing the CPU box should be avoided, unless all the precautions are 

followed. 

Fig. 1.40 A mother board used in a PC

1.17 SETTING UP AND STARTING THE PC 

If you need to setup a new PC, open all boxes and remove the contents. Visually inspect the contents 

to ensure that there was no damage during transportation. If all contents are in good shape, place the 

CPU box on or under the desk, and the monitor on the desk. If possible, connect the monitor power 

cord in the socket provided at the back of the CPU box. Then connect the monitor video cable to the 

corresponding connector at the back of the CPU box. Usually, the connectors at the back of the CPU 

are clearly marked and most connectors won’t go in the wrong place, but still be careful that you don’t 
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attempt to force the connectors in the wrong place. Most new keyboards and mouse come with the USB 

interface. In that case, these may be connected to any USB port. On the other hand, if your keyboard 

and/or mouse have old-style (PS/2) connectors, carefully connect these to the corresponding connectors 

at the back of the CPU box. In the same way, connect the printer to a serial, parallel or USB port. 

The microphone and speaker cables and jacks are almost similar in size and can easily get mixed-up. 

Therefore, when connecting them, be extra careful. Usually the speaker and microphone connectors are 

coded with different color. 

After you have done all connections, connect the CPU box power cord to the Constant Voltage 

Transformer (CVT) or an uninterruptible power supply (UPS) source. Whereas a CVT can take care of 

the voltage fl uctuations in the power line, a UPS, besides providing stable power, will also ensure that 

the PC continues to work when the electric power fails. Depending on the batteries installed in the UPS, 

it may continue to power the PC from a few minutes to hours, but in any case will give you a chance to 

save your work and gracefully shutdown the PC. However, if you do not have a CVT or UPS, at least 

use a surge-protector, which can protect your PC from voltage spikes. 

After making all connections, press the power-on button usually located at the front of the CPU 

box. After power on, the PC performs a Power-on Self-Test (POST) to ensure that critical components 

of the PC, including the memory are working correctly. The main jobs of POST are handled through 

BIOS (Basic Input/Output System), a small set of program stored in a permanent memory. The BOIS 

is the fi rst program run when the PC starts. The BIOS check that all basic operations, such as fl oppy 

disk, hard disk, video display units, RAM memory and other hardware is working correctly. If the 

PC encounters any errors during POST, it provides a suitable error codes through beeps or displaying 

the error code on the monitor. If everything is fi ne, it proceeds to load the operating system (OS), 

usually from the hard disk, and you will see the OS, usually Windows opening screen on the monitor. 

Depending on the Windows setup you may be required to provide a username and password to access 

the PC. After you have provided a valid username and password, if required, Windows gives you the 

access to the PC. Now you are in the full control of the PC. Figure 1.41 displays a typical Windows 

Fig. 1.41 Windows Desktop
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screen on Windows 7. Since you might be using a different Windows version, and the Windows screen 

is highly customisable, the screen that you will see on your monitor may be signifi cantly different from 

that show in the fi gure. Basically, the screen consists of a few icons that represent program or folders, 

customisable background, and a taskbar at the bottom of the screen. The taskbar contains a Start button, 

details about open windows, buttons to start common programs, current time and other information. 

This will be discussed in detail in the next chapter.
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USING WINDOWS

In this chapter, we will discuss the following topics:

History of Windows  �

Starting Windows �

The Desktop and Using the Mouse �

What is a Window �

Maximizing, Minimizing, Restoring, Closing, Moving and   �

Resizing a Window

Using the Start Menu �

Shutting Down, Restarting and Logging off Windows  �

Customizing Desktop: Gadgets, Themes, Screen Saver, Screen  �

Resolution and Using Multiple Monitors

Control Panel and Taskbar �

Managing Multiple Windows: Windows Flip, Aero Peek, Aero  �

Snap and Aero Shake

Windows Explorer: Libraries, Rename, Copy, Delete, Move Files  �

and Folders

Searching for Files and Folders �

Compressing (Zipping) Files and Folders �

Recycle Bin �

Burning Files to a CD or DVD �

Getting Help �

Installing USB Devices, and Printers  �

Downloading, Installing and Uninstalling a Program �

Windows Updates, Using System Tools and User Accounts �

Notepad, WordPad, Calculator, Paint, Snipping Tool and �

Sticky Notes

Creating Shortcuts on Desktop �

Windows Media Player �

Windows Essentials �
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2.1 HISTORY OF WINDOWS 

The operating system for Personal Computers (PCs) in the early 1980s was DOS (Disk Operating 

System), a single user, character-based operating system. Microsoft Corporation started working on 

developing a graphical user interface (GUI) for PCs in 1983. Microsoft came out with a few versions 

of Windows, such as Windows 1, Windows 2.0 and Windows 386 during 1985–1988, however, these 

versions did not become popular. Windows 3, announced in 1990 was the fi rst Windows program that 

was accepted by the users and software developers on a large scale. In 1992, Microsoft Corporation 

announced Windows 3.1, the enhanced and updated version of Windows 3. Windows 3.1 (or its 

variations, such as Windows 3 and 3.11) is not a full-fl edged operating system. It is a program that runs 

over DOS. It enhances the power and use of a PC running DOS in the following three ways:

1. It converts the plain character-based user interface provided by DOS into a Graphical User 

Interface (GUI). It makes the use of computers easy as users are not required to remember and 

type commands. Instead, users can click the little pictures (called icons) that represent commands 

to run programs. 

2. It provides multitasking capabilities to the PC. A PC running DOS can run only one task (program) 

at a time. For instance, you cannot simultaneously run word processor and spreadsheet program 

on a DOS-based PC. However, Windows converts a PC that could run just one program into a PC 

that can run two or more tasks simultaneously. 

3. Unlike DOS, that displays information in characters of the same size, Windows can use different 

fonts, i.e., different shapes and sizes of characters can be displayed and printed. TrueType fonts 

introduced in Windows 3.1 appear the same on the monitor as well as on the printed page.

Besides these, Windows provides the basis for a consistent user interface. Windows-based programs 

behave in an almost identical manner as far the user interface is concerned. That is, the method to move 

the cursor, select menu items, format text, scroll a document, open and save fi les, etc., in different 

Windows-based programs is almost the same.

Whereas Windows 3.1 is not an operating system, Windows NT introduced by Microsoft Corporations 

almost at the same time, is a complete operating system. The GUI used in Windows NT is almost same 

as that used in Windows 3.1, however Windows NT is more reliable. Windows NT is very diffi cult 

to be corrupted by other programs that do not work properly or crash. Windows NT did not become 

popular because it needed a lot of hardware resources (CPU power and memory) which were not easily 

available in PCs in early 1990s. 

In 1993, Microsoft introduced another product called Windows for Workgroup. It is the same as 

Windows 3.1. However, it also contains the required networking software for connecting different PCs 

without requiring any extra software. In other words, now PCs running Windows for Workgroup can 

share information and other input/output resources, such as printers. 

In 1995, Microsoft introduced Windows 95. Unlike Windows 3.1, Windows 95 is a full-fl edged 

operating system. That is, you do not need DOS to run Windows 95. The user interface in Windows 

95 was redesigned, and it introduced plug and play that allows the Operating System to automatically 

detect and confi gure hardware. Windows 95 was a great success. 

Microsoft came out with an updated and enhanced version of Windows 95 in the form of Windows 

98. Again, Windows 98 was a runaway success. Microsoft combined Windows NT technology and 

Windows 98 graphical user interface into Windows 2000 that was released towards the end of 1999. 
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While Windows 95 and Windows 98 use the FAT (File Allocation Table) fi le system, Windows NT 

and Windows 2000 use NTFS (Windows NT File System). The NTFS fi le system provides improved 

performance, reliability and better disk space utilisation. In September 2000, Microsoft released 

Windows Me (Millennium Edition), an upgraded Windows 98 with enhanced multimedia and Internet 

features. Another useful feature introduced in Windows Me is System Restore that allows rolling back 

of system fi les and installed programs to previous state if the computers starts failing or malfunctioning 

after installing a new program or software update.

In October 2001, Microsoft released Windows XP, an updated version of Windows 2000. The 

“XP” name is short for experience, symbolizing the rich and extended user experiences offered by the 

operating system. Windows XP also allows multiple user accounts on a single PC, where each user 

can have separate rights on the PC resources and customise and maintain separate settings. Microsoft 

released its Windows Vista in January 2007 and Windows 7 in October 2009. The next version of 

Windows, called Windows 8 was released in October 2012.

In this book, we shall discuss the basic features of Windows 7. Even if you are using Windows 

95/98/2000/Me/XP/Vista, many details given in this book are still applicable, though the information 

on your screen may be different from that shown in the book. Besides providing the basic operating 

capabilities to your PC, Windows 7 comes with a number of useful programs. It has its own Windows 

Explorer that can help you to copy and move fi les, and manage directories. Windows also comes with 

a number of useful applications, such as a mini word processor (WordPad), a drawing program (Paint), 

Clock, Calculator, Notepad and system tools to manage hard disks. In this chapter, we shall learn to 

use common features of Windows. 

Windows 7 comes in six editions—Starter, Home Basic, Home Premium, Professional, Ultimate 

and Enterprise. The Starter edition is normally used on low-end Netbooks. PCs used in homes normally 

have Home Basic or Home Premium edition of Windows 7. The Professional and Ultimate edition 

of Windows 7 are normally used in offi ces or high-end PCs. The Enterprise edition is available only 

for volume licensing for bulk users. Whereas the high-end Windows 7 editions have a few additional 

features, can address more physical memory and supports multiple processors, the basic features in all 

editions are the same. 

2.2 STARTING WINDOWS 

To start windows, switch on your PC. If your monitor has a power on/off switch, turn it on too and 

wait for a few seconds. The PC performs POST (Power on Self Test) and tries to start Windows. If it is 

successful in starting Windows, it either displays the Windows Desktop or you need to log on to your 

account to access Windows. This depends on the Windows version in use and how user accounts are 

set up. For instance, in a typical multiuser accounts setup on Windows 7, Windows displays user names 

and icons for all users. On clicking a user icon, Windows logs on to that account, if no password is 

defi ned for that account. On the other hand, if a password is associated to a user account, you will be 

prompted to enter the password before Windows gives you access to the computer. After successful log 

on, Windows displays the Desktop. 

2.2.1 Desktop

The screen that you see on starting Windows is called the desktop. Figure 2.1 displays a typical desktop, 

though the desktop that you would see on your PC may differ considerably from the one shown in the 
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fi gure. The desktop provides an interface between you and the applications you can run on your PC or 

the documents you can work with. 

A typical desktop consists of one or more icons and a taskbar. An icon is a small graphical picture 

that represents a document (fi le), application (e.g., a word processor), folder (directory), device (e.g., 

a printer or fl oppy drive), other computers, etc. As shown in Fig. 2.1, each icon has a text label that 

further explains it. Some of the icons generally found on the desktop include, Recycle Bin, Internet 

Explorer, Microsoft Word 2010, Microsoft Excel 2010 and Google Chrome. The Recycle Bin icon 

represents a folder that contains deleted fi les and folders. The Microsoft Word 2010 icon represents the 

Word Program. Similarly, other icons usually represent a corresponding program or folder. You will 

learn about common desktop icons later in this chapter.

Fig. 2.1 Windows desktop

The long horizontal bar at the bottom of the screen in Fig. 2.1 is called the taskbar. It consists of a 

Start button on the extreme left and the current time and date in the right. The area to the left of date 

and time is called the notifi cation area, where Windows displays activities happening on the PC, e.g., 

printing status, speaker volume or wireless signal strength. The Start button is used to open the Windows 

menu to start various programs installed on your PC. The taskbar usually also displays other icons that 

represent currently open applications or to launch Windows features or other applications. We will 

discuss the taskbar in detail later. Though Fig. 2.1 displays the taskbar at the bottom of the screen, you 

may place it at the top, left or right of the screen. If fact, the Windows desktop is highly customizable. 

As different persons set-up different items, such as pen, pencil, diary, calendar, table lamp, keyboard, 

etc., on their table differently, Windows allows you to completely customize the desktop. You will 

learn this very soon. First, let us learn the user interface, that is, how to interact with Windows to do 

various tasks. We will start with how to use a mouse. Even if you know how to operate the mouse, go 

through the next section, as we will introduce a few Windows concepts in that section.
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2.3 USING THE MOUSE 

The mouse is used to communicate with your PC. You can use the 

mouse to start or stop a program, make selections, move objects, run 

commands, etc. The mouse comes in different shapes. A typical mouse 

is shown in Fig. 2.2. Your mouse may have two or three buttons. 

2.3.1 Moving the Mouse 

You hold the mouse with your hand and move it across the fl at surface. 

When you move it across a fl at surface, a pointer moves across the 

computer screen in the same direction. The pointer that moves on 

the screen is called the mouse pointer. The mouse pointer can be of 

different shapes depending on its installation, the application you are 

running and its position on the screen. The typical shape of the mouse 

pointer is a hollow arrow as shown: 

2.3.2 Clicking the Mouse

Pressing and releasing the mouse button is called clicking the mouse. In Windows, clicking is used to 

select an item, e.g., an icon or a fi le, or to select text or image in a document. To select an item, say an 

icon on the desktop, you will move the mouse pointer on the item and click once. When you select an 

item by clicking, Windows highlights it and shows it in reverse background or a different color. Your 

mouse may have two or three buttons. Generally, clicking refers to clicking the left mouse button and 

we will follow the same convention. When we say, ‘click the mouse’, you press and release the left 

mouse button. In Windows, the middle mouse button is not used. Most applications, e.g., Word and 

Excel use the right mouse buttons for certain functions. On a Laptop/Netbook PC, you may click the 

mouse by tapping a fi nger on the touchpad or it may have separate buttons below the touchpad. 

Note  If you are a left-handed person, you may fi nd it diffi cult to press the left mouse button. Left-handed 
persons have an option of swapping the mouse buttons, i.e., after swapping the mouse buttons, the 
right button attains the functionality of the left. Therefore, if you are a left-handed person and have 
swapped the mouse buttons, when we say click the mouse button or click the left mouse button, you 
will press the right button. Refer to Section 2.9.2 to learn how to swap mouse buttons.

Let us practice some clicking. We will try to select the Recycle Bin icon. This icon looks like 

(refer to Fig. 2.1). The Recycle Bin icon looks different on Windows 98, XP or Vista.

∑ Move the mouse (or your fi nger on the touchpad) on the Recycle Bin icon and click once. The 

moment you click it, Windows highlights the icon as well as its label text. To deselect a selected 

icon, click any empty space on the desktop. 

Windows also provides useful tooltips for some icons and buttons on the desktop. Let us explore this. 

∑ Move the mouse pointer on the Recycle Bin icon and wait for a few seconds, and Windows displays 

a tooltip—“Contains the fi les and folders you have deleted” or something similar. If you do not get 

the tooltip, click anywhere on the desktop and try again.

Fig. 2.2 A typical mouse
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2.3.3 Double Clicking the Mouse

Rapidly clicking the mouse button twice is called double clicking. (You may also rapidly click your 

fi nger twice on the touchpad for double clicking.) In Windows, double clicking is used quite frequently 

for various purposes, such as to start an application associated with an icon, select text, open a folder, 

etc. Let us do some practice with double clicking the mouse.

∑ Double click mouse on the Recycle Bin icon on the desktop and Windows opens the Recycle Bin 

window superimposed on the desktop as shown in Fig. 2.3. If the Recycle window does not open, 

when you double click the mouse, you did not click fast enough. Try to click the mouse buttons 

rapidly.

Fig. 2.3 The Recycle Bin window on the Desktop

The Recycle Bin window is a typical window. All windows that you will see in Windows will be 

similar to this. You can resize or reposition any window anywhere on the desktop, or customize the 

display of its contents and appearance. Now, let us close the Recycle Bin window. 

∑ At the top right corner of the Recycle Bin window, you see a small button that looks like , 

which is the Close button. Click the mouse on the Close button to close the Recycle Bin window. 

2.3.4 Dragging the Mouse

Dragging the mouse means moving the mouse while keeping the left mouse button pressed. Dragging 

is generally used to move an item. For instance, you can move a window or an icon within a window/

desktop by dragging. Dragging is also used in Windows applications to move or copy text, move or 

copy fi les, and to draw lines and other shapes. Let us try to move the Recycle Bin icon by dragging it. 

(If the Recycle Bin window is open, click its close button to close it.)
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∑ Move the mouse pointer on the Recycle Bin icon. Press and hold (keep pressed) the left mouse 

button, and without releasing the button, move the mouse. 

 A copy of the icon moves with the mouse pointer. You can drag the icon anywhere on the desktop. 

When you release the mouse button, Windows places the icon at that spot on the desktop. 

2.3.5 Using the Scroll Wheel

If your mouse has a scroll wheel, you can use it to vertically scroll the contents of the window. Just 

rotate the scroll wheel and Windows moves the content of the current active window in the direction 

of the rotation.

2.4 WHAT IS A WINDOW? 

In the previous section, you got some idea about a window when you opened the Recycle Bin window. 

Typically, all windows look similar. In the Windows operating system, a window may represent several 

things, such as a document, an application (e.g., word processor or spreadsheet program), a folder (also 

known as directory/subdirectory), a dialog box (where the user enters some information), etc. You can 

keep several windows open at a time. Let us have a close look on a typical window. Figure 2.4 displays 

a Microsoft Word window. 

Fig. 2.4 A typical window
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The bar at the top of the window, called the title bar is used to display the name of the window and 

additional information, e.g., name of the document, if applicable. In the extreme left of the title bar, 

there is a Word icon. In fact, this icon is a button, called the Control Menu button. On clicking this 

button, Windows displays a menu that you can use to maximize, minimize, restore, move, resize and 

close the window, as shown. To close the menu, press Esc or Alt+F4 (press Alt and F4 keys together; 

do not press the ‘+’ key) or click anywhere outside the menu. 

The line below the title bar is called the tabs bar. (In Windows XP and prior versions, it is called the 

menu bar.) The tabs bar, which may not be available in some windows contains commands you can 

use on the current window and its contents. Some windows, e.g., Recycle Bin and Windows Explorer 

display an address bar below the title bar.

2.4.1 Maximizing, Minimizing, Restoring and Closing a Window

In Windows, every window is in one of the following three states: normal, maximized and minimized. 

In the normal state, the window can have any size just less than the maximum size of the desktop or its 

parent window. In the maximized state, the window occupies the entire area on the desktop or within 

its parent window. On the other hand, in the minimized state, the window is reduced to just a button on 

the taskbar or a small title bar within its parent window. 

When you work with multiple windows, sometimes you may like to use the entire screen for a 

particular window. For example, while working on a document fi le in the Word window, you may like 

to use the entire screen for the Word window. Later, if you want to work on a spreadsheet but do not 

want to close the Word document, you may minimize the Word window. After you have minimized or 

maximized a window, you may want to restore the window to its normal size. 

Maximize, Minimize and Restore a Window Look at Fig. 2.4. On the right side of the title 

bar of the window, there are three buttons. The fi rst button that looks like  is called the Minimize 

button. You can click this button to minimize the corresponding window. The button on the right 

side of Minimize button, which looks like  is called the Maximize button. Clicking this button 

maximizes the corresponding window. Let us use these buttons on the Recycle Bin window. 

∑ Double click the Recycle Bin icon to open the Recycle Bin window. Your screen should look 

similar to the Recycle Bin window displayed on the desktop shown in Fig. 2.3. (If the Recycle Bin 

window covers the entire desktop, it is already maximized. In that case, skip the next step.)

∑ Click , the Maximize button of the Recycle Bin window. 

 Windows expands the Recycle Bin window. Now it occupies the entire desktop (except the 

taskbar). 

When Windows maximizes a window, it replaces the Maximize button with the Restore button. This 

button looks like . You may click the Restore button to restore the window to its original size (prior 

to maximizing the window). Remember that the Restore button is displayed only when a window is in 

the maximized state. Let us restore the Recycle Bin window to its previous size.
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∑ Click , the Restore button on the Recycle Bin window’s title bar, and Windows restores the 

Recycle Bin window to its previous state. 

Another way to maximize a window or restore it to its previous size is by double-clicking its title bar. 

You can also minimize, maximize and restore an open window by clicking the corresponding command 

in the Control menu. Besides clicking the Control Menu button, you can also display the Control menu 

by right clicking the mouse (i.e., clicking the right mouse button) anywhere on the title bar of the 

window. 

∑ Click  on the title bar of the Recycle Bin window and watch the taskbar. 

 Windows minimizes the Recycle Bin window. In fact, the window is no more visible on the 

desktop. However, the ‘Recycle Bin’ window is available as a button on the Windows Explorer 

button on the taskbar, which looks like .

Next, let us try to restore the Recycle Bin window.

∑ Move the mouse on the Windows Explorer button and it displays a tiny Recycle Bin window 

above the button. Click the tiny ‘Recycle Bin’ window and Windows restores the Recycle Bin 

window. 

When a program (e.g., Recycle Bin or Microsoft Word) is running, Windows displays its icon as a 

button on the taskbar. The taskbar may also have icons for other pinned programs. (You will learn 

about pinning programs to the taskbar in Section 2.5.4.) To differentiate icons of pinned programs 

from the running (opened) programs, Windows highlights the icons of running programs by showing 

a border around these, as illustrated in Fig. 2.5. Notice that icons for Microsoft Word and Paint, which 

are running are enclosed in a border. On the other hand, other icons are displayed without the border as 

the corresponding programs are not running or open at the moment.

Fig. 2.5 Taskbar displaying icons for running and not running programs

Closing a Window The easiest way to close a window with the mouse is by clicking its Close 

button. The Close button that is located at the extreme right of the title bar looks like . You may 

also use the shortcut keys (Alt + F4) to close the current window. Moreover, if you prefer, you may use 

the Close command from the Control menu to close a window. The Control menu can be displayed by 

clicking the Control menu button on the title bar or right clicking the mouse anywhere on the title bar.

2.4.2 Moving and Resizing a Window

As we know, in Windows, you can open more than one windows at a time. You may need to open 

multiple windows when you want to run more than one application simultaneously. For instance, you 

can run Word in one window and Excel in another. When you have multiple windows open on your 

desktop, you may need to move or resize windows. Windows allows you to resize almost any open 

window or move it anywhere on the desktop or within its parent window.
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Moving a Window

∑ If the Recycle Bin window is not open, double click its icon to open it. If the window is maximized, 

click the Restore button on its title bar to restore it to normal state. 

You can move a window by dragging its title bar with the mouse. Let us move the Recycle Bin 

Window.

∑ Position the mouse pointer on any empty area on the title bar of the Recycle Bin window. 

∑ Press and hold the left mouse button. Without releasing the mouse button, move (drag) the mouse 

to move the window. When the window appears where you want to position the Recycle Bin 

window, release the mouse button.

 In the same way, you can move any open window on the desktop or within its parent window.

Resizing a Window You can change the size of most windows with ease. You may need to 

change the size of a window when you want to display more or less information in a window, or when 

it obstructs some other window and you want to show both windows simultaneously. Let us change the 

size of the Recycle Bin window. First, we will change the height of this window.

∑ Move the mouse pointer on the top or the bottom border of the window until the shape of the 

mouse pointer changes to a double-headed arrow similar to . While the mouse pointer is in the 

double-headed arrow shape, drag the mouse up or down. (Remember to keep the mouse button 

pressed while dragging.) As you drag the mouse, Windows resizes the window. 

If you want to change the width of a window, move the mouse pointer to its right or left-side border. 

The shape of the cursor changes to a double-headed arrow similar to . Then drag the border left or 

right to change the width of the window.

Note  If you want to change the height and width of the window simultaneously, drag the corner of the 
window. You may fi nd it easier to drag the bottom-right corner. (See Fig. 2.4.)

2.5 USING THE START MENU 

To start a program whose icon is available on the Desktop, you may double click it. For instance, 

double clicking the Trend Micro icon starts the Trend Micro program. (See Fig. 2.1.) In this way, you 

can start any program whose icon is available on the desktop. To start other programs whose icons are 

not available on the desktop, you can take the help of the Start menu. Clicking the Start button on the 

taskbar opens this menu. The Start button is located on the extreme left on the taskbar. 

∑ Click , the Start button located on the left of the taskbar. (See Fig. 2.1.). If your PC has a 

Windows keyboard, you can also open the Start menu by pressing the Windows key, which looks 

like ,  or something similar. 

Your PC displays a Start menu similar to the one shown in Fig. 2.6, though the menu you see on your 

monitor may be slightly different depending on the confi guration of this menu and the programs you 

have run recently. The Start menu is divided into two vertical sections: the white section in the left 

and the dark section in the right. As illustrated in Fig. 2.6, the left side Start menu displays pinned

programs at the top and frequently run programs below that. A pinned program always appears at the 

top of the Start menu for quick starting of the favorite programs. Notice that Windows displays a small 
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triangle against some of the programs (e.g., WordPad and Getting Started in Fig. 2.6) in the menu. This 

indicates that Windows displays more options (submenu) on selecting these menu items. To select a 

program from the Start menu, click the mouse on the desired program or use arrow keys to highlight it 

and then press the Enter key. If you do not want run any program from the Start menu, click any empty 

area on the desktop or press Esc.

Fig. 2.6 Start menu

Tip  To remove an item from the Start menu, e.g., Calculator or PDF Creator in Fig. 2.6, right click the 
corresponding item to display a shortcut menu and click Remove from this list. 

The right side of the Start menu contains links to important folders, such as Documents, Pictures, 

Music, Games, etc., on the computer. It also contains links to special Windows folders, such as Control 

Panel, Devices and Printers, Help and Support, etc. In this menu, you may also see “Run”, which is 

used to run a command in the old DOS style. Notice that an ellipsis (...) follows the Run command. 

When you choose a menu item that has an ellipsis (...) following its name, Windows opens a dialog 

box. For example, on choosing Run, you see the Run dialog box similar to what is shown below. 

This dialog box contains a message, a combo box to enter or choose a command , and three command 

buttons—OK, Cancel and Browse. The highlighted box in the center of the dialog box is called the 
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combo box. If you do not want to execute any command, click the Cancel button to close the dialog 

box.

At the bottom of the right side of the Start menu is the Shut Down button, which is used to shut down 

the computer. On clicking the arrow on the right of this button, Windows displays a few options, such 

as Restart, Hibernate, Sleep, Log Off, Lock, etc. These operations will be discussed later. 

2.5.1 Using All Programs to Access Programs

The Start menu can displays only a few items, whereas your computer typically contains dozens 

of programs. To access other programs installed in your computer, you can take the help of All 

Programs.

∑ Open the Start menu and click All Programs in the Start menu. 

Windows displays all programs installed on the computer in the menu as shown in Fig. 2.7. Notice that 

Windows replaces All Programs with Back in the menu; therefore, you may use Back (or the Esc key) 

to return back to the previous Start menu. Use the scroll bar in the menu to scroll the menu. 

Fig. 2.7 The Start menu displaying all programs installed on the computer

Notice that some programs, such as 7-Zip, Accessories, Dell DataSafe display a folder like icon to their 

left. On clicking these, Windows opens a submenu containing one or more options. Programs use this 

technique groups similar program under one menu item for quick access. For instance, you may fi nd 

Word 2010, Excel 2010, Access 2010, PowerPoint 2010 under Microsoft Offi ce in the menu. 

2.5.2 Searching for Programs and Files in Start Menu 

The Search box at the bottom of the Start menu (see Fig. 2.7) is amazing as it can locate any program 

installed in the computer almost instantaneously. Besides fi nding programs, it can also fi nd fi les with 

ease. When the Start menu opens, the insertion point (cursor) is positioned in the search box. As you 
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start typing in the search box, Windows initiates a very fast search operation and starts displaying 

programs and fi les matching the entered text. Let us use the Search box to fi nd the Word program on 

the computer.

∑ Open the Start menu and type Word in the Search box. 

Notice that as you type text in the search box, Windows updates the menu with matching programs, 

documents, fi les, etc., as shown in Fig. 2.8. To run a program or open a fi le, you just need to click it in 

the menu.

Fig. 2.8 Windows displaying programs and fi les matching the entered text “Word”

2.5.3 Pinning a Program to the Start Menu

Windows automatically updates and rearranges commands it displays in the Start menu depending 

on the programs you use and how frequently you use these. However, Windows can help you to place 

shortcuts for the programs you frequently use at the top of the menu so that you may fi nd these quickly. 

The process is called pinning a program to the Start menu. To pin a program to the Start menu:

∑ Click the Start button to open the Start menu and then click All Programs. If required, open a 

submenu to locate the program, e.g., Microsoft Word 2010 may be located under Microsoft Offi ce. 

∑ Right click the program that you want to Pin to display a context (shortcut) menu. Click Pin to 

Start Menu in the context menu. 

The pinned program appears in the top section of the Start menu. Later, if you decide to unpin a 

program from the Start menu, right click the pinned program and click “Unpin from Start Menu” in 

the context menu. 
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2.5.4 Pinning a Program to the Taskbar

Besides pinning a program to the Start menu, you can also pin a program to the taskbar, which makes 

sense as taskbar is normally always visible at the bottom of the desktop. After a program has been 

pinned to the taskbar, you just need a single click to start it. The procedure to pin a program to the 

taskbar is similar to pinning it the Start menu, except that you choose “Pin to Taskbar” instead of “Pin 

to Start Menu”. Similarly, to unpin a pinned program from the taskbar, right-click the program icon and 

click “Unpin this program from taskbar” in the context menu displayed by Windows. 

2.5.5 Copying Icons from Start Menu to the Desktop 

If you use a program frequently, and if its icon is available on the desktop, it may help you to quickly 

start the program. You can copy an icon from the Start menu to your desktop with ease: 

∑ Open the Start menu and locate the program whose icon you want to place on your desktop. 

∑ Drag the icon to your desktop. (See Fig. 2.9.) You may drag the icon on the desktop to reposition 

it, if required.

Once the icon for a program is available on your desktop, you may be able start the corresponding 

program by double clicking the mouse on that icon.

Fig. 2.9 Copying icon from Start menu to desktop

2.6 SHUTTING DOWN, RESTARTING AND

 LOGGING OFF WINDOWS 

If you do not want to work on your PC anymore, i.e., want to switch off the PC, you should fi rst shut

down Windows and let Windows switch off the computer.

Caution  Never switch off your PC without shutting down Windows, otherwise Windows may not start 
properly next time. Moreover, you may also lose your unsaved work. 
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∑ To shut down Windows, open the Start menu and click the Shut Down button, as illustrated in Fig. 2.9. 

The Shut Down button tries to close all open programs, shuts down Windows and then switches off the 

computer. If Windows is unable to close any program, it displays a suitable message. 

Sometimes, after installing an important update to Windows or installing or updating some other 

program, it may be required to restart Windows. The restart process shuts down Windows and restarts 

it again without switching off the computer. To restart Windows:

∑ Open the Start menu and click the arrow to the right of the Shut Down button, as illustrated in

Fig. 2.9. 

∑ Windows displays a submenu with these options: Switch User, Log Off, Lock, Restart, Sleep and 

Hibernate. Click Restart to restart Windows. After the Windows restarts, you will need to logon 

before you can use the computer.

Normally, computers contain sensitive or confi dential information, and you would not like 

unauthorized users to access it. Therefore, If you need to leave the computer unattended, to prevent 

unauthorized access to the computer, you may lock it or log off. When you lock the computer, Windows 

hides all program windows while they continue to run in the background. To unlock the computer, 

you need to enter the password. On the other hand, if you choose Log Off, Windows closes all open 

programs and you would need to Logon to work again on the computer. Use the Log Off option, if you 

need to leave the computer unattended for extended period.

∑ To Lock or Log Off, open the Start menu, click the arrow to the right of the Shut Down button and 

click the corresponding option on the submenu.

Windows supports multiple users and these users can even be logged on simultaneously. All logged on 

users can run programs independently. They can even run the same program, e.g., two users may run 

Microsoft Word 2010 program and work on their documents simultaneously. To switch users: 

∑ Open the Start menu, click the arrow to the right of the Shut Down button and click the Switch 

User option from the submenu. 

∑ Windows displays a screen with icons for all users. Click the icon for the desired user you want to 

switch to. You may be required to enter password before Windows allows you to access the user 

account.

2.6.1 Sleep and Hibernate

Windows can put the computer in sleep and hibernate modes to conserve electricity. These modes are 

particularly important for laptop PCs as these can extend the battery power. When you put the computer 

in these modes, Windows saves a copy of whatever applications were running on the hard disk. In 

the sleep mode, it also maintains a copy of the applications data in the memory for sometime, which 

can help the PC to wake up quickly during that time. If the computer has been in the sleep mode for 

extended time or is in hibernate mode, it reads the data from the saved fi le in the hard drive, so it may 

take few seconds to load all applications. 

∑ To bring the computer out of the sleep/hibernate mode, press a key on the keyboard or click 

mouse. If that does not work, press the Power button of your PC. 
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2.7 CUSTOMIZING THE DESKTOP 

Windows desktop is highly customizable. For example, you can add, delete or rearrange icons on the 

desktop or change their size. You can also change the visual appeal of the desktop and other Windows 

components by changing the theme. You can also add gadgets to the desktop, which display useful 

information. 

2.7.1 Rename and Delete Icons

Usually some text is displayed below the icon, which is helpful in identifying it. If you prefer, you can 

change this text. In order to do so

∑ Right click the icon on the desktop to display a context menu. Click Rename, type the new name 

and click any empty area on the desktop. 

If you do not need a desktop icon, you may delete it, though Windows 7 may not allow may not allow 

you to delete the Recycle Bin icon. 

∑ To delete a desktop icon, right click the icon and choose Delete from context menu. 

2.7.2 Resize and Arrange Icons

Depending on your screen size, resolution and your preference, you can display icons as large, medium 

or small. 

∑ Right click an empty area on the desktop and click View on context menu, and Windows displays 

the View options, as shown in Fig. 2.10. 

Fig. 2.10 Desktop icons View options

Now you may choose Large, Medium or Small icons options as per your preference. Notice that the 

“Align icons to grid” option is checked, which keeps the icons horizontally and vertically aligned to an 

invisible grid. The “Auto arrange icons” option, which is off by default and most users normally keep 
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it off is useful if you want Windows to automatically arrange icons when you move, rename, add or 

delete icons. 

∑ When the “Auto arrange icons” option is off, to reposition the icon on the desktop, just drag and 

drop it with mouse to the desired location. When you drag the icon with mouse, Windows attaches 

a copy of the icon to the mouse pointer. You can drag the mouse anywhere and the copy of the 

icon follows the mouse. When you release the mouse, Windows deletes the icon from the original 

position and places it at the new position.

Another way to rearrange icons on the desktop is by asking Windows to sort icons: 

∑ Right click an empty area on the desktop and click Sort by on context menu, and Windows displays 

a submenu containing these options: Name, Size, Item Type and Date Modifi ed. Now click the 

desired option to ask Windows to sort icons on the desktop. If you do not want to sort icons, click 

any empty area on the desktop to close the menu. 

Notice that View submenu in Fig. 2.10 contains two options, Show desktop icons and Show desktop 

gadgets checked. If you uncheck any of these options, Windows removes the corresponding item(s) 

from the desktop. 

2.7.3 Displaying Gadgets on the Desktop

A gadget is a special program that displays some useful information on the screen. Usually, the 

information displayed by the gadget updates on regular interval. Windows 7 contains a few gadgets, 

such as Clock, Calendar, CPU Meter, Currency Converted, Weather, Slide Show, Windows Media 

Center, etc. Most gadgets require an Internet connection to provide current information. You may fi nd 

the CPU Meter interesting as it displays the CPU and Random Access Memory usage in real time. 

Similarly, you may use the Windows Media Center gadget to launch Windows Media Center to play 

music or display pictures.

Fig. 2.11 Desktop Gadgets

∑ Right click an empty area on the desktop and click Gadgets on context menu, and the Window 

Gadgets Galley containing available gadgets appears, as shown in Fig. 2.11. Figure 2.11 also 

displays the Clock and Currency gadgets running on a desktop.
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∑ Double click the gadget icon to add it to your desktop. You can drag the gadget to reposition 

it anywhere on the desktop. When you hover the mouse on the gadget, it displays controls to 

customise the gadget. For instance, you may click  (Options) to display the weather details for 

a selected city with the Weather gadget or change the clock face for the Clock gadget. 

2.7.4 Changing the Desktop Background

While working on your PC, you are looking at the display on the monitor almost all the time. What 

would happen if your monitor displays a background color that you do not like? Well, there is no need 

to worry as Windows provides full control over the desktop background, also known as wallpaper. Let 

us learn to change the desktop background. 

∑ Right click the mouse on any empty area on the desktop; choose Personalize from the menu 

and Windows displays the Personalization window as shown in Fig. 2.12. You can also get this 

window by choosing Control Panel, Appearance and Personalization, Personalization from the 

Start menu.

There are two ways to change the desktop background; one by changing the theme and the other by 

directly changing background image. We will talk about themes in a moment. Notice that Fig. 2.12 

displays the current desktop background and the Desktop Background link below it.

Fig. 2.12 Personalizing the Desktop

∑ Click Desktop Background and Windows displays a window to choose the desktop background 

as shown in Fig. 2.13. 

∑ Windows displays available pictures for the desktop background and you can click one or more 

pictures for your background. You can use the Select All button to select all pictures or Clear All  

to clear all pictures. If you select multiple pictures for the desktop background, you can choose the 

time to change the picture.
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Fig. 2.13 Changing the Desktop Background

∑ If you prefer to use your own picture(s), e.g., digital camera pictures saved on the computer, click 

the button to the right of “Picture location:” or click the Browse button and select the folder/

location containing the pictures. Then choose the desired picture(s) in the usual way.

The Picture Position controls determines how the selected picture(s) would appear on the desktop. This 

controls has fi ve options to choose from: Fill, Fit, Stretch, Tile and Center. 

∑ As you make a selection, Windows updates your desktop. If you do not like the effect, choose some 

other option. Finally, click Save Changes to apply the changes or Cancel to cancel the changes. 

While choosing the desktop background, you should be careful that it does not make the icons merge 

in the background, making it diffi cult to see the icons. Windows also provides an option to choose solid 

colours as the desktop background. 

2.7.5 Using Themes to Change the Desktop

A theme is a combination of various computer properties, such as pictures, colors, sounds, desktop 

background, screen saver, window border, desktop icons, etc. In other words, a theme gives a distinctive 

look to computer. Windows comes with several aero, basic and high contrast themes, and depending on 

your preference and computer performance, you can choose a theme. Aero themes include translucent 

glass windows and special animations. You can even modify an existing theme to create a custom 

theme. Figure 2.12 displays two custom themes and few aero themes; use the scrollbar to view other 

available themes. Applying a theme is as simple as clicking the theme icon. And, after applying a 

theme, if you do not like it, choose a different theme.

After applying a theme, if you prefer, you can customize it. For instance, you can change the default 

desktop background or screen saver. The changed theme appears as Unsaved Theme, which you can 

save by clicking Save theme. The Aero themes, though look interesting need more computer resources. 

If your computer is not very powerful, consider using basic or high contrast themes, however, if you 
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are not using an aero theme, you will miss out several aero features, such as aero peek, aero shake, aero 

snap, etc. We would discuss these features later. 

2.7.6 The Screen Saver 

The Screen Saver automatically displays a predefi ned changing screen when there is no activity on 

the computer for a specifi ed time, e.g., when you leave the computer for tea/coffee break. While you 

are away from your computer, the screen would continue to display the same image. In the past, the 

technology of the phosphor coating in the monitor was not so good and it could get burnt if the same 

text/image was displayed on the monitor for a long time. Therefore, screen savers were introduced that 

would automatically change the static information on the screen when there is no keyboard or mouse 

activity for a specifi ed time. Once the Screen Saver takes over the control of display, it automatically 

keeps changing the image on the screen. When you move the mouse or press any key, Windows 

redisplays the original screen. Though today’s monitors do not really need the screen savers, these will 

stay forever, at least for fun. Windows includes a few predefi ned screen savers. Besides, you can choose 

pictures from a folder on your computer as screen saver. 

∑ To defi ne or change the screen saver, click the Screen Saver icon in the Personalization window, 

as illustrated in Fig. 2.12. Windows displays the Screen Saver Settings dialog box as shown in

Fig. 2.14. 

Fig. 2.14 Screen Saver Settings dialog box

∑ Click the button located in the Screen Saver box in the middle to choose the screen saver. If you 

want to display pictures (photos) as screen saver, choose Photos as screen saver, and then click 

Settings to choose the folder contains photos. 

∑ While defi ning screen saver, click Preview to preview the effect of your selection. Notice the Wait 

spinner box in the Screen Saver Settings dialog box. This is used to specify an elapsed time (in 

minutes) before the screen saver kicks in. Finally, click Apply to apply your selection. 
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It is also possible to display the logon screen to exit from the screen saver and return back to the active 

window through the “On resume, display logon screen” check box .

2.8 CHANGING SCREEN RESOLUTION 

You can make text and pictures larger or smaller by changing the screen resolution. The higher screen 

resolution enables Windows to display more information on the screen, however, the character size you 

see on the screen becomes small making it a little diffi cult to read, if your eyesight is not perfect. The 

maximum screen resolution you can use depends on the video adapter card and the type of monitor 

installed in your PC. 

∑ To view or change the screen resolution, right-click mouse on an empty location on the desktop, 

click Screen Resolution on the context menu and a windows appears that displays the current 

screen resolution, as shown in Fig. 2.15. 

Fig. 2.15 Changing Screen Resolution

∑ To change the screen resolution, click the Resolution button and use the slider control displayed 

by Windows, as illustrated in Fig. 2.15. The click the Apply button.

When you choose a setting which is not optimal, Windows displays a message box and gives you an 

option to revert back to the previous setting. Also remember that on fl at panel (LCD) displays, the kind 

of displays which are normally used with PCs these days, if you choose a resolution other than the 

maximum, the display does not look good. 

2.8.1 Using Multiple Monitors

Some computers, particularly laptops have an extra video output connector (jack). If your computer 

has an extra video connector, you can connect a second monitor or video projector on this connector. 
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Windows 7 Home Premium and higher have built-in support for multiple monitors and it should 

automatically detect the additional monitor when you open the Screen Resolution window. Figure 2.16 

displays two displays connected to a PC. Notice that the window contains an extra control: Multiple 

displays. This control is used to control how Windows handles multiple displays. As illustrated in 

Fig. 2.16, you can choose to duplicate displays, show desktop only on display 1 or 2, or extend these 

displays. Extending the displays is useful when you work on multiple programs simultaneously, as 

you can keep one program on display 1 and the second on display 2. In this case, the mouse pointer 

seamlessly moves from one display to the other and you can drag program windows from one display 

to the other. 

Fig. 2.16 The Screen Resolution window displaying two monitors connected to the computer

2.9 CONTROL PANEL 

The Control Panel is central place to change almost every Windows settings for the computer system. 

For example, you can use it to change the behavior of your mouse, keyboard, display, modem, printers, 

etc. You also use the Control Panel to remove (uninstall) a program, add or remove user accounts, 

change Windows appearance, etc. Let us have a look at the Control Panel. 

∑ Open the Start menu by clicking the Start button on the taskbar and click Control Panel. 

The Control Panel window appears that displays various Windows settings grouped into a few 

categories, such as System and Security, Network and Internet, Hardware and Sound, etc. Another 

view of the Control Panel can display these settings as icons. Figure 2.17 displays both versions of the 

Control Panel. Use the control displayed to the right of View by in the top-right area of the Control 

Panel to change the Control Panel view. 
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2.9.1 Searching Control Panel

If you are new to the Control Panel, you may fi nd it a little confusing, as it contains so many settings or 

icons. There are so many controls in this windows as it is central place to change all Windows settings. 

If you hover mouse over a link/icon, Windows displays a brief description about the setting. However, 

to help you accomplish your needs, the Control Panel contains a search box at the top—just type what 

you want to do (e.g., type Mouse if you want to change the mouse settings) and the Control Panel 

displays the matching settings you can change. Figure 2.18 displays a Control Panel window with tasks 

matching the entered text Mouse. Now you can click a link to change the corresponding settings.

Fig. 2.17 Control Panel

Fig. 2.18 Searching Control Panel

2.9.2 Controlling Mouse Properties

Mouse is one of the most extensively used devices for communicating with Windows. Different users 

may like to adjust the mouse properties, such as the double clicking speed, mouse buttons, mouse 

pointer shapes, etc., to their liking. If you are a left-handed person, you may like to swap the mouse 

buttons. Let us have a look at the Mouse Properties window. 
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∑ If the Control Panel window is not open, open the Start menu and click Control Panel. 

∑ Type Mouse in the search box (see Fig. 2.18). Now click Change mouse settings, the fi rst item in 

Fig. 2.18, and Windows displays the Mouse Properties window shown in Fig. 2.19.

The Mouse Properties window initially selects the Buttons page. It displays the current confi guration 

of mouse buttons. In Fig. 2.19, the buttons are suitable for right-handed persons. 

 

Fig. 2.19 Mouse Properties window

∑ For a left-handed person, swap the mouse buttons by clicking the Switch Primary and Secondary 

buttons check box. 

∑ If you have problem with the double click speed of the mouse, you can adjust it by dragging the 

slider towards Slow in the Double click speed box. The Mouse Properties window also provides 

space for testing the double click speed. If the graphics in the test area changes on double clicking 

the mouse, your double-click speed is okay.

Other tabs (pages) on the Mouse Properties window are used to change other mouse properties, such 

mouse pointer shapes and scroll wheel speed. As usual, after making changes, click the OK button to 

save changes or Cancel to abandon changes.

2.9.3 Changing Region and Language

Different regions in the world follow different formats for writing dates, times and numbers. For 

instance, in India, Dec 25, 2013 is normally written as 25-12-2013, whereas in USA, it is usually 

written as 12/25/2013. Similarly, there are differences in the way digits are grouped in numbers, 

currency symbol, currency formats, etc., in different regions. To ensure that programs display dates, 

times, currency, numbers, etc., in the acceptable formats, Windows has built-in support for almost all 

regions. For Indian subcontinent, Windows 7 supports English (India), Hindi (India), Assamese (India), 
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Bengali (India), Bengali (Bangladesh), Gujarati (India), Kannada (India), Konkani (India), Marathi 

(India), Oriya (India), Malayalam (India), Tamil (India), Telugu (India), Sanskrit (India) and Sinhala 

(Sri Lanka) formats. You may choose the suitable format from the Region and Language dialog box. 

∑ To open the Region and Language dialog box, search for “Region” in the Control Panel and click 

Region and Language.

Figure 2.20 displays a Region and Language format with the English (India) format selected. To change 

the format, click the button and choose the desired format. On choosing a new format, Windows updates 

the default date and time formats and their examples in the Region and Language dialog box. If required, 

you may change any of these by clicking the corresponding button. For additional customization of 

number, currency, time and date formats, click the Additional Settings button. 

Fig. 2.20 Region and Language window

2.9.4 Action Center

Action Center is the central place in Windows 7 to provide all kinds of alerts for smooth and effi cient 

running Windows 7, as well as to take actions to fi x those alerts. To open the Action Center: 

∑ Open Control Panel and click Action Center. (If you cannot fi nd Action Center in Control panel, 

type Action Center in the Search box.) Figure 2.21 displays an Action Center window. 

Any item that requires immediate action is marked in red color while the recommended items are marked 

in yellow color. Examples of red color items are important Windows updates and an outdated antivirus 

program. In Fig. 2.21, the Check Backup Settings item is shown in yellow color as Windows cannot fi nd 

a backup location. Normally, you do not need to open Action Center, as Windows displays the action 

center messages through the Action Center icon in the Notifi cation area of taskbar as discussed in the 

next section.
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Fig. 2.21 Action Center

2.10 MAKING MORE USE OF THE TASKBAR 

We have already discussed a few applications of the taskbar, e.g., Windows displays icons of the 

programs that are open on the taskbar. Besides, you can pin programs on the taskbar and then you just 

need to click the corresponding icon to start the program. 

Note  If you are migrating from Windows XP or Vista, the Quick Launch toolbar is not available in
Windows 7.

2.10.1 Notifi cation Area 

The Notifi cation area, also known as the System tray, located in the extreme right of the taskbar typically 

displays the System Clock and icons for some common processes (tasks) that may require some user 

attention or adjustment. A taskbar with the Notifi cation Area displaying three icons is shown here.

To keep the notifi cation area neat and tidy, by default, Windows 7 displays only a few icons and hides 

the rest. To reveal the hidden icons, click the arrow located to the left of the notifi cation and Windows 

displays a popup window containing the hidden icons, as shown in Fig. 2.22. To include any icon in the 

notifi cation area, drag the corresponding icon from the pop up to the notifi cation area. Similarly, you 

can drag an icon from the notifi cation area to the hidden icons popup window to hide the icon. And, you 

can drag icons in the notifi cation area to reposition them. 
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Fig. 2.22 Taskbar displaying hidden icons

Windows uses the icons in the notifi cation area to provide useful information for any situation that 

may require immediate attention. For instance, on laptop PCs, the Power icon displays the battery 

charge status and the Action Center icon may display a message if there are important Windows 

updates pending or no antivirus program is use. Similarly, the Speaker icon is used to display the 

speaker volume as well to change it. Therefore, depending on your requirement, you may put the 

required icons on the notifi cation area. Remember that if an icon is hidden, Windows will not be able 

to provide the notifi cation. To further customize the notifi cation area or to turn off/on the system icons 

(e.g., clock, volume, Action Center, etc.), click Customize (see Fig. 2.22) to open the Notifi cation Area 

Icons window shown in Fig. 2.23. To change the behavior of an icon, click the button displayed against 

the icon and choose the desired option. If you want to turn off/on system icons, click Turn system 

icons on or off, as illustrated in Fig. 2.23. 

Fig. 2.23 Customizing the notifi cations area
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2.10.2 Show Desktop 

While working on Windows programs, if you want to quickly view your desktop, Windows provides 

the Show Desktop button, conveniently located at the extreme right of your taskbar (See Fig. 2.22.) On 

clicking this button, Windows minimizes all open windows and you get a clear view of your desktop 

icons.

Note  If you are using Aero themes and the Peak at desktop option for the Show Desktop button is on, 
you can hover mouse on the Show Desktop button and then Windows makes all open windows 
transparent while displaying only their outlines, thus revealing all desktop icons.

Besides using the Show Desktop button, you may also show the desktop by clicking the Show the 

desktop command on the context menu that opens when you right click an empty area on the taskbar.

2.10.3 Customizing Taskbar

For additional customization of the taskbar, use the Taskbar and Start Menu Properties dialog box that 

you can open by right clicking any empty area on the taskbar and choosing the Properties command. 

Figure 2.24 displays the Taskbar and Start Menu Properties dialog box. This dialog box may be used to 

lock the taskbar and its toolbars on the desktop. In the unlocked condition, you can resize or reposition 

the taskbar anywhere on the Desktop. The Auto-hide option, which is not commonly used keeps the 

taskbar hidden, however, as soon as you move the mouse pointer on the area where the taskbar is 

supposed to be located, Windows brings it back. The Toolbars tab of the Taskbar and Start Menu 

Properties dialog box lists a few toolbars, such as Address, Links, Tablet PC Input Panel, Desktop, 

etc. You may click the corresponding check box to include these on the Taskbar. The Desktop toolbar, 

when placed on the Taskbar gives you a convenient way to access all icons on your desktop as well as 

few frequently used places such as libraries, Network, Control Panel, Personal folders, etc. The Links 

toolbar, as the name indicates, provides a convenient way to access your favorite websites as well as 

folders, fi les, programs, etc. Besides using the Taskbar and Start Menu Properties box, you can also 

turn on or off the Taskbar toolbars by clicking Toolbars on the context menu that you can display by 

right-clicking any empty area on the Taskbar. 

Fig. 2.24 Controlling Taskbar properties through Taskbar and Start Menu Properties dialog box
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2.10.4 Grouping and Ungrouping of Program Buttons on the Taskbar

To keep the taskbar tidy, by default, Windows 7 hides labels from the taskbar buttons and combines 

the buttons of the multiple windows of the same program. For example, if you open two documents in 

Microsoft Word, Windows 7 combines the two Word windows into a single button on the taskbar. This 

helps to keep the taskbar well organized and does not become full in most situations. Notice that in 

Fig. 2.24, the “Always combine, hide labels” option is selected. The other two options are “Combine 

when taskbar is full” and “Never combine”. If you want to change the behavior of the taskbar buttons, 

click the button against “Toolbar buttons”, choose the desired option (see Fig. 2.24) and click the Apply 

button.

2.10.5 Adjusting Date and Time

Windows maintains a real-time clock and displays it on the right of the taskbar. When you hover mouse 

over the clock, Windows displays additional information about the date, e.g., “17 August 2012 Friday”. 

If you click the clock on the Taskbar, Windows displays a calendar and clock on the desktop.

∑ If you need to adjust the date or time, right click the clock on the Taskbar and choose Adjust date/

time from the menu. Windows displays the Date and Time properties box shown in Fig. 2.25. 

Fig. 2.25 Date and Time Properties box

The Date and Time properties box can change date and/or time as well as the time zone. Use the Change 

date and time button to display a new dialog box to change date and/or time. If you prefer, Windows 

can maintain additional clocks which are used to display time for another city. To defi ne additional 

clocks, click the Additional Clocks tab in the Date and Time box. After you have defi ned and applied 

additional clocks, Windows displays time from all defi ned clocks when you hover or click mouse on 

the system time on the taskbar. The Internet Time tab of the dialog box is used to automatically adjust 

the computer time from an Internet time server computer. 
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2.11 MANAGING MULTIPLE WINDOWS 

As you know, Windows is a multitasking operating system. When you start several programs, each of 

these programs run in their respective windows. You can show these windows simultaneously on the 

desktop. The right click menu of taskbar contains a few commands that can help you to manipulate 

multiple open windows. Besides, if you are using an Aero theme, Windows supports more ways to 

manipulate windows, as we will discuss later. Let us open a few windows and then we will learn to 

manipulate them. 

∑ Double click the Recycle Bin icon on the Desktop to open the Recycle Bin window. Also open the 

Screen Resolution windows and the Control Panel as explained in Sections 2.8 and 2.9. You may 

also open other windows, such as Word, Excel, Paint, Calculator, etc. 

Now, multiple windows are open on your desktop. The commands to manipulate the open windows are 

available on the taskbar’s context menu. 

∑ Right click an empty area on the taskbar (Do not right click a button; however you may right click 

on the time at the right-hand corner of the taskbar.), and Windows displays the following context 

menu:

The Show windows stacked and Show windows side by side resize and arrange all open windows 

horizontally and vertically, respectively, on the desktop. The Cascade windows command resizes all 

open windows and displays these in a cascaded manner such that the title bars of all windows are 

always visible. Figure 2.26 displays three cascaded windows. 

∑ To minimize all windows, you can use the Show the desktop command from the right click menu 

of the taskbar or click the Show desktop button located on the right of the taskbar.

2.11.1 Windows Flip

When multiple windows are open, at any time, you can work only in one window. The window where 

you can work is called the active window. The title bar of the active window is highlighted (usually 

darker than the title bars of other windows). To make any window active, you have several options:

∑ Click anywhere in the desired window. When you click any window, Windows brings that window 

on the top.

∑ Click the corresponding button on the taskbar. For example, in Fig. 2.26, you can click the Paint 

button to bring the Paint window on the top. Notice that when a program is running, Windows 

highlights the corresponding icon on the taskbar with a border. 
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Fig. 2.26 Cascaded windows

∑ Press Alt+Tab to display a fl oating palette containing icons for 

all running programs, similar to the one shown here. 

∑ While Windows is displaying the icons palette, each time you 

press Tab while holding the Alt key, Windows highlights the next icon. When you release the 

keys, Windows brings the window of the highlighted icon to the front. 

2.11.2 Windows Flip 3D

If you are running an Aero theme and you are using Windows Home Premium and higher, Windows 

supports a very interesting way to fl ip windows. On pressing  + Tab, Windows displays a live 

miniature view of all running applications similar to Fig. 2.27.

Fig. 2.27 Windows 3D Flip
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∑ While Windows is displaying a live miniature view of all running application, each time you 

press Tab while holding the  key, Windows shuffl es the miniature windows. When the desired 

window is in the front, release the keys and the 3D view disappears and the selected windows 

comes to the front.

2.11.3 Using Aero Peek to Preview an Open Window

If you are running an Aero theme, you may be able to use a new feature called Aero Peek which displays 

thumbnails of the open window when you move the mouse pointer on the icon of a running program 

on the taskbar. If multiple windows are open within a program, e.g., you have opened two documents 

in the Word program, Windows displays a separate thumbnail for each document. You not only see 

the thumbnail of the open window, if you hover the mouse pointer on the thumbnail (see Fig. 2.28), 

Windows displays the full size preview of the window on the screen. Now, if you want to switch to 

the corresponding window, click the thumbnail. On the other hand, if you do not want to switch to the 

window, move the mouse pointer away from the thumbnail and the thumbnail(s) disappear.

Fig. 2.28 Taskbar displaying thumbnails of open windows

Note  If you are using a non-Aero theme or your PC cannot handle Aero themes, when you hover mouse 
on icon of a running program, Windows displays the title(s) of the corresponding window instead of 
the thumbnail(s).

2.11.4 Aero Snap 

The Aero snap feature of Windows 7 makes it very easy to maximize, restore or make it full height, 

half-width window. You can accomplish this with mouse or keyboard shortcut keys. 

∑ To maximize a window, drag its title bar to the top edge of your monitor. If you want to use the 

keyboard shortcut, press the Windows key ( ) + ≠ (Press the keys simultaneously; do not press 

the + key.)

∑ To restore the maximized window, drag its title bar down from the top of the monitor screen. 

Alternatively, press the shortcut keys:  + Ø.

∑ To make a window full height, half width, drag its title bar to the left or right edge of your monitor. 

And to restore the half width window, drag its title bar toward the centre of the monitor screen. 

Alternatively, you may use the shortcut keys:  + ¨ and  + Æ.

2.11.5 Aero Shake

Consider Fig. 2.29 where several widows are open on the monitor while the Windows Media Player is 

the active window. When too many windows are open, they distract attention from the active window. 

Aero Shake is a very interesting feature that you can use to minimize all windows except the current 

or active window.

∑ Click and hold the left mouse button on the title bar and shake the mouse (rapidly move back and 

forth) to minimize all windows except the active window. Alternatively, press the shortcut keys: 

 + Home. Follow the same procedure to restore the minimized windows. 
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Fig. 2.29 Using Aero Shake to minimize all windows except the active window

2.11.6 Using the Scroll Bar

Figure 2.30 displays the Windows help and Support window with vertical and horizontal scroll bars. 

You may press F1 to open this window. (If you do not see scroll bars in the window on your PC, reduce 

the size of the window.) To scroll the contents of the window up with mouse, you can do any of the 

following:

1. Click the scroll down button . This button is located at the bottom of the scroll bar. If you keep 

the mouse button pressed, the window contents scrolls continuously.

Fig. 2.30 The Windows help and support window
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2. Press and hold the left mouse button on the scroll box. Without releasing the mouse button, drag it 

down. As you drag the mouse down, the contents of the window move up. 

3. If your mouse has the scroll wheel (see Fig. 2.2), you can rotate this wheel down to scroll the 

window contents up.

Similarly, to scroll down the contents of the window, either click the scroll up button , or drag the 

scroll box up, or use the mouse scroll wheel. To scroll the window up or down with the keyboard, you 

can use the arrow keys. As shown in the Fig. 2.30, you can click above and below the scroll box to 

scroll the contents of the window by one page. In the same way, to scroll the contents of the window 

horizontally, you can use the scroll buttons or scroll box in the horizontal scroll bar. 

Note  You will see that the size of the scroll box is different in different windows. Even in the same window, 
the vertical and horizontal scroll boxes are usually of different size. In fact, the size of the scroll 
box represents the amount of information being displayed. A bigger scroll box indicates that more 
percentage of the total information is being displayed in the window.

2.12 CREATING A NEW FOLDER OR FILE ON DESKTOP 

Windows can help you to create a new empty folder or fi le on the desktop. Let us create a new folder 

on the desktop. Once a folder has been created, you can store documents (fi les) in the folder. A folder 

can also contain one or more subfolders.

∑ Right click mouse at any empty area on the desktop to display a context menu and click New in 

the menu. 

 Windows displays a submenu similar toFig. 2.31 that displays the various items you can create on 

the desktop. The submenu you will get on your PC depends on the software installed in your PC.

Fig. 2.31 Creating a new folder on Desktop
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∑ Click Folder in the submenu. 

 Windows creates a new folder on the desktop and names it ‘New Folder’. Notice that the folder 

name, i.e., ‘New Folder’ is highlighted. Let us change it to ‘My Folder’.

∑ Type My Folder and press Enter, and Windows renames ‘New Folder’ to ‘My Folder’. 

Note  To rename any item on the desktop, right click the mouse on that item and choose the Rename 
command from the menu. Then type the new name or edit the existing name. Finally press Enter to 
ask Windows to apply the new name. 

In the same way, you can create a new fi le by choosing the appropriate fi le type from the New submenu. 

After a new fi le has been created, you may double click to open that fi le to add or edit contents.

2.13  EXPLORING THE CONTENTS OF THE COMPUTER

 WITH WINDOWS EXPLORER 

Windows Explorer enables you to see the folder and fi les in your computer in a hierarchical structure. 

Besides looking at the fi les and folder, Windows Explorer can also help you to copy or move contents 

of one folder to another. You can also create new folders or delete existing folders or fi les. You can also 

open a fi le in the associated program from Windows Explorer. Windows Explorer works not only on the 

built-in hard-disk drive, it also works on external drives, USB Flash memory and computers connected 

on the network. Windows Explorer also helps you to maintain libraries, a new feature in Windows 7. 

Let us open Windows Explorer.

∑ Click , the Windows Explorer icon on the taskbar. If you do not fi nd this icon on the taskbar, 

right click the Start button on the taskbar and click Open Windows Explorer on the context 

menu. Windows opens the Windows Explorer window similar to that shown in Fig. 2.32.

Fig. 2.32 Windows Explorer
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2.13.1 Title Bar and Address Bar

Like a typical window, the Windows Explorer window contains the title bar at the top, though it remains 

blank. On the top right corner of the window, you fi nd the typical Minimize, Maximize/Restore and 

Close buttons. Below the title bar is located the address bar on the left and the search box on the right. 

The address bar displays the path of the currently selected location. You can also type an address of a 

folder (location) in the address bar to see fi les and folder contained in that folder. Notice that Windows 

Explorer displays the address of the current location in easy to understand bread-crumbs notation 

where folder names are separated by little triangles (�), e.g., “� Libraries � Music � Kishore” rather than 

the old slash notation (Libraries\Music\Kishore), though you can still type the address in the address 

box in the slash notation. The search box, located on the right side of the address bar is helpful in 

locating fi les in the selected folder and its subfolder; just type any part of the fi lename in the search box 

and Windows displays the matching result. 

Located on the left side of the address bar are the Forward and Back buttons, similar to those found 

on the Internet browsers. These buttons are used for the same purpose. For instance, with reference to 

Fig. 2.32, if you click Music, Windows Explorer selects the Music folder within the Libraries folder. 

Now, if you click the Back button, Windows Explorer selects the Libraries folder. After moving back 

the Libraries folder, you may click the Forward button to jump to the Music folder. 

2.13.2 Navigation Pane 

Navigation pane, which is located on the left side of the Windows Explorer window, contains a broad 

map of folders and other locations in your computer. When you select a location in the Navigation 

pane, Windows displays its contents (fi les and folders) in the Content pane. To help you quickly locate 

fi les on your computer, the Navigation pane contains the Favorites links list at the top. By default, it 

includes icons for Desktop, Downloads and Recent Places, however, you can add other locations to the 

Favorites list with ease: 

∑ Click the location, e.g., OS (C:) in Fig. 2.32 that you want to add to the Favorites list. Then 

right click Favorites to display the context menu and click Add current location to favorites. 

Similarly, if you want to remove an item (e.g., Dropbox in Fig. 2.32) from the Favorites list, right 

click the item and click Remove in the context menu. 

Besides Favorites, the Navigation pane includes other important locations in your computer, such as 

Libraries, Homegroup, Computer, Network, etc. 

2.13.3 Libraries

The concept of libraries is new in Windows 7. A library is like special folder, which can display contents 

from other folders. In fact, a library does not contain the folders; it just contains links to other folders. 

If you are familiar with playlists used with Media Players, libraries are like playlists, and like a playlist, 

you can add (or remove) folders to a library without physically copying (or deleting) fi les to the library. 

Besides, including folders from your hard disk, Libraries can also include folders from removable disks 

and network. 

Windows 7 initially starts with four libraries: Documents, Music, Pictures and Videos. If you wish, 

you can use the Documents library to manage all your documents. For example, if you have some 

Microsoft Word document fi les in the C:\Raj\Sales folder, you can include this folder in the Documents 

library. Similarly, you can also include C:\Raj\Stores, which contains Excel workbook documents in 

the Documents Library. To include a folder in a library:
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∑ Select the folder that you want to include in the library and click Include in Library on the Task 

toolbar, as shown in Fig. 2.33. Windows Explorer displays a menu containing list of libraries.

∑ Click the desired library name, and the folder gets added to the library and its name appears under 

the corresponding library. 

If you fi nd that the default libraries do not meet your requirements, you can create a new library with 

these simple steps: 

∑ Click Libraries in the Navigation pane and the New Library link appears on the Task toolbar. (See 

Fig. 2.32.)

∑ Click New Library on the toolbar and Windows Explorer creates a new library, names it something 

like “New Library” and puts the name in edit mode. Type a suitable name, e.g., Book Project and 

press Enter. 

Fig. 2.33 Including a folder in library

The new library is ready. You can add folders to the library as already described. Later, if you need 

to change the name of the library, right click the library and choose the Rename command from the 

context menu. 

2.13.4 Content Pane

The Content Pane displays the contents of the folder or location selected in the Navigation pane. For 

instance, in Fig. 2.32, the Content pane is displaying the content of Libraries. Notice that Libraries is 

highlighted in the Navigation pane and is also shown at the top of the Content pane. Depending on 

what is contained in the selected location in the Navigation pane, the Content pane display may include 

location, folder, fi les etc. 

∑ To reveal the contents of a folder or location, click it in the Navigation pane or double click 

it in the Content pane, as illustrated in Fig. 2.32. If the displayed contents include a folder, 

you may double click it to display contents of that folder. Figure 2.34 displays contents of 

the Sample Pictures folder in Pictures Library. 
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Fig. 2.34 Windows Explorer displaying contents of the Sample Pictures folder

2.13.5 Details Pane

The strip at the bottom of the Explorer window is called the Details pane, which displays detailed 

information about the selected item in the Content pane. To select an item, click its name or icon. If 

no item is selected, the Details pane displays the number of items displayed in the Content pane. (See 

Fig. 2.32.) 

Tip  You can change the amount of information Windows displays in the Details pane by changing its 
size. To change the size, either drag the border between Contents and Details panes or right click the 
Details pane and choose the size command from the context menu.

2.13.6 Changing the View of the Content Pane

Windows Explorer can display the details in the Content pane in several ways, such as Icons (Extra 

Large, Large, Medium and Small), List, Details, Tiles and Contents. The view used in Fig. 2.32 is Large 

Icons. The Icons view is generally good for limited number of fi les, generally pictures. On the other 

hand, when there are lots of fi les to be displayed, the preferred views are Details and List. 

∑ To change the Content pane view, click the arrow on the right side of Task Toolbar (see Fig. 2.34) 

to display a list of view options and click the desired option. Figure 2.35 displays contents of the 

Sample Pictures folder in Details view.

∑ As you see in Fig. 2.35, the Details view provides several details about the fi les. If fact, Windows 

Explorer can display a lot of other information about the fi les; to choose more columns right click 

in the headings area and choose the required columns from the context menu, as illustrated in the 

fi gure. 

∑ If you need to sort the list of fi les by name, date, size, etc., click the corresponding column name. 

For example, to sort the list by name, click Name, as illustrated in Fig. 2.35.
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Fig. 2.35 Contents of the Sample Pictures folder displayed in the Details view

2.13.7 Preview Pane

The Preview pane, which is off by default, displays a preview of the selected fi le. Windows can displays 

preview of several types of fi les, including pictures, text, documents, spread sheets, sounds and movies. 

For sounds and video fi les, the preview includes the play and stop buttons, i.e., you can play these fi les 

within Windows Explorer, without having to start Windows Media Player. While preview of sound and 

video fi les may be helpful in some situations, preview of pictures, text, document and spread sheet fi les 

is defi nitely useful as you can preview the contents of the fi le without opening these. 

∑ To preview a fi le, select its name/icon in the Content pane and click the Show Preview pane button, 

if required, as illustrated in Fig. 2.35. Figure 2.36 displays the preview of a Word document. 

Fig. 2.36 The Preview pane displaying the preview of a Word document
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∑ All panes, including the Preview pane are resizable. To resize the preview pane, drag the right 

border line between the Content and Preview panes, as illustrated in Fig. 2.36. To toggle the 

Preview pane, click the Preview Pane button.

2.13.8 Expanding/Collapsing Items in the Navigation Pane

In Windows, folders are stored in hierarchal structure, where each folder can have any number of 

subfolders, and each subfolder can contain any number of sub-subfolders. You can store fi les in any 

folder or subfolder. Windows also maintains some special locations (in fact, folders), such as Desktop 

and Libraries, which can also contain any number of folders and fi les. A typical PC can have hundreds 

of folders and subfolders. To help you view the desired folders and hide folders you are not interested 

in, the Navigation pane allows you to expand and collapse folders and other locations. To indicate 

whether a folder/location is in expanded or collapsed state, Windows Explorer displays icons to the left 

of items in the Navigation pane. Consider the Windows Explorer windows show in Fig. 2.37.

Notice that Windows Explorer displays solid down pointing triangle ( ) or empty triangle ( ) icons 

to the left of the items in the Navigation pane. (If you do not see these icons, click some item, e.g., 

Libraries in the Navigation pane.) The solid down pointing triangle indicates that Windows Explorer 

is displaying all subfolders of the selected item. On the other hand, the empty triangle indicates that 

there are some subfolders under the selected item that are not displayed at the moment. For instance, in

Fig. 2.37, Libraries is in expanded state while Favourites is in collapsed state. 

Fig. 2.37 Expanding and Collapsing items in the Navigation

∑ If you click the solid triangle to the left of Libraries, Windows Explorer hides Documents, Music, 

Pictures and Videos. On the other hand, on clicking the hollow triangle displayed to the left of 

Favorites, Windows Explorer reveals items available under Favorites.

∑ If you right click a folder/location in the Navigation pane, Windows displays a context menu 

which includes several useful commands, such as Copy, Rename and Delete. This menu also 

includes Collapse or Expand command, as applicable. Thus, you can also use the context menu to 

expand or collapse a folder/location in the Navigation pane. 
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2.13.9  Displaying Properties of Drives, Folders and Files 

While using Windows Explorer, if you right click a folder or drive, Windows displays a context menu 

that includes several useful commands, such as Copy, Paste, Rename, Delete and Properties. While 

we will talk about Copy, Paste, Rename in a moment, let us discuss the Properties command, which 

provides useful information about the item. The information Windows displays depends on the item, 

e.g., the properties of a fi le differ from that of a folder. Figure 2.38 shows the General tab of the 

Properties box of drive C with useful information, such as the drive capacity (size), used space and 

free space. Other tabs of the box provide tools and other details about the drive. The properties box of 

a folder provides details about the number of fi les and folders contained in the selected folder and the 

spaced used by these. 

Fig. 2.38 Properties of a hard disk

Tip  Windows allows you to change some properties of fi les and folders through the Properties box. Two 
such useful properties are Read Only and Hidden, though you should use Hidden with caution. 

2.13.10 Formatting a Disk/USB Flash Drive

If your PC has a fl oppy disk drive, Windows Explorer can help you to format a disk. It can also format 

a removable USB Flash drive. Here are the steps to format a fl oppy disk or USB Flash drive: 

1. Open Windows Explorer and expand Computer in the Navigation pane to reveal the fl oppy disk 

drive and other removable disk drives connected to your computer. 

2. If formatting a fl oppy disk, put the disk to be formatted in the fl oppy disk drive. 

3. Right click the drive icon in the Navigation pane to display a context menu and choose the Format

command from the menu. Windows displays the Format dialog box where you can choose the 

format options and defi ne a volume name for the disk. (See Fig. 2.39). The default options are 

good for normal formatting; however, you should assign a meaningful volume name to the disk. 

4. Click Start button to start the format process.
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Fig. 2.39 Formatting a removable (USB) Flash drive

Caution  When you format a disk or USB Flash drive, you lose all fi les on the disk/drive. Also, do not format 
the hard disk drive (C:)

2.13.11 Renaming/Deleting a File or Folder

To rename a fi le or folder in a Windows Explorer window, perform the following steps: 

1. Right click the fi le or folder you want to rename to display a context menu.

2. Click the Rename command in the context menu.

3. Type the new name and then press Enter.

The rename command is also available in the Organize menu that you can display by clicking the 

Organize button on the Task toolbar, as illustrated in Fig. 2.40. 

Fig. 2.40 Using the Organize menu
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Note  Windows Explorer supports a menu bar with File, Edit, View, Tools and Help menus. The File menu 
displays a menu which is similar to the Context menu you get on right clicking a fi le or folder. To 
display the menu, press Alt or F10 while the Windows Explorer is active. 

Here is another way to rename a fi le or folder: 

1. Click the fi le or folder you want to rename in the Content pane. Windows highlights the selected 

item.

2. Click again to ask Windows to put the item in the Rename mode.

3. Type the new name and then press the Enter key.

Caution  If Windows Explorer displays the extension name, do not change it when renaming a fi le. The 
extension name is 3 or 4 character name on the right side of the dot, e.g., in Marks.doc, “doc” is 
the extension name. Also, do not use special characters such as :, ;, $, etc., in the fi le name. 

∑ To delete a fi le or folder, click to select it the Explorer window and press the Del key. Alternatively, 

choose the Delete command from the right click or Organize menu. Then, Windows displays the 

Delete File confi rmation dialog box, as shown below. 

When you delete a fi le, it does not disappear from your PC. Instead, Windows puts it in Recycle Bin. 

Therefore, if you delete a fi le by mistake, you may undelete it from the Recycle Bin. This is discussed 

later in this chapter. On the other hand, if you do not want to put the fi le in the Recycle Bin, i.e., 

permanently delete a fi le, select the fi le or fi les that you want to delete, and then press and hold the 

Shift key while pressing Del.

2.13.12 Creating a New Folder/File 

Windows Explorer can help you create a new folder under the selected folder with ease. 

∑ Click the New Folder button on the Task toolbar, as illustrated in Fig. 2.40. Alternatively, right 

click empty area in the Content pane and choose New, Folder from the context menu. 

∑ Windows creates a new folder and names it “New folder” or something similar. Type the desired 

name for folder and press Enter. 

To create a new fi le in the selected drive/folder: 

∑ Right click empty area in the Content pane to display a context menu and click New in the menu. 

Windows Explorer displays a submenu containing the various types of fi les you can create. (See 

Fig. 2.31.) 
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∑ Click the desired fi le type in the submenu and Windows Explorer creates the fi le with a generic 

name, such as “New Microsoft Word Document”. Type the desired fi lename and press Enter. 

2.13.13 Selecting Multiple Files/Folders

While working in Windows, you often need to select multiple fi les/folders to copy, move or delete 

several fi les at once. You can select multiple fi les in any window that is displaying a list of fi les and 

folder, including Windows Explorer. Consider the Explorer window shown in Fig. 2.41. 

Fig. 2.41 Selecting Multiple Files

We want to select Chapter 01 through Chapter 04 fi les. In order to do so: 

∑ Select the fi rst fi le (Chapter 01) in the usual way by clicking once. To select all fi les up to Chapter 

04, press and hold the Shift key and the click the mouse (called Shift Click or Shift+Click). 

Alternatively, press and hold the Shift key and press the down arrow key three times. When you 

select multiple fi les and/or folders, Windows Explorer displays a suitable message, e.g., “4 items 

selected.” in the Details pane. (See Fig. 2.42.)

Fig. 2.42 Multiple fi les selected with Ctrl Click
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Consider another situation where we want to select Chapter 01, Chapter 03 and Chapter 07 fi les. To 

achieve this:

∑ Select the fi rst fi le (Chapter 01) in the usual way by clicking the fi le name in the Windows Explorer. 

Now to select next fi le, press and hold the Ctrl key and then click the Chapter 03 fi le. (called 

Control Click or Ctrl+Click). This will select Chapter 03 fi le while keeping Chapter 01 selected, 

but will not select the Chapter 02 fi le. In the same way, Ctrl+Click Chapter 07 to select this fi le 

while keeping previously selected fi les intact. Figure 2.42 displays multiple fi les selected through 

Ctrl+Click. 

Tip  To select all contents of the current folder, i.e., all fi les and subfolders, press Ctrl+A or choose the 
Select All command from the Organise menu. 

2.13.14 Copying Files to the Same Folder

Sometimes you may want to make a copy of a fi le in the same folder for the purpose of backup or 

making changes to a fi le while keeping the original content intact for reference. To make a copy of the 

fi le available in the Content pane of Windows Explorer, perform these steps. 

1. Right click the fi le name or its icon to display the context menu. 

2. Click the Copy command in the menu.

3. Right click any empty space in the Content pane to display the context menu, and click the Paste 

command and Windows makes a copy of the fi le and names it accordingly, e.g., Chapter 01 - Copy.

You can also copy fi le(s) by using keyboard shortcut keys. 

1. Select the fi le(s) you want to copy and press Ctrl+C keys. This copies the fi le in PC’s memory. 

2. Next, press Ctrl+V keys and Windows makes a copy of the fi le(s). 

Follow the same procedure to copy folders or combination of fi le(s) and folder(s).

2.13.15 Copying Files/Folders to a Different Folder

If you want to copy one or more fi les to a different folder on the same drive, or even to a different drive, 

e.g., to a fl oppy disk drive or USB fl ash drive, the steps are almost similar. 

1. Navigate to the required folder and select the desired fi le(s) and/or folder(s) you want to copy. 

2. Now press Ctrl+C keys, or choose the Copy command from the Context/Organize menu to copy 

the selected items in PC’s memory. 

3. Select the destination folder, i.e., the folder where you want to copy the fi les in the Navigation 

folder. 

4. Press Ctrl+V or choose the Paste command from the Organize/Context menu. 

Note  When copying a large number of fi les or one or more large size fi les, Windows displays a message 
box which shows the progress of the copy operation. 

2.13.16 Copying Files using Mouse

You can copy the selected fi les to any folder on the same or different drive with mouse very easily. 

Consider the Explorer window shown in Fig. 2.43. We want to copy the fi rst three fi les from the 
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Docs folder (source) to the Projects folder (destination) located under the Zoom folder. This can be 

accomplished with the following steps: 

1. Click the source folder in the Navigation pane and select the fi le(s) you want to copy. 

2. Scroll and expand any folder if required to display the destination folder. However, do not click the 

destination folder; otherwise, you will end up de-selecting the fi les selected in the previous step.

3. Drag the selected fi les with Ctrl key pressed to the destination folder (Projects). Windows Explorer 

changes the shape of the mouse pointer by attaching ‘copies of the selected fi les’. It also shows 

‘+ Copy to foldername’ inside a small tooltip box as you move the mouse pointer to a folder in 

the Navigation pane, as shown in Fig. 2.43. As you drag the mouse, Windows Explorer highlights 

one of the folders. When you release the mouse button, it would copy the fi les to the highlighted 

folder.

4. After you have positioned the mouse pointer on destination folder, it is highlighted and its name is 

being displayed in the tooltip box attached to the mouse pointer, release the mouse button and then 

release the Ctrl key. Windows now copies the fi les to that folder. 

Fig. 2.43 Copying fi les using the mouse

Tip 1.  While copying or moving fi les, you may fi nd it convenient if two Windows Explorer windows are 
open. In that case, you can select source and destination folders in different Explorer windows, 
making it convenient to drag and drop fi les. To open another Explorer window while one Windows 
Explorer is open, press Ctrl+N or  + E.

    2.  While copying fi les to a folder on another drive, e.g., hard disk drive to fl oppy or USB Flash memory 
drive, you may drag and drop fi les without keeping the Ctrl key pressed. 

2.13.17 Quickly Copying Files to Floppy Drive or USB Flash Drive

Windows provides a quick way to copy the selected fi les to the fl oppy drive or USB Flash drive. Use 

the following steps to accomplish this. 

1. Select the fi le(s) that you want to copy. 
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2. Right click the selected fi les and click the Send To command from the context menu. Then choose 

the desired destination.

Tip  The Send To command can also be used to send the selected fi le to a mail recipient, fax recipient or 
to create a shortcut to this fi le on the desktop.

2.13.18 Moving Files to Another Folder

Windows allows you to easily move selected fi le(s) from the current folder to another folder on the 

same or different drive. When you move a fi le, the fi le is removed (deleted) from the original folder and 

placed (copied) in the new folder. The steps are similar to copying the fi les, i.e., 

1. Select the fi le(s) you want to move in Windows Explorer. 

2. Right click the selected fi le(s) and click the Cut command in the context menu.

3. Now select the destination folder in the same or different Explorer window. 

4. Press Ctrl+V or choose the paste command from the Organize or context menu. 

If you want to move the selected fi les to another folder on the same drive with mouse, just drag and 

drop the fi les to destination folder. On the other hand, if you want to moves fi les to a folder on another 

drive, you must keep the Shift key pressed while dragging and dropping the fi les. 

2.14 SEARCHING FOR FILES AND FOLDER IN

 WINDOWS EXPLORER 

As you know that the modern PCs contain a large hard disk drive and it contains so many fi les and 

folders that it is quite normal to store a fi le or folder on the hard disk and not remember which folder it 

was stored in. Windows can help you to fi nd the fi le(s) or folder(s) you are looking for the search box

in the Start menu; we have already discussed this in Section 2.5.2. Windows Explorer also contains 

a similar search box in the top-right corner. (See Fig. 2.43.) The search box in Windows Explorer 

works similar to that in the Start menu, except that it searches for fi les within the selected folder and 

you can optionally specify search fi lters. Follow these steps to search for fi les and folders in Windows 

Explorer. 

∑ Open Windows Explorer and select the drive or folder where you want to perform the search in the 

Navigation pane. If you do not know the folder or location, select root folder, e.g., C:. In the same 

way, if you want to search in a CD or USB Flash drive, choose the corresponding drive or folder. 

∑ Type a few characters from the fi le name or content of the fi le in the search box. For instance, if 

you are looking for “CH 02 Word”, you may type CH or 02 or Word. As soon as you start typing 

characters in the search box, Windows Explorer starts displaying results in the Content pane. 

Notice that when you type characters in the Search box, you see some links in blue colors, such as 

Authors, Type, Date modifi ed, Size, kind, type, album, etc., as shown in Fig. 2.44. These links are used 

to apply the corresponding fi lter on the search results. You would normally use these fi lters to limit the 

search results or to perform complex search. For instance, you can use Date Modifi ed to search for fi les 

that were modifi ed on a specifi c date, date range, yesterday, last week, and so on.
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Fig. 2.44 Windows Explorer display search results and fi lter links

2.15 COMPRESSING (ZIPPING) FILES AND FOLDERS 

Unlike early 2000s, nowadays the storage space in the computer is not at premium, therefore, there is 

hardly any need to compress fi les stored on the computer. However, if you need to send a fi le as an email 

attachment or send it over an internal network or the Internet, it may be helpful to compress it prior to 

sending. Compressing, also known as zipping make the fi le smaller than the normal fi le, therefore, a 

compressed fi le takes less time to send over the network and the email recipient will also fi nd it easier 

to download the smaller fi le. Windows 7 includes built-in features to compress and un-compress fi les 

and folders. Here are the steps to compress (zip) fi les: 

∑ Select the fi les you want to compress (zip) and right click the selected fi les to display the context 

menu. 

∑ Click Send to in the context menu to display a submenu and then click Compressed (zipped) folder 

in the submenu, as illustrated in Fig. 2.45. 

Fig. 2.45 Compressing (zipping) fi les in Windows Explorer
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∑ Windows starts compressing the fi les and displays the progress in a progress box. When the 

compressing is complete, it creates a zipped folder in the same location where the fi les you selected 

are located (e.g., Project in Fig. 2.45.). Windows assigns a default name to the zipped folder it 

created and puts the folder name in edit mode. Type a suitable name, e.g., Zipped Project fi les

and press Enter to rename the folder. 

The process of compressing a single fi le, a folder or multiple folders is exactly the same as described. 

Tip  If you are using an older version of Windows which does not have built-in support for compressing 
fi les, you may download the zipping program from the Internet. One such free open source zipping 
program is 7-Zip that can be downloaded from www.7-zip.org. 

2.15.1 Decompressing (Unzipping) a Compressed Folder

As you know, the compressed fi les are placed inside a compressed (zipped) folder. To get original fi les, 

you need to decompress it, which is also known as unzip/extract. You can decompress (extract) selected 

fi les or all fi les at once at any location/folder in your computer. To a large extent, a compressed (zipped) 

folder is like a regular folders and if you double click it, Windows displays list of fi les and folders 

contained in that folder. In fact, if you double click any of the zipped fi le contained in a compressed 

folder, Windows automatically unzips it and opens it in read-only mode. To create a regular (unzipped) 

fi le from a zipped folder: 

∑ Double click the compressed (zipped) folder in Windows Explorer to reveal its contents. 

∑ Drag the compressed fi le to any regular folder. You may even drag the fi le to the desktop. The 

folder where you dragged the fi le to contains an uncompressed copy of the compressed fi le. 

To extract all fi les from a compressed folder:

∑ Right click the compressed (zipped) folder and click Extract all on the context menu. 

Windows displays the Extract Compressed (Zipped) Folders dialog box shown in Fig. 2.46. By default, 

Windows extracts the fi les to the same folder where the zipped folder is located. 

Fig. 2.46 Extracting fi les from a zipped folder

∑ Click the Browse button to choose a different folder to extract the fi les to. Finally click Extract to 

ask Windows to extract the fi les.
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2.16 USING RECYCLE BIN TO RESTORE ITEMS 

As you know, the Recycle Bin holds the items you delete. After deleting an item, if you realise that 

you made a mistake and want to get it back, you can use the Recycle Bin. (Caution: Items deleted from 

a fl oppy disk, USB Flash drive or a network drive are not sent to Recycle Bon.) Figure 2.47 displays 

Recycle Bin open in Windows Explorer, which you can open by clicking the Recycle Bin icon on your 

desktop. As Recycle Bin is opened in Windows Explorer, you can change the view of Details pane as 

per you preference by using the view button on the Task toolbar.

Fig. 2.47 Recycle Bin

∑ To restore any item available in the Recycle Bin to the original folders it were delete from, select 

the item and click the Restore the item on the Task toolbar. Follow the same procedure to restore 

multiple items. The Restore command is also available on the context menu that you can get by 

right clicking the selected item(s).

∑ On the other hand, if you want to remove an item from Recycle Bin, i.e., permanently delete it 

from the computer, select that item and choose the Delete command from the context menu or 

Organize menu. To completely empty the Recycle Bin, click Empty the Recycle Bin on the 

toolbar, as illustrated in Fig. 2.47.

The number of items the Recycle Bin can hold is limited by the hard disk space allocated to it by 

Windows. Therefore, you should periodically empty the Recycle Bin by deleting those items from the 

Recycle Bin that you no more want to restore. 

Tip  Typically, Windows allocate 5–10% of the hard disk space for Recycle Bin. To change this percentage, 
right click the Recycle Bin icon on the desktop and choose the Properties command.
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2.17 CREATING FILES/FOLDER ON

 FLOPPY DISK/USB FLASH DRIVE 

You can create fi les and folders on a fl oppy disk and USB Flash Drive in the same way as you do on 

the hard disk. If you get a new fl oppy disk, you may have to format it before you could store fi les on 

it. Formatting a fl oppy disk has already been discussed in Section 2.13.10. To see contents of a fl oppy 

disk or USB Flash drive:

∑ Insert the fl oppy in the fl oppy disk drive or connect the USB Flash Drive to a USB port. 

∑ Open Windows Explorer, expand the Computer icon in the Navigation pane and double click the 

icon for the Floppy disk drive or USB Flash Drive (e.g., Removable Disk (E:)). 

Windows Explorer displays the contents of the selected device in the Details pane. As mentioned 

earlier, you can create, copy and move fi les to/from a fl oppy disk and USB Flash Drive as you do on a 

hard disk, except that these devices are slower than the hard disk and their storage capacity, particularly 

for the fl oppy disk, is limited.

2.18 BURNING FILES TO A CD OR DVD 

If the CD/DVD drive in your PC is equipped with writing capabilities, you can use CDs/DVDs to keep 

backup of your fi les from your hard disk. The processes of storing fi les on a CD/DVD is usually called 

burning a disk. Whereas in early 2000s, most computers were equipped with CD-ROM, which could 

only read CDs, however, most recent computers can burn CDs as well as DVDs. You can store any kind 

of fi les, including audio, video and data fi les on a CD/DVD. Here are the steps to burn fi les to a CD/

DVD:

∑ Insert a blank writable CD/DVD into the corresponding drive. Windows displays the AutoPlay 

dialog box shown in Fig. 2.48. 

 

Fig. 2.48 AutoPlay dialog box for a blank writable CD

∑ The default option (Burn fi les to disk) is good for burning fi les using Windows Explorer. Click 

Burn fi les to disc.

Windows displays Burn a Disc dialog box shown in Fig. 2.49. At the top of the dialog box, there is a 

text box for entering the title for the disc. Notice that there are two burn options in the dialog box. The 
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fi rst option (Like a USB fl ash drive) is the best if you want to use the disk on computers which are not 

very old (Windows XP and later.) On the other hand, if you plan to use the disk in CD/DVD player, 

the second option is preferred. Windows supports two writing formats on CD/DVD: Live File System 

(UDF) and Mastered (ISO). Of these two formats, Live File System format is the latest and fl exible as 

you can add and remove fi les on the disk, as if you are transferring fi les to a USB Flash drive. On the 

other hand, you cannot remove fi les from the disk with the Mastered format. Let us choose the fi rst 

option that uses Live File System format.

 

Fig. 2.49 Burn a disk dialog box

∑ Type a suitable title for the disk in the Disk title box and click the fi rst option (Like a USB fl ash 

drive) if required and click Next.

Windows starts the format operation on the CD/DVD, which takes a few seconds to complete and 

displays Windows Explorer. (In some cases, Windows may display an AutoPlay dialog box with two or 

more options. In that case click Open folder to view fi les using Windows Explorer in the AutoPlay 

dialog box.) Windows Explorer selects the CD/DVD RW drive in the Navigation pane and displays 

“Drag fi les to this folder to add them to the disk”, as shown in Fig. 2.50.

Fig. 2.50 Drag fi les for burning in a CD/DVD
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Now you can drag the fi les you want to burn in the Content pane. You would fi nd it convenient to 

drag fi les from a second Windows Explorer window. (Press Ctrl+N to open a new Windows Explorer 

window.) When you drop fi les in the Details pane of the CD/DVD, it copies the fi le to CD/DVD. While 

copying the fi les, it also displays the Copying progress box. After the copy process is over, you would 

see the fi les in the Details pane. 

Tip  If you are using the Live File System format, you can rename, delete and edit fi les on the writeable 
CD/DVD as if you are working on a USB Flash Drive. 

∑ After you have copied the fi les, you can eject the disk by clicking Eject on the Task toolbar. 

Windows closes the current session and ejects the disk. Later, if you want to copy more fi les to the 

disk, just insert the disk in the drive and copy fi les in the usual way by drag and drop.

Note  If you use the Mastered (ISO) format for creating CD/DVD, you need to complete one fi nal step after 
you have dragged fi les to be copied (burnt), which is not required for the Live File System format. To 
complete the fi nal step, you need to click the Burn to disk link on the Task toolbar. Then Windows 
displays a Wizard that guides you through the process of naming the disk and burning the fi les on 
the disk. 

2.19 HOW TO PUT COMPUTER AND CONTROL PANEL

 ICONS ON DESKTOP? 

By default, Windows 7 only puts the Recycle Bin icon on the desktop. If you prefer, you can put other 

system icons, such as Computer, Control Panel, Network and User’s Files on desktop. Here are the 

steps to accomplish this: 

∑ Right click any empty area on the desktop to display a context menu and click Personalize on the 

menu. Windows display the Personalization window.

∑ Click the Change desktop icons link in the Personalization window. Windows displays the 

Desktop Icons Settings dialog box shown in Fig. 2.51. 

Fig. 2.51 Desktop icons settings
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∑ Check the Desktop icons that you want to display on your desktop in the dialog box. Finally click 

OK. 

Now Windows refreshes your desktop with the desktop icons you selected. 

2.20 GETTING HELP 

The Windows operating system has ballooned from simple MS-DOS that could fi t on a single fl oppy 

disk to a huge system that requires hundreds of MB of hard disk space to install. The Windows operating 

system has so many features that it is very diffi cult for anyone to know and remember all commands, 

options and features. Therefore, Windows comes with a detailed help system. 

∑ To open the help system, choose the Help and Support from the Start menu or click desktop and 

then press the F1 key. Figure 2.52 displays the Windows Help and Support window. 

Fig. 2.52 Windows Help and Support system

∑ You can use the Search box in the Help window to fi nd help topics matching specifi ed keywords. 

To search for help topics, enter matching keywords, e.g., “how to print” in the search box and press 

Enter, and the Help window displays links to the topics matching the search keywords. Now you 

can click any link to see the help details. 

Windows help has two modes: Online Help and Offl ine Help. The Offl ine help is the help details 

available on your computer that you can access anytime. In the Online help mode, additional help 

information is available from Microsoft, however, you should be connected to the Internet. 

While using any Windows feature, you can ask Windows to display help information. For example, 

you are working on the Control Panel, Recycle Bin or Devices and Printers and you want to know more 

about how to use a feature. 

∑ To get help details about an open Windows window, press F1. 
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Windows displays the relevant topic in a Windows Help and Support window. Now you may explore 

the help information or click any link displayed in the window to get more details. 

2.21 INSTALLING USB DEVICES 

Most recent computers have several USB ports. You can connect most devices, such as keyboards, 

mouse, printers, cameras, scanners, external hard drives, external CD/DVD player/recorders, USB 

Flash drives, etc., to USB ports. You can connect a USB compatible device to any USB port on your 

computer. You may sometimes fi nd additional USB ports on USB devices connected to your computer, 

e.g., keyboard.

Installing a USB device on a computer basically means installing software driver on the PC to 

enable your PC to use the device. When you connect a new device to a USB port, Windows detects 

it and tries to install the required driver from thousands of drivers for common products already built 

in Windows 7. Besides, during Windows update, it keeps collecting additional drivers. Therefore, the 

chances are very high when you connect a device to a USB port, Windows is going to install a suitable 

driver for you. On detecting a new device, Windows displays a few messages, such as “New device 

detected”, “Installing device driver software” and “Your device is ready to use” in balloons in the 

notifi cation area. After Windows display the “ready to use” message, you can start using the device. If 

Windows cannot fi nd the driver for the device, you may install the drivers from the CD provided with 

the device, if any, or search and download the driver from the manufacturer’s website. 

2.22 CHANGE OR UNINSTALL A PROGRAM 

If you do not need a program anymore, you can uninstall (remove) it. This will reclaim the disk space 

occupied by the program, and in some cases may also improve the performance of the computer. 

However, you cannot delete the folder containing the program to remove it, instead you must use 

the Control Panel to uninstall (remove) it. The control panel can also be used to change or repair the 

installed programs. Follow these steps to uninstall or change an installed program: 

∑ Open the Start menu and click Control Panel to open the Control Panel window. 

∑ Click Programs and Feature (or Programs, Programs and Features) in the Control Panel window. 

Windows displays the list of installed program in the Control Panel window. 

∑ Click the program that you want to uninstall, change or repair. 

Figure 2.53 displays the 7-Zip program selected. Notice that it displays details about the selected 

program in the Details pane at the bottom of the window. Also notice the Uninstall, Change and Repair 

links on the Task toolbar, which are used to uninstall (remove), change and repair the selected program, 

respectively.

∑ Click the Uninstall link on the Task toolbar to uninstall the selected program. Windows displays 

a confi rmation dialog box similar to the following. 
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Fig. 2.53 Remove or Change a program in Control Panel

∑ Click Yes to ask Windows to uninstall the program or No to cancel the uninstall process. 

The Programs and Features window of Control Panel can also be used to turn on or off Windows 

features through the Turn Windows Features on or off link, as illustrated in Fig. 2.53. On clicking 

this link, Windows displays the Windows Features dialog box where you can check or uncheck the 

corresponding features. Finally, click the OK button to ask Windows to implement your selection. 

2.23 DOWNLOADING AND INSTALLING PROGRAMS 

Nowadays, several freeware, shareware, open-source as well as commercial programs are available 

for download from the Internet. The process of downloading programs from the Internet and installing 

on your PC, through not standard, is usually not complicated. The following are the typical steps to 

download and install a program. 

1. Visit the website and navigate to the webpage that allows downloading the program fi le.

2. Determine the fi le that you want to download. Usually, there are multiple fi les available for 

different types of operating systems. For PCs running Windows, choose the fi le suitable for the 

Windows version you are using. 

3. The downloaded fi le gets saved automatically in the default download folder. (More about 

downloading fi les is discussed in Section 8.29.)

4. The downloaded fi le may have different extension names, such as ZIP, EXE or MSI. If the fi le 

extension name is EXE or MSI, open or run the fi le to initiate the installation process. On the 

other hand, a ZIP (compressed) fi le has to be fi rst unzipped. Most zipped fi les automatically unzip 

on double clicking the fi le name. However, if the fi le does not unzip automatically, use the unzip 

program to manually unzip it. After the fi le has been unzipped, it will reveal a setup fi le (usually 

called setup.exe or setup.msi) that you can run to install the program. 

Note  When you try to install a program on your computer, usually Windows displays some details about 
the program and asks if you want the program to make changes to the computer. You should click 
Yes only if want to continue with the installation process.
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2.24 INSTALLING PRINTERS 

To use a printer on a Windows PC, you need to install it. Installation of printer basically implies 

installing the printer driver, a software component that Windows uses to print on a specifi c printer. 

Different printers internally work in different ways; therefore, you need a separate printer driver for 

each printer you want to use with your PC. Besides installing printer drivers for a specifi c printer, 

sometimes we also install generic printer drivers for special tasks, such as to send a fax or to create a 

PDF (Portable Document Format) fi le from a document fi le. Once a printer driver has been installed, 

that printer driver (or printer) is available for use with all programs installed on the PC. 

∑ To see the list of printer drivers installed on your PC, open the Start menu and click Devices and 

Printers. 

Figure 2.54 displays the Device and Printers window. Notice that one of the printer has a tick mark (�) 

attached to its name, which indicates that this is the default printer. 

Fig. 2.54 Devices and Printers window displaying devices and printers installed in a computer

∑ To change the default printer, right click the desired printer icon to display a context menu and 

click Set as default printer in the menu. You may use other commands in the menu to change 

printing preference and properties, or share it with other PCs, if your PC is connected to a LAN 

(Local Area Network).

∑ To install a USB printer, just connect it to a USB port and Windows will do the rest. Refer to 

Section 2.21 for details. 

Non USB printers, usually come with installation instructions and an installation CD that contains the 

printer driver for the printer. On following the installation instructions, the required printer driver gets 

installed on the PC. If you do not have the installation CD, you may download the printer driver from 

the printer manufacturer’s website and install it. Windows includes drivers for most common printers 

and will let you choose a driver from its database during the installation process. To install a non-USB 

printer: 
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∑ Connect the printer to the PC, open the Devices and Printers window and click Add a printer on 

the task toolbar, as illustrated in Fig. 2.54. Windows displays the Add Printer wizard shown in

Fig. 2.55.

Fig. 2.55 Add Printer Wizard

∑ Depending on the type of printer you want to install, click Add a local printer or Add a network, 

wireless or Bluetooth printer. 

∑ On choosing the local printer option, the next step of the Add Printer Wizard asks you to choose 

the port where the printer is connected to. The default port is LPT1 (Printer Parallel Port 1). 

Change the port, if required and click Next. 

Now, the wizard displays the next step shown in Fig. 2.56, where it displays the list of printer 

manufacturers and models whose drivers are available with Windows. 

Fig. 2.56 Selecting Printer manufacturer and model
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∑ Now you need to choose the manufacture of your printer in the left list box. On choosing a 

manufacturer, the Wizard window displays the list of available printers in the right list box. Now 

choose the printer model name in right box. If you cannot fi nd your model in the list, you may 

choose a similar model name. The click the Next button. 

Windows displays the next step of the wizard shown in Fig. 2.57. Windows displays a default name for 

the Printer you are adding. You may keep the default name or defi ne a new name.

Fig. 2.57 Assigning a name to the Printer

∑ Type the new name for the printer, if required and click Next.

∑ Windows installs the driver on your computer and asks if you want to share the printer. If you want 

to share the printer, defi ne suitable share name for the printer. Then click Next to display the next 

step of the Wizard. 

∑ Now you have almost reached the end of the installation process. This step enables you to print 

a test page to ensure that the printer is working properly. In this step, you may also choose if you 

want the newly installed printer to be the default printer. Finally, click the Finish button to close 

the Add Printer Wizard dialog box. 

Windows displays the newly installed printer in the Devices and Printers window. 

2.25 WINDOWS UPDATES 

Microsoft regularly releases updates for the Windows operating system and related software. Some of 

these updates are critical for the safe operation of your PC, and Microsoft recommends that important 

updates should be installed on your PC at the earliest. Windows can automatically check the Windows 

Update Web site at the specifi ed time of every day (or on a specifi c day) to automatically download or 

download and install important updates. You can view the Windows updates settings for your computer 

in the Windows Update section of Control Panel. 

∑ Open the Start menu and click Control Panel to open the Control Panel window. 
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∑ Click Windows Update in the Control Panel window. If you cannot fi nd Windows Update in 

the Control Panel window, type Windows Update in the search box in the top right corner of the 

window and Windows will fi nd and display the Windows Update link for you. 

Windows displays the Windows Update details, including the date and time of the most recent check for 

updates and the date and time the last update was installed, as shown in Fig. 2.58. 

Fig. 2.58 Windows Update

The links displayed in the left side of the windows are used to check for updates, change update 

settings, view update history, etc. Let us have a look at the Windows Update settings.

∑ Click the Change Settings link in the Windows Update window and a new windows appears as 

shown in Fig. 2.59. 

Fig. 2.59 Choosing how Windows can install updates
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The default and recommended setting for installing important updates is install important updates 

automatically, as illustrated in Fig. 2.59. The other update options, which you can choose by clicking 

the current setting button, are: 

1. Download updates but let me choose whether to install them.

2. Check for updates but let me choose whether to download and install them.

3. Never check for updates (not recommended).

Using any setting other than “Install updates automatically” is not recommended for the safety of your 

computer.

2.26 USING SYSTEM TOOLS 

Windows comes equipped with several system tools that help to maintain the system or improve its 

performance. The system tools bundled in Windows 7 include, Character Map, Computer, Control 

Panel, Disk Cleanup, Disk Defragmenter, Resource Monitor, System Information and System Restore. 

These tools are available under the System Tools submenu under the All Programs, Accessories. To 

view available system tools or to run any system tool: 

∑ Open the Start menu and click All Programs. Windows displays the All Programs menu.

∑ Click Accessories in the All Program menu to displays the Accessories submenu. 

∑ Click System Tools in the Accessories submenu and Windows displays the available system tools 

as shown in Fig. 2.60. 

Fig. 2.60 System tools
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We have already discussed Control panel. Other important system tools are discussed in this section. To 

run a system tool, click the corresponding tool in the System Tools submenu. 

2.26.1 System Information

System Information provides general information about the computer system, such as Windows edition 

installed on your computer, CPU details, installed and available memory and system type (32 or 64 bit), 

etc. Figure 2.61 displays the System information details. To get the system details for your computer: 

∑ Open the System Tools submenu from the Accessories submenu, as already discussed in the 

beginning of this section and click System Information. 

Fig. 2.61 System Information

∑ Windows displays summary information about the computer system. To get more details, expand 

a category in the left pane and click the corresponding item, as illustrated in Fig. 2.61. 

2.26.2 Disk Cleanup

The Disk Cleanup tool can help you cleanup your hard disk by deleting downloaded program fi les, 

temporary internet fi les, other temporary fi les, emptying the Recycle Bin and compressing old fi les. 

This results in reclaimed hard disk space and improved performance. Figure 2.62 displays a Disk 

Cleanup window. 

∑ Check (�) the type of fi les you want to delete. As you check or uncheck fi les categories, Windows 

displays the amount of space you would gain after disk clean-up.

∑ Click the OK button to proceed with Disk Cleanup process. 

You should periodically clean-up the disk to improve the performance of your PC.
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Fig. 2.62 Disk Cleanup

2.26.3 Disk Defragmenter

The fi les on the hard disk are not stored in a linear way. Instead, each fi le is divided into small units, 

and each unit is stored in a unit space called cluster on the hard disk. This is done to optimize the read-

write performance on the hard disk. Depending on the size, a fi le may be stored in 1, 10, 100 or even 

thousands of clusters. Thus, while storing a fi le on the hard disk, the fi le system of the operating system 

may store it in clusters which may be physically located in different parts of the hard disk, depending 

on where the empty clusters are available. After repeated deletion and creation of new fi les, usually 

fi les gets so fragmented that hard disk read-write performance starts deteriorating as the hard disk head 

has to travel to clusters located in so many different areas of the disk to read or write a fi le. To improve 

performance, it is recommended to periodically run the Disk Defragmenter tool, which rewrites the 

fi les on the hard disk for optimised performance. 

∑ Open the Disk Defragmenter program from the Accessories, System Tools menu. You may also 

open this program by typing “Disk Defragmenter” in the search box of the Start menu and then 

clicking Disk Defragmenter in the search results under the Programs category. Windows displays 

a window similar to Fig. 2.63.

∑ Select the disk you want to defragment, e.g., “OS (C:)” and click the Analyze disk button. Windows 

analyzes the disk and updates the percentage value of the fragmented disk.

∑ If your disk is more than 10% fragmented, you should defragment the disk by clicking the 

Defragment disk button. 
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Fig. 2.63 Disk Defragmenter

Windows starts the defragmentation process which takes signifi cant time as the fragmented fi les are 

rewritten. It displays the defragmentation progress under the Progress column in the window. When 

the process is complete, you should see “0% fragmented” (or a number close to 0%) in the Disk 

Defragmenter window.

∑ Click the Close button to close the Disk Defragmenter window. 

2.26.4 System Restore

System Restore is a very useful tool that can help you to rollback your system to a previous state, if 

you notice a problem after installing new software or upgrading existing software. In other words, you 

can undo the installation of a program, driver or Windows update. Windows automatically maintains 

restore points on regular intervals and when it installs important software. When you notice unexpected 

change in the behavior of the computer after installation of a driver or program, usually uninstalling 

that program or driver fi xes the problem. However, if that does not fi x the problem, you can restore the 

computer system to an earlier date when everything worked fi ne. When Windows restores the system, 

your data fi les, e.g., documents, spreadsheets, downloaded fi les, e-mails, etc., are not affected.

∑ To use System Restore, open System Restore from the Accessories, System Tools menu or search 

for it from the Start menu. 

∑ Windows displays the System Restore window that briefl y explains the System Restore process. 

Click Next and a  System Restore window appears with the list of restore points, as shown in

Fig. 2.64.

The System Restore window displays various restore points (date and time) and some brief description 

about each restore point. 

∑ Click the restore point you want to apply. You may click the Scan for affected program to fi nd 

the program that will be affected by the system restore. Then click Next to proceed to the next 

step. 
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Fig. 2.64 System Restore

∑ Click Finish to proceed with system restore. Windows displays a confi rmation box. On clicking 

Yes in the box, Windows starts the system restore process. 

After the system restore is complete, Windows automatically restarts the computer. If things do not 

work as expected, you can undo the system restore and try an earlier restore point. 

2.27 USER ACCOUNTS 

Windows allows sharing a computer by allowing multiple user accounts. Each user is assigned a user 

name and password (optional) which are used to allow logging to the system. Each user maintains its 

own desktop settings, documents, start menu settings, list of favorite websites (bookmarks), control 

panel settings, etc. New users can be created only by a user who has Administrative rights. However, 

when a user is created, it may be assigned Administrative or Standard rights. The User Accounts section 

of Control panel is used to manage existing user accounts or create new user accounts. 

∑ Open the Control Panel window form the Start menu and then click User Accounts. Window 

displays the User Accounts window for the current user, as shown in Fig. 2.65. 

The User Accounts window displays the user name, picture and type (administrator or standard) in the 

upper right section of the window. 

∑ To change the user profi le, e.g., password, picture, account name, account type, etc., click the 

corresponding link and follow the instructions.

∑ If you want to view all users or want to change the profi le of another user account, click Manage 

another account link, as illustrated in Fig. 2.65. 
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Fig. 2.65 The User Accounts window

Windows displays the Manage Accounts window, which contains icons all users on the computer, as 

shown in Fig. 2.66. You can click any user icon to manage that account, as illustrated in the fi gure. 

Fig. 2.66 The Manage Accounts window

2.27.1 Creating a New Account

∑ To create a new account, click the Create a new account link in the Manage Accounts window. 

Windows prompts you to provide a name for new account you want to create, as shown in Fig. 2.67. 



 Using Windows    103 1 

Fig. 2.67 Naming a new account

∑ Type the account name in the New Account name box. Windows can create two types of users: 

Standard user and Administrator. As described in the Create New Account window, Administrator 

users have complete access to the computer. By default, Windows create a standard user. Change 

the user type, if required and click Create Account. 

Windows creates the user and displays the new user in the Manage Accounts window. Now you can 

click the newly created user and change its profi le, e.g., change the picture, password, account name, 

etc. 

2.28 USING NOTEPAD 

Notepad is a simple and easy to use text editor. Notepad does not support any text or paragraph formatting, 

i.e., it opens and saves text in the ASCII (American Standard Code for Information Interchange) mode. 

You can use it to type a simple memo or short note. Notepad can also be used to type programs for 

programming languages or applications, e.g., BASIC, dBASE, FoxPro, HTML, etc. 

Note  To create or edit fi les that require formatting, use WordPad or some word processor, such as 
Microsoft Word.

∑ To start Notepad, click the Start button to open the Start menu and then choose All Programs, 

Accessories, Notepad. Alternatively, open the Start menu, type Notepad in the Menu’s search 

box and click Notepad in the search results. 

Windows opens the Notepad windows shown in Fig. 2.68. When Notepad starts, it creates a fi le and 

names it—Untitled. So you may start typing text in this fi le. Notepad will ask for the fi lename when 

you save it. 
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Fig. 2.68 Notepad window

∑ When you type text, the cursor may automatically move to the next line when the current line gets 

fi lled up depending on the setting of word wrap. To change the word wrap setting, click Format

to open the Format menu (see Fig. 2.68.) and then click Word Wrap. 

∑ The Edit menu supports the Cut, Copy, Paste and Select All commands to copy and move text in 

the fi le. The Edit menu also supports the Time/Date command to enter the current time and date in 

the fi le at the cursor position. 

∑ To save the fi le, click File to open the menu and then click Save in the menu. Alternatively, press

Ctrl+S to save the fi le. 

If you are saving the fi le for the fi rst time, it displays the Save As dialog where you defi ne the fi lename 

and choose a folder (location) to save the fi le. The use of Save As dialog box, which is same in all 

Windows applications, is described in the next section. 

∑ To open an existing fi le, use the Open command from Notepad’s File menu or press Ctrl+O.

2.29 USING WORDPAD 

WordPad is a small word processor. We are calling it small, as it does not have the advanced features of 

the full-fl edged word processors. For instance, you will not fi nd features such as spell-check, grammar-

check, hyphenation, AutoCorrect, etc., in WordPad. However, it contains the necessary commands 

to format text, paragraphs and page. It is a true WYSIWYG (What You See is What You Get) word 

processor. That is, what you see on the screen is nearly what you get on printing the document. You can 

also insert graphics in WordPad documents. You can use WordPad to create professional-looking letters 

and documents. WordPad uses the Windows interface, therefore, after learning How to Use WordPad, 

you will be able to apply the same techniques on other programs, such as Paint, Word and Excel. The 

WordPad program is located in the Accessories submenu.

∑ To start WordPad, click the Start button to open the Start menu and then choose All Programs, 

Accessories, WordPad. Alternatively, open the Start menu, type WordPad in the menu search box 

and click WordPad in the search results. Figure 2.69 displays a WordPad window.

Like a typical window, the WordPad window displays the title of the program in the title bar. WordPad 

has automatically created a new document with the name ‘Document’. So, you can straightaway start 

typing. Later, when you save the document, you assign a name of your choice to it. On the left side of 
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the title bar is a customizable Quick Access toolbar, which contains frequently used commands, such 

as Save, Undo and Redo. 

Fig. 2.69 WordPad window

If you are new to Windows 7, you won’t fi nd typical menus in most Windows programs; instead 

these programs use the Ribbon interface. The Ribbon, located under the title bar provides quick access 

to all formatting commands on the default Home tab. These commands are placed under various groups, 

such as Clipboard, Font, Paragraph, Insert and Editing. Normally, you will be able to determine the task 

WordPad will perform on clicking a button or icon by just looking at the graphics. However, if you 

are not sure, move the mouse pointer on the corresponding button or icon and wait for a second, and it 

displays a tooltip containing some description.

The empty area below the Ribbon is called the Document pane where you type your document or 

WordPad displays an existing document. The last line of the WordPad window, called the status bar 

contains a Zoom Slider which is used to change the zoom setting of the document. 

Note The Ribbon interface will be discussed in detail in Chapter 3.

2.29.1 Typing a Document in WordPad

Consider the sample letter shown in Fig. 2.70. In the sample letter, the address is centred and the date 

is right aligned on the page. You may format paragraphs as you type the letter or initially type the letter 

without caring for paragraph formatting and then format paragraphs. While typing text, remember the 

following points:

1. While typing text in a paragraph, when you reach near the end of the line, do not press the Enter key, 

as you would have done on a manual typewriter. Just continue typing and WordPad automatically 

moves the last word of the line to the next line if it goes past the right margin. Press the Enter key 

only when the paragraph ends. 

2. When you want to end a line, press the Enter key. For example, in Fig. 2.70, you will press Enter 

after typing each address line and date. Similarly, press the Enter key to type a blank line.
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Let us begin typing.

∑ Type DOEACC Society, the fi rst line of the address. Do not press the Enter key. 

 WordPad displays ‘DOEACC Society’ in the document area. This line is left aligned, the default 

for all paragraphs in WordPad. 

Fig. 2.70 A sample letter

∑ To center the paragraph, click the Center button in the Paragraph group on the Ribbon. Then press 

the Enter key.

∑ Type 6 CGO Complex and press Enter to move the cursor to the next line. Then type New Delhi -

110003 and press Enter. Press Enter once more to leave another blank line. 

∑ Since the date is right aligned, click the Align Text Right button in the Paragraph group on the 

Ribbon, type March 19, 2013 and press Enter.

∑ Refer to the sample letter shown in Fig. 2.70 and type the rest of the letter. Just remember not to 

press Enter at the end of each line in the paragraph. That is, while typing the body of the letter, 

you will press Enter only after ‘...shall take place in June.’ 

2.29.2 Saving the Document in a File

So far, the letter that you have typed is sitting in the temporary memory of your PC. To permanently 

store the letter, you need to save it in a disk fi le.

∑ Click , the Save button on the Quick Access toolbar located at the top left corner of the WordPad 

window. You can also accomplish the fi le save operation by pressing Ctrl+S, the shortcut keys for 

the Save command. 

WordPad displays the Save As dialog box shown in Fig. 2.71, where you enter the name of the fi le that 

you want to assign to the document. Besides the fi lename, which you type in the File name box (see 

Fig. 2.71), you can also select the drive and the folder where you want to store this fi le. In Fig. 2.71, the 
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current folder is ‘Documents Library, so, if you do not change the folder, the fi le will be saved in this 

folder. If you want to save the fi le in some other folder, perform the following steps:

Fig. 2.71 Save As dialog box

∑ To select a folder that visible in the Save As dialog box, double click it. For instance, to save the 

document in the GardenTools folder, double click GardenTools to open this folder. 

∑ To save the document in a new folder, click the New Folder button on the Task toolbar. 

∑ To select a different major area, e.g., Desktop instead of Documents Library, click it in the 

Navigation pane. Then double click to open a folder that may exist in the selected area. 

∑ After you have selected the folder to save the document into, type a suitable fi lename. Finally, 

click the Save button to save the fi le. 

2.29.3 Editing a WordPad Document

After typing a document in WordPad, if you notice any mistake or want to change or add text in any 

part of the document, you can edit your document. To edit, you need to move the cursor to the position 

where you want to carry out editing. You can move the cursor by using the mouse or the keyboard. 

∑ To move the cursor with the mouse, move the mouse pointer where you want to place the cursor 

and click the mouse button. 

∑ To move the cursor with the keyboard, use the cursor movement keys. On the right-hand side of 

the keyboard, you fi nd four arrow keys. You can use these keys to move the cursor in the direction 

of the arrow keys. For instance, you can use the left arrow (←) key to move the cursor to the 

previous character position, the right arrow (→) key to move the cursor to the next character 

position. Similarly, you can use the up arrow (↑) and down arrow (↓) keys to move the cursor up 

and down by one line, respectively. 

∑ If you need to delete a character, use either Del or the Backspace key. Notice that the cursor is 

always placed between two characters. The Del key deletes the character to the right of the cursor 

position whereas the Backspace key deletes the character to the left of the cursor position. 
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∑ If you want to delete a word or a sentence, select it and then press the Del key to delete the 

selected text. Double clicking the mouse on a word selects that word and triple clicking selects 

the paragraph. Alternatively, click and drag the mouse to select any length of text. After you have 

selected the text that you want to delete, all you need to do is to press the Del key. 

∑ If you delete any text by mistake, you can undelete (restore) the text by pressing Ctrl+Z or by 

clicking the Undo button on the Quick Access toolbar. 

2.29.4 Formatting Paragraphs

You can control the appearance of your document by formatting paragraphs. For example, you can 

change the alignment of paragraphs to centred or right aligned. You can also change the font, size and 

style (bold, italic, underline, etc.) of any text in the document. The character formatting commands 

are available in the Font group and the paragraph formatting commands are available in the Paragraph 

group. 

∑ To format a paragraph, click anywhere in that paragraph and click the corresponding control in the 

Paragraph group. For instance, click Justify to justify the paragraph or Center to create a centred 

paragraph. 

∑ You can also change the formatting of paragraph through the Paragraph dialog box. To open 

the paragraph dialog box, click the Paragraph button in the Paragraph group or right-click the 

paragraph to display a context menu and click the Paragraph in the menu. 

2.29.5 Formatting Text

You can give a professional look to the documents created in WordPad by formatting the text in several 

ways. For example, you can change the size of the text. You can also use different styles, such as 

bold, italic, underlined, etc., on the selected text. You can also change the font of the selected text. For 

example, you may format the address of the DOEACC Society in the following way: 

DOEACC Society

6 CGO Complex

New Delhi - 110003

Here, ‘DOEACC Society’ is shown in Arial font in 12 point, bold and italic style. The last line of the 

address is underlined. 

∑ To format the text, select the text and click the corresponding control in the Font group. For 

instance, click the Bold button to format the selected text in bold letter. Similarly, click the Italic

to show the text in the italic style. 

∑ If you want apply a different font to the selected text, click the down pointing arrow on the right 

of the Font Family dropdown box (see Fig. 2.69) and click the desired font. Similarly, you can 

change the font size through the Font Size control located next to the Font Family control. 

∑ After making changes, you may resave the modifi ed document by press the Save button on the 

Quick Access toolbar.

2.29.6 Printing a Document

∑ To print the current document, press Ctrl+P. You can also access the print command by clicking 

the WordPad button (see Fig. 2.69). WordPad displays the Print dialog box shown in Fig. 2.72.
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Fig. 2.72 Print Dialog box

The default options in this dialog box are suitable to print one copy of all pages of the document on the 

current printer. You can use the top part of the Print dialog box to select a different printer. The Page 

Range box, which is used to specify the range of pages to print, has three options:

All This option prints all pages of the document. 

Pages When your document contains several pages and you want to print a particular range 

of pages, e.g. from page 3 to 7, use this option. To specify the page range, click Pages

in the Page Range box and type the required starting and ending page numbers, e.g., 

3-7.

Current Page Prints the current page where the cursor is positioned. 

Selection  Use this option when you want to print some selected text, e.g., a particular paragraph. 

To use this option, select the text that you want to print prior to using the Print 

command. 

∑ After you have selected the Page Range and printer, press Enter or click the Print button to start 

printing.

2.29.7 Opening a Document

∑ To open an existing fi le, click the WordPad button (see Fig. 2.69) and click Open or press Ctrl+O. 

WordPad displays the Open dialog box.

∑ Double click the fi le you want to open, or click to select the fi le and press Enter or click the Open 

button in the Open dialog box.

WordPad opens the document in the WordPad window.
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2.30 USING CALCULATOR 

Windows contains an on-screen calculator that you may use for doing calculations while working 

with Windows. Like Notepad and WordPad, the calculator program is available in the Accessories 

submenu.

∑ To open Calculator, click the Start button to open the Start menu and then choose All Programs, 

Accessories, Calculator. Alternatively, open the Start menu, type Calculator in the menu search 

box and click Calculator in the search results.

The calculator can operate in four modes—Standard, Scientifi c, Programmer and Statistics. Figure 2.73 

displays calculators operating in Standard and Scientifi c modes. 

Fig. 2.73 Standard and Scientifi c Calculators

∑ To change the calculator mode, click View to display a menu and then click the desired option. 

∑ To enter numbers and some of the symbols, such as *, /, +, -, =, %, etc., use the keyboard or click 

the corresponding button on the calculator. For other operations, click the corresponding button. 

∑ If you want to use the result of the calculation in any document, press Ctrl+C to copy the result in 

Windows Clipboard. Later you can press Ctrl+V or use the Paste command in any document to 

paste the result from Clipboard. 

2.31 USING PAINT 

Paint is a useful program included in Windows. You can create your own graphics (simple line drawing) 

using Paint’s drawing tools. It is also possible to import readymade graphics fi les from other compatible 

programs into Paint. Then you can modify the imported graphics by using Paint’s drawing tools. The 

graphics you create in Paint can be printed or you can copy it to Clipboard so that you may paste it in 

any Windows application. Paint is available in the Accessories menu. 

∑ To open the Paint program, click the Start button and then choose All Programs, Accessories, 

Paint. Alternatively, open the Start menu, type Paint in the menu search box and click Paint in 

the search results to open Paint. 

Figure 2.74 displays a Paint window. Like WordPad, Paint also uses the Ribbon interface, so you fi nd 

all paint tools available on the Home tab in the Tools and Shapes groups. 
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Fig. 2.74 The Paint window

∑ Click the required tool, e.g., Pencil, Line, Curve or Rectangle on the Ribbon. Then choose the 

required size (e.g., line thickness) and color. 

Note  You must select the desired line thickness prior to drawing the line or other shapes. You cannot 
change the line thickness after drawing the line. 

∑ Move the cursor to the drawing area. Click or drag the mouse to draw the shape. If required, use 

the Eraser tool to erase a part of the drawing. 

∑ If you need to superimpose text on the drawing, use the Text tool.

∑ To print the graphics you have drawn, press Ctrl+P to display the Print dialog box. Follow the 

same procedure described earlier in the WordPad section.

∑ If you need to save the graphics, click the Save button on the Quick Access toolbar and follow 

the same procedure described in the WordPad section. Paint can save the fi le in various common 

formats, such as JPEG, TIFF, PNG, GIF and BMP. 

2.31.1 Copying Picture to Another Application

If you want to copy the complete picture or a part of the picture to another application, perform the 

following steps:

1. Use the Select tool to mark the area of the picture you want to copy.

2. Press Ctrl+C, the shortcut keys for the Copy command. Paint copies the picture to Clipboard. 

3. Open or switch to the other application where you want to paste the copied picture. Move the 

cursor to the required position and then use the Paste command (Ctrl+V). 

2.32 USING SNIPPING TOOL TO CAPTURE SCREENSHOTS 

While Windows always had shortcut keys (PrtScn) to capture the screen and Alt+PrtScn to capture 

the screenshot of the active window, Snipping Tool introduced in Windows 7 makes screen capture 

more convenient. Snipping Tool enables you to capture any part of the screen that you can paste in 

any Windows application or save it as JPEG, GIF, PNG or embedded HTML fi le. Snipping Tools is 

available in the Accessories menu. To open Snipping Tool:
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∑ Open the Start menu and choose All Programs, Accessories, Snipping Tool. You can also search 

for Snipping Tool in the search box of the Start menu. 

Window displays Snipping Tool shown in Fig. 2.75 on the screen and dims the screen. Snipping Tool 

can capture the screen in four modes: Rectangular snip, Free Form snip, Windows snip and Full-screen 

snip. Rectangular snip captures any rectangular area of the screen whereas Free Form snip enables 

you to capture freehand (non-rectangular) area of the screen. Windows snip captures an active window 

whereas Full-screen snip captures the entire screen. 

Fig. 2.75 Snipping Tool

∑ Click the arrow on the right of the New button to choose the type of snip. If you select Rectangular 

or Free Form snip, drag the cursor around the area on the screen you want to capture. As you 

drag the mouse, Snipping Tool outlines the area with a red border. When you release the mouse, 

the Snipping Tool windows expands to display the captured screen as shown in Fig. 2.76. (If you 

select Windows snip, Snipping Tools enables you to choose a windows.) 

Fig. 2.76 Captured screen area displayed in the Snipping Tool window

∑ You may use the Pen, Highlighter and Eraser tools to mark-up the captured image, if required. Then 

press Ctrl+C to copy the image or click the Save button to save the image. To paste the copied 

image in any Windows application, click the cursor at the desired location and press Ctrl+V or use 

the Paste command/control. 

2.33 STICKY NOTES 

You might have seen people sticking paper Post-it notes on the edge of their monitors. The Sticky Notes 

feature of Windows 7 enables you to create virtual sticky notes that you can move around on the screen 

and delete them with ease when you don’t need them anymore. To create a sticky note: 
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∑ Open the Start menu and choose All Programs, Accessories, Sticky Note. 

∑ Window creates a Sticky Note on the screen and you can type or paste text in the Sticky Note 

window. Figure 2.77 displays a Sticky Note window with some text. 

Fig. 2.77 Sticky Note

∑ If you need to create a new sticky note, click + on the top left corner of the Sticky Note window, 

as illustrated in Fig. 2.77. Similarly, you may click the Delete Note button located in the top-right 

corner of the window to delete the note. 

∑ If you want to remove the Sticky Notes from the screen but not delete them, right click the Stick 

Notes icon on the taskbar and choose Close Window from the shortcut menu. All Sticky Notes 

disappear from the screen, but will appear on the screen when you open the Sticky Notes program 

next time.

2.33.1 Customizing and Formatting Sticky Notes 

∑ The default color of the Sticky Note is yellow, however, if you prefer a different color, right click 

the note window to display a context menu and click the desired color. 

∑ To format the notes text, drag the mouse to select the desired text and press the corresponding 

keyboard shortcuts, e.g., Ctrl+B for bold, Ctrl+I for italic and Ctrl+U for underline. Similarly, 

you can press Ctrl+T for the strikethrough style or Ctrl+Shift+L to create a bulleted list. 

2.34 CREATING SHORTCUTS ON DESKTOP 

Placing shortcuts on the desktop can help to quickly run a program or open a fi le or folder. There are 

several ways to create shortcut icons on the desktop. We have already discussed that if a program exists 

in the Start menu, you can drag it to the desktop to create a shortcut. If you want to create a shortcut for 

a fi le, folder, program, etc., on the desktop, follow these steps: 

∑ Open the Windows Explorer or Computer window. 

∑ Expand a drive or folder, if required so that the item whose shortcut you want to create is visible 

in the Content pane.

∑ Right click the item (fi le, folder or drive) whose shortcut you want to place on the desktop and 

choose the Send To command and then choose Desktop (create shortcut), as shown in Fig. 2.78. 
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Fig. 2.78 Creating a Desktop Shortcut

Note  If you choose the Create Shortcut command from the context menu, Windows creates the shortcut 
in the same folder. In that case, you can drag the shortcut from the folder to the desktop.

Another way to create a shortcut on the desktop is by using the Create Shortcut wizard. This wizard 

guides you through all steps to create a desktop shortcut. Here are the steps to accomplish this. 

1. Right click the mouse on any empty area on the desktop to display the context menu. 

2. Choose the New command and then choose the Shortcut command from the submenu. Windows 

displays the Create Shortcut wizard shown in Fig. 2.79.

Fig. 2.79 The Create Shortcut wizard
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3. If you know the location (address) of the item whose shortcut you want to create, you may enter it 

in the text box. If you do not know the location, click the Browse button and Windows displays the 

Browse For Files or Folders window shown in Fig. 2.80 that can help you to locate the target item. 

This window is similar to the Navigation pane of Windows Explorer. You can click the triangle 

icon to expand a folder/drive to reveal its subfolders and fi les. After you have located the target 

item, select it and then click the OK button, and Windows puts it in the text box on the Create 

Shortcut wizard. 

Fig. 2.80 The Browse for fi les or folder window

4. Click the Next button to display the next step of the wizard. In this step, Windows puts a default 

name for the shortcut in a text box. If you like, you can type a different name. 

5. Finally, click the Finish button to ask Windows to create the shortcut on the desktop. 

After the shortcut has been placed on the desktop, you can double-click it to open the corresponding 

program, folder or drive. If you want to change the properties of the shortcut, e.g., change the icon or 

the target item, right click the shortcut and choose the Properties command from the shortcut menu. 

2.35 RUNNING A COMMAND 

While normally you use the Start menu, taskbar icons or desktop shortcuts to open a program, folder 

or fi le, the Run command provides an alternate way to accomplish the same task. The experienced 

users fi nd the Run command useful to run programs which are not available in the Start menu or on the 

desktop. You can also use the Run command to run the Disk Operating System (DOS) commands. To 

use the Run command: 

∑ Open the Start menu and click Run. Alternatively, press  +R, and Windows displays the Run 

dialog box shown in Fig. 2.81. The last run command automatically appears in the Open textbox. 
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Fig. 2.81 The Run dialog box 

∑ If you want to run a previously run command, click the arrow to the right of the Open box to 

display a drop-down list and choose the desired command. To run a new command, type it in the 

Open textbox. Finally, press OK to run the command. 

∑ If you want to run DOS commands, type cmd in the Open textbox and press the Enter key or click 

the OK button. 

∑ Your monitor displays a Command Prompt window similar to Fig. 2.82. Now your can type any 

DOS command (e.g., DIR, CHDIR, MD, COPY, DEL, etc.) and press the Enter key to run it. 

Fig. 2.82 The Command Prompt window

Note  You may also be able to open the Command Prompt window from the Windows Start menu by 
choosing All Program, Accessories, Command Prompt.

∑ To close the Command Prompt window, click the Close button located at its top right corner in the 

title bar or type EXIT and press the Enter key. 

2.36 WINDOWS MEDIA PLAYER 

Windows Media Player is a useful program to play audio and video on your PC. Besides, playing audio 

and video fi les, it can also rip (transfer) music from CDs to your PC, as well as burn digital music fi les 
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in a CD. Though Windows Media Player has been around for may years, the version 12 included with 

Windows 7 features several advanced functions, including streaming of music to other computers in the 

home as well as over the Internet. To open Windows Media Player: 

∑ Open the Start menu, click All Programs and then click Windows Media Player in the programs 

list displayed in the menu. Figure 2.83 displays a Windows Media Player window playing an 

album from the Music library on the PC. 

Fig. 2.83 Windows Media Player 

The left side of the Windows Media Player window displays a Navigation pane, which contains the 

various source for the media fi les, e.g., Music, Videos, Pictures, Recorded TV, CD/DVD, etc. 

∑ Like Windows Explorer, you may click the triangle icon displayed to the left of an item to expand/

collapse items available under an item. For instance, with reference to Fig. 2.83, on clicking the 

triangle icon to the left of Playlists, it displays playlists stored on the PC. 

∑ On clicking an item in the Navigation pane, Windows Media Player displays the media fi les/

albums available in that source in the middle pane. Then you can double click an item (e.g., album) 

to displays songs available in that item, and you can double click the album or the song (track) to 

start playing it.

∑ At the bottom of Windows Media Player in the middle pane, there are buttons to play/pause, stop, 

move to next/previous track, volume control, etc. 

2.36.1 Playing Music CDs

When you insert a music CD in the CD/DVD-CD drive, Windows may automatically start playing it 

using Windows Media Player or display an AutoPlay dialog box shown in Fig. 2.84. 

∑ If you see the AutoPlay dialog box, click Play Audio CD using Windows Media Player, as 

illustrated in Fig. 2.84. If Windows Media Player is not open, Windows opens it in the Now 

Playing mode and starts playing the CD. 
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Fig. 2.84 AutoPlay dialog box for audio CD 

∑ The Now Playing mode of Windows Media Player displays a compact player hiding most details. 

If you want to switch to the regular view, click the Switch to Library button, as illustrated in

Fig. 2.85. 

Fig. 2.85 Windows Media Player in the Now Playing mode playing a CD   

2.36.2 Ripping CDs to Hard Drive

You can copy all or selected tracks from an audio CD to your hard drive as standalone fi les. The process 

of copying fi les from CD to the hard drive is calling ripping. After the fi les have been ripped to the hard 

drive, you won’t need the CD to play music. Besides, you will also be able pick your favorite songs 

from different albums to create playlists. Follow these steps to rip music from a CD. 

∑ Start Windows Media Player and insert a CD in the CD/DVD-CD drive. 

∑ Windows Media Player starts playing the CD and selects all track, as shown in Fig. 2.86. If you 

don’t want to rip all tracks, click to uncheck the tracks that you do not want to rip. 
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Fig. 2.86 Ripping a CD in Windows Media Player   

∑ Use the Rip Settings button (see Fig. 2.86) to change the rip settings, such as the format and audio 

quality. The default format is Windows Media Audio. If you plan to transfer the ripped fi les to other 

devices, you may consider to change the format to mp3. 

∑ Finally, click Rip CD to start the ripping process. Windows Media Players rips one track at a time 

and displays the status in the Rip Status column. When the ripping completes, Windows Media 

Player may automatically eject the CD. The ripped fi les are now available in the Music library. 

2.36.3 Creating a Playlist

Windows Media Player can help you put together your favorite track from one or more albums as a 

playlist. For example, you may create a playlist containing your favorite dance songs. A song can be 

included in more than one playlist. 

∑ To create a playlist, click the Create Playlist button, as illustrated in Fig. 2.87. 

∑ If the right pane lists any tracks, click the Clear List button to clear it.

Fig. 2.87 Creating a playlist
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Now we have an empty playlist. The next job is add tracks (media fi les) to the playlist. 

∑ Click the source in the Navigation pane which contains the tracks you want to add to the playlist. 

To add a track to the playlist, either drag it to the playlist area in the right pane, or right click the 

track and choose Add to, Play list, as illustrated in Fig. 2.88. 

∑ In the same way, you can add additional tracks to the playlist from the same or different music 

source. After you have added the required tracks to your playlist, click the Save List button (see 

Fig. 2.88) to save and name your playlist. 

Fig. 2.88 Adding tracks to a playlist   

∑ To view saved playlists, click the Playlist link in the navigation pane. Then you may double-click 

any playlist to play it. 

2.37 WINDOWS ESSENTIALS 

Windows 7 does not include common application programs, such as email, calendar, chat, address book 

and video editing. However, all these programs and much more are available for free download from 

Microsoft. Collectively, these programs are called Windows Essentials or Windows Live Essentials. The 

following programs are part of Windows Essentials:

Mail Microsoft’s email program. 

Photo Gallery A program to manage, organise and edit photos. 

Messenger/Skype A program for online chatting. 

Movie Maker A program to create movies and publish them on the web.

Writer A program to compose blog posts. 

Family Safety A program to manage and monitor children’s activities on the web. 

We would discuss some of these programs in Chapter 9. If you want to install these programs 

now:

∑ Visit the download.live.com website or search for “Windows 7 Essentials” in the browser program. 

(Searching in browser is discussed in Chapter 8.) 

∑ Click the Download Now button on the Microsoft website to download the setup program to your 

computer. 
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∑ Open (run) the downloaded fi le. Click Yes when Windows asks if you want to allow the pro-gram 

to make changes to the computer. 

∑ The Windows Essentials setup program asks if you want to install all Windows Essentials pro-

grams or selected programs, as shown in Fig. 2.89.

Fig. 2.89 Installing Windows Essentials

• Click the fi rst option if you want to install all Windows Essentials programs, otherwise click the 

second option to choose the programs you want to install. 

The installation process takes a few minutes. When the installation completes, you may need to restart 

your computer. Now you should fi nd the Windows Essentials programs in the Start menu. 
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3
WORD PROCESSING 
WITH MICROSOFT WORD

In this chapter, we will discuss the following topics:

Word Processing  

Microsoft Word  

Starting Word  

Creating, Saving and Printing a Document  

Cursor Movement and Editing a Document  

Formatting Text and Paragraphs  

Using Bullets, Numbering and Tabs  

Page Setup   

Print Preview   

Find and Replace Text  

Checking Spelling and Grammar  

Inserting Page Numbers and Page Breaks  

Document Views  

Borders, Shading, Headers and Footers  

Zooming Text  

Changing Case  

Inserting Date, Time and Bookmarks  

Moving to a Specifi c Page/Bookmark  

Click and Type   

Using Multiple Columns in a Document  

Drawing Tools and Inserting WordArt, Picture, SmartArt and   

Chart

Using Symbols, AutoText, Footnotes and Endnotes  

Numbering Figures  

Tracking changes  

Mail Merge: Letters, Envelopes and Labels  

Password Protecting Documents  

Customizing Word and Styles  
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3.1 WORD PROCESSING 

Word processing, in computer terminology, refers to typing, editing and formatting of any kind of 

document, which could be a letter, memorandum, balance sheet, or something similar. As the term 

suggests, word processing simply processes words, i.e., textual information. We can use it to prepare and 

print professional looking letters, reports, memos, booklets, and so forth. The current word processors 

are very powerful. Some of the features available in most word processors are:

∑ Adjustable page size and margins

∑ Printing selected text in boldface, italic, underlined, superscript or subscript style

∑ Using different font and the size of characters for the selected text 

∑ Paragraph formatting

∑ Moving/copying selected text to another location within the document or to another document 

∑ Facility to create headers, footers, footnotes and endnotes

∑ Facility to create multiple-column text and tables

∑ Including pictures, graphics and charts in the document

∑ Index and table of contents generation

∑ Online spelling checking, grammar checking and thesaurus

While working on a word processor, you fi rst key-in (type) the document that you want to print. 

While keying-in the document, you use various commands to format it in the desired way. We can 

check on the computer screen for mistakes and correct them. The word processing program normally 

helps us to correct spelling and grammatical mistakes. The display on the computer screen almost 

resembles the printed output that one gets on printing the document. Thus, with the word processing 

program, we can prepare professional looking documents, which are relatively error-free. We can save 

the document in the computer’s disk or USB fl ash drive for future use. 

Normally, business letters are not too different from one another in a particular company. For 

instance, the second reminder letter asking for payment does not differ much from the fi rst reminder 

already sent, except for the date, reference number and reminder number. In such cases, if one is 

using a word processor, the previous letter/document can be recalled from the computer’s storage and 

modifi ed, without retyping it in full. This helps save time and effort. 

There are certain jobs, such as tender offer, project report, manuscript of a book, thesis, etc., that 

require several revisions. In such cases, word processing is very convenient as it permits any number 

of revisions to be carried out in the document before printing the fi nal version. Word processors have a 

number of other useful features that can make your job very easy, as you will learn in this chapter.

3.2 MICROSOFT WORD 

Microsoft Word is a software program (application) designed by Microsoft Corporation, USA for 

word processing applications. Since 1990, Microsoft has released several versions of its popular Word 

program, such as Word for Windows 1.0, Word 2.0, Word 5.1, Word 6.0, Word 97, Word 2000, Word 

2001/Word X, Word 2002/XP, Word 2003, Word 2004, Word 2007, Word 2008 and Word 2010. Some 

of these versions are also available for other operating systems, such as DOS and Mac (Apple PC). The 

new releases usually have a few additional commands and features. However, the basic features are the 

same in all versions. 
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In this chapter, we will use Word 2010. If you use any other version of Word, the screen displays 

that you get may be slightly different from those used in the examples in the chapter. However, version 

prior to Word 2007 do not support the Ribbon interface, therefore, to use the commands available on 

the Ribbon, you will need to use the corresponding menus.

Note  Hereafter, we will not specify the version number (2010) after ‘Word’. However, you should remember 

that when we use ‘Word’ in the text, we are referring to Word 2010. 

3.2.1 Starting Word

Assuming that your PC is on and Windows is running, depending on how your PC is setup, you can 

start Word in several ways. 

∑ If there is an icon for Word on your desktop, double click that icon to start Word. The Word icon 

normally looks like .

∑ If Word icon is available on the taskbar (or on Quick Launch toolbar on your taskbar if you are 

using Window XP/Vista), you can start Word by clicking that icon. 

∑ You may also start the Word program from Windows Start menu. The Word program may be 

located in the Start menu or anywhere in the menu system. You may fi nd it in the Start, Programs/

All Prgrams submenu, Microsoft Offi ce or Microsoft Applications. If you still cannot fi nd the 

Word Program, click the Start button and type Word 2010 in Search Programs and fi les text box 

to ask Window 7 to fi nd it for you.

On starting Word, you see a Word window similar to Fig. 3.1. Word displays the name of the program, 

i.e., Microsoft Word in the title bar of the window. In the title bar, it also displays the name of the 

currently open document. Although you did not open any document, Word automatically creates an 

empty document, names it ‘Document1’and opens it for you. So, if you want to create a document, 

say a letter, you can straightaway start typing. You can give it any name at the time of saving the 

document.

Fig. 3.1 Word 2010 opening screen
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Ribbon Interface If you have used Word 2007, you are already familiar with the Ribbon interface 

used with Word and other Microsoft Offi ce programs. The menus, submenus and toolbars dialog box 

used in earlier versions of Word are gone. As more and more features were added to Word and other 

Offi ce products, the menu structure (File, Edit, Format, Help, etc.) became too complex. In Offi ce 

2007, Microsoft replaced the original menu interface with the Ribbon interface, where commonly used 

commands/tools are always visible. In the Ribbon interface, the various commands are divided into 

various tabs, such as File, Home, Page Layout, Reference, Mailing, Review and View. Word starts 

with the Home tab, however, you may click other tabs, as required to access the corresponding tools, 

features or commands. Besides, when you select a specifi c object, Word may display an additional 

contextual tab; for example, when you click a picture, Word displays the Picture Tools tab.  

In Fig. 3.1, the Home tab is selected and the Ribbon displays tools, commands and features classifi ed 

into various groups, such as Clipboard, Font, Paragraph, Styles and Editing. Each group displays 

commonly used options for quick access, however, to access the full set of options, you may click the 

dialog box launcher icon ( ). Dialog box launchers are located at the bottom right corners of groups 

on tabs, as illustrated in Fig. 3.1. As you would see, one feature of the Ribbon, called live preview, 

is particularly helpful. Live preview lets you preview the effect of several potential changes on the 

selected text in your document by simply pointing to options on the Ribbon. 

Normally, you will be able to determine the task Word will perform on clicking a button or icon by 

just looking at the graphics. However, if you are not sure, move the 

mouse pointer on the corresponding button or icon and wait for a 

second, and Word displays a Tooltip. For instance, if you hold the 

mouse pointer on  (Bold button), Word displays the following 

tooltip: 

We will discuss additional features of the Ribbon interface along with describing how to use Word. 

Above the top left corner of the Ribbon is a customizable Quick Access toolbar that contains icons for 

most commonly used commands, e.g., Save, Undo and Redo changes.

The empty area below the Ribbon is called the Document pane where you type your document or 

Word displays an existing document. Depending on the selected options, you may also see a ruler at 

the left and top of the document pane. The ruler shows the area available for typing and also helps 

to set and clear tab stop positions. On the right side and the bottom of the document pane, Word 

shows scroll bars. The scroll bars help you to view other parts of the document when your document 

cannot be displayed completely in the document window, which is usually the case. The last line of the 

Word window, called the status bar displays useful information, such as the current page, line number, 

number of words in the document, etc., on the left side, and view controls and zoom settings, etc., on 

the right side. The status bar is customizable; you can control the elements you want to display on the 

status bar by right clicking the status bar and checking the desired elements on the Customize Status 

Bar context menu displayed by Word. 

3.3 CREATING A DOCUMENT 

As you know, when you start Word, it automatically creates a new document—Document1. So, you can 

straightaway start typing the text, i.e., there is no need to use any command to fi rst create a document. 

After you have typed your document, when you save it, Word asks for the fi lename. At that time, you 

can assign a suitable fi lename to Document1 and save it in the desired folder. 
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Typing text in Word is slightly different from using a manual typewriter. If you have never worked 

on a word processor, remember the following points while typing text in a Word document:

1. While typing text in a paragraph, when you reach near the end of the line, do not press the Enter 

key, as you would have done on a manual typewriter. Just continue typing and Word automatically 

moves the last word of the line to the next line if it goes past the right margin  (Thanks to Word’s 

word wrap feature!). Press the Enter key only when the paragraph ends.

2. If you need to center text in a line, for example in headings, do not use the Tab key or spacebar for 

doing that. Instead, you can use a command to center a line on the page. Similarly, if you need to 

align a line on the right side of the page, do not use spacebar or the Tab key.

3. If you need to type a table, do not use spacebar to align columns. For creating multi-column 

tables, either use Tabs or the Table facility. You will learn about using tabs and tables later in this 

chapter. 

4. Do not use the Enter key repeatedly to start a new page. Use the corresponding command for 

starting the new page. However, you may press the Enter key if you want to have a blank line in 

your document. 

Consider the sample letter shown in Fig. 3.2. Try to enter this letter in the Document1 fi le that is 

already open.

Note  Although you know that you have to press the Enter key only at the end of the paragraph, we have 

still marked the end of the paragraph (where you need to press the Enter key) with . Use the Tab 

key to indent the fi rst line of the paragraph.

Fig. 3.2 A sample letter

If the online spelling check option is enabled in Word on your PC, Word may highlight the spelling 

mistakes with a wavy (curly) red underline. In the same way, if the online grammar check option is on, 

it may highlight grammatical errors through green wavy underline. Ignore it for the time being.

When you type a document, it is being stored in the temporary Random Access Memory (RAM) of 

your PC. The temporary memory loses its contents if the electric supply (AC power) connected to your 

PC gets disconnected or you reset your PC. To make the document permanent, you need to save it in a 

disk fi le in the hard disk, fl oppy disk or USB fl ash drive of your PC. 
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3.4 SAVING A DOCUMENT IN A DISK FILE 

∑ To save the document that you have typed in a disk fi le, click , the Save button on the Quick 

Access toolbar located at the top left corner of the Word window. You can also accomplish the fi le 

save operation by pressing Ctrl+S, the shortcut keys for the Save command. 

On using the Save command, Word displays the Save As dialog box shown in Fig. 3.3. If you are running 

Windows XP or Vista operating system, your Save As dialog would look different. The Save As dialog 

box enables you to assign a fi lename to the document you are saving. Besides the fi lename, you can also 

select the drive and the folder where you want to store this fi le. The fi lename that you want to assign to 

the document has to be typed in the fi lename box. Word selects a default drive and folder (directory) for 

saving fi les. For instance, in Fig. 3.3, the currently selected folder is ‘Documents Library’. So, if you 

do not change the folder, the fi le will be saved in this folder. (Your computer may display a different 

folder.) If you want to save the fi le in some other folder, perform the following steps:

   To select a folder that is visible in the Save As dialog box, double-click it. For instance, to save 

the document in the GardenTools folder, double-click to open this folder. 

   To save the document in a new folder, click the New Folder button. 

   To select a different major area, e.g., Desktop instead of Documents Library, click it. Then 

double-click to open a folder that may exist in the selected area. 

∑ After you have selected the folder to save the document into, type a suitable fi lename. If you prefer, 

you may keep the fi lename suggested by Word. Finally, click the Save button to save the fi le.

Fig. 3.3 Save As dialog box

3.5 PRINT AND PRINT PREVIEW A DOCUMENT 

If you wish to print a document, it must be open. It is always a good practice to Print Preview the 

document to get a bird’s eye view of the document before printing. You can preview the document, 

change print settings and print the document from one location, the Backstage view. 
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∑ Click the File tab to open the Backstage view. The left section of the Backstage view has commands, 

such as Save, Save As, Open, Close, Info, Print, Help, etc.

∑ Click Print and Word displays the Print settings in the middle pane and preview of the document 

in the right pane, as shown in Fig. 3.4. 

Fig. 3.4 Print settings and previewing a document

Tip  Press Ctrl+P, the shortcut keys for the Print command to directly display Print Preview while working 

in any tab. 

The preview pane displays the preview of the current page, as you would get when the page is printed. 

If your document has multiple pages, use the scroll bar or the arrows in the Page Control, located in 

the bottom left corner of the preview pane. The Zoom slider located in the bottom right corner of the 

preview pane is used to change the page magnifi cation. 

The middle section displays the Print button, currently selected printer and the current print settings. 

The default settings are good to print one copy of all pages of the document on the default printer. 

Therefore, if you click the Print button, Word prints one copy of the document on the default printer. 

If multiple printers are attached to your PC and you want to print the document on some other printer, 

click the current printer name to display the list of installed printers and choose the desired printer. If 

you want to print more than one copy, use the Copies spinner control to type or select the number of 

copies. On clicking Print All Pages, Word displays options to print the current page, the selected text 

or a custom print range. If you choose Custom Print Range, Word displays a Pages text box to enter 

the page range, e.g., 2-4 to print pages from 2 to 4. Similarly, you may enter 2,4,8-10 to print page 

numbers 2, 4 and 8 to 10. If you need more control on the printing process, click the Printer Properties 

link located under the printer name.
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3.6 RESAVING AND CLOSING A DOCUMENT 

On printing the document, if you fi nd that you have missed out a line at the end, you can type that. 

Similarly, you may correct the mistakes in the document, if any. After you modify your document, you 

need to resave it to write the changes back to the disk. 

∑ Click  on the Quick Access toolbar or press Ctrl+S to resave the document.

Another way to save the document is by choosing the Save command in the Backstage view. (Click the 

File tab to open the Backstage view.) You should periodically save your document as you edit it so that 

you do not lose the changes due to power failure or computer malfunction. Once you are fi nished with 

a document, you can close it. 

∑ To close the current document fi le, press Ctrl+W or click Close in the Backstage view. 

If you try to close a document and you have not saved the latest editing changes in the fi le, Word 

displays a dialog box similar to the following.

Now, you have three options: 

  Save: Word saves the changes in the fi le and closes it.  

  Don’t Save: Word does not save the changes and closes the fi le. The latest modifi cations to 

the document will be lost. 

  Cancel: Word cancels the fi le close command and returns you to the document.  

3.7 CREATING A NEW DOCUMENT 

∑ To create a new document, either press Ctrl+N keys or click File to open the Backstage view and 

click New. 

If you press Ctrl+N, Word immediately creates a new document and assigns it a temporary name, such 

as Document2, Document3, etc. This document, based on the Normal template, is similar to the blank 

document Word creates when it starts. However, if you click New in the Backstage view, Word displays 

the list of templates in the middle pane and the preview of the selected template and a Create button in 

the right pane, as shown in Fig. 3.5. (Click the File tab to open the Backstage view.) 

The templates available for use are displayed in the Available Templates box in the upper part of 

the middle pane. A template is a special kind of document with predefi ned page layout and document 

formatting styles. Optionally, it may also contain text and images. In other words, a template performs 

like a framework around which Word creates a document. For instance, a Fax template may already 

contain the Fax title and a header section to enter From, To, Subject, Number of pages, etc. The Word 
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templates are available under various categories, such as Blank Document, Blog Post, Recent Templates, 

Sample Templates and My Templates. In addition, you may search for professional templates at Offi ce.

com, Microsoft’s online resources and download in your computer. 

Fig. 3.5 Creating a new document

By default, Word selects the Blank Document template. If you click the Create button while Blank 

Template is selected, Word creates a blank document based on the normal template (Normal.dotm). 

When Word in installed, it automatically installs several templates. 

∑ Click Sample Templates to display the list of sample templates available in your PC. (See

Fig. 3.6.) 

Fig. 3.6 Templates available under the Sample Templates category
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On clicking a template in the middle pane, Word displays its preview in the right pane. On clicking 

the Create button located in the right pane, Word creates a new document. Figure 3.7 displays a Fax 

document created using the Fax template.

Fig. 3.7 A fox document created using a template

Note  Wizards, which enabled users to create some documents, such as memo and resume in interactive 

way in earlier versions of Word are not available in Word 2010 and Word 2007. The wizards have 

been replaced with templates.

3.8 GETTING HELP 

Word is a huge application and no one expects you to remember how to do various tasks. If you are not 

sure how to accomplish a task, you can take the help of Word Help, which contains a number of useful 

articles. By default, Word searches for the help fi le on your computer as well as on the Internet through 

www.offi ce.com. 

∑ To open the help window, press F1 or click the Help button ( ) located on the top right corner 

of the Word window as well as all dialog boxes. Word displays the Word Help window shown in 

Fig. 3.8. 

Fig. 3.8 Word Help window
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∑ Type a few words regarding the help topic you are looking for in the search box at the top and click 

the Search button and Word displays the search results matching the entered search text.

∑ To read a help topic, click the corresponding help topic link. To close the Word Help window, 

click the Close button located on the top right corner. 

3.9 OPENING A DOCUMENT 

You may need to open an existing document to make changes or print it. Word can help you to open a 

required document with ease. 

∑ To view the list of recently edited documents, click the File tab to display the Backstage view and 

then click Recent in the left pane. 

Word displays a list of recent documents in the middle pane shown in Fig. 3.9. If the document you 

want to open is listed in the Recent Documents box, you may click to open it. Word can also display the 

list of recent documents in the left pane below Close in the left pane if the “Quickly access this number 

of Recent Documents” checkbox in the middle pane is checked. In that case, you may also open a 

document by clicking its name in the left pane. 

Fig. 3.9 Opening a document in Backstage view

∑ If the document you want to open is not listed in the Backstage view, click Open in the Backstage 

view to display the Open dialog box shown in Fig. 3.10.
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Fig. 3.10 Opening a document in the Open dialog box

Tip You can press Ctrl+O to display the Open dialog box from any tab. 

The fi lenames displayed in the list box are only from the selected folder. For instance, in Fig. 3.10, the 

Open dialog box displays Word document fi les from the Documents Library folder. To display fi les 

available in other folders, you need to open the corresponding folder. To open any folder that is displayed 

in the Open dialog box or whose icon is displayed in the left pane, double click it. For example, in

Fig. 3.10, you may double click GardenTools to display Word documents available in this folder. 

Similarly, you may double click Desktop to display documents available on your desktop. On clicking 

the drive letter displayed under Computer, the Open dialog box displays folders and documents 

available on the drive. In the same way, you may navigate to any folder on the network your computer 

is connected to. To open any document whose fi lename is displayed in the Open dialog box, double-

click the fi lename or type the fi lename in the File Name box and click Open.

Note  As you make selections of folders in the Open dialog box, you may use the Back and Forward 

buttons, located in the top left corner to switch back and forth to your selections. These buttons look 

similar to the Back and Forward buttons on the browser and have similar functionality. 

3.9.1 Opening Documents from Earlier Versions of Word/Other Programs

You don’t need to do anything special to open documents created in earlier versions of Word, e.g., Word 

97 or Word 2002/2003 as Word 2010 seamlessly opens those documents. You can edit those documents 

and when you save them, Word saves them in the original old format. If you plan to use new features 

available in 2010, you should convert the documents to the Word 2010 format (.dotx) by using the Save 

As command from the File tab, choosing Word Document as Save as type and clicking Save.

Word can also open non-Word documents fi les, such as Word templates, text fi les, XML fi les and 

WordPerfect documents. To display a specifi c type of fi le in the Open dialog box, click the All Word 

Documents button and choose the document type. When you open a non-Word document, Word 

automatically performs the fi le conversion, if required. 
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3.9.2 Opening a Copy of the File

Instead of opening and modifying a document, you may ask Word to make a copy of a document fi le 

and open the copy for editing. This keeps the original fi le unchanged and you are free to modify the 

copy as you wish. To open a copy of a document fi le:

∑ Click to select the fi le that you want in the Open dialog box and click the down-pointing arrow to 

the side of the Open button (see Fig. 3.10) to displays the fi le open options, such as Open as Copy, 

Open Read-Only and Open. 

∑ Click the Open as Copy option and Word makes a copy of the selected fi le, assigns it a name, such 

as Copy (1) SalesMeeting, and opens it for editing. 

3.9.3 Opening a File in the Read-Only Mode

If you choose the Open Read-Only option from the Open button in the Open dialog box, Word opens 

the fi le in the Read-only mode. While Word allows you to modify the opened document, at the time 

of saving the document, you will need to defi ne another fi lename to save the modifi ed document into. 

Word does not allow you to overwrite a document fi le opened in the Read-only mode.

3.9.4 Switching Between Open Documents

Word allows you to simultaneously keep more than one document open. To open another document 

while one is open, use the File, Open command (or press Ctrl+O) and open the document in the usual 

way. If more than one document is open in Word, you can switch between the open documents using 

the View tab or the Windows taskbar. To use the View tab method, perform the following steps:

∑ Click the View tab and then click Switch Windows located on the right, and Windows displays a 

list of open documents in a dropdown list, as shown in Fig. 3.11.

∑ Click the document you want to view from the dropdown list.

Fig. 3.11 Switching between multiple open documents



Word Processing with Microso   Word    135 1 

To switch documents using the Windows taskbar, follow these steps:

∑ Click the Word button in the Windows taskbar and Windows displays an entry/icon for each open 

document as shown in Fig. 3.11.

∑ To view a document, click the corresponding entry/icon. If you wish to close an open document, 

click the red close button displayed against the document entry/icon.

Note  If you do not see all open documents on Word button on the taskbar, open the Word Options dialog 

box from the backstage view, click Advanced and check Show all windows in the Taskbar in the 

Display section.

3.9.5 Viewing Multiple Open Documents Simultaneously

When multiple documents are open, Word can display them simultaneously. To do so, click the View 

tab and then click Arrange All in the Window group. This divides the screen into two or more Word 

windows, each displays one document. You can click in any window to carry out editing, or resize or 

close these windows in the usual way. 

3.10 CURSOR MOVEMENT 

While editing a document, the cursor movement is the basic requirement. You need to move the cursor, 

also known as insertion point to the desired place in the document to insert new text or begin selecting 

text. 

As you know, a typical cursor is a blinking vertical line. When you open a document, initially, Word 

places the cursor (insertion point) at the beginning of the document. To move the cursor to any location 

in the document, all you need to do is move the mouse pointer there and click. If you need to move 

the cursor to a part of the document that is currently not visible on your screen, scroll the document by 

using the scroll bar located at the right/bottom of the window. Alternatively, you can also use the scroll 

wheel on your mouse. This has already been discussed in the previous chapter. 

3.10.1 Using the Keyboard to Move the Cursor (Insertion Point)

Sometimes, it is faster to move the cursor by using the keyboard shortcut keys. On the right-hand side 

of the keyboard, you fi nd four arrow keys. You can use these keys to move the cursor in the direction 

of the arrow keys. Word supports a number of other cursor movement commands to move the cursor 

to the next/previous word or paragraph, beginning/end of the line/document, etc. The list of commonly 

used keyboard shortcuts is given below. 

To move Press Key(s)

One character to the left Left Arrow (←)

One character to the right Right Arrow (→)

To the previous word Ctrl+Left Arrow 

To the next word Ctrl+Right Arrow 

To the end of a line End

To the beginning of a line Home

To the previous line Up Arrow (↑)

To the next line Down Arrow (↓)
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Up one screen (scrolling) PgUp

Down one screen (scrolling) PgDn

To the end of a document Ctrl+End 

To the beginning of a document Ctrl+Home 

Note  ‘+’ has been shown only for readability. Do not press the ‘+’ key. ‘+’ indicates that you need to press 

these keys simultaneously. For instance, Ctrl+Left Arrow means press and hold the Ctrl key and then 

press the left arrow (←) key. 

3.11 EDITING A DOCUMENT 

In real life, when you type a document, it may not be error-free in the fi rst attempt. Most of the errors 

are typographical, i.e., misplaced, omitted or extra characters typed unintentionally. The process of 

changing text to correct mistakes or to revise text is called editing. There are three basic ways of 

correcting mistakes—inserting, deleting and overtyping.

3.11.1 Inserting Text

You can insert text anywhere in an open document. However, before you start inserting text, make sure 

that you are working in the Insert mode. By default, Word works in the Insert mode and may display 

the Insert status button on the status bar. 

Note  If you do not see Insert or Overtype status button on the status bar, right click any empty area on 

the status bar to display the Customize Status Bar menu and click Overtype. Then click anywhere 

outside the menu to turn it off. 

While working in the Insert mode, to insert text, you need to move the cursor (insertion point) to left 

of the character where you want to insert new text and start typing new text. This is illustrated in Fig. 

3.12. For instance, to insert “different” before “operations” in the document open in Fig. 3.12, we 

need to click before “operations” to move the cursor and then type different. As you insert text in the 

document, Word automatically pushes the text down and reformats the document. You can insert any 

amount of text anywhere in the document. 

Fig. 3.12 Editing a document
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3.11.2 Deleting a Character

On your keyboard, there are two keys that you can use to delete characters. These are Del and Backspace. 

The Del key deletes the character to the right of the cursor position and Backspace deletes the character 

to the left of the cursor position. For example, in Fig. 3.12, the cursor is position to the left of “S” in the 

fi rst line, therefore, on pressing the Del key, the character “S” would get deleted. 

3.11.3 Overtyping

In the overtype mode, the typed character replaces the next character. However, if any text is selected 

(discussed later in this Section), the typed character replaces the entire selected text. If you continue typing 

in the overtype mode, Word continues to replace old characters with the newly typed characters.

∑ To select the Overtype mode, click the Insert button on the status bar. Depending on the selected 

options, you may also be able to toggle the Insert/Delete mode on pressing the Ins key on your 

keyboard.  

3.11.4 Inserting a New Paragraph and a Blank Line

If you need to insert a new paragraph at the end of the document:

∑ Press Ctrl+End to move the cursor to the end of the document.

∑ Press the Enter key to insert a new paragraph. 

Now you can type the text in the newly inserted paragraph. In the same way, if you need to insert a 

blank line or new paragraph before an existing paragraph, move the cursor to the beginning of the 

paragraph and press the Enter key, as illustrated in Fig. 3.12.

3.11.5 Splitting a Paragraph

∑ To split a paragraph in two parts, click the mouse in the paragraph at the desired location, and press 

Enter. 

3.11.6 Selecting Text

In Word, it is very important to know how to select text because you can perform so many operations 

on the selected text. For instance, you can delete, copy or move the selected text or format it in bold 

or italic style. Because you may like to apply the various Word commands on different lengths of text, 

such as a word, sentence, paragraph, etc., you should know how to select the desired text. You can select 

text with the mouse or the keyboard.

∑ To select text with mouse, make sure that the portion of the document where you want the selection 

to begin is visible. 

Now, depending on your requirements, you can select a word, line, sentence, paragraph, multiple 

paragraphs or even the entire document. 

∑ To select a line of text, move the mouse pointer to the left of the line until the mouse pointer 

changes to a right pointed arrow, and then click, as shown in Fig. 3.13. 

∑ Similarly, to select a paragraph, double-click while the mouse pointer is showing a right pointed 

arrow or triple click anywhere in the paragraph. 

∑ If you want to select a sentence, press and hold the Ctrl key and then click anywhere in the 

sentence. To select a word, double-click the mouse anywhere on that word.
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Fig. 3.13 Selecting text with mouse

Another way to select text with the mouse is by click and drag. That is, click the mouse where you want 

the text selection to begin and without releasing the mouse button, drag the mouse in any direction. As 

you drag the mouse, Word highlights and selects the text. When you release the mouse, the text selection 

freezes. To deselect the selected text, click mouse anywhere in the document. Though normally not 

required, if you need to select a vertical block of text, drag the mouse with the Alt key pressed. 

∑ To select the entire document, move the pointer to the left of any line of text until it changes to a 

right pointed arrow, and then triple click. The keyboard shortcut keys to select the entire document 

is Ctrl+A.

By using a combination of certain keys, you can select the desired text very quickly. The basic steps 

to select the text with keyboard are as follows:

∑ Click mouse to the location where you want the text selection to begin. 

∑ Press and hold the Shift key and then press the required keys to move the cursor. As you move 

the cursor, Word selects the text. For instance, if you press and hold Shift and then press Ctrl+Æ, 

Word selects the next word. If you want to select the next word too, keep the Shift key pressed 

and then press Ctrl+Æ. Similarly, pressing the down arrow (Ø) key or the up arrow (≠) key while 

holding the Shift key down selects the text in the corresponding direction.

What is a Paragraph? In Word, when you start typing in a new document, you enter text in the 

fi rst paragraph. Your paragraph may have any number of lines. When you press the Enter key, Word ends 

the paragraph and starts a new one. Thus, only the Enter key marks the end of the current paragraph and 

starts a new paragraph. When you press the Enter key, Word inserts a special symbol at the end of the 

paragraph. This special symbol is ¶. If you like, you can see these symbols in your documents. 

∑ Click the Home tab, if required on the Ribbon. Next, click the  button on the Ribbon in the 

paragraph group. This button is called the Show/Hide ¶ button. 

 Word turns on the display of non-printing characters. It displays the ¶ symbol at all places where 

you pressed the Enter key. In this mode, Word displays a ‘dot’ for every spacebar and → for the 

Tab key used in the document. 

The ¶ symbol is a part of the paragraph. Therefore, when you need to select a paragraph, you must 

also select this symbol. When you triple click to select a paragraph, Word automatically selects the 

paragraph mark. If you are not sure whether the paragraph mark has been selected, you may turn on 
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the display of paragraph marks by clicking  on the Home tab. To turn off the display of non-printing 

characters, click  again.

3.11.7 Moving Text

To move text from one location to another in a document, Word provides several convenient ways. First 

you need to select the text that you want to move. Use any of the techniques described earlier in this 

section to select the desired text. Now to move the selected text, use any of the following steps. 

1. Drag the selected text with mouse to move the text. As you drag the mouse, a dotted vertical line 

moves with mouse. Make sure that the dotted line is placed where you want to move the text. 

When you release the mouse button, Word moves the text to the new location. 

2.  Use the Ctrl+X keys or the scissors icon  in the Clipboard group of the Ribbon to cut the 

selected text. Word removes the text from the document and saves it on Clipboard (memory). 

Next, move the cursor where you want the cut text to be placed and click  in the Clipboard 

group on the Home tab or press Ctrl+V. 

When you paste text, Word may display the Paste Options icon, as shown below.

When you paste text, it is possible that the formatting of the source text and the destination paragraph is 

different, e.g., source text may in bold style while the destination in normal style. On pressing the Ctrl

key or clicking the Paste Options icon, Word displays three paste options: Keep Source Formatting, 

Merge Formatting and Keep Text Only. The fi rst option keeps the source formatting, the second merges 

the formatting to use the formatting used by the majority of text in the paragraph and the third option 

copies only text. Thus the pasted text gets the formatting of the destination paragraph.

3.11.8 Copying Text

Copying text is similar to moving text. You can copy text in the same document as well as to another 

document. The fi rst step in the copy text process is to select the desired text. 

1. To copy text in the same document with mouse, drag the selected text while keeping the Ctrl key 

pressed. Word attaches the plus symbol (+) to the mouse pointer to indicate the copy process. As 

you drag the mouse, a dotted vertical line moves with mouse. When the dotted line is positioned 

at the right spot, release the mouse button. Word immediately copies the text to the new location. 

Now release the Ctrl key. 

2. Press Ctrl+C keys or click  on the Ribbon to copy the selected text in Clipboard (memory). 

Next, move the cursor where you want to paste the text and press the Ctrl+V keys or click  on 

the Ribbon. 

3. To copy text in another document, open or select the other document and move the cursor to the 

position where you want to copy the text. Next, press Ctrl+V or click  to paste the copied text. 

Like moving text, Word also displays paste icon/options when you paste text. 

3.11.9 Previewing Paste Options

You may also see the paste options on the context menu when you right click the mouse, as shown in 

Fig. 3.14. When you move the mouse pointer on any paste option, Word previews the text being pasted 
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in the document. In other words, you get an idea how the document will look if you paste the text using 

a particular paste options. To complete the paste operation, click any of the three paste options. 

Fig. 3.14 Paste options in the context menu

3.11.10 Deleting Text

To delete text, you need to perform the following two steps:

1. Select the text you want to delete using keyboard or mouse.

2. Press the Del key. 

3.11.11 Replacing Text

To replace an existing word in a document with a new word, follow these steps:  

1. Double-click to select the word to be replaced.  

2. Type the new word. 

When you type a character in a Word document, it automatically replaces the selection. This will work 

whether you have selected a single character, word or multiple words or ever one or more paragraphs. 

3.11.12 Undoing and Redoing Changes

While working on a document, you may delete or move some text by mistake. However, if that happens 

or you make any unwanted changes, you can easily undo the changes. To use the undo command, 

press Ctrl+Z or click the Undo button on the Quick Access toolbar located at the top left of the Word 

window. The Undo button looks like . 

You can use the undo operation multiple times to undo earlier changes. Undo can reverse all kinds 

of editing operation including delete, replace, move, typing, etc. To undo more than one operation in 

one go, click the down pointing arrow to the right of the Undo button to display the list of actions Word 

can undo and click an action in the list; Word will undo all actions up to clicked action.
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You can even undo your undo operations by using the Redo command. To use the redo command, 

press Ctrl+Y keys or click , the Redo button on the Quick Access toolbar.

3.11.13 Pasting Text Using Clipboard

Word maintains a Clipboard that can hold up to 24 text or other types of copied items. Advanced users 

can selectively paste copied items from Clipboard. 

∑ To display the Clipboard task pane, click the dialog box launcher button located at the bottom 

right of the Clipboard group on the Home tab.   

∑ To paste an item from the Clipboard task pane, move the cursor (insertion point) at the desired 

location in the document and click the item in the Clipboard task pane. To paste all items, click the 

Paste All button.

∑ You may press the Clear All button to clear the Clipboard. To close the Clipboard task pane, click 

the Close (X) button in the top right.

3.11.14 Saving a Document with a New Name

After you started making changes in a document, if you decide to keep the old version too, you can save 

the modifi ed version in a different document fi le. 

∑ Use the Save As command in the Backstage view to get the Save As dialog box. 

∑ Choose the fi lename and the folder to save the document into and click Save. 

3.12 FORMATTING TEXT 

Word allows you to format the text by applying various text styles, such as boldface, underline, italic, 

superscript, subscript, strike-through, etc. You can apply the commonly used styles by using the 

corresponding buttons on the Home tab of the Ribbon or by using the keyboard shortcut commands. To 

apply any style to any text, you need to perform two steps:

  Select the text that you want to format by using the keyboard or the mouse. 

  Apply the necessary formatting command.

The Font group of the Ribbon shown in Fig. 3.15 contains buttons to apply common text formatting 

styles.

Fig. 3.15 Font group on the Ribbon
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When you select text with mouse, e.g., double click a word, Word displays a faded mini formatting 

toolbar above the selection which becomes clearly visible when you move the mouse on the Mini 

toolbar. Word also displays the Mini toolbar when you right click the selected text. This toolbar, shown 

on the right, contains commonly used formatting tools. To apply a text 

formatting style on the selected text, you may use the Mini toolbar, the 

Ribbon or keyboard shortcut keys. 

3.12.1 Applying the Bold Style

∑ To format the selected text in the bold style, press Ctrl+B or click , the bold button on the 

Ribbon or the Mini toolbar. 

∑ If you need to remove the bold style, select the text and click . Basically, the Bold button 

toggles the bold style on the selected text. 

3.12.2 Applying the Italic Style

∑ To display the selected text in the italic style, press Ctrl+I or click the Italic button, i.e  .

3.12.3 Applying the Underline Style

∑ To apply the underline style on the selected text, press Ctrl+U or click , the Underline button.

The Underline button applies a continuous underline to the selected text, including spaces. Word 

supports other underline styles too, such as double underline, dotted underline, dashed underline, wave 

underline, etc. 

∑ To apply some other underline style, click the down pointing arrow on the side of the underline 

button on the Ribbon to display the available underline styles and click the desired underline style. 

Note  To remove a style, select the text and apply the same style again. For instance, clicking the Italic 

button removes the italic style if the text is formatted in the italic style. 

3.12.4 Applying Multiple Styles

You can apply as many styles as you like to the selected text. For instance, you may display a word in 

bold as well as italic style. 

3.12.5 Changing the Character Size

When you type text in a document, all characters are of a ‘pre-defi ned’ size. In Word, the character 

size (in fact height) is specifi ed in points. (72 points are equal to 1 inch.) The typical point size used in 

Word is from 9 to 12. If you do not select a new point size, all characters that you type are of the default 

size. If you wish to know the point size in use in your document, look at the Font group on the Home 

tab. Word displays the size of the characters at the cursor position or the selected text in the Font size 

box on the Ribbon. For instance, in Fig. 3.14, the font size in use is 11. To change the font size for the 

selected text:

∑ Click the Grow Font button on the Font group or the Mini toolbar to select the next bigger font 

size. (See Fig. 3.15.)

∑ Click the Shrink Font button on the Font group or the Mini toolbar to select the next smaller font 

size.
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∑ Click in the font size box and type the desired font size. 

∑ If you want to choose the new size from a drop-down list, click the down-pointed arrow on the 

right of the font box to display the font size list box as shown in Fig. 3.16. Move the mouse pointer 

on a font size to preview its effect on the selected text. To change the font size for the selected text, 

click the desired font size number in the list box.

Fig. 3.16 Selecting font size

3.12.6 Changing Font

Font refers to the shape and style of characters. The same character can be printed in different shapes 

and styles. Each particular shape and style of the character set is given a font name, such as Times New 

Roman, Arial, Courier, Letter Gothic, etc. The default font depends on the template used to create the 

document. However, you can apply any font to any selected text, or even to the entire document. 

Word displays the name of the current font in the Font name box. This box is located on the left side 

of the Font Size box on the Ribbon as well as the Mini toolbar. For instance, in Fig. 3.17, the Times 

New Roman font is in use. 

Fig. 3.17 Selecting a font



144    Computer Course: Windows 7 and Offi  ce 2010  

∑ To change the font for the existing text in a document, select the text and click the drop-down 

arrow on the right side of the Font name box.  (See Fig. 3.17.)

Word displays the list of available fonts in a Font name list box, as shown in Fig. 3.17. On your 

computer, the list that you will get may be different from that shown depending on the fonts installed 

on your PC. The list box can display only a few fonts; to see other fonts use the scroll bar displayed 

on the right side of the Font name list box. The top part of the Font name list box displays the recently 

used fonts. Then it displays all installed fonts in alphabetical order. When you move the mouse pointer 

on a font name, Word displays its preview on the selected text. 

∑ To apply new font on the selected text, click the desired font in the Fonts list box. 

3.12.7 Color

To display color, you must have a color monitor, and to print color, you must have a color printer or a 

color plotter. Even if you do not have a color printer, you can still defi ne colors in your text. However, 

you should not use colors on your text if you plan to print the text on a ‘black and white’ printer, as the 

colored text may not print in good contrast. 

∑ To change the color of the selected text, you may use Font Color button, which looks like . 

On clicking the Font Color button, Word applies the color of the thick underline on the button on 

selected text. 

∑ To choose a different color, click the down pointing arrow on the right of the button, and Word 

displays a Color Palette to choose the color as shown below. 

∑ To choose a color, click the corresponding color on the Color Palette. To display additional 

colors, click More Colors. 

In addition to changing the text color, Word also enables you to highlight the text with any color. In 

other words, you can defi ne a background color. 

∑ To highlight text, click , the Text Highlight Color button,  and Word changes the shape of the 

mouse pointer by attaching a highlighter pen. 

∑ Now drag the mouse on the text to highlight the text. To return the cursor to the normal mode, click 

 again. 
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∑ To choose a different highlighter color, click the down pointing arrow on the side of  and 

choose the desired colour. 

3.12.8 Text Effects

The Font group on the Home tab has several buttons to apply text effects, such as strikethrough, 

subscript and superscript. Examples of using these effects are shown here. 

Strikethrough Draws a line through the selected text, e.g., This text is printed in the strikethrough 

style. 

Superscript Text printed in the superscript style is printed in reduced font size and slightly above 

the normal text, e.g., (A+B)2 = A2 + B2 +2AB 

Subscript Text printed in the subscript style is printed in reduced font size and slightly below 

the normal text, e.g., in H2O, ‘2’ is printed in the subscript style.

Word has a Text Effects button ( ) that you may use to apply fancy text effects, such as outline, 

shadow, refl ection and glow. (Text Effects button is available only since Word 2010.) To apply these 

effects on the selected text, click the Text Effects button and Word displays the available text effects in 

a box, as shown here.

You can click the mouse on the samples shown in the upper part of the box to apply that text effect on 

the selected text. To have additional options, click Outline, Shadow, Refl ection and Glow effect names 

links in the lower part of the box.

3.12.9 Font Dialog Box

Commonly used character formatting commands are available on the Ribbon and the Mini toolbar. 

However, for more character formatting options as well as an alternate way to access these options, you 

may use the Font dialog box.

∑ To open the Font dialog box, click the Dialog Box Launcher located at the bottom right corner of 

the Font group of the Ribbon. (See Fig. 3.15.) Figure 3.18 displays the Font dialog box.
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Fig. 3.18 Font dialog box 

The upper part of the Font dialog box is used to select the font, font style, font size and font color. If you 

want to apply some special types of underlines, click the Underline Style box and choose the desired 

style. On choosing an option in the Font dialog box, Word displays its preview in the Preview box at the 

bottom of the box. Here are some of the underline styles not available on the Ribbon.

 Word can underline text in several styles. 

 Word can underline text in several styles. 

 Word can underline text in several styles. 

3.12.10 Effects

The Effect area of the Font dialog box has several check boxes to apply one or more combinations of 

the following effects on the text: 

Double Strikethrough Draws a double line through the selected text, e.g., This text is printed in the 

double strikethrough style. 

Shadow As the name ‘shadow’ implies, it adds a shadow behind the text, e.g., 

.

Outline In the outline style, Word displays an inner and outline border, e.g., Outline Outline 

stylestyle. 

Emboss The emboss style makes the text appear raised off the page, e.g., 

.

Engrave This style makes the text appear as if pressed into the page, e.g., Engrave 

style. 

Small Caps On selecting this option, all lower case characters are converted to upper 

case. However, Word also reduces the font size for all lower case characters 

converted to ‘SMALL CAPS’. 
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All Caps Displays all lower case letters as upper case. For example, ‘Computer Society’ 

formatted in the All Caps style will look like —COMPUTER SOCIETY.

Hidden As the name ‘hidden’ implies, any text formatted in the hidden style 

is not displayed or printed. This style is generally not used in normal 

documents. 

The Advanced tab of the Font dialog box has controls to precisely control the character spacing, 

position, scaling and kerning. If you want to use the modifi ed settings in the Font dialog box as the 

default font for the current document or all new documents based on the current template, click the

Set As Default button.

Clear Formatting To clear formatting on the selected text, click the Clear Formatting button ( )

located in the Font group on the Home tab.

Note The Clear Formatting command does not remove highlighting from the text.

3.13 COPY TEXT FORMATTING USING FORMAT PAINTER 

Format Painter can help you save time by quickly applying the text formatting from one portion of 

your document to another. To accomplish this, Word provides the Format Painter button ( ) in the 

Clipboard group as well as the Mini toolbar. 

∑ Select text in a document that contains the formatting you want to copy.

∑ Click the Format Painter button on the Mini toolbar or the Clipboard group on the Ribbon. Word 

changes the mouse pointer by attaching a paint brush. 

∑ Drag the mouse on the text to which you want to apply the formatting copied in the previous 

step.

3.14 PARAGRAPH ALIGNMENT 

Word can align paragraphs in four ways—left-aligned, centered, right-aligned and justifi ed (also 

called right-justifi ed). Figure 3.19 illustrates paragraphs aligned in these styles. As shown in Fig. 

3.19, a left-aligned paragraph is aligned on the left side, whereas the right-aligned paragraph is 

aligned on the right side. When you justify (right-justify) a paragraph, Word increases the spacing 

between words of all lines of the paragraph, except the last line such that both sides of the paragraph 

are aligned. When you center a paragraph, Word increases the spacing on the left and right side of 

each line of the paragraph so that each line appears in the centre of width of the print area of the page. 

Though you can center a paragraph containing several lines, usually a centered paragraph contains 

only a single line, e.g., title of a document or address. In the same way, usually the right-aligned 

paragraph contains a single line. Figure 3.20 shows a letter that makes use of paragraphs aligned in 

different ways.  
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Fig. 3.19 Paragraph alignment

Changing the alignment of a paragraph is very simple with the paragraph alignment buttons located 

in the Paragraph group on the Ribbon as shown in Fig. 3.20. There are four buttons to align a paragraph 

in four different ways. Besides using these buttons to change the alignment of a paragraph, Word also 

uses these buttons to display the alignment of the current paragraph where the cursor is located. Notice 

that in Fig. 3.20, the Justify button is selected or highlighted, which indicates that the current paragraph 

is justifi ed.

Fig. 3.20 Using diff erent types of paragraph alignment in a letter

∑ To change the alignment of a paragraph, click anywhere in the paragraph and then click the 

appropriate paragraph alignment button. 

Note  Usually, the paragraph characteristics you get for the new paragraph on pressing the Enter key are 

the same as that for the current paragraph. However, it is possible to specify different characteristics 

for the next paragraph if you use paragraph styles. 
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3.14.1 Click and Type

Click and Type is very interesting and useful feature that automatically does paragraph alignment for 

you. While the paragraph alignment buttons are useful to change the alignment of existing paragraph, 

Click and Type can help you to quickly align paragraphs as you type text or tables in a document, thus 

speedup creation of a document. With this feature, all you need to do is double click in an empty area 

of the document and start typing and Word automatically formats the paragraph for you. Let us assume 

that you want to create the following letter: 

Milan Vihar Housing Society Ltd.

Plot 72, Patpar Ganj

Delhi – 110092

Jan 29, 2013

Dear Mr. Gupta,

∑ To use the Click and Type feature, ensure that you are working in the Print Layout view. If 

required, click the Print Layout view button located on the right side of the status bar. 

∑ Now create a new document and move the mouse pointer in the centre of the line where you want 

to type the text until the mouse pointer changes to . Then double click the mouse. 

Word automatically formats the line at the cursor as centered. Now you can begin typing text in a 

centered line. Similarly, when you want to type a left-aligned paragraph, double click the cursor near 

the left side of the line and begin typing. In the same way, to type a right-aligned paragraph, double 

click near the right side of the line and begin typing. 

∑ If Click and Type does not work, make sure that you are working in the Print Layout view and 

this option is enabled, as illustrated in Fig. 3.21. To open the Word Options dialog box, click the 

File tab, click Options and then click Advanced. 

Fig. 3.21 Enabling Click and Type in the Word Options dialog box

Note  Click and Type works only while typing new text and cannot be used to change the alignment of 

existing text in a document. 



150    Computer Course: Windows 7 and Offi  ce 2010  

3.15 USING BULLETS AND NUMBERING IN PARAGRAPHS 

Sometimes we need to create bulleted or numbered paragraphs. Consider that you need to create a 

document with the following text: 

Mark the following statements as true or false:

 ∑ You can change the line spacing to single or double.

 ∑ The Paragraph dialog box is opened by pressing Ctrl+P.

 ∑ The Increase Indent button is located on the Home tab.

 ∑ Press Ctrl+5 to select 1.5 lines spacing. 

To help you easily create the bulleted paragraphs, Word provides the convenient Bullet button ( ) 

on the Home tab of the Ribbon in the Paragraph group. 

∑ Click  to apply the bullet paragraph style to the current paragraph or a blank line. After typing 

text in the bulleted paragraph, when you press Enter, Word automatically applies the bulleted 

style to the next paragraph. 

∑ In this way, you can continue to type the bulleted list. When you reach the end of the bulleted list 

and do not need the bulleted paragraph, press Enter on the last blank bulleted paragraph to ask 

Word to convert it to a regular paragraph. 

∑ If you need to convert an existing paragraph or paragraphs into bulleted paragraphs, select the 

paragraphs(s) and click . Similarly, to remove bullets, select paragraph(s) and click . 

When you click the Bullet button, Word applies the last used bullet symbol. The Word’s bullet library 

contains several symbols and you can choose any symbol for your bulleted paragraph. To choose a 

different bullet symbol, click the down pointing arrow on the right side of the Bullet button and Word 

displays a dialog box to choose the bullet symbol as shown in Fig. 3.22. Click the desired symbol and 

Word applies that symbol as the bullet to the current or selected paragraphs. Advanced users can defi ne 

a new bullet symbol by clicking the Defi ne New Bullet link at the bottom of the box.

Fig. 3.22 Choosing the bullets symbol
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In the same way, clicking the Numbering button, located next to the Bullet button on the Ribbon 

creates numbered paragraphs. When you insert a new paragraph by pressing the Enter key in the 

numbered paragraphs, Word automatically renumbers the paragraphs. By default, Word numbers 

paragraphs as 1, 2, 3, and so on, however, it can also create a numbered list with other numbering 

styles, such as 

 — 1),  2),  3), ...

 — I.,  II.,  III., ..

 — A.,  B.,  C., ...   or   A),  B),  C), ...   or   a),  b),  c), ...

∑ If you wish to change the numbering style, select the numbered paragraphs and click the down 

pointing arrow on the right side of the Numbering button to display the Numbering options, as 

shown in Fig. 3.23.

Fig. 3.23 Choosing the numbering symbol

3.16 FORMATTING PARAGRAPHS 

To give a professional look to your document, you may format the paragraphs in several ways by 

applying different paragraph formatting commands. 

3.16.1 Changing Line Spacing

The usual line spacing in paragraphs is single. However, Word allows you to change the line spacing to 

2 (double), 1.15, 1.5, 2, 2.5, 3, etc. As applicable to other formatting commands, Word applies the line 

spacing command to the current paragraph (where the cursor is located) or the selected paragraphs. To 

change line spacing: 

∑ Move the cursor to the desired paragraph or select multiple paragraphs, if you want to change the 

line spacing for more than one paragraph. 

∑ Now click the Line and Paragraph Spacing button ( ) in the Paragraph group on the Home

tab to display the line spacing options and click the desired option. 
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If you prefer to use the keyboard shortcuts for changing line spacing, press Ctrl+2 to select double line 

spacing or Ctrl+5 to select 1.5 line spacing. 

3.16.2 Changing Paragraph Indents (Margins)

Consider the second paragraph shown in Fig. 3.24. Notice that the left and right sides of the paragraph 

are indented. In other words, the paragraph uses margins on both sides.

∑ To increase or decrease left indent, you may click the corresponding buttons on the Paragraph 

group on the Ribbon, as shown in Fig. 3.24. With each click of the Increase/Decrease Indent 

button, Word changes the indent by one step, which is usually 0.5 inch. 

Fig. 3.24 Left and right indented paragraph

∑ If you want to add right indent to a paragraph, click anywhere in that paragraph, click the Paragraph 

Dialog Box Launcher ( ) located at the bottom right corner of the Paragraph group and Word 

displays the Paragraph dialog box shown in Fig. 3.25.

Fig. 3.25 Paragraph dialog box
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∑ As illustrated in Fig. 3.25, to create the right indent, enter the desired indent value in Right

Indentation box. You may also click the spinner box to change the indent. The preview box 

displays the effect of your selections. 

3.16.3 Changing the Unit of Measurement

Notice that the unit of measurement in the Paragraph dialog box in Fig. 3.25 is cm (centimeters). Word 

supports several units of measurements, such as inches, points, centimeters, millimeters and picas. Let 

us change the unit of measurements to inches: 

∑ Open the Word Options dialog box from the Backstage view.

∑ Click Advanced in the Word Options dialog box (see Fig. 3.21) and scroll to the Display 

section. 

∑ Click the dropdown list against “Show measurements in units of” and click the Inches option. 

3.16.4 Changing Spacing Before and After a Paragraph

∑ To add spacing before or after the selected paragraphs, click the Line and Paragraph Spacing 

button ( ) in the Paragraph group and click Add Space Before Paragraph or Add Space 

After Paragraph.

Word allows to precisely defi ning spacing before and after a paragraph. For instance, you can specify 

the spacing after a paragraph to be 6 points or 0.2 inches. Remember that 72 points are equal to 1 

inch.

∑ Click the Paragraph dialog box Launcher ( ) located at the bottom right corner of the 

Paragraph group to display the Paragraph dialog box. You may also open the Paragraph dialog 

box by choosing the Paragraph command from the Context menu that you can display by right 

clicking the mouse.

∑ Enter or choose the desired spacing in the Spacing Before or Spacing After text box in the 

Paragraph dialog box, as shown in Fig. 3.25. 

3.16.5 Using the First Line Indent

Sometimes, you like to indent the fi rst line of the paragraph, i.e., you want to start the fi rst line of the 

paragraph after leaving some gap, as show in the following document:

   The microprocessors have come a long way in the last decade and half. In this brief period, they 

have reached performance levels that took mainframe computers 30 years to achieve. In terms of net 

computing power delivered by the industry, microcomputers today outperform mainframes and mini 

computers by four orders of magnitudes.

   The microprocessors have infl uenced our society more than mainframes, to despite three 

decades of lead the latter enjoyed. It took just three years for microprocessors exceed the combined 

population of minis and mainframes put together.

To create or change the fi rst line indent, do not use the spacebar or the Tab key; instead use the Paragraph 

dialog box. You need to perform the following steps:

1. Select the paragraph(s) that you want to format.

2. Open the Paragraph dialog box.

3. Click the drop-down arrow on the right side of the Special box. (See Fig. 3.25.)

4. Select First Line from the list of options displayed by Word.
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5. Select or type the amount of indent required for the fi rst line. The default value of the indent is 0.5” 

or 2.53 cm.

6. Press the Enter key or click OK. 

3.16.6 Creating Hanging Paragraph

Look at the paragraphs shown in the following example. These types of paragraphs where the second 

and subsequent lines start after some indent are called hanging paragraphs. 

TREE A useful DOS command that graphically displays the path of each directory and 

subdirectory on the specifi ed drive. Optionally, it can also list fi les in each directory.

MOVE The MOVE command is used to move fi les from one directory to another. This command 

is also used to rename directories. 

To create a hanging paragraph similar to the fi rst sample paragraph, follow the steps given below. 

∑ Type TREE and then press the Tab key to move the cursor to the next tab stop position. Then type 

the remaining text in the usual way. 

∑ Ensure that the cursor is positioned in the paragraph and open the Paragraph dialog box. 

∑ Click the drop-down arrow on the right side of the Special box. (See Fig. 3.25.) Choose the 

Hanging option in the Special box. 

Word automatically fi lls 0.5” in the By spinner box located on the right side of the Special box. The 

default value is okay for the sample paragraph. 

∑ Press the Enter key or click the OK button, and Word creates hanging paragraphs similar to that 

shown in the sample.   

3.16.7 Using the Drop Cap Effect

Look at the paragraph shown in Figure 3.26. In this paragraph, the fi rst character of the paragraph is 

much bigger than rest of the text. This effect is called the Drop Cap effect. There are two drop cap 

effects besides the None effect. The paragraph shown in Fig. 3.26 uses the Dropped effect. The In 

Margin effect displays the drop cap character in the page margin.

Fig. 3.26 Using the drop-cap eff ect on a paragraph
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∑ To use the Drop Cap effect in a paragraph, click on the paragraph, click the Drop Cap button on 

the Insert Tab and choose the desired drop cap effect, as illustrated in Fig. 3.26.

3.16.8 Controlling Paragraph Indents through Ruler Bar

Word displays the left, right, hanging and fi rst line indent positions for the current or selected 

paragraph(s) in the ruler bar, as illustrated below. (If you do not see the ruler bar at the top of your 

document area, open the View tab and click Ruler in the Show group.) 

The markers on the ruler bar display the indent positions for the current/selected paragraph(s). 

These markers can also be used to change any indent setting. For instance, if you want to change the 

left indent for a paragraph, move the cursor in that paragraph and drag the Left Indent marker on the 

ruler bar. Similarly, you can change other indents. Changing indents precisely through markers on the 

ruler bar requires practice and you have to be careful to drag the required marker. Therefore, in the 

beginning, you may fi nd that changing indents through the Paragraph dialog box is easy and accurate.

3.17 USING TABS 

Consider the sample shown in Fig. 3.27. The fi gure contains a list. To type such a list, do not use the 

spacebar to align columns; instead, you should use tabs. When you start Word, it automatically sets 

tabs after every 0.5”, or 1.27 cm if you are using centimeters as unit of measurement. That is, the tabs 

are set at 0.5”, 1.0”, 1.5”, 2.0”, 2.5”, and so on. Therefore, you just need to press the Tab key to move 

the cursor to next 0.5” position. 

Fig. 3.27 Employees List

∑ To create a list similar to Fig. 3.27, type Pooja Chopra, the fi rst name in the list and press Tab to 

move the cursor to the next tab stop position. 

∑ Next, type Assistant and press Tab to move the cursor to the next tab stop position. Type Sales 

and press Enter to move the cursor to the next line. In the same way, type rest of the list.

In professional documents, you may like to position columns of your list at precise locations rather than 

using the default tab stop position. For instance, you may like the second column to start at 1.8 inches 

from the fi rst column and the third column from 2.7 inches. Besides, sometimes, instead of left-aligned 

columns as in Fig. 3.27, we may require centred or right-aligned columns. Figure 3.28 displays various 

types of tabs supported in Word.
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Fig. 3.28  Various types of Tabs

In a Word document, tabs are defi ned and assigned for the current or selected paragraphs. Usually 

on pressing the Enter key, the current tab settings are carried over to the next paragraph. To defi ne tabs, 

you may use the Ruler bar or the Tabs dialog box. If you do not see the ruler bar at the top of your 

document area, open the View tab and click Ruler in the Show group. Your ruler bar should be similar 

to the following ruler bar:

The left edge of the ruler bar displays a Tab button. At present, this button looks like . The Tab 

button is used to select the type of tab you want to defi ne using the ruler bar and mouse. As you know, 

you can use fi ve types of tabs in your document. To change the type of tab, click the Tab button. Each 

time you click the Tab button, Word displays the next tab type. By clicking the Tab button on the ruler 

bar, you get the following tab types.

Left-aligned (Flush-left/Standard) Tab

Right-aligned Tab

Centre-aligned Tab

Decimal Tab

Bar Tab

∑ To defi ne a tab for the current paragraph, click the mouse on the Tab button to change the tab type, 

if required. 

∑ Move the mouse pointer on the ruler bar at the desired position where you want to set the tab and 

click the mouse. Word displays a tab symbol at the clicked position to indicate that a tab has been 

setup there.

∑ If the tab position requires adjustment, drag the tab symbol to the new position. To delete a tab, 

just drag the tab symbol off the ruler bar. 
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3.17.1 Defi ning Tabs using the Tabs Dialog Box

The Tabs dialog box allows you to defi ne or clear tabs at precise positions for the current or selected 

paragraphs. 

∑ Click the Home tab, if required; click the Dialog Box Launcher located in the lower right corner 

of the Paragraph group to display the Paragraph dialog box. 

∑ Click the Tabs button in the Paragraph dialog box to display the Tabs dialog box shown in

Fig. 3.29. 

Fig. 3.29 Tabs dialog box

∑ To set a tab, type the desired tab stop position in the Tab stop position box, click the tab type 

(alignment) and then click Set. 

To clear tabs, you may use the Clear or Clear All button. The leader character is used to fi ll the space 

to the tab stop position with a character instead of leaving the blank space, as shown in the following 

list:

Orange . . . . . . . . . . . . . . . . . . 25

Banana . . . . . . . . . . . . . . . 1,234

Apple . . . . . . . . . . . . . . . . . 45

3.18 CREATING TABLES 

Look at the table shown in Fig. 3.30. You can easily create such a table with Word. The Tables facility 

in Word is very powerful and fl exible. Your table can have any number of rows or columns. You can 

type any length of text in different cells of the table. Word automatically resizes the table as required 

as you enter text in the table. The text entered in the table is formatted by using the usual commands. 

For instance, you can select the text in the table and press Ctrl+B to make it bold. In the same way, you 
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can align text in the table by using the Paragraph dialog box or by using the Formatting buttons in the 

Paragraph group on the Home tab.

Fig. 3.30 Table in a document

An easy way to insert a table in a document is by using the Table button on the Insert tab. This 

button allows you to create a table with specifi ed number of rows and columns that you want to have 

in your table. 

∑ Click in the document where you want to insert the table. 

∑ Click the Insert tab and then click the Table button, and Word displays a table grid as shown in 

Fig. 3.31. 

Fig. 3.31 Inserting a table in a document

∑ Slide the mouse on the squares in the grid to select the number of columns and rows you need in 

your table and Word displays the preview of the table. After you have selected the desired number 

of rows and columns, to create the table, click the mouse on the grid. 

Figure 3.32 displays a table created using the Table button. Notice that Table Tools appear on the 

Ribbon. Word has several built-in table styles and you can choose these by clicking the corresponding 

button in the Table Styles group. You can resize a row/column by dragging the row/column lines or the 

corresponding pointers on rulers. Entering text in a table is simple.

∑ Click in any cell and enter text in the usual way.

∑ To move to the next cell, use the Tab key or click the mouse in the desired cell. Additional 

formatting commands are available in Table Tools.
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Fig. 3.32 An empty table inserted in a Word document

You can modify an existing table with ease. For instance, you can delete or insert row(s) or column(s) 

in a table. When you right click the mouse while the cursor is positioned in the table, the context menu 

displays options to select, delete and insert cells, rows and columns. The corresponding buttons are also 

available on the Layout tab of Table Tools shown in Fig. 3.33. Besides the layout tools, you would fi nd 

the Formula button helpful. This button is used to perform simple calculation, such as sum, average 

and count on the table data. Figure 3.33 displays the sum function being entered in a cell to calculate 

the column total. 

Fig. 3.33 Inserting a formula in a table cell to calculate total
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3.19 PAGE SETUP 

To give a professional look to your documents, Word supports several commands on the Page Setup tab. 

For instance, you can defi ne the page size, margins (top, bottom, left, right, etc.), orientation (portrait 

or landscape), etc., for your document. Before learning how to set-up the page, have a look at Fig. 3.34 

that describes the various margins we can control through Page Setup.

Fig. 3.34 Page setup
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3.19.1 Changing Page Size and Margins

∑ To change margins, click the Page Setup tab and then click the Margins button in the Page Setup

group to display the Margins gallery as shown in Fig. 3.35. If the margins that you want to use are 

available in the Margins gallery, click them. 

Fig. 3.35 Page Setup dialog box

∑ If you want to use custom margins, click Custom Margins to display the Page Setup dialog box 

shown in Fig. 3.35. 

∑ The dialog box displays the current values of the various margins for the document. To change 

any margin, either directly type the desired margin in the corresponding margin box or use the 

corresponding spinner button to change the margin. Click the arrow buttons to increase or decrease 

the margin in predefi ned steps, usually by 0.1”. 

∑ If you want to create a wide document, click the Orientation button in the Page Setup group and 

then click Landscape. Alternatively, click Landscape in the Page Setup dialog box. 

∑ If you want to use header and footer in your document and want to control their position, choose 

the Layout tab in the Page Setup dialog box.

∑ If you want to print the document on a non-default paper, choose the Paper tab in the Page Setup 

box and select the desired paper size. You may also use the Size button in the Page Layout group 

to choose the page size. 

3.20 FINDING TEXT (Ctrl+F) 

Word can search for specifi c word(s) in a document being edited. The main use of this command is to 

position the cursor at a specifi c word for the purpose of editing. 
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∑ To fi nd text in a document, click the Find button in the Editing group on the Home tab and the 

Navigation pane appears, as shown in Fig. 3.36. Alternatively, press Ctrl+F, the shortcut keys for 

the Find command.

Fig. 3.36 Finding text

∑ To search for text, type it in the Search box in the Navigation pane, and Word displays the search 

results in the Navigation pane and highlights it in the document, as shown in Fig. 3.36. 

The Find command does not restrict you to fi nding only one complete word. You can search for a partial 

word, e.g., know in Knowledge or multiple words, e.g., Faculty of Arts. The Find command also has 

some options to precisely control the fi nd operation. To view these options, click the arrow button on 

the right of the search box (see Fig. 3.36) and click Options. Figure 3.37 displays the options you can 

use with Find.

Fig. 3.37 Find Options dialog box
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While searching, Word does not care about the case of the letters. For instance, if you ask it to 

locate ‘Knowledge’, it will fi nd Knowledge, knowledge as well as KNOWLEDGE. However, if you do 

not want Word to fi nd knowledge when you ask it to fi nd Knowledge, check (select) the Match case 

check box. And, if you want Word not to search for partial words, select the Find whole words only 

check box. The Sounds Like check box when selected in the Find and Replace dialog box can help 

you to locate word(s) that sound similar. For instance, if you ask Word to fi nd Geta with the Sounds 

Like check box selected, Word will fi nd Geta, Gita as well as Geeta. For advanced search, you may 

experiment with other search options.

3.21 REPLACING TEXT 

The Replace Command is used to fi nd the search text and replace it with the specifi ed text, e.g., you 

may use it to replace New Delhi with Bhopal in an open document. 

∑ To use the Replace command, click Replace in the Editing group on the Home tab, or press 

Ctrl+H and Word displays the Find and Replace dialog box shown in Fig. 3.38.

Fig. 3.38 The Replace tab of Find and Replace dialog box

∑ To perform a replace operation, enter the required text in the Find What and Replace With text 

boxes and click the Find Next button. If Word locates the specifi ed search text, it highlights it in 

document. Now you have the following options:

 1. Click the Replace button if you want Word to replace the highlighted text (New Delhi) with 

the replacement text (Bhopal) and want Word to fi nd the next occurrence of New Delhi. 

 2. Click Replace All if you want New Delhi to be replaced with Bhopal throughout the document 

in one stroke.

 3. Click Find Next if you do not want to replace the text at the present location; however, want 

Word to fi nd the next occurrence of New Delhi. 

 4. Click Cancel if you do not want to replace the text at the present location and want to close 

the Find and Replace dialog box. 

∑ Replace also supports options similar to the Find options discussed in the previous section. To 

display these options, click More in the Find and Replace dialog box.

Tip  If you replace the wrong text my mistake, click the Undo button on the Quick Access toolbar or press 

Ctrl+Z to undo the replace operation.
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3.22 CHECKING SPELLING AND GRAMMAR 

Word comes equipped with a very useful spelling and grammar checking and correction tool that can 

help you to produce error-free documents. Word contains a powerful dictionary that includes nearly 

all commonly used words. In addition to the built-in dictionary, you can also use a custom dictionary 

to store words not available in the Word dictionary, such as names of persons, cities, technical terms, 

etc. 

Depending on the selected options, Word can automatically check spellings and grammar while you 

type your document. When this feature is on, Word marks words that it cannot fi nd in its dictionaries 

with red wavy underline. If the online grammar checking is enabled, it marks grammatical errors with 

green wavy underline. 

∑ To manually start Spelling and Grammar checking, press F7 or  on the Review tab. When it 

fi nds a spelling error, it displays the Spelling and Grammar dialog box as shown in Fig. 3.39.

Fig. 3.39 Spelling and Grammar dialog box

When Word fi nds a word in the document that it cannot fi nd in its dictionaries, it highlights that word 

in the Spelling and Grammar dialog box. If possible, it also offers some suggestions, e.g., in Fig. 3.39, 

it is offering a suggestion for the misspelled word “Howver”. 

∑ You can choose any of the suggestion and click the Change button to replace the misspelled 

word with the selected suggestion. On clicking Change All, Word replaces the misspelled word 

throughout the document. 

∑ If you want Word to remember this correction and automatically correct the word should you type 

this misspelled word again, click the AutoCorrect button. 

∑ When your document contains names of persons, cities, etc., or technical terms, you may click the 

Ignore button to ask Word to ignore the word and continue checking the spelling. If you frequently 

use a name or technical term in your documents, you may add it to your custom dictionary by 

clicking the Add to Dictionary button.

If the Grammar checking option is not disabled in your setup of Word, it also checks grammar while 

checking spellings, and offers suitable suggestions. Word comes equipped with numerous dictionaries 

for various languages. Even for the same language, several dictionaries are available. For instance, for 

English, Word has dictionaries for English India, English UK, English USA, and so on.

∑ If you want to change the default dictionary, click the Options button as illustrated in Fig. 3.39. 

Word does support proofi ng tools for Hindi, English, Gujarati, Kannada, Marathi, Punjabi, Tamil, 

Telugu, and Urdu, however, you need to buy it separately. 
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3.22.1 Checking Spelling and Grammar while Typing 

Word can check spelling and grammar as you type. Use the Proofi ng sections of the Word Options 

dialog box to control these options. 

∑ Click the File tab to open the backstage view and click Options to open the Word Options dialog 

box.

∑ On the Word Options dialog box, click Proofi ng. To check spelling as you type, click Check 

spelling as you type, as illustrated in Fig. 3.40. Similarly, to ask Word to mark the grammar 

errors, as you type, check Mark grammar errors as you type.

Fig. 3.40 Controlling Spelling and Grammar options

The dialog box also contains check boxes to control other spelling and grammar options, e.g., to 

ignore words typed in all uppercase letters, ignore words containing numbers, etc. 

After you have enabled the ‘Check Spelling as you type’ option, if you type a misspelled word, Word 

marks it with a red wavy underline. On right clicking the misspelled word, it may offer suggestions in 

the context menu as shown in Fig. 3.41. To accept a suggestion, click the desired word in the menu.

Fig. 3.41 Fixing spelling mistakes through right-click menu
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3.22.2 Using AutoCorrect to Automatically Fix Typing Errors

AutoCorrect is a very useful feature which can automatically correct many common typing errors, e.g., 

typing ‘teh’ instead of ‘the’.

∑ To test if this feature is working, type teh in any document and press spacebar. If Word does not 

automatically correct teh to the, you need to enable the AutoCorrect option. 

∑ Open the Word Options dialog box, click Proofi ng and then click AutoCorrect Options to display 

the AutoCorrect dialog box shown in Fig. 3.42. 

Fig. 3.42 AutoCorrect dialog box

∑ For AutoCorrect to function, ensure that Replace text as you type check box is selected. The 

dialog box also enables you to manually defi ne AutoCorrect entries, though normally these entries 

are added in the background by clicking the AutoCorrect button while performing the spelling 

checking. 

3.23 INSERTING PAGE NUMBERS 

As you type text in a document, Word automatically takes care of page breaks as per the defi ned page 

setup.

∑ To display page numbers at the top or the bottom of the page of your document, click Page Number

in the Header and Footer group on the Insert tab and Word displays a menu containing options 

to insert or remove page numbers as shown in Fig. 3.43.

∑ Now click the appropriate command to control the position for the page numbers. To change the 

format of page numbers or to start the page number from a number other than 1, click Format 

Page Numbers.
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Fig. 3.43 Inserting page numbers in a document 

3.24 INSERTING PAGE BREAKS 

As you know, as you type text in a document, when there is not enough space on the current page for 

the text, Word automatically ends the current page and starts a new page. This type of page break is 

called soft page break. However, sometimes, you may like to end the current page after a particular 

line and start the next page, i.e., to forcibly end the current page by inserting a page break. This is also 

called hard page break. 

∑ To insert a page break at the cursor position, press Ctrl+Enter. Alternatively, click the Insert tab 

and click Page Break in the Pages group.

Inserting a Blank Page If you need to insert a blank page in your document: 

∑ Move the cursor to the location where you want to insert a blank page. Click Blank Page in the 

Pages group on the Insert tab.

3.25 ADDITION OF COVER PAGE 

While you can type text and format it to create a cover page for your document, Word provides an 

alternate convenient way to accomplish the same. To insert a cover page from a wide selection of 

preformatted cover page designs offered by Word:

∑ On the Insert tab, click Cover Page in the Pages group to display icons for the available cover 

pages.

∑ Click the icon for the cover page you want to insert at the beginning of your document.

∑ Now you can edit the inserted cover page to customise it as per your needs. If you need to remove 

the cover page, click Cover Page in the Pages group on the Insert tab and click Remove Current 

Cover Page.

3.26 LOOKING AT A DOCUMENT IN DIFFERENT VIEWS 

While editing a document, you can look at the document in fi ve ways—Print Layout, Draft, Web 

Layout, Outline and Full Screen Reading. The Print Layout view is the default view. The view that you 

would use depends on your needs and personal preference. 
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1. Print Layout View: This view displays the page as WYSIWUG (What is you is what you get), 

i.e., it displays page margins, header, footer, page numbers, etc. However, this view reduces the 

area available for editing. 

2. Draft View: The Draft view is suitable for editing and formatting the document. While each 

element, such as paragraph, graphics, table, etc., is displayed and formatted as it would appear on 

the printed page, it hides header, footer and page margins. While you get more editing area in this 

view, it does not show the page as would appear on printing. 

3. Web Layout View: This view is suitable if you are designing a document for creating a web 

page. 

4. Outline View: The Outline view is normally used for complex and long documents. It organises 

the document units based on heading levels and you can cut, copy or move these with ease. 

5. Full Screen Reading View: As the name suggests, this view is the most suitable for reading the 

document on the screen as Word removes the Ribbons as well as most toolbars. Word does not 

prevent you from editing the document in this mode. To close this view, press Esc or click the 

Close button located in the top-right corner. 

Fig. 3.44 Document View buttons

3.27 ADDING BORDERS AND SHADING TO PARAGRAPHS 

To enhance the appearance of your document, you can show a border (box) around a paragraph or even 

fi ll the box with a shade, as shown in Fig. 3.45.

Fig. 3.45 Using borders and shading

∑ To format a paragraph with border or shading, ensure that the cursor is positioned in that paragraph. 

If you want to show border around selected text, select the required text. 

∑ On the Home tab, click the arrow button on the right of the Borders button ( ) and Word 

displays a menu contains the border options, as shown in Fig. 3.46. 
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Fig. 3.46 Menu displaying the border options  

∑ The border options menu contains options to create common types of border, e.g., top, left, right, 

bottom, all, none, etc. You can click the corresponding option to create the required border. For 

additional options, e.g., to create a shadow or 3D border and to add shading, click Border and 

Shading in the menu to display the Borders and Shading dialog box shown in Fig. 3.47. 

Fig. 3.47 Borders and Shading dialog box

In the Settings area in the left side of the Borders and Shading dialog box, there are fi ve buttons—None, 

Box, Shadow, 3D and Custom. These buttons are used to create different types of boxes around the 

selected text/paragraph(s). For instance, if you click the Box button, Word draws a box. On the other 

hand, if you click the Shadow button, Word draws a Shadow box. When you click any button, Word 

displays its effect in the Preview box. The dialog box also has controls to select the line style, thickness 

and color, as illustrated in Fig. 3.47. 

∑ To fi ll a paragraph box with a shade, i.e., to display a background for the box, click the Shading

tab to display the Shading page in the Borders and Shading dialog box. Then choose the desired 

fi ll colour and style through the corresponding dropdown boxes.
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3.28 ADDITION OF BORDERS, BACKGROUND AND

 WATERMARK TO PAGE 

To enhance the appearance of your document, you can add a border around each page. To add a page 

border, you should be working in the Print Layout view. 

∑ Click the Page Layout tab and then click Page Borders in the Page Background group. 

Word displays the Borders and Shading dialog box with the Page Border tab selected. The contents of 

the Page Border tab are similar to the Borders tab shown in Fig. 3.47. Now you can apply a page border 

as per the steps discussed in the previous section. 

3.28.1 Page Background

∑ To apply a background color to the page, click Page Color in the Page Background group on the 

Page Setup tab.  

∑ Word displays a dialog box to choose the background color. Besides choosing the solid colors, 

you can give striking effect to the page background by clicking Fill Effects and choosing gradient, 

texture or pattern.  

3.28.2 Adding Watermark to Pages

You can add a watermark to your document, which is displayed and printed in dim style behind the page 

information. The watermark can serve as a page background or convey a message, such as Confi dential, 

Draft, Do not copy, etc. You can use a watermark from a few commonly used pre-defi ned watermarks 

or defi ne your own. 

∑ To apply a watermark to the document, click Watermark in the Page Background group on the 

Page Layout tab and Word displays the Watermark dialog box shown in Fig. 3.48.

Fig. 3.48 Defi ning a watermark for the document

∑ If the watermark you want to use is displayed in the Watermark gallery, click to select it, otherwise, 

click Custom Watermark to display the Printed Watermark dialog box. This dialog box enables 

you to choose watermark text from a large list of predefi ned texts, type your own text or defi ne a 

picture as the watermark.
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3.29 USING HEADERS AND FOOTERS IN THE DOCUMENT 

The header is a special text that is printed at the top of each page (above the normal text.) as shown in 

Fig. 3.34. The sample page contains a header—Defi ning Page Setup. Normally, we use only text as the 

header; however, it can also include graphics. You might have noticed a header in books that is used to 

show the title of the book or the name of the chapter. Similarly, in a multi-page document, we may also 

use footer. The footer is text and/or graphics printed at the bottom of every page.

∑ To defi ne the header (or footer) for a document, click the Insert tab and then click Header (or 

Footer) in the Header and Footer section and Word displays a gallery containing built-in styles, as 

shown in Fig. 3.49.

Fig. 3.49 Choosing a header style

∑ You can scroll the gallery to view additional styles. If you do not like any of the predefi ned style, 

click the Blank style and you will be able to defi ne your own header (or footer) text; otherwise, 

click the style you like. 

∑ Word inserts the header/footer in the document and moves the insertion point to that area. The 

document text appears in dim intensity and Words adds Header and Footer Tools to the Ribbon 

to help you design and format the header/footer as shown in Fig. 3.50.

Now you can click the placeholders to type the text, if applicable. You can type text or insert graphics 

using the regular Word commands. Similarly, you can format the header/footer text the same way as 

you format the document text. You can click Go To Header/Footer buttons to switch between header 

and footer. 

∑ To close Header & Footer Tools, double-click in the document area or click the Close button 

located at the right in Header & Footer Tools.

∑ If you prefer, you can defi ne a different header and/or footer for even and odd pages. Similarly, 

you can defi ne a different header/footer for the fi rst page of your document. To do so, click the 

corresponding button in Header & Footer Tools and use Previous/Next buttons to defi ne separate 

header/footer.
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Fig. 3.50 Editing header

3.30 ZOOM IN AND OUT 

The zoom feature enables you to enlarge or reduce the size of the text and other objects in the document. 

While 100% displays the document in regular mode, you can use any zoom percentage from 10% to 

500%. 

∑ The quickest way to change the zoom percentage is by using the zoom slider (see Fig. 3.50.) You 

may either drag the slider with mouse or click the Zoom In (+) or Zoom Out (-) button, which 

changes the zoom percentage in steps of 10%.  

∑ An alternate way to change the zoom the document is by using the Zoom dialog box, which you 

can open by clicking the Zoom button on the View tab. This dialog box let you type the zoom 

percentage or increase/decrease the zoom percentage in steps of 1%. 

Tip  If your mouse has a scroll wheel, hold down the Ctrl key and rotate the scroll wheel to zoom in or zoom 

out. On laptops equipped with touchpad, you may be able to do pinch-zoom. 

3.31 CHANGING CASE 

∑ If you need to change the case of the text you have typed, click the Change Case button ( ) in 

the Font group on the Home tab. 

Word displays a menu with fi ve options—Sentence Case, Lower Case, Upper Case, Title Case and 

Toggle Case. The Sentence Case capitalizes the fi rst letter of the fi rst word in the selected sentence, or 

the fi rst word after the end of a sentence. The Lower Case option changes the selected text to all lower 

case letters, and Upper Case to all upper-case letters. Title Case capitalizes the fi rst letter of each word 
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of the selected text, e.g., it changes Computer and society to Computer And Society. Finally, Toggle 

Case changes all upper case letters to lower case letters and all lower case letters to upper-case letters 

in the selected text. For instance, Toggle Case converts My Computer to mY cOMPUTER.

Tip You may use Shift+F3 shortcut keys to change case for the selected text. 

3.32 INSERTING DATE AND/OR TIME 

To type the date and/or time in your documents, you can take the help of Word. Word can type the 

system date and/or time in the document for you. 

∑ Move the cursor where you want to insert the date/time and click the Date and Time button in 

the Text group on the Insert tab and Word displays the Date and Time dialog box as shown in

Fig. 3.51. 

∑ Word allows you to insert the date and/or time in several formats, languages and calendar type. 

Click the desired format and click OK. 

Notice the Update Automatically check box near the bottom of the dialog box. Check (select) this 

check box only when you want Word to automatically change the inserted date to the system date. For 

instance, if you want to insert a date in the document and would like Word to display tomorrow’s date 

when you open the document tomorrow, check Update Automatically prior to clicking OK.

Fig. 3.51 Date and Time dialog boxes displaying available formats in English and Hindi 

Depending on the installed languages on your computer, you may be able to choose the language 

form the Language drop-down list box and calendar type from Calendar Type box. The fi rst dialog box 

in Fig. 3.51 displays available formats in the English (India) language in the western calendar, whereas 

the second uses the Saka era in Hindi. 

3.33 INSERTING BOOKMARKS 

If you are creating a long document, you may fi nd the seldom used bookmark feature helpful. A 

bookmark is a named location in the document that is used for future reference. For instance, in a large 
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document that contains several sections, you may assign a bookmark to the beginning of each section. 

After bookmarks have been defi ned in a document, you can use Go To Bookmark to quickly jump to 

the desired bookmark. 

∑ To add the bookmark to a document, select the text or move the cursor to the location where 

you want to insert the bookmark, and click Bookmark in the Links group on the Insert Tab. In 

response to this, Word displays the Bookmark dialog box shown in Fig. 3.52. 

Fig. 3.52 Bookmarks dialog box

∑ Now enter the desired bookmark name in the Bookmark Name box and click Add. While assigning 

a bookmark name, always use meaningful names.

∑ After you have created bookmarks, to jump to a specifi c bookmark, open the Bookmarks dialog 

box by clicking Bookmarks in the links group on the Insert tab and then double click the desired 

bookmark. Alternatively, click the desired bookmark name and click the GoTo button. Yet another 

way to jump to bookmark is discussed in the next section.

3.34 MOVING TO A SPECIFIC PAGE/BOOKMARK (F5) 

Word can help you to quickly jump the cursor to the desired page, bookmark, footnote, endnote, etc., 

through the Go To tab of the Find and Replace dialog box. 

∑ Press F5 or Ctrl+G and Word opens the Go To tab of the Find and Replace dialog shown in

Fig. 3.53.

Fig. 3.53 Jumping to a specifi c bookmark/page
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∑ To jump to a specifi c bookmark, ensure that Bookmark is selected in the Go To What list box, 

choose the desired bookmark from the drop-down list box in the dialog box and click the Go To 

button. 

If you want to jump to a specifi c page:

∑ Select Page in Go to what, type the desired page number and click Go To. If you want to move 

forward a specifi c number of pages relative to the current page, enter ‘+’ followed by the number 

of pages, e.g., +3 moves the document forward by three pages. 

3.35 ADDITIONAL PARAGRAPH FORMATTING OPTIONS 

The Lines and Page Breaks tab of the Paragraph dialog box contains additional paragraph formatting 

options to precisely control the appearance of the documents, as illustrated in Fig. 3.54. The

Window/Orphan control, when checked ensures that minimum numbers of lines are kept on both 

pages when a paragraph gets divided into two pages. If you want to keep the entire paragraph on the 

same page, check Keep Lines Together. The Keep with Next option, normally used with headings 

ensures that the current paragraph and the next paragraph remain on the same page. And, if you do not 

want to hyphenate a paragraph, click Don’t Hyphenate.

Fig. 3.54  Line and Page Break options in the Paragraph dialog box

3.36 USING MULTIPLE COLUMNS IN A DOCUMENT 

Word can help you to create a document with multiple columns, similar to what you see in newspapers 

or some books. For instance, consider the page shown in Fig. 3.55, where the text is formatted in two 

columns. Converting paragraphs to multiple columns is quite simple.
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Fig. 3.55 A page formatted in two columns

∑ Select the paragraphs that you want to convert into multiple columns. If you want to convert all 

text in the document to multiple columns, press Ctrl+A.

∑ Click the Page Layout tab and click the Columns button in Page Setup group (See Fig. 3.56) and 

Word displays a gallery containing the columns choices.

∑ Click the desired column style.

Fig. 3.56 Converting document text to multiple columns 

For more precise control on the number of columns and columns widths, click More Columns… in 

the Columns gallery. 
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3.37 USING WORDART 

You can use WordArt to create special text effects. You will fi nd these effects particularly useful for 

creating signs and headings. The text effect shown here have been created with WordArt. 

∑ To insert WordArt in your document, move the cursor to the desired location. If you want to 

convert an existing text to WordArt, select that text. 

∑ Click the Insert tab and then click WordArt in the Text group and Word displays a WordArt 

Gallery shown in Fig. 3.57.

Fig. 3.57 Selecting the WordArt style 

∑ Click the WordArt style you want to use and Word displays a text box containing “Your Text 

Here” or your selected text. Word also displays the Drawing Tools on the Ribbon as shown in

Fig. 3.58. Type or change the required WordArt text in the text box. 

Fig. 3.58 WordArt inserted in a document
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∑ You can change the WordArt style by using the Styles, Effects and other controls available in 

Drawing Tools. (Click the WordArt object if you don’t see Drawing Tools.) You can resize the 

WordArt object by using the resizing handles or rotate the object, as illustrated in Fig. 3.58.

3.38 INSERTING PICTURE, CLIP ART AND TEXT BOX 

Word can directly import graphics fi les created in most of the common graphics fi le formats, such as 

Paint, PC Paintbrush, AutoCAD and CorelDraw. Similarly, you can easily insert camera digital pictures 

in your documents. To insert any graphics or picture fi le in your document at the cursor position: 

∑ Click  (the Picture button) on the Insert tab to display the Insert Picture dialog box shown in 

Fig. 3.59.

Fig. 3.59 Selecting a picture fi le in the Insert Picture dialog box

∑ The Insert Picture behaves like the Open dialog box you use to open a document. You can change 

the folder, if required and then double click the fi le you want to insert. Figure 3.60 displays a 

picture inserted in a document. 

After the picture has been inserted, you may resize, crop or modify it using many built-in picture 

tools. Notice that Word automatically displays Picture Tools when a picture is selected. You would 

particularly fi nd the Picture Styles tools helpful as you can change the picture’s impression by just 

selecting the Picture Style. Word displays the live preview as you hover the mouse on a Picture Style. 

You would also fi nd the tools available in the Adjust group helpful to change the picture brightness or 

colour or remove the background. 
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Fig. 3.60 A picture inserted in a document

3.38.1 Adding Clip Art

Word has a number of clip art images that you can include in your document. For instance, it has clip 

art fi les for an anchor, computer, diskette, dinner, animals, offi ce equipment, etc. To insert any graphics 

or picture fi le in your document at the cursor position: 

∑ Click the Clip Art button on the Insert tab to display the Clip Art pane shown in Fig. 3.61.

∑ Type a word or two for the clip art image you want to fi nd in the Search box. You can use options 

in the Clip Art pane to choose the type of image fi les (e.g., illustrations, photographs, audio, 

video, etc.) and if you also want to search at www.offi ce.com. On clicking Go, Word displays the 

results. 

Fig. 3.61 Inserting a Clip Art in a document
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∑ Click an image to insert it in the document. As for a picture, Word displays Picture Tools that you 

can use to resize, crop, rotate or edit the image. 

3.38.2 Adding Text Box 

The Text Box icon on the Insert tab provides a convenient way to add a text box to your document. 

After adding a text box, you can type text in the box. As for an image, Word has a number convenient 

ways to format the text box.

3.39  INSERTING SHAPES, SMARTART, SCREENSHOT

 AND SYMBOLS 

To create professional looking documents, Word includes a set of tools on the Insert tab to insert Shapes, 

SmartArt, Chart and Screenshots. The Shapes tool can be used to inset dozens of shapes as shown in 

Fig. 3.62. To insert a shape, click the desired shape and drag the mouse pointer in your document. Then 

Word displays Drawing Tools that you can use to resize, reposition and format the shape. 

You can use SmartArt to insert useful blocks for creating an organization chart, process fl ow, 

cycles, pyramids, etc. The Chart tool is helpful to insert a chart in the document. After inserting 

a chart, you can format it as per your choice with the help of all sorts of tools provided by Word. 

Basically, Word inserts an Excel chart object in your document. 

If you want to insert the Screenshot of an application in your document, click Screenshot on the 

Insert tab. Then Word displays icons for all open windows and you can click the desired icon to insert 

the corresponding Screenshot.

You can insert symbols, such as ®, S and ™ in your document by clicking  on the Insert 

tab and choosing the symbol from the Symbols gallery. If the symbol you need is not available in the 

gallery, click More Symbols to display the Symbols dialog box and then double click the desired 

symbol to insert it in your document.  

Fig. 3.62 Shapes Gallery displaying shapes you can insert in a document
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3.40 USING AUTOTEXT TO INSERT COMMONLY USED TEXT 

In typical work environment, often you may need to type the same text again and again. Some examples 

of such text are name and address of the company, ‘Thanking you’, ‘Yours Sincerely’, etc. Word can 

help you insert such text, called AutoText with ease. Here are the steps required to create an AutoText 

entry. 

∑ Type and format the text. Your text can include multiple lines of text. 

∑ Press Alt+F3 or click the Insert tab, Quick Parts, AutoText, Save Selection to AutoText Gallery

to display the Create New Building Block dialog box shown in Fig. 3.63. Word assigns a default 

name for the AutoText entry.

Fig. 3.63 Creating an AutoText entry

∑ Type a suitable name for the AutoText entry. Optionally, type description for the entry. Then click 

OK to create the entry.

∑ After you have created AutoText entries, inserting the corresponding text at the cursor location in 

the document is very easy. On the Insert tab, click Quick Parts, AutoText to display the list of 

available AutoText entries and click the entry you want to insert in your document. 

3.41 INSERTING FOOTNOTES AND ENDNOTES

IN A DOCUMENT 

You might have seen footnotes and endnotes in some books and articles. Footnotes are printed at the 

bottom of the page and endnotes at the end of the document. To insert a footnote or endnote in a Word 

document:

∑ Move the cursor where you want to insert the footnote/endnote and click the References tab. 

∑ Click Insert Footnote/Insert Endnote.  

∑ Word inserts the footnote/endnote at the cursor location and prompts you to enter the footnote/

endnote text. 

∑ If you need to delete a footnote/endnote, select it in the document and press the Delete key. 
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3.42 AUTOMATICALLY NUMBERING FIGURES AND TABLES 

If your document contains several fi gures, tables, equations, etc., you can ask word to automatically 

number these for you. The advantage of using automatic numbering over manual numbering is that 

as you add or delete a fi gure or table, Word automatically renumbers the entire document. To use this 

feature in a document:

∑ Move the cursor at the desired location and click the References Tab.

∑ Click Insert Caption to display the Caption dialog box shown in Fig. 3.64. 

Fig. 3.64 Caption dialog box

∑ Now choose the desired label, such as Figure, Table, Equation, etc., from the Label drop-down 

box. If you need to create a new label, use the New Label button. Finally, click OK to insert the 

caption in the document. 

3.43 INSERTING HYPERLINKS 

You may include hyperlinks in your document. A hyperlink is used to display an existing webpage or 

fi le. It can also be used to jump to a location or bookmark in the current document. 

∑ To insert a hyperlink, click Hyperlink on the Insert tab to display the Insert Hyperlink dialog box 

shown in Fig. 3.65. 

The Text to Display box is used to defi ne the text for the hyperlink. The Link To panel in the left side of 

the dialog box is used to select the type of the link, e.g. to an existing fi le name, web page or a location 

within the current document. The Address box in the lower part of the dialog box is used to defi ne 

address for the fi le, webpage, email, etc. 

∑ After defi ning the required options, click OK to insert the hyperlink. 

∑ When you move the cursor on a hyperlink, Word displays a tooltip explaining how to jump to the 

hyperlink. You can Ctrl+Click a hyperlink to go to the link and Word opens the linked document 

or webpage, as applicable.



Word Processing with Microso   Word    183 1 

Fig. 3.65 Insert Hyperlink dialog box

3.44 TRACKING CHANGES 

Sometimes more than one user modifi es a document. For instance, you may prepare a project report 

and hand it over to your Manager for review. While reviewing the report, if your Manager makes any 

changes to the document, and you want to know all changes made by the Manager, you may turn 

on Track Changes by pressing Ctrl+Shift+E or clicking Track Changes on the Review tab. When 

the Track Changes option is ON, Word display the Reviewing toolbar and any changes made to the 

document are displayed in different color with suitable comments. The buttons in the Changes group 

on the Review tab enables you to reject or accept any or all changes. 

3.45 CREATING A PDF FILE FROM A WORD DOCUMENT 

If you want to share a Word document with other users or for commercial printing and they do not have 

the Word program, they may have diffi culty opening it. Also, e-mailing a big Word document may be 

an issue due to its large fi le size. In these situations, saving the document as a PDF (Portable Document 

Format) fi le may be the best option as it retains the document formatting, the fi le size becomes small 

and yet anyone can view or print it as PDF readers are available free of cost. A PDF fi le can be opened 

on any hardware, operating system or application. Most computers already have one or more PDF 

readers installed, however, if you need one, visit http://get.adobe.com/reader or search PDF reader 

on the web. To create a PDF fi le:

∑ Open the Word document, click the File tab and then click Save As to open the Save As dialog 

box.

∑ Click the fi le type against Save As Type to display the fi le types list and click PDF.

∑ Change the fi le name or folder, if required and click the Save button to create the PDF fi le.

Note Word also supports the XPS Document format, which is Microsoft’s equivalent of PDF. 
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3.46 EMAILING A DOCUMENT 

While you can attach any document, including a Word document to an e-mail message, Word has a 

built-in option to e-mail the document you are editing. In other words, you do not need to worry about 

the fi le name and path of the document; just click Save and Send link in the Backstage view and click 

the desired send option, as illustrated in Fig. 3.66. 

Word supports options to attach the document as a Word document, PDF fi le or XPS fi le. If you 

select PDF or XPS option, Word automatically creates the corresponding fi le. Then it opens the default 

e-mail client program on your PC, creates a new message and attaches the fi le. Now all you need to do 

is type the e-mail address and message, and send the e-mail. 

Fig. 3.66 E-mailing a document

3.47 USING MAIL MERGE 

Mail Merge is a very useful and powerful addition to the primary feature of Word, word processing. 

You can use Mail Merge to print personalized form letters (bearing the addressee’s name and address 

on the letter), envelopes, mailing labels, etc. Form letters are letters that have the same (or nearly the 

same) contents and are sent to several persons. Business letters describing the launch of a new product, 

call letters for interviews, notices for a meeting, invitations to a party, etc., are examples of form letters. 

To help you perform Mail Merge, Word includes a Step by Step Mail Merge Wizard on the Mailing tab. 

This Wizard helps you to set up the Mail Merge document and prepare the mail merged output. Let us 

learn to use Mail Merge. 

∑ Press Ctrl+N to create a new document, click the Mailing tab and click  and Word displays a 

pull-down menu shown in Fig. 3.67.
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Fig. 3.67 Start Mail Merge menu 

∑ The Step by Step Mail Merge Wizard guides us through the Mail Merge process. On clicking this 

command in the menu, Word displays the Mail Merge wizard on the right side of the window as 

shown in Fig. 3.68.

The fi rst step of the Wizard shown in Fig. 3.68 asks you to select the type of Mail Merge document you 

want to create. The Mail Merge wizard can help you to create various types of Mail Merge documents, 

such as letters, envelopes, labels, email messages and directory. The default option is Letters which is 

used to create Mail Merge letters. 

Fig. 3.68 The fi rst step of Mail Merge Wizard

∑ Ensure that Letters is selected as the document type and click Next: Starting document, as 

illustrated in Fig. 3.68.
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In Step 2, Mail Merge prompts you to select a document for Mail Merge. The default option, i.e., Use 

the current document is good to create a new Mail Merge document based on the current document. 

To modify an existing Mail Merge document or convert an existing Word document into a Mail Merge 

document, use the third option, i.e., Start from existing document. 

∑ Ensure that Use the current document is selected, click Next: Select Recipients and the Mail 

Merge wizard displays the next step shown in Fig. 3.69. 

Fig. 3.69 Select Recipients in Mail Merge wizard

The recipients list contains the name, address and other details that you want to include in the Mail 

Merge document. If you already have the required data in an Access, Excel, text, dBASE, Lotus, ODBC 

fi le, choose the fi rst option (Use an existing list) and click the Browse button to choose the required 

fi le. The second option (Select from Outlook contacts) enables you to choose the recipients from the 

contacts you have in your Outlook program. Finally, the last option (Type a new list) enables you to 

manually type the list. Normally, you would use the fi rst or the second option, however, for now, let us 

choose the third option. 

∑ Click Type a new list option and then click Create to enter data for recipients. 

Word displays a New Address List form that helps you to enter and edit the recipients list, as shown in 

Fig. 3.70. 

∑ Type an address entry and then click the New Entry button to enter the next entry. After entering 

details for all recipients, click OK and save the address list in a fi le. You may edit or sort the 

recipients list, if required. Finally, close the list.  
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Fig. 3.70 New Address List dialog box

∑ Click Next: Write your letter to move to the next step. 

Writing the letter in a Mail Merge document is similar to typing in a regular Word document. However, 

you need to perform one extra step of inserting Merge fi elds in the Mail Merge document at appropriate 

places. That is, you insert fi elds corresponding to the Title, First_Name, Last_Name, Address, City, 

State, etc., from the recipients list fi le (also called the data source) in the document at appropriate place. 

∑ To insert a mail merge fi eld in the document, move the cursor at the required place in the Mail 

Merge document and then choose the required fi eld from the Insert Merge Field button on the 

Mailing tab, as shown in Fig. 3.71. 

Fig. 3.71 Inserting Merge fi eld in a Mail Merge document
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Word inserts the selected fi eld in the document and shows it enclosed within double angle brackets, 

e.g., «First_Name». To view the actual data instead of the fi eld name, click Preview Results on the the 

Mailing tab. 

3.47.1 Printing Merge Letters

You can print the merged letters directly on the printer or save the output fi rst in new document fi le and 

then print these later like any other document fi le. You can even send the output as an email message. 

To perform the Mail Merge, click Finish and Merge ( ) and choose the desired option. 

3.47.2 Printing Envelopes and Labels

Most modern printers can directly print on envelopes and label stationery, and Word can help you to 

print directly on an envelope or label stationery. 

∑ To prepare an envelope or label, choose the corresponding option when you click  (see Fig. 

3.67) and Word displays the corresponding options dialog box. Figure 3.72 displays the Envelopes 

Options dialog box.

Fig. 3.72 Envelopes Options dialog box

∑ Now choose the envelop size you plan to use and click OK. 

The rest of the process of creating a Mail Merge document for envelopes and labels is same as that for 

letters. 
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3.48 PASSWORD PROTECTING A DOCUMENT 

If you prepare a document that contains confi dential information, you can protect it with a password 

to prevent unauthorized users from viewing or modifying it. A password protected document can be 

opened only after providing the correct password. 

∑ To password protect the current document, click File to go to the Backstage view and click Save 

As to open the Save As dialog box. 

∑ Click Tools to display a submenu shown in Fig. 3.73.

Fig. 3.73 Save As dialog box displaying Tools

∑ Click General Options to display the General Options dialog box shown in Fig. 3.74. The dialog 

box allows you to defi ne two passwords—one to open the document and the second to modify the 

document. The use of Password to modify is optional. After defi ning password(s), Word asks you 

to reconfi rm the passwords. Remember that passwords are case-sensitive and if you forget these, 

you may not be able to open the document. 
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Fig. 3.74 General Options dialog box

3.49 CUSTOMIZING WORD 

Word is highly customizable. The central place to change Word options is through the Word Options 

dialog box that we have already discussed. You can open this dialog box by clicking Options in the 

Backstage view. As shown in Fig. 3.75, various options are classifi ed into categories, such as General, 

Display, Proofi ng, Save, etc., which are listed in the navigation pane in the left. On clicking an option 

category, Word displays the corresponding options in the right pane. Advanced users may try to 

customize the Ribbon and Quick Access Toolbar. If you are not sure about an option, click the help 

button (?) located on the right side of the title bar.

Fig. 3.75 Word Options dialog box



Word Processing with Microso   Word    191 1 

3.49.1 Customizing Quick Access Toolbar

By default, the Quick Access toolbar contains three commands—Save, Undo and Redo, however, you 

can customize it to add any command that you frequently use. 

∑ An easy way to add/remove commands to the Quick Access toolbar is by clicking the drop-

down arrow located on the right side of the toolbar and clicking the corresponding command, as 

illustrated in Fig. 3.76. Click More Commands to display additional commands that you can add 

to the Quick Access toolbar.

∑ To add any command available on any tab of the ribbon, right click the command to display a 

context menu and click Add to Quick Access Toolbar. 

3.49.2 Customizing Ribbon

Microsoft has grouped the commands into various tabs and groups on the Ribbon after monitoring 

the sequence of commands used by thousands of users over extended period. Most users fi nd the 

commands layout on the Ribbon convenient, however, if you prefer, you can change the layout of the 

Ribbon. To do so, click Customize Ribbon in the Word Options dialog box as shown in Fig. 3.75. Then 

the Options dialog box displays controls to add a custom group to any tab and add any command(s) to 

that group. Although the Ribbon can be customized, most users do not customize the Ribbon because 

they would have trouble fi nding commands on the standard Ribbon on other computers. 

Fig. 3.76 Customizing Quick Access toolbar

3.50 USING STYLES 

When our documents are simple and small, we are able to format it using the formatting buttons on the 

Ribbon or using keyboard shortcuts. However, as our documents become long and complex, maintaining 

consistent formatting becomes an issue. For instance, if your document has several section headings, 

you would like to use the same formatting style for all headings. To apply consistent formatting, you 

will fi nd the styles helpful. A style is a predefi ned set of formatting which may include font, paragraph, 
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border and shading formatting. You can either use existing styles or create your own new styles. Each 

style is given a name. Word comes equipped with several commonly used formatting styles for section 

headings, normal text, index, table of contents, etc. When you create a new document, it gets all styles 

that are available in the template you use. Let us have a look at the styles that you can use on a document 

based on the Normal template. 

∑ Press Ctrl+N to create a new document and type Using Styles. Do not press the Enter key. 

∑ Move the mouse over Heading 1 in the Styles group (see Fig. 3.77) and Word displays the preview 

of the style on the text in the paragraph. To view additional styles, click the scroll buttons.  To view 

all available styles, click , the More button to open the Styles gallery.

∑ You can also apply styles through the Styles Pane. To open the Styles Pane, click Dialog Box 

Launcher located at the bottom-right in the Styles group.  

Fig. 3.77 Applying Styles

You can also create your own styles with ease with the following steps:

∑ Use any formatting tools to format a paragraph as per your requirements. 

∑ Click  in the Style group to open the Style Gallery, shown in Fig. 3.78. 

Fig. 3.78 Creating a new style
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∑ Click Save Selection as a New Quick Style to display the Create New Style from Formatting 

dialog box. Type a name for your style and click OK to create the style. Word adds your style to 

Quick Styles.  

After you have created a new style, you may apply it on any paragraph in the document through the 

Quick Style gallery or the Styles pane. 
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4
MICROSOFT EXCEL

In this chapter, we will discuss the following topics:

Electronic Spreadsheet (Worksheet) �

Excel �

Organization of the Worksheet: Row, Column, Cell, Cell Address  �

and Active Cell 

Entering Information and Formula in a Worksheet �

Saving, Closing, Opening and Creating a Workbook �

Using a Template to Create a Workbook �

Aligning, Formatting and Editing Data �

Excel Functions �

Changing Column Width and Row Height �

Copying and Moving Data �

Conditional Formatting  �

Using Date and Time �

Hiding and Unhiding Columns and Rows �

Creating Charts and Sparklines �

Multiple Worksheets in a Workbook �

Printing Worksheet and Page Setup �

Header, Footer, Zoom and Naming Ranges �

Using Statistical, Math, Financial and Text Functions �

Using Goal Seek and the IF Function �

Sorting and Filtering Data and Database Functions �

Inserting Picture, Clip Art, Shapes, Smart Art, Screenshots,  �

WordArt, Text Box and Symbols

Format Painter, Find and Replace and Spelling Checking �

Protecting Workbooks �

Importing and Exporting Data �

Saving a Workbook as Template �

Excel Options �
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4.1 WHAT IS AN ELECTRONIC WORKSHEET

 OR SPREADSHEET? 

An electronic worksheet or spreadsheet program is used to perform calculations, store information 

in the memory of a computer and display the information or the results in the required format on 

your computer screen. The information entered in a worksheet can be changed very easily, and when 

any information is changed, the worksheet program automatically recalculates results on the basis of 

the new information. The worksheet program can also display the results in the form of charts. The 

information entered in the worksheet can also be printed. 

The application of a worksheet is limited only by your imagination. Some common applications 

of a spreadsheet are in the areas of budgets, annual reports, income statement, tax calculations, 

invoicing (billing), accounts payable and receivable, production and marketing analysis, investment 

and loan analysis, banking and other fi nancial services, tender evaluation, scientifi c calculations and 

cost-effective analysis. Using an electronic worksheet program to prepare a spreadsheet offers several 

advantages, such as 

� The results are accurate and quick.

� The worksheet can be quite big in size and any part of it can be viewed or edited.

� Data entered in a worksheet can be formatted in several ways to give it a professional look.

� Several mathematical, trigonometric, fi nancial and statistical functions are built-in. All sorts of 

complicated calculations can be performed using these functions, facilitating rapid operation.

� Data can also be viewed in the form of numerous types of charts (graphs). 

� The worksheet is saved in an electronic fi le, which can be retrieved and modifi ed later, if 

required. 

� An existing worksheet or any part of it can be merged with any existing or new worksheet. 

� With the electronic worksheet program, you can easily and quickly produce reports and get answers 

to ‘what-if’ questions. 

� The information stored in a worksheet can be transferred in full or part to other software programs, 

such as Word, Access, FoxPro, dBASE, MySQL, etc. Similarly, information stored in other 

software programs can also be transferred to a worksheet.

4.2 WHAT IS EXCEL? 

Excel is an integrated electronic worksheet (spreadsheet) application developed by Microsoft 

Corporation, USA for Windows operating system as well as Mac OS X. Excel supports all features 

mentioned in the previous section. A few other important features of Excel are:

� Includes hundreds of useful functions, including date- and time-related functions and database 

management. 

� Tools to create charts, sparklines and conditionally format data to visually analyze it. 

� Each workbook fi le can have multiple sheets and can be saved as a webpage or PDF fi le. 

� Includes feature, such as header, footer, and spelling checking.

� Table and Pivot table to analyze the entered data.

� Keyboard macros to automate tasks. 

� Selected or all data in the worksheet can be protected with password.
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Different versions of Excel, such as 3, 4, 5, 7, 97, 2000, 2002 (XP), 2007 and 2010 are available for 

use on the Windows operating system. The Excel program is also available for Apple Macintosh (Mac) 

computers. The basic features in all these versions are the same. In this book, we shall discuss important 

and commonly used features of Excel 2010 on Windows 7. Most of the discussion is applicable to all 

versions of Excel. If you use some other version of Excel, the screen displays that you get may differ 

slightly from those shown in the book, particularly if you use version 2003 or earlier as Excel has 

replaced the menu interface with the Ribbon interface since Excel 2007.

4.2.1 Starting Excel

Depending on how your PC is setup, you can start Excel in several ways: 

∑ If there is an icon for Excel on your desktop, double click that icon to start Excel. The Excel icon 

normally looks like .

∑ If the Excel icon is available on the taskbar or Quick Launch toolbar on your taskbar, you can start 

Excel by clicking that icon. 

∑ You may also start Excel from Windows menu. The Excel program may be located anywhere in 

the menu system. However, normally you will fi nd it in the Programs/All Programs submenu, 

Microsoft Offi ce or Microsoft Applications. On Windows 7, click the Start button on the taskbar, 

click All Program and Windows displays the list of programs installed on your computer. Click 

the Microsoft Offi ce folder in the programs list and click Microsoft Excel 2010, as illustrated in 

Fig. 4.1 to start Excel.

Fig. 4.1 Starting Microsoft Excel 



Microso   Excel    197 1 

On starting Excel, your screen displays the opening screen of Excel, similar to Fig. 4.2. Depending 

on the Excel version you are using and how it is set up on your PC, your opening screen may look 

different from Fig. 4.2. 

Fig. 4.2 Excel opening screen

When you start Excel, it automatically creates a new workbook—Book1. Notice that the name 

of the program (Microsoft Excel) and the workbook (Book1) are displayed in the title bar of the 

window. On the right side of the title bar, you fi nd the familiar Minimize, Maximize/Restore and Close 

buttons to minimize, maximize/restore and close the Excel application window, respectively. A similar 

set of minimize, maximize/restore and close buttons below the Excel application window are for the 

workbook window.

Excel displays the Quick Access toolbar on the left end of the title bar, which contains icons for the 

most commonly used commands and tools, e.g., Save, Undo and Redo changes. Below the title bar, 

you fi nd the familiar ribbon which has various tabs, such as File, Home, Insert, Page Layout, Formulas, 

Data, Review, View, Add-Ins, etc. The ribbon interface in Excel works exactly like in other Microsoft 

Offi ce 2010 program. If you are not familiar with the ribbon interface, please refer to Section 3.2. Also, 

to learn how to customise the Quick Access toolbar or the Ribbon, refer to Section 3.49.

The bar below the ribbon is called the formula bar. Excel uses the formula bar to display information, 

such as the address of the active (current) cell, contents or the formula entered in the current cell, etc. 

We will format the cell in a moment. 

The area below the formula bar that occupies most part of the Excel window is called the workspace 

or worksheet area. This area is used to enter information (data) in your worksheet. You also enter 

formulas here and Excel displays the calculated results in place of formulas. You also use this area to 

displays charts. 

The workspace area is a grid of rows and columns. It has a border on the top and on the left. 

This border is called the worksheet frame. Notice that there are column letters A, B, C, etc., and row 
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numbers 1, 2, 3, etc., in the worksheet border. The letters along the top border designate columns and 

the numbers along the side border designate rows. 

At the bottom left of the worksheet frame, you fi nd the sheets tab, which contains a few tabs, marked 

sheet1, sheet2, sheet3, etc. In fact, each workbook fi le contains a number of sheets. By default, Excel 

includes three sheets in the new workbook, though you can add additional worksheets, if required, with 

ease. Most of the simple worksheet tasks are generally confi ned to a single sheet and multiple sheets 

are used only in complex worksheets. On the right of the sheets tab and the right side of the worksheet 

area are located the scroll bars.

The last line of the Excel screen is called the status bar. Excel uses the status bar to display useful 

information, such as the status of the operation in progress, e.g., opening or saving a fi le. The status 

bar can also show the status of keys, such as Caps Lock, Scroll Lock, Ins and Num Lock. It also has 

controls to change the worksheet view as well as the zoom level. 

∑ The status bar is customizable—right click anywhere on the status bar to display a context menu 

and click to choose the controls you want to display.

Note  In Excel, the document (fi le) in which you enter data is called the workbook. The sheets within a 

workbook are called worksheets. That is, you enter data in one or more worksheets of a workbook. 

4.2.2 Organization of the Worksheet Area 

The worksheet area (window) of the Excel window is the most important because all the data that 

you type, the results of calculations and charts (graphs) are displayed here. The organization of the 

worksheet area is discussed in this section.

Rows and Columns A worksheet is made up of rows and columns. Though the worksheet in

Fig. 4.3 is displaying 10 columns and 21 rows, the actual worksheet size is signifi cantly larger than this. 

An Excel 2010 worksheet can have up to 16,384 columns and over a million rows. 

Row numbering in Excel is straightforward. The fi rst row is called row 1, the second row is called 

row 2, the fi fth row is called row 5 and the hundredth row is called row 100 and so on. The fi rst 26 

columns are referred to by letters A through Z. The 27th column is called row AA, the 28th column 

AB, and so on. 

Note  Excel can also refer to columns by numbers, however, normally, this numbering scheme is not used. 

Cell and Cell Address The area formed by the intersection of a row and column is called a cell. 

As shown in Fig. 4.3, the intersection of column E and row 11 forms a cell. The cell is the smallest unit 

in the worksheet that is used to store data. A cell is referred to by its column-row number. For instance, 

in Fig. 4.3, the cell in the top left corner of the worksheet which is also the active (current) cell is 

referred to by ‘A1’. Similarly, the cell below cell A1 is called A2. The cell formed by the intersection 

of column E and row 11 (see Fig. 4.3) is referred to as E11. ‘E11’ is also the address of that cell. Each 

cell in the worksheet has a unique address. The cell address is very important in the worksheet as it is 

used in formulas to refer to a particular cell.

Active Cell In a worksheet, there is a thick border around one of the cells. In Fig. 4.3, cell A1 has 

a border around it. This cell is called the active or current cell. Any data that you type is stored in the 

active cell. You can make any cell of the worksheet active by using the mouse or the keyboard. Notice 

that Excel displays the address of the active cell in the Name Box located at the left, just above the 

worksheet frame (See Fig. 4.3.). 
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Fig. 4.3 Components of a worksheet

∑ When you click the mouse on any cell in the worksheet, Excel makes that cell active and shows a 

border around it. Only one cell can be active at a time, therefore, previous active cell returns to the 

normal state.

∑ If you want to make a cell active which is currently not visible in the worksheet area, use the scroll 

bar(s) to scroll the worksheet. You may either use the scroll buttons located at both ends of the 

scroll bars or the scroll box to scroll the worksheet. 

∑ When the desired cell is visible in the worksheet area, click the mouse on that cell to make it active. 

If your mouse has the scroll wheel, you may rotate this wheel to scroll the worksheet.

You can also move the active cell by using the keyboard. The commonly used active cell movement 

keys are shown in Fig. 4.4. 

Fig. 4.4 Active cell movement keys
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4.2.3 Entering Information in a Worksheet

Entering information in an Excel worksheet is simple. As you know, the information in a worksheet is 

entered in the active cell, therefore, fi rst you need to select or activate the cell where you want to enter 

the information. 

∑ Click the required cell or use keyboard keys to select the desired cell. 

∑ Type the required information and press the Enter key. 

∑ For instance, to enter “Profi t and Loss Statement” in cell A1, click cell A1, type Profi t and Loss 

Statement and press the Enter key.

When you start typing data in a cell, two changes take place—Excel changes ‘Ready’ in the status 

bar to ‘Enter’ and it displays the characters being typed in the formula bar. Excel also displays two 

additional buttons in the middle part of formula bar. The fi rst button (X) is called the Cancel button and 

the next button  is called the Confi rm or Enter button. 

∑ You may click  instead of the Enter key to confi rm the data in a cell. You may also press the 

Tab or arrow keys to confi rm the data in the cell and move the cell pointer to the next cell for data 

entry. 

You can enter two types of data in a worksheet—constant values and formulas. A constant value is 

a fi xed value which may be a number, e.g., 12, 5200, 90.50, etc., or text (also called label), e.g., Rajan, 

New Delhi, Profi t, etc. Once entered, these values remain fi xed and do not change, unless you edit the 

data in the cell. On the other hand, when you enter a formula in a cell, Excel calculates the result of that 

formula and displays the result in the cell. A formula may refer to one or more cells in the worksheet 

and its result changes when data in those cells change. 

When you enter data in a cell, Excel automatically fi nds out if the entry is the text or a number based 

on what you enter. Excel treats an entry numeric, if it includes only numeric characters (0 through 9) 

and any of the following special characters:

+ – ( ) , / $ % . E e

A few examples of numeric entries are 45660.23, 12,345, +456, – 45.4, 25%, $890 and (450). Based 

on whether the entered data is numeric or text, Excel applies a default formatting and alignment. We 

will discuss formatting and alignment in a moment. 

4.2.4 Entering a Formula

Consider the worksheet shown in Fig. 4.5 that displays the sum of sales fi gures for January and February 

in cell B3. To calculate the sum, you may take the help of a formula. A typical formula consists of one 

or more operands (data values), e.g., sales fi gures in Fig. 4.5. 

Fig. 4.5 Entering a formula in a worksheet
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A typical formula uses two or more operands and these are connected together by an operator, 

e.g., the formula “=40+20” uses two operands 40 and 20, and the “+” operator. Excel uses operators 

to determine what operation(s) it needs to perform on operands. The operand in a formula may be a 

constant value, cell address or a cell range address (group of cells). With reference to the worksheet 

shown in Fig. 4.5, the sales fi gure for January is entered in cell B1 and that for February in cell B2. 

Accordingly, the formula for the total sale is B1+B2. In Excel, to differentiate a formula from the 

normal text entry, the formula always starts with ‘=’. Thus, the complete formula is =B1+B2, which 

is entered in the cell B3 where we want to display the result. As illustrated in Fig. 4.5, while Excel 

displays the result in the corresponding cell, it displays the formula used in the calculation in the 

formula bar when the cell pointer is positioned in the corresponding cell. 

The cell address(es) in the formula can be typed in the upper or lower case letters; for instance, 

=B6–B4, =b6–b4 and =B6–b4 are the same. Besides typing the cell address in the formula, you can 

also click a cell, e.g., to type the formula “=B6–B4” in a cell, type =, click cell B6, type –, click B4 and 

then press Enter.

Note  If the cell displays the formula instead of the result, check if you forgot to type the ‘=’ sign in the 

beginning of the formula. Also, avoid typing space in the formula.

Arithmetic Operators in Formulas The formula used in cell B3 in Fig. 4.5 uses the arithmetic 

operator + (plus). You may use other arithmetic operators, such as – (minus), * (multiplication),

/ (division) and ^ (exponentiation) in the formula. The table shown in Fig. 4.6 lists arithmetic operators 

that you may use in Excel formulas, along with the order of precedence. 

Operator Operation
Precedence 

Number
Example Result

() Parentheses 1 =2+3*5 17

=(2+3)*5 25

+ or – Identifi es a number as positive 

or negative, e.g. +45, –A5

2 =-10 -10

% Percentage 3 =34% 0.34

^ Exponentiation 4 =2^3 8

=200%^2 4

* Multiplication 5 =5*2 10

=5*2^3 40

/ Division 5 =144/12 12

=144/12% 1200

+ Addition 6 =10+5 15

=100+50/5 110

– Subtraction 6 =10-5 5

=50-10/5 48

Fig. 4.6 Operators and order of precedence

If a formula involves more than one operator, Excel evaluates it using the order of precedence 

given in Fig. 4.6. However, this order can be overridden by enclosing an operation within parenthesis. 

For instance, consider the formula =2^2*3–5. Since ^ (exponentiation) has precedence over * 
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(multiplication) and subtraction (–), Excel fi rst calculates 2^2, i.e., 4. Since * has precedence over –, 

Excel fi rst multiplies 4 with 3 (i.e., 12) and then subtracts 5. Thus you get 12–5, i.e., 7 as the result. On 

the other hand, if you want Excel to fi rst subtract and then multiply (i.e., 22*(3–5)), the formula should 

be entered by using parenthesis, e.g., =2^2*(3–5).

Advantages of Using a Formula As soon as you change data in any cell involved in the 

formula, Excel immediately recalculates and displays the new result. The facility of changing fi gures in 

the worksheet and immediately viewing their effect on the worksheet is one of the most useful features 

of Excel. This is particularly useful when the worksheet contains a number of interrelated fi gures 

(formulas). It can help you to perform the ‘what-if’ analysis. For instance, in a budget worksheet, 

you can fi nd out how much the profi t increases if you increase the selling price by 10% or if the raw 

material cost decreases by 5%. You can do this quickly by just replacing the corresponding fi gures in 

the worksheet.

Comparison Operators To compare two cell values or results of expressions, Excel supports the 

standard comparison operators, such as = (equal), > (greater than), < (less than), <= (less than or equal 

to), >= (greater than or equal to), <> (not equal). An example of the use of the comparison operators 

in a formula is “=B2>B3”, which checks if the value in cell B2 is greater than B3, and displays True

or False. Normally, the comparison operators are used with the logical function IF, which is discussed 

in Section 4.37.

Text Concatenation Operator To concatenate two text expression, Excel supports the text 

concatenation operator &, e.g., if cell A1 contains “Raj” and cell A2 contains “Verma”, then the 

formula =A1 & A2 entered in cell D1 displays Raj Verma. 

Error Message When you enter a formula that Excel does not understand or you have used invalid 

data in the formula, it displays a suitable error message that may help you to fi x the error. All error 

messages begin with the # character. Here is a list of Excel formula errors. 

#### This error message is not an error in real sense. It indicates that the cell is not wide enough 

to display the cell contents. To fi x the error, simply widen the column. 

#DIV/0! This error message indicates that the formula is attempting to divide by zero. This could 

be due to a typing error or the denominator has somehow become zero as a result of some 

other formula in the worksheet. 

#VALUE! Excel displays this error message when the formula is referring to text data while it is 

expecting numeric data. For instance, =D1+D2 will result in #VALUE!, if D1 contains 

12 and D2 contains “XYZ”.

#NUM! Excel displays this error message when the formula refers to non-numeric data while it is 

expecting text data. 

#NAME? This message indicates that Excel does not recognize some part of the formula. It could 

be due to misspelled function name or undefi ned range name. 

#N/A Not Available. Excel may display this message when a function, e.g., VLOOKUP() 

cannot return any result. 

#NULL! Normally you get this error message when you forget to type a comma while specifying 

multiple cell/range addresses with some functions, e.g., =SUM(D1,D2 D3) 

#REF! Indicates that the cell reference used in the formula is invalid.

Besides, Excel displays the Circular Reference warning message when a formula entered in a cell 

refers to that cell address directly or indirectly. 
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4.3 SAVING A WORKBOOK 

To preserve the worksheet data for future use, you must save your worksheet (in fact the workbook) as 

a disk fi le in the hard disk, fl oppy disk or USB fl ash drive.

∑ To save the workbook, click , the Save button on the Quick Access toolbar located at the 

top left corner of the Excel window. Alternatively, press Ctrl+S, the shortcut keys for the Save 

operation.

On using the Save command, Excel displays the Save As dialog box shown in Fig. 4.7. The Save As 

dialog box enables you to assign a fi lename to the workbook. Besides the fi lename, you can also select 

the drive and the folder where you want to store this fi le. The fi lename that you want to assign to the 

document has to be typed in the fi lename box. When Excel displays this dialog box, it automatically 

enters a default name, such as Book1, Book2, etc., for the current workbook. Similarly, it also selects a 

default folder. While normally you would change the fi le name to a meaningful name, if you prefer, you 

can also select a folder for saving the workbook. The procedure to pick a desired folder is the same as that 

in any other Microsoft Offi ce or Windows application. For additional information, refer to Section 3.4.

Fig. 4.7 Save As dialog box

∑ After entering the fi lename in the File Name box and choosing the required folder, click the Save

button to save the fi le.

∑ By default, Excel saves the workbook fi les in the Excel 2010 format. However, if you need to save 

the fi le in some other format, e.g., Excel 97-2003, CSV (Comma Separated Variable) or PDF, click 

against the ‘Save As’ Type box to choose the required fi le type before clicking the Save button, as 

illustrated in Fig. 4.7.

4.4 CLOSING A WORKBOOK 

∑ After you have fi nished working on a workbook, if you want to close it, press Ctrl+W. An alternate 

way to close the fi le is by clicking Close in the Backstage view, which you can open by clicking 

the File tab.
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If you try to close a workbook that has unsaved changes, Excel prompts you to save the workbook 

before closing it. Of course, you can close the workbook without saving the changes, if you prefer. 

4.4.1 Closing the Excel Application

After fi nishing working on your workbook, if your wish to close the Excel application: 

∑ Click the File tab to display the backstage view and then click Close. Alternatively, press Alt+F4

keys or click the close button (X) located at the extreme right of the title bar to close Excel. 

∑ Another way to quit Excel is by clicking the Excel application button ( ) located at the top left 

corner of the Excel window to display the Application menu and then clicking Close. 

4.5 OPENING AN EXISTING WORKBOOK FILE 

Excel can help you to open an existing workbook with ease. If you want to open a workbook that you 

have edited recently, Excel can help you to open it through the Backstage view. 

∑ Click the File tab to display the Backstage view and then click Recent in the left pane. 

Excel displays a list of recent workbooks in the middle pane shown in Fig. 4.8. 

Fig. 4.8 Opening a workbook in Backstage view

∑ If the workbook you want to open is listed in the Recent Documents box, you may click to open it. 

Excel can also display the list of recent workbooks in the left pane below Close in the left pane if 

the “Quickly access this number of Recent Workbooks” checkbox in the middle pane is checked. 

∑ If the workbook you want to open is listed in the Backstage view, click to open it, otherwise, click 

Open to display the Open dialog box shown in Fig. 4.9. 

Tip You can press Ctrl+O to display the Open dialog box from any tab. 

The fi lenames displayed in the list box are only from the selected folder. For instance, in Fig. 4.9, the 

Open dialog box is displaying workbook fi les from the Documents Library folder. 
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Fig. 4.9 Opening a workbook in the Open dialog box

∑ To display fi les available in other folders, you need to open the desired folder. To open any folder 

that is displayed in the Open dialog box, double click it. For example, in Fig. 4.8, you may double 

click GardenTools to display workbooks available in this folder.

∑ Similarly, click the icon displayed in the left pane to display fi les in that location/folder, e.g., click 

Desktop to display workbooks available on your desktop. 

∑ To open any workbook whose fi lename is displayed in the Open dialog box, double click the 

fi lename or type the fi lename in the File Name box and click the Open button. 

4.5.1 Workbook Opening Options

Excel can help you to open a workbook in a few different modes. You may choose these options by 

clicking the down-arrow on the right side of the Open button, as illustrated in Fig. 4.9. The Open Read-

Only mode opens the workbook and allows you to modify it; however, you cannot write the changes 

back to the original workbook. The Open as Copy option makes a copy of the workbook and opens the 

copy for editing. The Open and Repair is used in some rare situations when a workbook has become 

corrupted and can’t be opened in the regular way.

4.5.2 Opening Workbooks from Earlier Versions of Excel/Other Programs

Excel can open workbook fi les created in earlier versions of Excel as well those created by other 

programs. While it seamlessly opens workbooks created in earlier versions of Excel, to open fi les 

created in other programs, click All Excel Files (see Fig. 4.9) and choose the corresponding fi le type to 

display the matching fi lenames. Then click the fi lename to open it. 

4.6 CREATING A NEW WORKBOOK 

∑ To create a new document, either press Ctrl+N keys or click the File tab to open the Backstage 

view and click New. 
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On pressing Ctrl+N, Excel immediately creates a new workbook and assigns it a temporary name, such 

as Book2, Book3, etc. This workbook, based on the Normal template, is similar to the blank workbook 

Excel creates when it starts. However, if you click New in the Backstage view, Excel displays the list of 

templates in the middle pane and the preview of the selected template and a Create button in the right 

pane, as shown in Fig. 4.10. 

Fig. 4.10 Creating a new workbook

The Available Templates box displays the templates available for use. A template is a special kind 

of workbook with predefi ned page layout and formatting. Optionally, it may also contain data. In 

other words, a template performs like a framework around which Excel creates a workbook. For 

instance, a Billing Statement template may already contain the name, address and phone number of 

the company. The Excel templates are available under various categories, such as Blank Workbook, 

Sample Templates, Agendas, Budgets, etc. In addition, you may search for professional templates at 

Offi ce.com, Microsoft’s online resources and download these to your computer. 

By default, Excel selects the Blank Workbook template. If you click the Create button while Blank 

Template is selected, it creates a blank workbook based on the normal template. When Excel is installed, 

it automatically installs a few templates. 

∑ Click Sample Templates to display the list of sample templates available in your PC. (See

Fig. 4.11.) 

∑ On clicking a template in the middle pane, Word displays its preview in the right pane. Click the 

Create button in the right pane to create the workbook. Figure 4.12 displays a worksheet created 

using the Billing Statement template.

After you create a worksheet based on a template, you can enter data and change its formatting as 

per your requirements. Advanced user can customise a template or save an existing workbook as a 

template. 
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Fig. 4.11 Templates available under the Sample Templates category

Fig. 4.12 A worksheet created using the Billing Statement template
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4.7 ALIGNING DATA IN CELLS 

When you enter data in a worksheet, by default Excel left aligns the text entries and right aligns the 

numeric entries. To change the alignment of data in cells, you can use the alignment controls available 

in the Alignment group on the Home tab, as shown in Fig. 4.13.

Fig. 4.13 Alignment controls on the Alignment group on the Home tab

As illustrated in Fig. 4.13, the fi rst three controls in the lower row in the Alignment group are used to 

align the cell data left, centre and right, respectively. For example, to right align “Total” in cell A5, click 

cell A5 and then click . Similarly, you can use Center Text to center contents of the current cell or 

the selected cells. If you want to indent the text in a cell, use Increase Indent, and to reduce the indent, 

click Decrease Indent. 

Besides changing the horizontal alignment, you can also change the vertical alignment of the cell 

contents. By default, Excel vertically aligns data to the bottom of the cell. Notice that the Bottom Align 

( ) is highlighted in Fig. 4.13. When you use different font size characters in various cells in a row, 

you may use Middle Align ( ) to center the text between top and bottom border of the cell, or Top 

Align ( ) to vertically align text to the top of the cell. 

The Format Cells dialog box provides an alternate way to control the alignment of data in the cell. 

You can open this dialog box by clicking the Dialog Box Launcher located at the bottom right of the 

Alignment group. (See Fig. 4.13.) The Format Cells dialog box may be used to control all aspects of 

the cell formatting, including alignment of data in cells. Figure 4.14 displays the Alignment tab of the 

Format Cells dialog box.

∑ To change the horizontal alignment of text for the current or selected range of cells, click the 

Horizontal drop-down list box and choose the desired alignment. 

The Vertical drop-down list box controls the vertical alignment of data in a row. Wrap Text is a useful 

option that displays long text that cannot fi t in the cell as multi-line text; it automatically increases the 

row height as required. Another useful formatting option available in the Format Cells dialog box is 

the orientation of text in a cell. This option can help you to display text at an angle, e.g., at 45 or 90 

degrees, as illustrated in Fig. 4.15. 
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Fig. 4.14 Format Cells dialog box

Fig. 4.15 Changing the orientation of text in cells

∑ To change the orientation of text, either drag the Text Pointer or directly type the desired angle 

in the Degrees box. An alternate way to select the text orientation is by clicking the Orientation

( ) in the Alignment group and then click the desired orientation options from the menu, as 

illustrated in Fig. 4.15.

4.8 FORMATTING DATA IN CELLS 

To give a profession look to your worksheets, you may format the cell data in several ways. For instance, 

you can change the font and font size, apply text styles, such as bold, italic and underline, text colour 

and background color, etc. You can change the formatting of cells using individual commands or apply 

one of the several built-in styles. First, let us learn to use the individual commands and then we will 

learn to apply the built-in styles. You can format the data in a cell or range of cells. 
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∑ To format a single cell, you need to make it active by either clicking that cells or using keyboard. 

∑ If you want to select multiple cells, i.e., range of cell, also known as range, drag the mouse to 

select the desired cells. If you want to use keyboard to select the range, press and hold the Shift 

key and then press the arrow keys. 

After selecting a cell or the range, you can apply any formatting command on the text in the selection. 

4.8.1 Bold, Italic and Underline Styles

∑ To apply the bold, italic and underline styles on the selected range, click the corresponding controls 

in the Font group on the Home tab, as illustrated in Fig. 4.16. 

Fig. 4.16 Formatting cell data

The lower part of the Font group has controls to apply bold, italic and underline styles. The use of these 

controls is similar to that in the Microsoft Word. You may apply more than one style on the data. 

∑ To remove an applied style, click the corresponding button again. You may also use the standard 

keyboard shortcuts to apply these styles, e.g., Ctrl+B for bold, Ctrl+I for italic and Ctrl+U for 

underline. 

4.8.2 Changing the Font Size

When you type text in the cells of a worksheet, all characters are of a pre-defi ned size. In Excel, the 

character (font) size (in fact height) is specifi ed in points. (72 points equal 1 inch.) The typical character 

size used in Excel is from 8 to 12. Excel displays the size of the characters for the data entered in the 

current cell in the Font size box in the Font group. In Fig. 4.16, ‘11’ displayed in the Font Size box 

indicates that the font size for the characters in the current cell is 11.

∑ To change the size of characters for a cell, make that cell active and click the down-pointed arrow 

located on the side of the Font Size box and choose the desired font size. You may also directly 

type the required font size in the Font Size box. 

∑ To select the next font size, click Increase Font Size located next to the Font Size box. (See Fig. 

4.16.) Similarly, you can click Decrease Font Size to decrease the font size by one. 
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4.8.3 Changing Font 

Font refers to the shape or typeface of characters. The same character can be printed in different shapes 

and styles and each particular shape and style of the character set is given a font name, such as Times 

New Roman, Arial, Courier, Letter Gothic, etc. You can show the text in a cell in any font available in 

Windows in your PC. Excel displays the Font used on the data in the active cell in the Font group on 

the Home tab, as shown in Fig. 4.16.

∑ To apply a new font on the current or selected cells, click the drop-down arrow on the right side 

of the Font Name box to display the list of available fonts in a Font dropdown box, as shown in

Fig. 4.17.

∑ When you hover the mouse on a font in the list, Excel displays a preview of the font on the selected 

range. To apply a font on the selected cell(s), click the corresponding font name in the Font drop-

down list.

Fig. 4.17 Changing font

4.8.4 Changing Font Color and Cell Fill Color

By default, Excel displays the text in the cell in black color against white background, however, you 

can change the text color (Font Color) and background (Cell Fill Color). 

∑ To change the color of the text in the selected cell(s), you may use the Font Color button, which 

looks like . On clicking the Font Color button, Excel applies the color of the thick underline 

on the button on the selected text. 

∑ To choose a different color, click the down pointing arrow on the right of the button, and Excel 

displays a Color Palette to choose the color. 

∑ To change the cell background for the selected cell(s), click the down pointing arrow to the right 

of the  (Fill Color) to display a Color Palette as illustrated in Fig. 4.18. Now click the desired 

color for the cell background. To remove the applied background color, click No Fill. 
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Fig. 4.18 Applying background color to cells

Note  You may also change style, font, font size, font color, fi ll color and other cell formatting options 

through the Format Cells dialog box. To open this dialog box, click Dialog Box Launcher located at 

the bottom right corner of the Font group on the Home tab.

4.8.5 Formatting Cells using the Mini Toolbar

The Mini toolbar provides a convenient place to fi nd commonly used formatting commands. 

∑ To display the Mini toolbar, select some text in a cell or right click the cell, cells or other objects. 

∑ The Mini toolbar with common formatting controls, such as Bold, Italic, Font, Font Size, Font 

Color, Border, Increase Decimal, Decrease Decimal, Currency Format, Percentage Style, etc., is 

shown in Fig. 4.19. Click the corresponding control to apply it on the current or selected cells or 

object.

Fig. 4.19 Worksheet displaying a Mini toolbar
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Notice that when you right click, besides displaying the Mini toolbar, it also displays a context menu 

which contains a number of useful commands. We will discuss some of these commands later in this 

chapter.

4.8.6 Formatting Cells using Built-in Styles

Excel has several predesigned built-in styles that you can apply on a cell or range of cells to quickly 

give beautiful look to your worksheet. After you have selected the cells you want to format using the 

built-in styles, follow these steps: 

∑ Click  in the Styles group on the Home tab and Excel displays the Styles gallery, as 

shown in Fig. 4.20.

Fig. 4.20 Applying built-in styles on cells

∑ Hover the mouse on a style to preview it on the selected cells(s) or click to apply it on the selected 

cell(s).

Note  While normally you format cell or range after you have typed data, however, you may format a range 

before you type any data. In that case, when you type data in that range, the data would appear in 

the applied format. 

4.8.7 Formatting Cells as Table

Excel can help you to quickly format a range of cells and quickly convert it into a professional looking 

table. Excel has several predefi ned table styles that you can apply on the table data entered in a 

worksheet. Have a look at the two tables shown in Fig. 4.21; the second table has been formatted using 

Excel’s predefi ned table style. 

∑ To apply the table style, click any cell in the table range, e.g., cell B4 in the sample worksheet 

shown in Fig. 4.21 and then click . 

∑ Excel displays a gallery containing various table styles you can apply. Click any style and Excel 

selects the data for the table and displays the Format As Table dialog box as shown in Fig. 4.22. 

∑ Click OK to confi rm the data for the table and Excel applies the table style on the data. 

∑ Excel displays the Table Tools tab on the Ribbon which includes the Table Styles gallery. You 

can hover your mouse on any style to preview its effect on the table or click to apply.
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Fig. 4.21 A table formatted using a predefi ned table style

Fig. 4.22 Format As Table dialog box

Notice the arrows located in the header columns of the table. These may be used to fi lter the data in the 

table. Filtering is discussed in Section 4.39. 

∑ If you want to insert a blank table in your worksheet, click the Insert tab, click Table in the Tables 

group and then drag mouse to defi ne the table range. 

∑ To insert/delete rows or columns in the table, click the arrow to the right of Insert and Delete in 

the Cells group on the Home tab (See Fig. 4.21) and choose the corresponding command. 

4.9 FORMATTING NUMBERS 

Excel allows the numbers entered in the worksheet or numeric results of formulas to be formatted 

in several different ways. For example, you can show 123456.23 entered in a cell as 123,456.23, 

$123,456.23, 123,456.2, `123,456.23, Rs123,456, etc., by applying suitable formats on the cell. For 

applying commonly used formats, Excel has the corresponding buttons in the Number group on the 

Home group on the Ribbon. For applying other formats, you may use the Format Cells dialog box. 

∑ Assuming that the current cell contains 123456.23, if you click  (Comma Style) in the Number 

group on the Home tab, Excel modifi es the display to insert a comma at the thousand, million, 

billion positions in the number. By default, Excel follows the American way of writing numbers.) 
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Accordingly, you would see 123,456.23 in the cell. However, if you have selected English (India), 

Hindi (India) or a similar format in Windows’ Region and Language, you may see 1,23,356.23 

instead of 123,456.23.

Note  If you see “#####” in the cell instead of the number, increase the column width. See Section 4.12 

for more information.

∑ To decrease the number of decimal digits displayed in a number, click , (Decrease Decimal) 

in the Number group. Similarly, click  (Increase Decimal) to increase the number of decimal 

digits in a displayed number. 

Besides applying the numeric format on a single cell, you may also apply it on a range that may include 

any number of cells—just select the required range prior to clicking the numeric format button. 

4.9.1 Selecting Indian Format

If you have not already selected Indian format in Windows’ Region and Language, you may like to 

select it as it would result in Excel (and other Microsoft Offi ce applications) to use Indian way of 

grouping digits in numbers, ` as the currency and display dates in Indian format. 

∑ Click the Start button on the taskbar to open the Start menu and then click Control Panel to 

display the Control Panel window.

∑ Click Change Keyboards or other input methods/Region and Language and Windows displays 

Region and Language dialog box as shown in Fig. 4.23. Click the Format tab if required. 

Fig. 4.23 Choosing format for displaying numbers, currency and dates

∑ Click the Format control to display the language format list and click English (India). 

∑ Click the Apply button and then click OK to close the Region and Language dialog box. 
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4.9.2 Applying the Currency Format

The currency format prefi xes or suffi xes the currency symbol to the numeric data. For instance, it can 

display 123456.34 as `1,23,456.23, Rs 123,456.34 or $123,456.34. The currency format is the comma 

format plus the currency symbol. 

∑ To apply the currency format on a range, select the range and then click the Accounting Number 

Format button located in the Number group on the Home tab. This button looks like  or

.

∑ While the Accounting Number Format button applies the default currency symbol, if you want to 

choose a different currency symbol, e.g., €, £ or ¥, click the arrow button on the right side of the 

button and click the desired symbol. 

Another way to apply the currency format and/or to change the currency symbol is through the 

Format Cells dialog box, which you may open by clicking the dialog box launcher button located at the 

bottom-right corner of the Number group on the Home tab. 

4.9.3 Displaying Negative Numbers

By default, Excel displays negative numbers in regular format, -245. However, many accounting 

programs display negative numbers in red color or within parentheses (245). Excel offers a few choices 

to display negative numbers. 

∑ Select the cell or the range that you want to format. Then click Dialog Box Launcher located at 

the bottom right corner of the Number group on the Home tab to display the Format Cells dialog 

box.

∑ Click the Number tab in the Format Cells dialog box, click Number in the Category list to display 

options for displaying negative numbers. Now click the desired format for negative numbers, as 

illustrated in Fig. 4.24. The custom category may be used to defi ne and apply custom fromats.

Fig. 4.24 Customizing the appearance of negative numbers
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4.9.4 Fixed Number of Decimal Places

In this format, Excel always displays a fi xed number of decimal places with the number. For instance, 

you can format a range to display 2 decimal digits. In that case, if you enter a number in that range 

without decimal digits or with only one decimal digit, Excel automatically adds the required number of 

decimal digits to show the number with two decimal digits. If you enter a number with more decimal 

digits, Excel rounds off the number. This is illustrated in Table 4.1.

Table 4.1 Numbers with more decimal numbers

NUMBER ENTERED DECIMAL DIGITS USED DISPLAYED IN CELL AS

31545 2 31545.00

5.1 2 5.10

23.346 2 23.35

–23.4 2 –23.40

0.15 4 0.1500

∑ To display fi xed number of decimal places for the selected range, open the Format Cells dialog box 

and click Number in the Category list. (See Fig. 4.24). 

∑ Choose the desired number of decimal places in the Decimal Places box and click OK. 

4.9.5 Percentage Style 

The Percentage style displays the value of the cell as percentage and suffi xes the percentage sign (%) 

after the number. Some examples of this style are given in Table 4.2.

Table 4.2 Percentage style 

NUMBER ENTERED DECIMAL DIGITS USED DISPLAYED IN CELL AS

0.15 0 15%

0.23 2 23.00%

–0.1255 2 –12.55%

∑ To format a cell in the Percentage style, select the cell click  in the Number group on the 

Home tab. Alternatively, you can directly type the number in the percentage style in the cell. For 

example, to show ‘12%’ in a cell, you can type 12% in the cell.

4.9.6 Scientifi c Style

The Scientifi c style is used to display very small or large numbers. With this format, Excel displays 

numbers in scientifi c notation. For instance, 100000 may be displayed as 1.00E+05 and 0.000067 as 

6.70E–05. 

∑ To apply Scientifi c style on the selected cell/range, click the down pointing arrow to the right 

of the Number Format list box to display the list of formats and click Scientifi c, as illustrated in

Fig. 4.25.
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Fig. 4.25 Applying Scientifi c format

4.10 EDITING DATA IN A CELL 

While creating a worksheet, you often need to edit data in a cell. There are two ways to edit data in 

cell—you can edit the data in the cell or in the formula bar. 

∑ To edit data in a cell, double click the cell that contains data you want to edit. If the cell you want 

edit is the active, you may press F2 to put in the edit mode. Excel displays the cursor in the cell. 

Now you may use the usual editing keys, such as Del, Backspace and arrow keys to move cursor 

and edit data in the cell. 

∑ You can edit the contents of the active cell in the Formula Bar; click in the Formula bar and edit 

data in the usual way, as illustrated in Fig. 4.26. 

Fig. 4.26 Editing data in a cell

∑ After you have modifi ed the data in the cell or Formula, press Enter to confi rm changes or press 

Esc to cancel editing changes.
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4.10.1 Replacing or Deleting Data in a Cell

∑ To replace the data in a cell with entirely new data, make that cell active, type the new data and 

press Enter. 

∑ If you need to delete data entered in a cell, make the cell active and press the Del key.

4.10.2 Undoing and Redoing Actions

Sometimes, after editing data in a cell or after making some other change in the worksheet, you realize 

that you have made a mistake and you want to go back to the previous stage. 

∑ To undo the last action, click  on the Quick Access toolbar or press Ctrl+Z. 

∑ To undo several actions in one go, click the arrow to the right of  and Excel displays a list of 

actions it can undo. Now click an action in the list and Excel will undo all actions up to the clicked 

action. 

∑ You can even undo your undo actions. To do so, click  on the Quick Access toolbar or press 

Ctrl+Y. 

4.11 EXCEL FUNCTIONS 

Consider a case when you need to add the monthly sales fi gures for 12 months to arrive at the sales 

fi gures for the entire year. Assuming that these fi gures are entered in consecutive columns starting from 

cell B6, you may use the following formula:

 =B6+C6+D6+E6+F6+G6+H6+I6+J6+K6+L6+M6

Typing a formula involving so many cells becomes diffi cult and error-prone. In such cases, you can use 

the built-in functions of Excel, e.g., SUM may be used to add numbers entered in a range of cells. An 

Excel function is a built-in formula to perform a predefi ned calculation or returns a predefi ned value, 

e.g., the current date or the mathematical constant pi. Excel functions can perform several complex 

tasks, as you will see in the later part of the chapter. Most functions operate on a group (range) of 

cells. 

4.11.1 What is a Range?

In Excel, a range is a rectangular area of cells in the worksheet. A range may include just a single cell, 

a number of consecutive cells in a row or column, or cells from consecutive rows and columns. A range 

may include cells from multiple rows and columns; however it must form a rectangle in order to be 

valid. 

In Excel, a range is defi ned by specifying its fi rst and the last cell. For example, in Fig. 4.27, the 

range that contains cost fi gures for January – April is from cell B4 through E4. In Excel, this is specifi ed 

as B4:E4, B4.E4 or B4..E4. When a range includes multiple columns and rows, the opposite corner 

cells are used to specify it. 

4.11.2 Using a Range with SUM

The SUM is a built-in function that calculates the sum of a range of numbers. With reference to

Fig. 4.27, here are the steps to calculate the sum of cost fi gures entered in the range B4:E4 in cell F4:

∑ Click cell F4, type the formula =SUM(B4:E4) and press Enter. Notice that as you start typing the 

characters after typing “=”, Excel may display a list of functions matching the entered characters 
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if the AutoComplete option is on. You may double click a function name to ask Excel to enter it

for you. 

Excel displays the result in cell F4, while the formula bar displays the formula used in the calculation. 

4.11.3 Specifying a Range by Mouse

Instead of typing the actual range address (e.g., B4:E4 in the previous example), you can specify it 

with mouse. Assuming that we want to calculate the sum of cost fi gures in cell F4, we need to perform 

these steps: 

∑ Click cell F4 and type =SUM( 

∑ Now click the starting cell of the range, i.e., B4 and drag the mouse to cell E4. Notice that as we 

drag the mouse, Excel highlights the range and displays it with the SUM function, as illustrated in 

Fig. 4.27. 

Fig. 4.27 Selecting a range for SUM by dragging the mouse

∑ Ensure that the highlighted range includes the correct range. If required adjust the range by 

dragging the mouse to the correct range and then press Enter, and Excel displays the result of the 

SUM function in the cell. 

4.11.4 Using the AutoSum Button 

Since the SUM function is frequently used in worksheets, Excel includes  (AutoSum) in the 

Editing group on the Home tab. (See Fig. 4.27.) 

∑ After selecting a cell and pressing , Excel automatically determines and highlights a range for 

the SUM function. If the range selected by Excel is what you want to use, just press Enter to get 

the result.

∑ If you want to use a range different from that suggested by Excel, click the mouse in the starting 

cell of the desired range and then drag the mouse to select the range. Finally, press Enter to display 

the result. 

Note  If you want to fi nd minimum, maximum, average, count of values in a range, click the arrow on   

and choose the corresponding function. Excel contains hundreds of built-in functions. We would 

discuss additional commonly used functions later.
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4.12 CHANGING COLUMN WIDTH AND ROW HEIGHT 

When you enter a text entry in a cell which is wider than the cell width, Excel can display only partial 

data in the cell. If the cell in the next column is empty, Excel allows the cell to borrow the space from 

the next cell to display the remaining text. However, if the next cell is not empty, Excel cannot borrow 

space from the next cell, therefore, it ends up displaying only partial data in the cell. While displaying 

numeric data or dates (to be discussed), if the column width is not suffi cient to display the complete 

data, Excel displays “####” in the cell instead of displaying partial data. When Excel truncates the cell 

contents or displays “####” in the worksheet, it only affects the display of the worksheet. The actual 

data stored in the cell is not changed. If you increase the column width or reduce the font size, Excel 

displays the complete cell contents. 

While changing the column width, ensure that the cell pointer is positioned somewhere in that 

column. That is, some cell in the column should be active. In Excel, you can change the column width 

in many ways. 

∑ To change the column width using the menu, click the Format button in the Cells group on the 

Home tab to display the menu, as shown in Fig. 4.28.

Fig. 4.28 Changing column width

∑ Click Column Width and Excel displays the Column Width dialog box 

shown here. 

The Column Width dialog box displays the current width of the column. The 

default width of every column in a new worksheet is 8.43 as shown in the Column 

Width dialog box. 

∑ To change the column width, enter the new value and press the Enter key.

4.12.1 Using Mouse to Change Column Width

∑ With reference to Fig. 4.28, to change the width of column A, move the mouse pointer to the 

vertical border line between column A and B in the column border until the shape of the mouse 

pointer changes to a thick vertical line with a double-headed arrow like . 
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∑ While the shape of the mouse pointer is like the double headed arrow with a thick vertical line, 

drag the mouse pointer left or right to change the column width. As you drag the mouse pointer, a 

vertical line moves on the worksheet and Excel also displays the new width in a small box (called 

the ToolTip box) above the column border. When the vertical line is positioned at the desired 

column width, release the mouse button and Excel applies the new width to the worksheet.

4.12.2 Changing Width for All Columns

∑ To change the width for all columns of the worksheet, click the Format

button to display a menu (see Fig. 4.28) and then click Default Width. Excel 

displays the following Standard Width dialog box.

∑ Now, type the desired width in the Standard Width dialog box and click OK.

You can use any integer or decimal number from 0 through 255 and Excel applies the new width to all 

columns except those columns whose width you have previously changed. 

4.12.3 Changing Column Width for a Range of Columns

Excel can also help you to change the width for a range of columns, e.g., columns B through E. To do 

this, fi rst you need to select the required column range. 

∑ To select a range of columns, click and hold the mouse button on the fi rst column name in the 

column border and then drag the mouse on the column border to select the desired range of columns. 

As you drag the mouse, Excel selects and highlights the desired columns range, as shown in

Fig. 4.29. Now you may change the width of all selected columns by dragging the column border 

or through the Column Width dialog box. 

Fig. 4.29 Selecting a range of columns

Note  If you need to select non-adjacent columns, click the mouse on a column letter in the columns border 

to select the fi rst column. Then Ctrl+Click one column at a time to select additional columns. 

4.12.4 Changing Row Height

When you change the font size of data entered in a cell, Excel automatically changes the row height. 

However, if you want to manually change the row height, use the Row Height command from the Format 
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menu (See Fig. 4.28) and specify the desired row height in the Row Height dialog box displayed by 

Excel. Alternatively, drag the bottom row border line between with mouse, as illustrated in Fig. 4.29.

4.12.5 Selecting the Best Fit Row Height and Column Width 

∑ If you want to automatically adjust the column width for the current column so that it can 

accommodate the widest cell entry in that column, click Format in the Cells group on the Home 

tab to display the Format menu and click AutoFit Column Width.

∑ Similarly, click AutoFit Row Height in the Format menu so that it can accommodate the tallest 

character in the row.

If you select a range of columns and rows before using these commands, Excel applies these commands 

on the selected range. 

4.13 FILLING CELLS BY EXTENDING A RANGE 

It is often required to enter names of months, days of the week, or other series in the worksheet. 

Consider the worksheet shown in Fig. 4.30 which contains a few series. You can create such series by 

typing data in the initial cell(s) and extend the series by dragging the Fill handle. 

∑ Select the range that contains the fi rst few values of a sequence, e.g., A6:B6 in Fig. 4.30. For 

month/day name, you need to type the only the fi rst value. 

∑ Move the mouse pointer over the bottom right corner of the range and the mouse pointer changes 

to a thick cross, called Fill Handle. Drag the mouse to extend the range. When you release the 

mouse, Excel fi lls data in the range.

Fig. 4.30 Extending a series

4.14 MOVING DATA 

When you initially create a worksheet, you may not consider all aspects. Therefore, many times, after 

creating the worksheet, you want to change the position of data in the worksheet. 
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4.14.1 Using the Mouse to Move Data

You can easily move data from one cell or a range of cells to anywhere in the worksheet with mouse. 

Here are the steps to move the contents of cell A1 to B1. 

∑ Click cell A1 to make it active. Move the mouse pointer to any part of the cell border except the 

bottom right corner. (Do not move the mouse inside the cell.) 

∑ While the mouse pointer is on the cell border, press and hold the mouse button. Excel displays the 

message in the status bar—‘Drag to move cell contents, use Alt key to switch sheets’. 

∑ Without releasing the mouse button, drag the mouse pointer to cell B1 and release the mouse 

button. Excel moves the cell contents from cell A1 to B1.

You can move contents of a range of cells in the same way. 

Note  If the shape of the mouse pointer does not change when you move the mouse on the cell border 

and you are unable to move the cell contents with mouse, ‘Cell drag and drop editing’ is disabled 

in your Excel program. To enable it, click the File tab to open the Backstage view, click Options, 

Advanced and click the Enable fi ll handle and cell drag-and-drop check box. Then click OK to 

close the Options dialog box. 

4.14.2 Using Cut and Paste Commands

You can move data using Cut and Paste with these step: 

∑ To move data from a single cell, click that cell. To move data from a range, drag mouse to select 

the range. 

∑ Click the scissors icon  in the Clipboard group of the Ribbon or press Ctrl+X keys to cut the 

selected text.

Excel does not remove the data from the source range, however, it displays fl ashing dotted lines in the 

border around the cut range. This is also called marqueeing (marking). Excel has put the cut data into 

the clipboard.

∑ To paste data, move the cell pointer to the starting cell of destination range and press Enter, press 

Ctrl+V or click  in the Clipboard group on the Home tab on the Ribbon. An alternate way to 

complete the paste operation is to right-click the destination cell to display a context menu and 

click  in the menu. 

Note  After cutting the text, if you don’t want to complete the paste operation, press Esc to remove 

margueeing from the source range. 

4.15 COPYING DATA TO ANOTHER AREA 

Excel can help you to copy data from one cell or range to another with Copy and Paste or using the 

mouse. To use the Copy and Paste technique:

∑ Select the desired cell or range and press Ctrl+C or click  in the Clipboard group of the 

Ribbon on the Home tab. 

∑ To paste the copied data, move the cell pointer to the starting cell of destination range and press 

Enter, press Ctrl+V or click  in the Clipboard group on the Home tab on the Ribbon. 
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To copy a range with the mouse:

∑ Select the range, press and hold the Ctrl key and then drag the range border to the desired 

destination. Excel copies the range when you release the mouse button.

4.15.1 Copying or Moving a Formula

When you copy or move a cell or range that contains a formula, Excel automatically adjusts the formula 

in the destination using relative addressing. For instance, consider the worksheet shown in Fig. 4.31. 

The formula used in cell E8 is =E6-(E4+E5). Now, if your copy cell E8 to F8, Excel puts =F6-(F4+F5) 

formula in cell F8. Notice that Excel has changed all reference to column E to column F while copying 

the formula. After copying or moving data containing formula to a new area, usually the copied formula 

continues to work correctly.

Fig. 4.31 Copying a formula

In Section 4.13, you learnt to extend a range by dragging the fi ll handle. You can follow the same 

technique to extend the formula. For instance, with reference to the worksheet shown in Fig. 4.31, if 

you need to enter the formula to calculate profi t for May through December in cells F8:M8, move the 

mouse pointer over the bottom right corner of cell E8 until it changes to Fill Handle and drag the mouse 

to extend the range. When you release the mouse, Excel fi lls the range with the formula. 

4.15.2 Absolute Cell Reference

As you know, when you copy or move a formula, Excel adjusts cell addresses used in the original 

formula as per the new location. Though this works in most cases, sometimes you may like to keep the 

cell address fi xed (absolute) when you copy a formula referring to that cell. Consider the worksheet 

shown in Fig. 4.32, where the charge for the fi rst guest is calculated based on the number of days the 

guest has stayed in the hotel available in column D multiplied by the per day room charge available 

in cell B6. The formula used to calculate the room charges in cell E9 is =D9*B6. If you copy cell 

E9 to E10, Excel would adjust the formula to =D10*B7, which will result in incorrect room charges 

calculation, as cell B7 is empty. In this situation, we need to keep reference to cell B6 in the formula 

=D9*B6 absolute, so that when this formula is copied, Excel does not change it. 

∑ To make cell reference in formula absolute, add a “$” sign before the row and column number, 

e.g., $B$6. In other word, the formula for room charges should be =D9*$B$6. 

Now, if this formula entered in cell E9 is copied to E9, Excel will put =D10*$B$6. 
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Fig. 4.32 The Hotel worksheet  

Tip While entering/editing a cell address in a formula, press F4 to make the cell reference absolute.

In some situations, you may need to use mixed cell reference, i.e., the column reference is absolute 

while the row reference is relative. In that case, use the $ sign with the row number but not column, 

e.g., $B6. Similarly, in cell address B$6, the column reference is relative while the row reference is 

absolute.

4.15.3 Paste Options

When you use the Paste button or Ctrl+V to paste cell contents, Excel copies everything, including cell 

formatting, comments and formula in cells, if any. Sometimes, you may like to copy only cell value 

(and not the formula). For instance, if you want to copy the value of last year’s profi t from a worksheet 

to a new worksheet, copying the formula will not work; instead, you need to copy the value (result). On 

the other hand, sometimes, you may like to link the data in the cell to the cell data you are coping from. 

On other occasions, you may just like to copy the formatting. To enable the user to control the paste 

operation, Excel displays various paste options when you click  located below the Paste button on 

the Home tab, as shown in Fig. 4.33. You can also view paste options in the context menu that you get 

on right clicking in a cell. Excel also displays the paste options on clicking the smart tag  Excel 

displays when you do the paste operation. The paste options are divided in the following sections.

Paste The options in the Paste section are used paste everything, formulas, formulas 

with number formatting, without borders, transpose rows and columns, etc. 

Paste Values The paste options in this section are used to paste values or values with 

formatting. 

Other Paste Options Use these options to paste formatting, picture or link the cells to data in the 

source cells. 

Paste Special Opens the Paste Special dialog box to enable you to choose the paste options.

When you hover the mouse over a paste option, Excel displays a live paste preview for the paste option, 

which may help you select the right option. 
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Fig. 4.33 Paste options 

4.16 INSERTING/DELETING ROWS, COLUMNS AND CELLS 

When you initially create a worksheet, you may not consider all aspects of the data to be entered in the 

worksheet. Later you may realize that you have missed out a row or column at a particular position. 

However, you can easily insert any number of rows or columns at any location in the worksheet. 

4.16.1 Inserting Rows and Columns

Consider the worksheet shown in Fig. 4.31. To insert a blank row at the top of the worksheet (i.e., 

before row 1): 

∑ Click the row number on the row border to select row 1, as illustrated in Fig. 4.31. Excel highlights 

the entire row 1.

∑ Click  in the Cells group on the Home tab and Excel inserts a row above the selected 

row.

If you need to insert multiple rows, drag mouse on the row border to select the number of rows you 

want to insert, and then click the Insert button. When Excel inserts row(s), it automatically adjusts cell 

reference used in the formula in the worksheet.

∑ The procedure to insert a column is similar to inserting a row. That is, click the column letter on 

the column border to select the column and then click Insert in the Cells group on the Home tab. 

In the same way, you can insert multiple columns. 

4.16.2 Deleting Rows and Columns

∑ The procedure to delete column(s)/row(s) is similar to inserting column(s)/row(s), except that after 

selecting the required column(s)/row(s), click Delete in the Cells group on the Home tab. 

Besides fi nding the Delete (and Insert) commands in Cells group, these commands are also available in 

the context menu that you get on right clicking the selected row(s) or column(s). 
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4.16.3 Shifting Cells

While normally we insert an entire row or column in the worksheet, 

however, sometimes, you may need to shift the entered data down or 

right, without inserting any row or column. To accomplish this: 

∑ Select the range that you want to shift down/right, right-click 

to display the menu and click Insert. Excel displays the Insert 

dialog box shown in Fig. 4.34.

∑ Click to change the shift cells option, if required and click OK. 

4.16.4 Erasing Part of a Worksheet

∑ To erase a part of the worksheet, select the range by dragging the mouse and press the Del key. If 

you end up deleting some data by mistake, press Ctrl+Z or the Undo button on the Quick Access 

toolbar to restore the data. 

The Del key deletes the contents of the range but retains formatting. If you want to delete the contents 

as well as formatting, click  in the Cells group to display a menu and click Clear All. 

Note  On deleting a row, column or a range, if you see ‘#REF!’ displayed in any cell of your worksheet, it 

indicates that you have deleted some cells that were being used in formulas. In that case, immediately 

use Undo. 

4.17 CENTERING ACROSS A RANGE (MERGE AND CENTER) 

When you create a workbook, you usually show the title centered at the top of the worksheet. For 

instance, ‘Profi t and Loss Statement’ is centered in the range A3:E3 in Fig. 4.35. Notice that the range 

A3:E3 has been merged and appears like a single cell with ‘Profi t and Loss Statement’ centered in it. 

∑ To merge and center data, select the range, e.g., A1:E1 and click  (Merge and Center) in the 

Alignment group on the Home tab. While merging data, enter data only in the fi rst cell.

Fig. 4.35 Centering across a range

Fig. 4.34 Shifting cells down 

or right
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4.18 DRAWING A BORDER AROUND CELLS 

To give beautiful look to your worksheet, you can draw a border around selected cells. You may draw 

the border around all or specifi ed sides of the cell. Figure 4.32 displays a few types of borders used in 

a worksheet. Here are the steps to draw a border:

∑ Select the cells you want to apply some type of border to. 

∑ Click the down arrow to the right of , the Borders button to display the border options, as 

shown in Fig. 4.36. 

∑ Click the desired border type to ask Excel to apply it on the selected range.

Fig. 4.36 Drawing a border

Notice that Excel displays last applied border style on the Border button. You can click  to apply 

the type of border displayed on the button on the current or the selected range. The lower sections of the 

border options contain commands to change the line colour, line style and to erase the border. 

4.19 CONDITIONAL FORMATTING 

When you use a formula in a cell, its result depends on the data it refers to. For instance, the monthly 

profi t displayed in cell B8 in Fig. 4.37 depends on data in cell B4, B5 and B6. Thus, the profi t value 

in cell B8 may be positive, zero or negative. To grab attention to the profi t fi gures, you can apply 

conditional formatting, so that:

 ® If the profi t is negative, Excel displays the cell value in dark red color with light red fi ll.

 ® If the profi t is up to 10,000, it displays the cell value in dark yellow with light yellow fi ll. 

 ® If the profi t is more than 10,000, it displays the cell value in dark green with light green fi ll. 
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∑ To apply conditional formatting, fi rst select the cell or cells you want the formatting to be applied 

to. Then click Conditional Formatting in the Styles group on the Home tab to display a menu 

containing the conditional formatting choices. 

∑ Click Highlight Cells Rules and Excel displays a submenu as shown in Fig. 4.37.

Fig. 4.37 Applying conditional formatting to cells

∑ Click the type of rule you want to apply, e.g., Less Than and Excel displays a dialog box shown in 

Fig. 4.38 to defi ne one or more values and the color you want to apply when the condition is true. 

To defi ne the fi rst rule, i.e., when the profi t is negative, you would enter 0. 

∑ Next, click the down arrow to choose one of the built-in format styles, as illustrated in Fig. 4.38 or 

defi ne a custom format. 

In the same way, you may defi ne additional rules, as required.

Fig. 4.38 Defi ning a Conditional Formatting rule

4.19.1 Conditional Formatting using the Top/Bottom Rules

Top/Bottom Rules provide a convenient way to apply conditional formatting on a range. 

∑ On clicking Top/Bottom Rules in the Conditional Formatting menu (see Fig. 4.37), Excel displays 

a submenu containing various choices, such as Top 10 Items, Top 10%, Bottom 10 Items, Bottom 

10%, Above Average and Below Average. 

These options are self-explanatory, e.g., use Top 10 Items to apply conditional formatting to the top 10 

items, and Bottom 10% to items falling within the bottom (last) 10% in value. 

∑ On selecting an option, Excel displays a dialog box similar to Fig. 4.38 to defi ne the formatting for 

rule, e.g., display Top 10 Items in Green color. You can also apply multiple rules on a range.
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4.19.2  Conditional Formatting using Data Bars, Color Scales

and Icon Sets

Excel offers as easy way to apply conditional formatting on a selected range using Data Bars, Icon Sets

and Color Scales. Notice that Excel displays these options in the Conditional Formatting choices in 

Fig. 4.38. Figure 4.39 displays the use of these conditional formatting options in a worksheet. The Data 

Bars formatting displays more color for higher values and less color for lower values. The Icon Sets

display different icons for different types of values to identify the trend. The Color Scales formatting 

use different colors to identify different data values. 

Fig. 4.39 Data Bars, Color Scales and Icon Sets conditional formatting applied on a worksheet

To apply conditional formatting using Data Bars, Icon Sets or Color Scales: 

∑ Select the Range you want to format and click Conditional Formatting in the Styles group. 

∑ Click the desired conditional formatting in the menu, and Excel displays a submenu containing 

various choices. For instance, if you click Icon Sets, it displays various types of icons you can 

apply. Click the desired option and Excel formats the range accordingly.

∑ After you have applied conditional formatting to a range, you can use Conditional Formatting

again to change the formatting style. If you need to remove the conditional formatting, click 

Conditional Formatting and then click Clear Rules. 

4.20 USING DATES AND TIME 

You may often want to use dates in a worksheet. You may, for instance, wish to enter the date of birth of 

an employee in a worksheet. Excel provides several easy ways to enter the current or the specifi ed date 

in a cell. Besides, it can display the entered date in several date formats. For example, a cell containing 

26–Jan–2013 can be formatted to display the date as 26-01-2013, 26 January 2013, 26-Jan-13, and so 

on. Moreover, you can also perform arithmetic operations on two dates. For example, you can subtract 

one date from another to work out the number of days between them, or calculate the date that will fall 

20 days from today. 
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4.20.1 Entering the Current Date

To enter the current date in a cell, you can take the help of the TODAY function. 

∑ Type =TODAY(). As you start typing the function, Excel may display a list of functions matching 

the entered characters and offers some help information. Press the Enter key and you should see 

the current date, e.g., 26-01-2013 in the cell. (If you see “####” in the cell, increase the column 

width.)

The date format you would see in your worksheet depends on the Regional Settings selected in Windows 

Control Panel and customization you might have done on Windows. However, as Excel can display the 

date in various formats, you can change the date format as per your requirements. Figure 4.40 displays 

date values displayed in a worksheet in various formats. 

∑ To choose a date format, click the down pointing arrow to the right of the Number Format list 

box in the Number group on the Home tab to display the list of formats and click Long Date or

Short Date. 

∑ To pick other date formats, click More Number Formats to display the Formats Cells dialog 

box shown in Fig. 4.40. You can also display the Format Cells dialog box by clicking Dialog Box 

Launcher at the bottom right of Number group. Now click the desired date format in the Type list 

box and click OK. 

To display additional date formats choose a different locale (location) in the Format Cells dialog box, 

as illustrated in Fig. 4.40. If you want to enter a date-time value in a cell, use =NOW(). 

Fig. 4.40 Choosing date format

4.20.2 Entering Dates in a Worksheet

∑ To enter a specifi c date, e.g., April 16, 2013 in cell, you can simply type the date in any of the 

Excel’s date formats, e.g., 16/04/2013, 16-04-2013, 2013-04-16, etc. 
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After entering a date in a cell, if Excel right aligns it in the cell or allows you to change the date format, 

it indicates that Excel has accepted the entered data as a date, and not as a text entry. 

∑ Another way to enter a specifi c date in a cell is by using the DATE() function, e.g., 

=DATE(2013,09,20) enters a date value corresponding to September 20, 2013 in the cell. 

While entering a function in a cell, you may notice that after you have typed the function name, e.g., 

=DATE(, Excel displays a function tooltip, e.g., DATE(year, month, day). The function tooltip may 

help you to enter the required parameters and their sequence for the function. 

4.20.3 Using Date Arithmetic

Excel enables you to perform arithmetic operations on dates entered in a worksheet. For instance, you 

can fi nd out number of days between two date values or fi nd out a date that is 5 days before or after a 

specifi ed date. For example, if cell A1 and A2 contain date values, =A1-A2 entered in a cell displays the 

number of days between these two dates. Similarly, =A1+2 entered in another cell displays a date that 

is two days after the date entered in cell A1. For manipulation of the date data entered in the worksheet, 

Excel provides the following functions:

DAY Calculates the day of the month from the date. For example, if cell A18 contains 27/03/2013, 

=DAY(A18) entered in any cell displays 27.

MONTH Calculates the month number from the date. For instance, if cell A18 contains 27/03/2013, 

=MONTH(A18) displays 3.

YEAR Calculates the year number from the date. For instance, if cell A18 contains 27/03/2013, 

=YEAR(A18) displays 2013.

4.20.4 Entering Time

Like the date, you can enter the desired time in the worksheet by entering it in any of the acceptable 

time formats. For instance, to enter 9.30 am in a cell, you can type 9:30 or 9:30 AM or 9:30 am. 

Similarly, to enter 3.35 pm, you can type 3:35 PM, 3:35 pm or 15:35. If you also want to include 

seconds’ information in the time, you can enter it in any of the following ways: 9:30:10, 9:30:10 am. 

9:30:10 AM, 13:30:13, 1:30:13 PM, etc. When you enter the time in a cell in any of the acceptable time 

formats, Excel right aligns the entry in the cell and displays the time in the same format. If the entry 

remains left aligned, it indicates that you have not entered the time in an acceptable time format. You 

may also use the TIME() function to enter a specifi c time, e.g., =TIME(9,30,15) to enter 9:30:15 am.

4.21 HIDING AND UNHIDING COLUMNS AND ROWS 

Excel provides you with the facility to hide one or more columns or rows. However, hiding does not 

remove the data from the hidden columns or rows. Also, the formulas in the hidden columns and rows 

continue to work properly. Hiding columns and rows is useful when you do not want to display or print 

unimportant data. 

∑ To hide a column, right click the mouse on the column letter in the column border to display the 

context menu. Next, click the Hide command to hide the column. Use the same steps to hide 

multiple columns or one or more rows. 

Figure 4.41 displays a worksheet with hidden column D. Notice that the column border does not show 

column D.
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∑ To unhide a column, select the column range that contains the hidden column, right click 

the mouse to display the context menu and then click the Unhide command, as illustrated in

Fig. 4.41. 

Fig. 4.41 Unhiding a column

4.22 CREATING CHARTS 

Often a worksheet contains so much numeric data that it becomes diffi cult to accurately analyze it and 

to take a correct decision. In such cases, the facility to represent data in the form of charts comes very 

handy. Excel allows you to view charts on the screen as well as to print them on a printer or plotter. It 

supports many types of charts, such as Column, Line, Pie, Bar, Area, Stacked-Bar, XY, 3-D Bar, Radar, 

Doughnut, etc. In Excel, creating a chart is very simple—all you need to do is to select the range that 

you want to include in the chart and click the desired chart button. 

4.22.1 Creating a Column Chart

Consider the data shown in Fig. 4.42 that displays the sales fi gures for the months of January, February 

and March for PC, Printer and Scanner products. The sales fi gures are included in the range A3:D6. 

Notice that besides the sales fi gures, the range also includes column and row headings which Excel 

would use to label the chart axis. To create a column chart similar to the one shown in Fig. 4.42, follow 

the steps given below:

∑ Select the range A3:D6 that you want to plot in the chart.

∑ Click the Insert tab and then click the Column button in the Chart group, as illustrated in Fig. 4.42.

Excel displays icons for various types of column charts it can create as shown in Fig. 4.43. 

∑ Click the desired chart type and Excel creates the corresponding chart. If you click the fi rst column 

chart type under “2-D Column”, Excel creates a chart similar to the one shown in Fig. 4.44.

The chart has used data in the fi rst column as legend and the data in the fi rst row as chart axis. Notice 

that Excel is displaying the contextual Chart Tools tab in Fig. 4.44. (If you do not see Chart Tools, 
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click anywhere in the chart.) Chart Tools are helpful in modifying the chart, e.g., you can change the 

chart style or layout, as illustrated in Fig. 4.44. If you need to resize the chart, drag the resizing handles 

located on the chart border. Moving the chart is very simple; just drag the chart border or the empty 

space inside the border. 

Fig. 4.42 Sample data to create a chart

Fig. 4.43 Excel displaying various types of column charts it can create
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Fig. 4.44 2D Clustered Column Chart

4.22.2 Changing the Chart Type

As you know besides the column chart, Excel can create several other types of charts. To change the 

chart type, follow the steps given below: 

∑ Click the chart to display Chart Tools. Then click the Design tab in Chart Tools to display the 

Design tools. The Ribbon should look similar to Fig. 4.44.

∑ Click the Change Chart Type button on the Ribbon. This button is the fi rst button on the 

Ribbon. 

Excel displays the Change Chart Type dialog box shown in Fig. 4.45. This dialog box displays chart 

categories in the left and icons for the chart types in the right. On clicking a chart category, the dialog 

box displays the available charts for that category. To change the chart type, click the icon for the 

desired chart and then click OK.

Fig. 4.45 Change Chart Type dialog box
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4.22.3 Pie Chart 

A pie chart presents various data values of a range as wedge-shaped sections (pies) of a circle. It 

displays the percentage of each part (data value) of the total of all values in the range. The total or 

the circle represents 100 per cent. This chart is suitable to display the budget allocation to different 

departments, to compare the profi t for the different divisions of a company, or to compare the market 

shares of various PC manufacturing companies in the total PC market. Figure 4.46 displays a pie chart 

for different types of investments made by an investor. Unlike other types of chart, the pie chart can 

plot only one data series. 

Fig. 4.46 A pie chart

4.22.4 Modifying Chart

Modifying a chart is quite simple as Excel provides several controls on the Layout and Format tabs of 

Chart Tools. For instance:

∑ To add/remove the chart title, click the Chart Title button and choose the desired option, as 

illustrated in Fig. 4.46. 

∑ Similarly, use Legends, Data labels, Axis Title, Grid Lines and other buttons on the Layout tab to 

change the appearance of the chart. 

∑ To reposition, a specifi c part of the chart, e.g., legend within the chart, click that area of the chart 

and drag to reposition it. 

The Format tab in Design Tools shown in Fig. 4.47 contains tools to change the shape/style of the 

chart or any component within the chart. You apply any background colour to the chart. Figure 4.47 

displays Shape Effect being applied to an area chart. 
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Fig. 4.47 Shape Eff ect being applied to an Area chart

4.22.5 Moving Chart to a Chart Sheet

By default, Excel embeds the chart on the same sheet. However, if you like to show the chart on its 

own chart sheet:

∑ Click the chart that you want to move and click Design in Chart Tools on the Ribbon.

∑ Click the Move Chart button located on the right in the Location group, and Excel displays the 

Move Chart dialog box shown in Fig. 4.48. 

∑ Click the New Sheet option. Optionally, you may also type a different name for the new sheet, 

instead of the default name. Then click OK to close the dialog box. 

Fig. 4.48 Move Chart dialog box

Excel adds a new sheet to the workbook and moves the chart on this new chart sheet. 
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Note  Sometimes, you do not see the chart on the newly added chart sheet. This may be due to the default 

printer being off-line or misconfi gured printer. You may change the default printer to ‘Microsoft XPS 

Document Printer’ and try again.

4.23 USING SPARKLINES 

Sparklines is a new feature available in Excel 2010. A sparkline is a tiny chart in the cell background. 

Excel can create three types of sparklines, line, column and Win/Loss, as illustrated in Fig. 4.49. 

Line and Column sparklines are similar to line and column charts, respectively. A Win/Loss sparkline 

is similar to the Column sparkline, except that the negative values are highlighted in different colors. 

If you can create charts, adding sparklines to the worksheet should be easy. Here are the steps to 

create a Line sparkline, similar to the one shown in Fig. 4.49. 

Fig. 4.49 Sparklines used in a worksheet

∑ Select the source data range for the sparkline, e.g., B4:F4. 

∑ Click the Insert Tab, click the Line button in the Sparklines group and Excel displays the Create 

Sparklines dialog box shown in Fig. 4.50, which includes the Data Range selected in the previous 

step. 

Fig. 4.50 Create Sparklines dialog box

∑ Type G3 in the Location Range box where you want to place the sparkline. You can also click the 

corresponding cell in the worksheet to choose the cell. 



240    Computer Course: Windows 7 and Offi  ce 2010  

∑ Click OK to close the Create Sparklines dialog box and Excel displays the sparkline on the 

worksheet. 

In the same way, you can create other types of sparklines. The cell that displays the sparkline is like 

a normal cell and you may enter any text in that cell, if required. When you click a cell containing a 

sparkline, Excel displays Sparkline Tools on the Ribbon to customize the sparkline, e.g., change line or 

data point marker color, mark high, low and negative points, clear sparkline, etc. 

4.24 MULTIPLE WORKSHEETS IN A WORKBOOK FILE 

So far, all the workbooks we have discussed were confi ned to a single worksheet (sheet). Excel is 

capable of storing information in multiple worksheets within the same workbook fi le. After opening a 

workbook fi le, if you look at the left side of the horizontal scroll bar, you fi nd a few tabs named Sheet1, 

Sheet2, Sheet3, and so on. When you create a new workbook fi le, Excel creates a fi xed number of 

worksheets in this fi le. 

∑ By default, Excel selects the fi rst sheet (Sheet1), however to view or enter data in other sheets, 

click the corresponding sheet tab. 

When you need to enter a lot of data in a workbook, entering it in separate sheets helps in better 

organization of the data. For instance, you may enter Assets data on sheet 1 and Liabilities on Sheet2. 

Similarly, using multiple sheets in a workbook is useful when you have more than one set of similar 

but related data. For example, a company may divide its operations into two regions—Northern Region 

and Southern Region. If the company wants to store data for both divisions separately, it may do so by 

using separate sheets. In that case, it may also show the combined data for both divisions in another 

sheet, e.g., 

 1. Sheet1 displays the combined total for both regions.

 2. Sheet2 displays the Profi t and Loss summary for the Northern Region

 3. Sheet3 displays the Profi t and Loss summary for the Southern Region

A sample data for the above scheme is shown in Table 4.3:

Table 4.3

SHEET 1 (COMBINED) SHEET 2 (NORTHERN REGION) SHEET 3 (SOUTHERN REGION)

Cost Cost 2,45,000 Cost 1,39,000

Overheads Overheads 45,000 Overheads 20,000

Sales Sales 3,20,000 Sales 1,70,000

Profi t Profi t 30,000 Profi t 11,000

When the data is entered in multiple sheets, a formula may refer to cells belonging to more than one 

sheet. For instance, to calculate the values to be displayed in Sheet 1 for Cost, Overheads, Sales and 

Profi t, we can sum of the corresponding fi gures in Sheet 2 and 3. Notice the formula used in cell B2 in 

4.47. The formula “=Sheet2!B2+Sheet3!B2” adds the cell B2 from sheet 2 and cell B2 from sheet 3, 

which refer to the cost fi gures for northern and southern divisions, respectively. 
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4.24.1 Renaming, Moving and Inserting and Deleting Sheets

∑ To change a sheet name to a meaningful name, e.g., North or Sales, double click the sheet tab and 

type the desired name, as illustrated in Fig. 4.51. Alternatively, right click the sheet tab to display 

a context menu and click the Rename command.

∑ Similarly, if you want move a sheet, e.g., to move Sheet3 before Sheet2, drag the sheet tab left or 

right with mouse.

∑ To insert a new sheet after the last sheet, click the Insert Sheet button on the right of the sheets 

tab (see Fig. 4.51.) To insert a sheet before a specifi c sheet, right click the corresponding sheet tab 

and click the Insert command on the context menu. Then click OK in the Insert dialog box. 

Fig. 4.51 Formula containing reference to sheet names

∑ Similarly, to delete a sheet, right click the sheet tab and click the Delete command. If the sheet 

contains any data, Excel displays a confi rmation box. Remember that you cannot undo the sheet 

delete operation. 

∑ To quickly identify a sheet, you may change the background color of the sheet tab. To do so, right 

click the sheet tab and click the Tab Color command in the context menu displayed by Excel.

4.24.2 Hiding and Unhiding Sheets

∑ If you want to hide a sheet so that its data is not visible, right click the sheet tab and click the Hide 

command in the context menu, and to unhide a sheet, use the Unhide command.

4.24.3 Using Sheet Background

∑ If you want to use a picture as the background for a sheet, click the Page Layout tab and then click 

the Background button in the Page Setup group. 

In response to this command, Excel displays the Sheet Background dialog box. This dialog box is like 

any Windows fi le select (open) dialog box. You may choose any picture fi le from any folder in your 

PC. Figure 4.52 displays a background being used on a sheet. Though the worksheet background looks 

good on the screen, it is rarely used because it not printed when you print a worksheet.

∑ To remove the background from a sheet, click Delete Background on the Page Setup tab, as 

illustrated in Fig. 4.52.
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Fig. 4.52 A worksheet using a background

4.25 KEEPING TITLE ROW(S) AND COLUMNS VISIBLE 

When you use Excel for real-life applications, you may end up with a worksheet that may have hundreds 

of rows. Consider the employee worksheet shown in Fig. 4.53. If you vertically scroll the worksheet, 

the column titles entered in row 2 moves off the window making it diffi cult to follow what data each 

column represents. Similarly, assume that the employee worksheet contain additional columns, such 

as address, date of joining, date of last promotion, allowances, tax, deductions, net salary, etc. In 

this situation, when you horizontally scroll the worksheet, column A which contains the name of the 

employee may become invisible making it diffi cult to know which employee this row refers to.

Fig. 4.53 Using Freeze Panes to keep rows and/or columns visible
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To overcome this problem, Excel allows us to freeze specifi ed number of rows and/or columns, so 

that these are always visible when you scroll the worksheet. With reference to the example shown in 

Fig. 4.53, we may like to freeze column A and rows 1 and 2. Follow these steps to accomplish this: 

∑ Move the cell pointer to cell B3 which is below and to the right of the row(s) and column(s) you 

want to keep visible. 

∑ Click the View tab and click Freeze Panes. Excel displays three options as shown in Fig. 4.53. 

∑ Click Freeze Panes, the fi rst option. (You may use the second option (Freeze Top Row) if column 

titles are contained in row 1 and you want to freeze row 1 but not column(s). Similarly, use Freeze 

First Column to keep the fi rst column visible.)

Excel displays dark line(s) indicating frozen row(s) and/or column(s). Excel keeps them visible when 

you scroll the worksheet. To unfreeze panes, click Freeze Panes and then click Unfreeze Panes.

Another way to keep the title rows visible is by splitting the worksheet window in two horizontal 

windows by dragging the Horizontal Split Bar, as illustrated in Fig. 4.53. Then you can display title in 

the top window while you work in the lower window to view or edit data. Similarly, you may split the 

screen in two vertical windows, if required. 

4.26 PRINTING THE WORKBOOK 

Like other Microsoft Offi ce programs, you can preview the worksheet, choose what to print, change 

print settings, print preview and print from one location, the Backstage view. 

∑ Click the File tab to open the Backstage view. The left section of the Backstage view has commands, 

such as Save, Save As, Open, Close, Info, Print, Help, etc.

∑ Click Print and Excel displays the Print settings in the middle pane and preview of the document 

in the right pane, as shown in Fig. 4.54. If Excel displays the Show Print Preview button instead 

of the preview in the right pane, click this button to display print preview.

Fig. 4.54 Print Settings and previewing a worksheet
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Tip  Press Ctrl+P, the shortcut keys for the Print command to directly display Print Preview while working 

in any tab. 

Note  If you do not see the print preview, make sure that the printer displayed in the Printer section is 

powered-on and ready (on line). Excel may display the preview if you choose another printer. You 

may change the default printer to ‘Microsoft XPS Document Printer’ and try again.

∑ By default, Excel prints all pages of the active sheet(s) on the selected printer. Therefore, if you 

click the Print button located in the middle pane, it would print the current worksheet. 

∑ If multiple printers are installed and connected to your PC, you may choose the printer by clicking 

the button that displays the current printer’s name in the Printer section and choosing the desired 

printer, as illustrated in Fig. 4.54. You may click the Printer Properties link to control the printer 

properties.

∑ You can use the Copies option to control the number of copies and the Pages control to defi ne the 

print range, if your worksheet has more than one page. 

∑ Use the fi rst button in Settings section to control “what to print”. Use this option to print the entire 

workbook (all sheets), selected sheet(s) or the selected range. You may also change the page 

orientation, margins, page size, etc., though these are normally defi ned before you begin printing 

on the Page Setup tab, as you would learn in the next section. 

∑ Click the Show Margins button (see Fig. 4.54) to display page margins. Then, if required, you can 

drag the margin lines to change margins. 

4.26.1 Setting Up Print Area

When you work on real-life worksheets, you will fi nd that your worksheet runs across several columns 

and rows. You may not like to print all worksheet data every time you use the Print command. To 

overcome this problem, Excel allows you to defi ne one or more ranges as the print area. After you have 

setup the print area, when you use the Print command, Excel prints data only from the defi ned print 

area. 

∑ To defi ne print area, select the range, click the Print Area button in the Page Setup group in the 

Page Layout tab to display a menu. Then click the Set Print Area command to defi ne the print 

area. Other commands in the menu are Clear Print Area and Add to Print Area.

4.27 SETTING UP PAGE AND MARGINS 

To give a professional look to your worksheet, you can modify several print parameters, such as the 

page size, margins, orientation, header and footer. You may need to change the page size and margins 

depending on the paper you are using and margins you want to leave at the top, bottom, left and right 

side of the page. These are defi ned through the controls on the Page Layout tab and the Page Setup 

dialog box. 

4.27.1 Selecting Page Size and Orientation

∑ To select the page size, click the Page Layout tab, click the Size button in the Page Setup group 

and click the desired paper size from the list displayed by Excel, as illustrated in Fig. 4.55. 

∑ The Orientation control in the Page Setup group in used to selection orientation: Portrait or 

Landscape. The default selection for orientation is portrait. In the landscape orientation, Excel 
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prints horizontally along the long edge of the paper. Use the landscape orientation when the width 

of the worksheet is more than its length or you are using lots of columns.

Fig. 4.55 Selecting page size, orientation and margins

4.27.2 Changing Margins

When Excel prints a worksheet, it leaves a specifi ed margin at the top, bottom, left and right side of the 

page, however, you may changes these margins as per your requirements.

∑ To change margins, click the Margins control in the Page Setup group on the Page Layout tab 

and choose from the standard margins list displayed in the menu. If the standard margins are not 

suitable for your needs, click Custom Margins in the menu to display the Page Setup dialog box 

shown in Fig. 4.56. You may also click Dialog Box Launcher located at the bottom right of any 

group on the Page Setup tab to display the Page Setup dialog.

∑ To change any margin, either type the new value in the corresponding margin box or use the 

spinner buttons to increase or decrease the margin. When you select a particular margin box, Excel 

highlights the corresponding margin line in the sample page displayed in the Preview box.

The Margins page of the Page Setup dialog box contains two check boxes—Horizontally and Vertically

in the ‘Center on Page’ box. When you check the Horizontally check box, Excel centers the worksheet 

on the printed page. This option will make the blank area that Excel leaves on the printed page even. 

You may use this option when your worksheet data does not cover the full width of the page. Similarly, 

the Vertically check box vertically centers the worksheet data on the printed page. These check boxes 

can help you to make the printed page look balanced.

4.27.3 Scale to Fit

When you worksheet is too wide or too tall, and you want to fi t the printed output within a specifi ed 

number of pages, you can take the help of Width, Height and Scale controls in the Scale to Fit group on 
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the Page Setup tab. (See Fig. 4.55). The default value of scale is 100%; use a smaller number to shrink 

and a number greater than 100 box to enlarge the worksheet on the printed page.

Fig. 4.56 Defi ning margins in Page Setup dialog box

4.27.4 Controlling Display and Printing of Gridlines 

When you work on a worksheet, you normally see gridlines to mark rows and columns.

∑ If you want to turn off the display of gridlines, uncheck the View Gridlines checkbox in the Sheet 

Options group in the Ribbon. (See Fig. 4.55.) 

∑ When you print a worksheet, by default, Excel does not print the gridlines. However, if you like, 

you can ask Excel to print the gridlines by checking the Print Gridlines checkbox, as illustrated 

in Fig. 4.55.

4.27.5 Printing Title Rows and Comments

When you use Excel for real-life applications, you may end up with a worksheet that may have 

hundreds of rows. When you print such a long worksheet, Excel obviously prints it in more than one 

page. Also, while creating a worksheet you normally type titles for columns in the fi rst few rows. So, 

when a long worksheet is broken into two or more pages, the descriptive titles are not printed on the 

second and subsequent pages. This may make it diffi cult to follow what data each column represents. 

To solve this problem, you can ask Excel to print a specifi ed number of rows (containing column 

titles or description) at the beginning of each page. For instance, if rows 2 and 3 contain the title rows, 

enter “2:3” in the “Rows to Repeat at the Top” box in the Sheet tab of the Page Setup dialog box, as 

illustrated in Fig. 4.57.

The Print section of the Sheet tab of the Page Setup dialog box also contains a few other controls that 

you may fi nd useful. For instance, if you want to include the row and column heading in the printout, 

check the Row and Column Heading check box. Comments is another useful option used to control the 

printing of cell comments. (To insert comments in a cell, right click the cell and click Insert Comment 

in the context menu.)
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Fig. 4.57 Sheets tab of Page Setup dialog box

4.28 DEFINING HEADER AND FOOTER 

When your worksheet contains several pages, you may fi nd it useful to print headers and/or footers. As 

you know, the header is printed at the top of every page in the top margin of the page, and the footer is 

printed at the bottom of every page. You can show any information, such as the name of the company 

or the report, current date, current time, page number, etc. in the header and footer. 

∑ To defi ne or change the header or footer, click the Insert tab and then click the Header & Footer

button in the Text group. Excel displays the Header section and Header & Footer Tools, as shown 

in Fig. 4.58.

∑ The header section is divided in three parts. You can click in any section and type any text for the 

header. 

∑ To help you quickly defi ne the header/footer, Excel has several predefi ned header/footer text, e.g., 

page, date, fi lename, etc., which you can choose by clicking the Header/Footer button in Header 

& Footer group, as illustrated in Fig. 4.58. You can also choose these elements separately by 

clicking the corresponding control in the Header & Footer Elements group.

∑ To insert a picture in the Header/Footer, use the Picture control in the Header & Footer Elements

group. To switch between header and Footer, use the Go To Header/Footer button in the 

Navigation group. 

The header/footer text is formatted in the same way as you format the worksheet data. After defi ning 

the header/footer, click in the worksheet area to continue working on the worksheet data. You may 

Print Preview the worksheet to view the header and/or footer you have defi ned. 
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Fig. 4.58 Defi ning header and footer

4.29 WORKING WITH ZOOM 

If you fi nd the text and other objects on the worksheet too small or too large, you can change the zoom

(magnifi cation). The quickest way to change the zoom level is through the Zoom Slider located on the 

right side of the status bar, as illustrated in Fig. 4.58. To change the zoom level, either drag the zoom 

slider with mouse or click “+” or “–” located at the left and right side of the slider, respectively. As 

shown in Fig. 4.58, Excel displays the current zoom percentage to the left of the zoom slider. You may 

click the zoom percentage to open the Zoom dialog box to change the zoom percentage.

4.30 NAMING RANGES 

You have used ranges in previous sections for copying, moving and formatting, and with functions. 

In those cases, you specifi ed the range either by typing the range address (e.g., B4:E4) or by pointing 

(i.e., highlighting the range with the mouse or arrow keys.) Specifying the exact range by typing or 

pointing may become cumbersome if you need to use the same range with several functions. In such 

cases, the easier way is to assign a name to the range once and then use the range name with functions. 

For example, if the cost fi gures are entered in the range B4:E4, you may name this range as COST. 

Then you may use =SUM(COST) to calculate the total of the cost fi gures. This function is same as 

=SUM(B4:E4). A range name is also helpful in quickly jumping to a range with the Go To command 

that you can initiate by pressing F5 or Ctrl+G. 

∑ To assign a name to the selected range, e.g., B4:E4 in Fig. 4.59 or the current cell, click Name 

Box, type the name you want to assign, e.g., COST and press Enter. 

∑ An alternate way to name a range is by clicking Defi ne Name in the Defi ned Names group on the 

Formulas tab, which displays a dialog box to defi ne the name. Use the Names Manager button to 

open a dialog box to delete/edit defi ned names as well as to create new range names. 
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Fig. 4.59 Naming a range

4.31 USING STATISTICAL FUNCTIONS 

Excel supports more than 75 statistical functions. Some of the commonly used statistical functions are 

given here. For additional functions, refer to the Excel help system.

 AVERAGE Calculates the average of a list of values.

 COUNT Counts the number of non-blank numeric cells in a list.

 MAX Finds out the maximum value in a list of values.

 MIN Determines the minimum value in a list of values

 STDEV Calculates the standard deviation of a list of values.

 VAR Calculates the variance of a list of values.

 MEDIAN Returns the median of the given list of values.

 MODE Returns the most frequently occurring value in a range of data.

These function are used on numeric data. Some examples illustrating the use of these functions are 

=MIN(A1,A2,A3), =MAX(A1:A6) and =AVERAGE(A1,A2,A5,B1:B10). 

4.32 INSERTING A FUNCTION 

Excel contains hundreds of functions which are classifi ed in several categories, such as Database, 

Date & Time, Engineering, Financial, Information, Logical, Math and Trigonometry, Statistical, Text, 

Lookup and Reference and Cube. To help you fi nd and use the required function to perform a specifi c 

task, you may take the help of Insert Function button on the Formulas tab. 

∑ Click the cell where you want to insert a function and click Insert Function ( ) located to the 

left of Formula Bar (see Fig. 4.59). The Insert Function button is also located on the Formula tab. 

Excel displays the Insert Function dialog box shown in Fig. 4.60.

The Insert Function dialog box helps you to select a function. If you are looking for a function that 

can help you to calculate the future value or present value for an investments, type the corresponding 

words in the Search for a Function box and click the Go button. Then Excel displays the list of function 

matching the entered words in the dialog box. 



250    Computer Course: Windows 7 and Offi  ce 2010  

Fig. 4.60 Insert Function dialog box

Another way to select a function is by choosing a function category. As already mentioned, Excel 

functions are classifi ed into several categories. On clicking in the Select a Category dropdown box, 

Excel displays the list of categories to choose from. On selecting a category, Excel displays the list of 

functions available for the selected category. 

∑ When you click a function in the Select a Function box in the Insert Function dialog box, Excel 

displays its brief description. For addition information, click the Help link, as illustrated in

Fig. 4.60, to ask Excel to display the help information for the selected function. 

∑ After you have found the function you want to use, click the OK button, and Excel displays 

the Function Arguments dialog box shown in Fig. 4.61. The dialog box helps you to choose the 

arguments for the function. The arguments shown in bold letters are required while those in normal 

letters are optional. 

Fig. 4.61 Function Arguments dialog box
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4.33 USING MATH FUNCTIONS 

Math functions perform mathematical operations on numeric data entered in the worksheet. Some of 

the commonly used Math functions are discussed in this section.

4.33.1 SUM

The SUM function calculates the sum of values in a list. You have already used the SUM function in 

the following formats:

1. SUM(C8:G8)

2. SUM(COST)

Besides specifying a single range or the range name, you can specify multiple ranges or constant 

numbers with SUM. Some examples of SUM are given in the following:

 SUM(10,20,30,40) Sums up the four numbers used with SUM.

 SUM(A1:G3,25,27) Sums up 25, 27 and values in the range A1:G3.

 SUM(A1:A3,B1:B3)  Sums up values in ranges A1:A3 and B1:B3.

 SUM(PROFIT,SALES) Sums up values in PROFIT and SALES ranges.

 SUM(PROFIT,12,15) Sums up values in PROFIT,12 and 15. 

 SUM(PROFIT,A1:C1,10) Sums up 10 and values in ranges PROFIT and A1:C1. 

In fact, the list used with SUM can include up to 255 values or ranges in any sequence. In the same way, 

you can use a list of numeric values with other statistical functions.

4.33.2 ABS

It calculates the absolute value of a number. In other words, it converts a negative number into the 

corresponding positive number, e.g., =ABS(–12.3) entered in a cell displays 12.3 and =ABS(15.3)

displays 15.3. Besides using a constant (i.e., fi xed number, such as 15.3), a cell reference or range name 

can also be used with ABS, e.g., ABS(GAIN), ABS(A12), etc. 

Note  We have not shown the ‘=’ sign before ABS(GAIN) and ABS(A12). However, remember that a 

formula always begins with ‘=’.

4.33.3 EXP

Returns e raised to the power of a given number. For example, =EXP(1) displays 2.718282 and EXP(2) 

returns 7.389056. A fractional or negative number can also be used with the EXP function.

4.33.4 INT

This function rounds the number down to the nearest integer. For example, =INT(20.87) displays 20, 

whereas and INT(–12.3) and INT(–12.9) return –13.

4.33.5 LN, LOG10 and LOG

The LN function calculates the natural logarithm (base e) of the specifi ed positive number. For 

example, LN(10) returns 2.305850. The LOG10 function calculates the common logarithm (base 10), 

e.g., LOG10(100) returns 2. The LOG function calculates the common logarithm (base 10) or to the 

base that you specify. For instance, LOG(100) calculates logarithm of 100 to base 10 and returns 2 

as the answer. On the other hand, LOG(100,2) returns the logarithm of 100 to the base 2 and returns 

6.643856 as the answer.
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4.33.6 MOD

This function calculates the modulus (remainder) of two values. For example, =MOD(1408,10)

displays 8.

4.33.7 RAND

This function returns an evenly distributed random number greater than or equal to 0 and less than 1. 

A new random number is returned every time the worksheet is calculated. You can multiply the RAND 

function with a number greater than 1 to generate a random number greater than 1. For example, to 

generate a random number greater than or equal to 0 but less than 100, use the formula =RAND()*100. 

On pressing the F9 function key, Excel displays a new number in the cell.

4.33.8 ROUND

The ROUND function rounds off a number to the specifi ed number of decimal places. For example, if 

cell A14 contains 1456.5863, =ROUND(A14,0) entered in some other cell rounds off the value in cell 

A14 (i.e. 1456.5863) to a whole number (0 decimal places) and displays 1457. Similarly, the number 

stored in cell A14 can be rounded off to one, two or more decimal places, as shown in Table 4.4.

Table 4.4

FUNCTION DISPLAYED VALUE REMARKS

=ROUND(A14,1) 1456.6 Cell A14 contains 1456.5863

=ROUND(A14,2) 1456.59 Cell A14 contains 1456.5863

=ROUND(A14,3) 1456.586 Cell A14 contains 1456.5863

You can also round off a number to tens, hundreds and so on by using a negative number with decimal 

places. For example,

FUNCTION DISPLAYED VALUE REMARKS

=ROUND(–56789,–2) –56800

=ROUND(56789,–3) 57000

=ROUND(A14, –3) 1000 Cell A14 contains 1456.5863

Note  CEILING and FLOOR are two other useful functions that round up (away from zero) and round down 

(toward zero), respectively.

4.33.9 SQRT

The SQRT function calculates the square root of a positive number. Similar to other functions, SQRT 

can be used to calculate the square root of the result of another function, e.g., SQRT(SUM(C1:C5)) and 

SQRT(ROUND(A1,–2)).

4.33.10 Trigonometric Functions

Excel supports a number of trigonometric functions. Some of the commonly used trigonometric 

functions in Excel worksheets are ACOS, ACOSH, ASIN, ASINH, ATAN, ATAN2, ATANH, COS, 

DEGREES, SIN and TAN. For details, refer to the Excel help system.
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4.34 USING FINANCIAL FUNCTIONS 

Financial functions allow us to calculate loans, depreciation, cash fl ow, and so forth. In this section, we 

shall describe the application of commonly used fi nancial functions. Before describing these functions, 

let us explain certain terms that we come across while using them.

1. Rate: Rate refers to the rate of interest per period. Rate is not necessarily the annual rate of 

interest. Whereas the annual rate of interest is almost invariably used in a practical situation, we 

have to convert the annual interest rate into a periodic rate while using fi nancial functions. This is 

so because though the fi nancial institutions specify the annual interest rate, they, however, charge 

or pay interest on a monthly, quarterly or half-yearly basis. 

2. Period: Period refers to the time interval between payments. 

3. PMT: PMT refers to the periodic payments made to pay off a loan or paid into a deposit account. 

4. NPER: NPER refers to the number of periods. For example, if a bank compounds interest on a six-

monthly basis, there will be two periods in a year. Similarly, if you deposit `1000 every month in 

a bank account, you will use 12 as the NPER in calculations. Normally you have to convert years 

into NPER in fi nancial functions.

4.34.1 Using RATE

The RATE function can be used to calculate the interest rate charged to pay off a loan. Suppose you 

have taken a loan of `100,000 that has to be paid off in 48 monthly instalments of `3,000 each. In this 

case, you can use the RATE function to calculate the rate of interest charged on this loan. The RATE 

function has the following syntax:

RATE(nper, pmt, pv, fv, type, guess)

Here nper is the total number of payment periods. In our case, nper is 48. Pmt is the payment made 

each period, which in our case is 3000. Pv is the present value of the total amount that a series of future 

payments is worth now. In case of a loan, Pv is equal to the total loan amount. Thus, in our case, Pv is 

100000. Fv is the future value at the end of the last payment. The future value of a loan is 0. Therefore, 

in this example, we can omit or use 0 for fv. Type is the number 0 or 1. It indicates when payments are 

due. If type is omitted or 0; it means that payments are made at the end of period. On the other hand, 

if payments are made at the beginning of the period, use 1 for type. Guess is your guess for what the 

rate may be. If you do not use guess in the function, Excel assumes the guess to be 10%. While using 

the RATE function, the fi rst three arguments, i.e., nper, pmt and fv are compulsory, and the other three 

parameters, i.e., fv, type and guess are optional.

Thus, you can use the following arguments for calculating the rate of interest for the loan of ̀ 100,000 

that has to be paid off in 48 equal monthly installments of `3000 each. 

nper 48

pmt –3000

pv 100000

fv 0

type 0  if the fi rst payment starts after 1 month, 

 1 if the fi rst payment is made on receiving the loan. 

Note  In Excel, the payments that you make are entered as negative values, and the payments that you 

receive are entered as positive values. In other words, cash outfl ows are entered as negative and 

cash infl ows are entered as positive values.
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∑ Enter =RATE(48,-3000,100000) in a cell, and Excel displays 2% as the result. Use the Increase 

Decimal button on the Home tab to increase the number of decimal digits in the result, e.g., 

1.60%. 

The result (1.60%) means that you are paying a periodic interest rate of 1.60% to pay off the loan. To 

get the annual rate of interest, we multiply 1.60% with 12 (since we are making monthly payments). 

Thus, the annual interest rate is 1.60%X12, i.e., 19.2%. 

The above calculation is based on the assumption that the payments are made at the end of each 

period. If the payments are made at the beginning of each period (month), we can use the following 

function: RATE(48,-3000,100000, ,1).

You can also take the help of the Function Argument dialog box to enter the arguments to use the 

RATE function, as shown in Fig. 4.61. Notice that as you enter arguments in the dialog box, Excel 

updates the function in the worksheets and displays the result in the dialog box after you have entered 

the required arguments. Finally, press OK to insert the function in the worksheet. 

4.34.2 Using FV to Calculate the Future Value

The FV function returns the future value of an investment based on periodic, constant payments and a 

constant interest rate. For example, you want to save some money for purchasing a motorcycle after two 

years. You open a special deposit account where you deposit `2000 at the beginning of every month. 

The bank pays 12% annual rate that is compounded every month. (In other words, the monthly rate of 

interest is 12%/12, i.e., 1% per month.) To fi nd out how much money will be in the account at the end 

of 24 months, we can use the FV function. This function has the following syntax:

FV(rate, nper, pmt, pv, type)

Here, rate is the periodic rate of interest. All other arguments have the same meaning as discussed 

with the RATE function. (Pv and type are optional.) In this example, we will use the following 

arguments with the FV function:

rate 0.12/12

nper 24

pmt –2000

pv 0

type 1  (The fi rst deposit is made at the beginning of the month.)

Notice that we have to convert the annual rate of interest into the periodic (monthly) rate of interest 

as the payments are made on monthly basis. You can also enter 12%/12 as rate as Excel automatically 

uses 0.12 for 12%.

∑ Enter =FV(12%/12,24,-2000,0,1) in a cell or use the Insert Function button to enter it.

 Excel displays 27,243.20 as the result. That is, you would have `54,486.40 in your account after 

24 months.

4.34.3 Using PV to Calculate the Present Value

The PV function can be used to calculate the present value of a series of equal payments to be received 

in future. These payments are discounted at a fi xed periodic rate of interest. Obviously, the discount 

rate has to be realistic and is usually about the current interest rate. Suppose, for instance, you expect 

to receive `800 every month over the next 24 months. If the current discount (interest) rate is taken as 
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12.00% per annum, let us calculate the present value of these future payments to be received by using 

the PV function. This function has the syntax: 

PV(rate, nper, pmt, fv, type)

Here, rate is the periodic rate of interest. All other arguments have the same meaning as discussed with 

the RATE function. (Fv and type are optional.) In this example, we will use the following arguments 

with the PV function:

rate 0.12/12

nper 24

pmt –800

fv 0

type 0  if the fi rst payment starts after 1 month, 

 1 if the fi rst payment starts at the beginning of the month

Fv is taken as 0 as no payments are received after the last payment is received. 

∑ Enter =PV(0.12/12,24,-800) in a cell. 

 Excel displays 16,994.71 as the result. That is, the present value of a series of 24 monthly payments 

at a discount (interest) rate of 12% per annum is `16,994.71.

4.34.4 Using PMT

The PMT function can be used to calculate the equal periodic payments required to pay off a loan. 

Consider, for example, that you want to take a loan of `200,000 at an annual interest rate of 14%. The 

loan has to be repaid in 15 years in equal monthly instalments. You can calculate the required monthly 

instalment (EMI) with the PMT function. This function has the following syntax: PMT(rate, nper, pv, 

fv, type). Here, fv and type are optional.

In this case, we can use 14%/12 as rate (since we are making monthly payments, we have to use the 

monthly rate of interest), 180 as nper (15 x 12) and 200000 as pv. Since fv is zero and we are making 

payments at the end of the month, we can omit fv and type. 

∑ Enter =PMT(14%/12,180,200000) in a cell and Excel displays –2663.48 as the result. (Excel 

may display the negative number in parenthesis or in different color.) That is, to pay off a loan of 

`200,000 at 14% annual rate of interest in 180 monthly instalments, you have to pay `2,663.48 

every month.

4.34.5 Calculating Net Present Value with NPV

The NPV function is a slightly modifi ed form of PV. It calculates the net present value of a series 

of cash fl ows discounted at a fi xed interest rate. These cash fl ows, which need not be equal, occur at 

fi xed intervals and the fi rst cash fl ow occurs at the end of the fi rst period. For example, consider the 

worksheet shown in Fig. 4.62. You expect to get fi ve monthly payments that are entered in the range 

C2:C6. Assume that the discount (interest) rate that is entered in cell C8 is 10% per annum. We can use 

the NPV to calculate the net present value of these cash infl ows or incomes. The syntax of the NPV 

function is: 

NPV(rate, value1, value2, ...)

The formula =NPV(C8/12,C2:C6) entered in cell C9 displays `3,291.31. In this example, all values 

in the range C2:C6 are entered as positive values since these are payments received (cash infl ows) or 
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income. If you have to make a payment, i.e. there is a cash outfl ow, it has to be entered as a negative 

number. 

4.34.6 Calculating Internal Rate of Return with IRR

The IRR function calculates the internal rate of return (IRR) expected from a series of cash fl ows 

occurring at regular intervals. This is illustrated in Fig. 4.62. Here, an initial investment of `100,000 

entered in cell F2 results in 12 annual cash fl ows. The initial investment, which is an outfl ow, is entered 

as a negative value. The cash infl ows (income) are entered as positive values in the range F3:F14. The 

IRR function has the following syntax:

IRR(values, guess)

Fig. 4.62 Using NPV and IRR

Here, values includes the range of cash outfl ow (the initial investment) and cash infl ows. Guess is 

optional and in most of the cases, you can omit it. A formula =IRR(F2:F14) displays 9.51% as the 

result. This is the internal rate of return (IRR) for the investment of Rs. 100,000 with the expected cash 

infl ows.

4.35 USING TEXT FUNCTIONS 

Generally, most real-life workbooks have lot of text. After the text has been entered in the workbook, 

sometimes you feel the need to modify the text. For instance, you have entered the names of employees 

in upper case and now you want to change the text to proper case. Or you may like to fi nd out the 
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longest name you have entered in a range. Excel has several built-in functions for manipulation of text. 

You may fi nd the text functions particularly useful when data is transferred or copied from some other 

application, such as FoxPro or Word. Some of the common text functions are discussed in brief in this 

section. For more information on these or other text functions, refer to the Excel help system.

4.35.1 UPPER

The UPPER function converts the text to uppercase. For example, if cell A1 contains ‘Ram Krishna’, 

=UPPER(A1) entered in some other cell displays ‘RAM KRISHNA’ in that cell. 

4.35.2 LOWER

The LOWER function is opposite of UPPER. That is, LOWER("Train") or LOWER("TRAIN") 

returns ‘train’.

4.35.3 PROPER

The PROPER function converts the text to proper case, i.e., it capitalizes the fi rst letter in each word 

of the text. For instance, =PROPER("Raj KUMAR") or =PROPER("raj kumar") displays ‘Raj 

Kumar’.

4.35.4 LEFT

The LEFT function returns the specifi ed number of characters from the left side of a text string. For 

instance, if cell A1 contains ‘Ram Krishna’, =LEFT(A1,3) displays ‘Ram’, being the leftmost 3 

characters. 

4.35.5 RIGHT

The RIGHT function, which is opposite of the LEFT functions, returns the specifi ed number from the 

right side of a text string. For instance, if cell A1 contains ‘Ram Krishna’, =RIGHT(A1,7) displays 

‘Krishna’, being the rightmost 7 characters.

4.35.6 MID

The MID function returns a specifi ed number of characters from a text string starting at the specifi ed 

character position. This function has the syntax—MID(text, start_num, num_characters). For instance, 

=MID("High-tension lead", 6,7) displays ‘tension’. 

4.35.7 CLEAN

The CLEAN function removes nonprintable characters from text. You may fi nd this function useful 

when your worksheet contains data exported by another application. 

4.35.8 LEN

The LEN function returns the number of characters including spaces in a text string. For instance, 

=LEN("TRAIN") displays 5.

4.35.9 CONCATENATE

The CONCATENATE function is used to join several character strings together. For instance, if cell B1 

contains ‘Ram’ and cell B2 contains ‘krishna’, =CONCATENATE (B1,B2) displays ‘Ramkrishna’.
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4.36 USING GOAL SEEK 

Consider the formula =PMT(B2/12,B3,B4) entered in cell B6 in Fig. 4.63. It calculates Equated 

Monthly Instalment (EMI) to pay off a loan of ̀ 100,000 at 8% annual interest rate in 36 months. Notice 

that we have used “B2/12” in the formula to convert the annual interest rate to the monthly interest rate 

because the repayment frequency is monthly. The formula result means that the required monthly EMI 

payment is `3,133.64. 

Fig. 4.63 Using Goal Seek on the PMT() function

Now, let us assume that customer cannot afford this EMI payment and wants to fi nd out the number of 

months it will take to pay off the loan if he/she reduces the monthly payment to ̀ 2,500. In this situation, 

you would fi nd Excel’s Goal Seek useful. 

∑ To use this tool, click the Data tab. Next, click the cell that contains the PMT formula, i.e., cell 

B6, click What-If Analysis and then click Goal Seek as illustrated in Fig. 4.63. In response to this 

command, Excel displays the Goal Seek dialog box shown in Fig. 4.64 

Goal Seek helps you to fi nd the input value required to get the 

desired result. The Goal Seek dialog box contains three text 

boxes: 

 1. Set Cell : Contains the formula.

 2. To Value: Desired result value.

 3.  By Changing Cell: The cell whose value should be 

changed to get the desired result. 

∑ The Set Cell already contains B6, the cell containing the formula. If we enter -2500 in the To Value

box and B3 in By Changing Cell box, and click OK, Excel displays the Goal Seek Status dialog 

box on the screen and puts 46.6781 in cell B3, which means that it will take 46.67 months to pay 

off the loan at `2,500 per month. 

4.37 USING IF TO MAKE A FORMULA FLEXIBLE 

We need to use fl exible formulas several times in our day-to-day life. For instance, if the gross total 

value of items purchased by a customer is ̀ 4000 or more, he/she is entitled to a 15% discount, otherwise 

Fig. 4.64 Goal Seek dialog box
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to 10%. Similarly, if a guest stays in a hotel for three or more days, he/she is entitled to a 10% discount; 

however there will be no discount for a stay of less than three days. In these situations, we need to use a 

formula that depends on the result of a condition. This can be accomplished by using the IF() function 

in the formula, which has the following syntax: 

IF(condition, true-value, false-value)

This function checks for the condition and if the condition is evaluated as true, it returns true-value, 

else, i.e., when the condition is false, it returns false-value. Consider the formula entered in a cell.

=IF(B4 >= 4000, 0.15, 0.10)

Excel checks for the contents of cell B4. If it contains a value that is more than or equal to 4000, it 

displays the true-value, i.e., 0.15 , otherwise, Excel displays the false-value, i.e., 0.1. Similarly, the 

formula =IF(B4 >= 4000,B4*15%,B4*10%) entered in a cell calculates a discount equal to 15% or 

10% depending on the condition “B4 >= 4000”. 

4.38 SORTING DATA 

Excel is often used to manage large amount of data, such as payroll details for employees working in an 

offi ce, products sold by salesperson of a company during a year, daily temperature and rainfall details 

for a city during the last two years, and so on. This type of information, which can run into hundreds, or 

even thousands of rows is known as list, table, data list or even database. Often we need to rearrange the 

long list of data in the desired order, e.g., you may like to sort the employees’ list entered in the STAFF 

workbook fi le shown in Fig. 4.65 in an alphabetical order of names, department or designation.

Fig. 4.65 Workbook containing list of employees
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4.38.1 Using Sort Buttons

To quickly sort a the data list (database) in ascending or descending order, Excel provides two buttons 

on the Data tab:  (Sort Ascending) and  (Sort Descending). You may use these buttons to sort the 

data on the ascending or descending order of any fi eld (column). For instance, to sort the employees’ 

database shown in Fig. 4.65 in the ascending order of names:

∑ Click any cell in column A (e.g., cell A9) in the data list range. Click the Data tab, if required and 

click . Figure 4.66 displays the employees’ list sorted on the Name fi eld. 

Fig. 4.66 Employees’ list sorted in ascending order of names

Note  You can also access the Sort and Filter commands by clicking the Sort & Filter button on the Home 

tab and then choosing the required command from the drop-down menu. 

∑ To change the sorting in the descending order of names, you may click  while the cell pointer is 

located anywhere in column A in the data list range. Similarly, to sort the database on Department, 

Designation or Salary column, move the cell pointer anywhere in the corresponding column in the 

list and click the required Sort button.

4.38.2 Sorting on Multiple Columns (Fields)

The Sort buttons can sort the data only on a single column. To sort the data on multiple columns (fi elds), 

you can use the Sort Dialog box. Let us sort the employees’ list shown in Fig. 4.65 in ascending order 

of Department, ascending order of Designation and from smallest to largest value of Salary. 
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∑ Click any cell in the data range, e.g., cell B8. Click the Data tab, if required and then click the large 

Sort button. (See Fig. 4.66.) 

Excel displays the Sort dialog box shown in Fig. 4.67. If your database is sorted on some column, Excel 

displays the corresponding fi eldname in the Sort By box. Notice that the ‘My list has headers’ check 

box in the top right corner is checked as our list has column headings in the top row of the list. 

Fig. 4.67 Sort dialog box

∑ Click the Sort by drop-down list box and click Department, the fi rst sort by column. The default 

value of Sort On, Values is okay. Similarly, the default value of sort order, which is “A to Z” is 

good for the ascending order sort. 

∑ Click Add Level to add controls for the next sort level on the Designation column. Choose 

Designation as Sort by column. Default values of Sort On and Order are good in this case.

∑ Click Add Level to add controls for the last sort level. Choose Salary as Sort by column. Default 

values of Sort On and Order are good in this case. At this stage, the Sort dialog box should look 

similar to Fig. 4.68.

Fig. 4.68 Sort dialog box with three sort by columns

∑ Click OK to ask Excel to sorts the list as shown in Fig. 4.69.
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Fig. 4.69 Data sorted on three columns

4.39 FILTERING DATA 

When the data list in a worksheet contains a lot of rows, it is helpful to analyze data if we can view only 

the data that meets specifi ed criteria and temporarily hides other rows. For instance, while working on 

Managers in the employees’ list similar to Fig. 4.65, you can hide employees who are not managers. 

Excel enables you to accomplish this by applying AutoFilter on a data list. Let us try AutoFilter on the 

staff list shown in Fig. 4.69. 

∑ Click any cell in in the data range, e.g., cell B8. Click the Data tab, if required and then click the 

Filter button. (See Fig. 4.70.) 

Excel applies AutoFilter on the data and displays drop-down arrows on the right side of all columns in 

the header row, as shown in Fig. 4.70. These arrows enable you to display only those rows (records) in 

a data list that contain a specifi ed value (e.g., Salary = 65000 or Designation = Manager), or that meet 

a set of criteria (e.g., Department = Sales and Salary > 46000).

∑ To specify criteria on a particular column, you need to click the corresponding drop-down arrow. 

For example, on clicking the drop-down arrow on the right side of Designation fi eld, Excel 

displays a drop-down list as shown in Fig. 4.71. 
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Fig. 4.70 Using AutoFilter

Fig. 4.71 Choosing AutoFilter options on the Designation fi eld
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The list displayed on clicking the drop-down arrow is used to apply a fi lter on the selected column. 

∑ Click Select All, the fi rst check box to uncheck all selections. 

∑ Next, click Manager, as we want to display rows containing Manager in the Designation 

column. 

∑ Finally, click OK to ask Excel apply AutoFilter. 

The fi ltered list should look similar to Fig. 4.72. Notice that icon displayed to the right of the Designation 

column has changed to the fi lter icon ( ).

Fig. 4.72 AutoFilter applied on the Designation fi eld

Note  If you want to fi lter data with more than one option, e.g., Manager and Assistant, check the required 

options before clicking OK. 

4.39.1 Applying Custom Filter

To apply a custom fi lter, e.g., Designation begins with “A”, Salary > 50000, Salary >= 50000 and 

Salary <= 60000, top 10, above average, below average, etc., click Text Filters/Number Filter

(see Fig. 4.71) and choose the required option from the menu. 

4.39.2 Removing Filter 

∑ To remove the fi lter applied on a column, click the corresponding fi eld’s Filter icon (see Fig. 4.72) 

and the Clear Filter command in the drop-down menu.

∑ To completely remove AutoFilter from the data, click the Filter button on the Data tab.

4.39.3 Applying Filter on Multiple Columns

∑ You can apply fi lter on multiple columns, e.g., employees belonging to the Sales department and 

who are Assistant. To do so, apply AutoFilter on the fi rst column in the usual way. After Excel 

displays the fi ltered data, apply AutoFilter on the second column in the same way.
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4.40 USING DATABASE FUNCTIONS 

Database functions are similar to the statistical functions already discussed in this chapter. However, the 

difference between the two is that database functions use only those records in calculations that meet 

the specifi ed criteria. For instance, from the employee database, you can calculate the average salary 

of the employees working in a particular department; the sum of salaries paid to the employees of a 

particular department; the number of employees working in a particular department. The commonly 

used database functions are listed in Table 4.5. In this section, you will use some of the database 

functions on employees’ list (database). 

Table 4.5 Common database functions

DAVERAGE Calculates the average value in a fi eld of a database based on specifi ed criteria.

DCOUNT Counts the cells that contain numbers that match the criteria in the fi eld column of records 

in the database.

DMAX Finds the largest value in a fi eld from the selected records of a database.

DMIN Finds the minimum (least) value in a fi eld from the selected records (based on the specifi ed 

criteria) in a fi eld of a database.

DSTDEV Calculates the standard deviation of the selected records (based on the specifi ed criteria) in 

a fi eld of a database. 

DSUM Calculates the sum of the selected records of a database.

DVAR Calculates the population variance of the selected records of a database.

Figure 4.73 shows the use of the DMAX function to calculate the maximum salary payable to the 

employees working in the Production department (criteria). Here the data (database) is entered in the 

range A4:E18 and criteria in the range G4:G5. Notice that the function entered in cell D20 uses range 

names. (See the section on how to defi ne range names. If you do not defi ne range names, specify the 

range address with DMAX, e.g., the DMAX(A4:E18,4, G4:G5) function.) The DMAX function has 

the following syntax: 

DMAX(database,fi eld,criteria)

Therefore, to use this function, we need to specify three arguments (data):

1. Database: This specifi es the database rows (records), including column names (fi eldnames) to be 

used in calculations. 

2. Field: Field is a positive number that specifi es the fi eld in the database range to be used for 

calculations. Use 1 for the fi rst fi eld, 2 for the second fi eld, and so on. For instance, the Salary fi eld 

in Figure 4.73 has the number 4. 

3. Criteria: This specifi es the range containing the condition(s) to be applied to the database.

Thus, in the function DMAX(Input,4,Criteria), Input is the name of the range that contains the 

database (A4:E18), 4 is the fi eld number (Salary) and Criteria is the name of the range than contains 

the criteria (G4:G5) to be applied on the database. Accordingly, the function calculates the maximum 

salary of the employees working in the Production department.
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Fig. 4.73 Using the DMAX database function

4.41 INSERTING PICTURE, CLIP ART, SHAPES, SMART ART,

 SCREENSHOTS, WORDART, TEXT BOX AND SYMBOL 

Excel includes several useful tools in the Illustration group on the Insert tab to insert pictures, clip art, 

shapes, smart art and screenshots in your worksheet. The Insert tab also includes other tools to insert 

WordArt, text box and symbols. Figure 4.74 displays a few of these objects inserted in a worksheet. 

The process of inserting a clip art, WordArt, smart art, text box and symbol in an Excel worksheet 

is exactly the same as in Word document. For instance, 

∑ To insert a picture, click the Picture button, choose the picture and drag the mouse on the worksheet 

to place it at the desired location. 

∑ Take the help of the Picture Tools displayed by Excel on the Ribbon to resize, reposition or format 

the inserted picture. 

∑ You can insert a WordArt, clip art, text box, etc., in the same way. Refer to Sections 3.37 through 

3.39 to learn more about how to insert these object. 
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Fig. 4.74 Clip art, WordArt, picture, shape and SmartArt used on a worksheet

4.42 COPYING THE FORMAT USING FORMAT PAINTER 

Format Painter ( ) can help you save time by quickly applying the formatting from one cell to another. 

The copied formats can then be pasted (applied) to any cell or range in the same or another workbook. 

Consider the worksheet shown in Fig. 4.75. You will agree that it will more than a few mouse clicks to 

format a cell like B3. Assume that you want to use exactly the same format on cell C3. Instead of using 

so many formatting commands again, you can use Format Painter to copy the formatting from cell B3 

and then paste it on cell C3. It requires the following steps:

Fig. 4.75 Using Format Painter to copy format

∑ Click cell B3 whose format you want to copy. 

∑ Click  on the Mini toolbar or the Clipboard group on the Ribbon. Excel changes the shape of 

the mouse pointer by attaching a paintbrush to it. 
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∑ Click cell C3 and Excel formats this cell exactly like cell B3. 

In the last step, we applied the copied format to a single cell. If you like, you can apply the copied 

format to multiple cells by dragging through the range where you want to apply the formatting. 

4.43 FINDING AND REPLACING DATA IN A WORKSHEET 

The Find command can help you to quickly locate a cell containing the specifi ed data. You would fi nd 

this command particularly useful when your worksheet contains many rows and columns, or it contains 

several worksheets. 

∑ To fi nd text, press Ctrl+F. Alternatively, click Find and Select button on the Home tab to display 

a menu and then click Find in the menu. Excel displays the Find and Replace dialog box shown in 

Fig. 4.76.

Fig. 4.76 Find and Replace dialog box

∑ Enter the text you want to search for in the Find What text box and click the Find Next button. By 

default, Excel searches for the text in the current worksheet. If you want to search in all worksheets, 

click Options and choose the Workbook option prior to clicking Find Next. 

∑ If you want to view all occurrences of the search text, click Find All in the Find and Replace dialog 

box. In that case, it lists the matching cells in the dialog box. 

If you wish to fi nd a specifi ed text and replace it with another text, press Ctrl+H or choose the Replace 

command from the Find and Select menu. The Find and Select menu also has commands to search for 

comments, formulas, conditional formatting, etc.

4.44 SPELLING CHECK 

To ensure that there are no spelling mistakes in your worksheet, you can take the help of Excel’s 

spelling checking tool. 

∑ To start spelling checking, press F7 or click Spelling button on the Review tab. 

The spelling checking in Excel works similar to that in the Word program. That is, Excel checks if all 

words used in a sheet can be found in the built-in or custom dictionaries. If any word is not found in 

these dictionaries, Excel tries to offer suggestion(s) for replacing that word. 

∑ If you feel that the word is spelled correctly, click the Ignore or Ignore All button. 
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∑ To accept any suggestion, click the suggestion that you want to use and click Change or Change 

All button. 

For more information on how to use spell check, refer to Chapter 3. If you select a range prior to 

invoking spelling checking, Excel checks only the selected range; otherwise, it checks the entire sheet. 

The spelling checking is done only on the active sheet(s). Therefore, if you do not select multiple 

sheets, it checks only the current sheet. To select multiple sheets at once, perform these steps. 

∑ Click the Sheet name on sheets tab that you want to select. 

∑ To select another sheet, press and hold the Ctrl key and click the sheet name. When multiple 

sheets are selected, Excel displays ‘[Group]’ in the title bar. You can repeat this step to select 

additional sheets.

∑ Press F7 to start spelling checking. 

4.45 PROTECTING A WORKBOOK WITH A PASSWORD 

To prevent unauthorized access to your workbook fi le, you can assign a password to it. Excel supports 

two types of passwords—(a) a password to open the workbook fi le and (b) a password to change the 

workbook. You can defi ne either or both passwords for any workbook fi le. 

∑ To password protect the current workbook, click File to go to the Backstage view and click Save 

As to open the Save As dialog box. 

∑ Click Tools to display a submenu shown in Fig. 4.77.

Fig. 4.77 Password Protecting a workbook
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∑ Click General Options to display the General Options dialog box shown in Fig. 4.78. 

Fig. 4.78 General Options dialog box to defi ne passwords

The dialog box allows you to defi ne two passwords—one to open the workbook and the second to 

modify the workbook. The use of Password to modify is optional.

∑ After defi ning password(s), Word asks you to reconfi rm the passwords. 

Remember that passwords are case-sensitive and if you forget these, you may not be able to open the 

document. That is, after defi ning ‘swamy’ as the password, you cannot enter ‘Swamy’ or ‘SWAMY’ to 

open the workbook.

4.46 PROTECTING A SHEET IN A WORKBOOK 

If your workbook contains several sheets and a particular sheet contains important data or formulas 

that you do not want other users to change, you may protect that sheet. The sheet protection is done 

independent of the workbook protection. In other words, you may protect a sheet even when the 

workbook is not protected. 

∑ To protect a sheet, click the Review tab, click the Protect Sheet button in the Changes group and 

Excel displays the Protect Sheet dialog box shown in Fig. 4.79. 

Fig. 4.79 Protect Sheet dialog box 
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∑ Now enter a password and click OK. Excel asks you to reconfi rm the password. 

∑ After a sheet has been protected, Excel does not allow you to make changes to the data. To make 

changes to the data, you need to unprotect the sheet by clicking Unprotect Sheet on the Review 

tab and providing the correct password. 

Note  Advanced users may unlock specifi ed range(s) on a worksheet through the Allow Users to Edit 

Ranges button on the Review tab prior to protecting a worksheet. In that case, Excel allows to make 

changes in the unlocked range(s) while rest of the worksheet remains read-only.

4.47 IMPORTING AND EXPORTING DATA 

Excel enables you to import data from a number of other sources, such as an Access database, Web 

pages, text fi les (.txt, .csv), SQL Server, etc. To import external data into an Excel worksheet, click Get 

External Data on the Data tab, choose appropriate option and choose the data source. 

In the same way, you can save an Excel workbook in several different fi le formats by choosing the 

desired fi le format in the Save As Type box in the Save As dialog box, as shown in Fig. 4.77. Now 

choose the desired format and click OK to save the Workbook in the selected format.

4.47.1 Saving a Workbook as a PDF File

Excel provides a convenient command to create a PDF fi le from a workbook on the Backstage view. 

This functionality works exactly as in Microsoft Word already discussed in the previous chapter. Refer 

to Section 3.45 for details. 

4.47.2 Sending a Workbook as an Email Attachment 

If you want to send the current workbook as an attachment to an Email, click Save and Send link in the 

Backstage view. Refer to Section 3.46 for details as it works exactly like in Word. 

4.48 SAVING A WORKBOOK AS TEMPLATE 

Sometimes you may need to create similar types of workbooks on regular basis. For instance, a company 

may need to create a monthly budget workbook every month. Similarly, one may need to prepare 

invoice or expense statements on regular basis. Instead of creating these fi les from scratch, you may use 

a template workbook that already contains the basic data, such as the company name, address, headings, 

logo, required formulas and formatting. In other works, you create the skeleton of the required fi le (say 

Invoice) in a template. Creating a template is as simple as creating a regular workbook fi le: 

∑ Create a new workbook fi le and enter the required data and formulas in the usual way. Format the 

cells as per requirement. 

∑ When the workbook is ready, click the File tab to open the Backstage view and click the Save As

command to display the Save As dialog box. In this dialog box, choose Excel Template as the fi le 

type. (See Fig. 4.77.)

∑ Enter the desired template name in the File Name box and click the Save button to create the 

template fi le. While creating a template fi le, it is suggested to save it in the default folder. 
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4.48.1 Creating a Workbook Based on a Template

∑ To create a new workbook based on your template, click New in the Backstage view, choose your 

template and click Create. Refer to Section 4.6 for details. 

4.49 CHANGING EXCEL OPTIONS 

The Excel program is very fl exible. You may control the appearance of the workbook and the working 

of the program through the Excel Options dialog box shown in Fig. 4.80, which you can display by 

clicking Options in the Backstage View. Figure 4.80 displays the General page of the Options dialog 

Fig. 4.80 Excel Options dialog box

box. This page is used to control the general options, including the standard or default font name and 

size. The various options that you can control through the Options dialog box are grouped in various 

categories, such as Formulas, Proofi ng, Save, Language, etc., listed in the left pane of the dialog box. 

You may click any category link to display the corresponding options. You may go through these 

categories to learn more about the options you can change. For help, click the Help button on the Title 

bar of the Options dialog box or press F1. 
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5
MICROSOFT ACCESS

In this chapter, we will discuss the following topics:

Microsoft Access �

Starting Access �

Creating a Database  �

Table �

Creating a Table in Datasheet and Design View, Field Types,  �

Primary Key, and Field Properties

Using Lookup Wizard �

Opening an Existing Database �

Opening and Editing Data in a Table: Navigating Records, Insert  �

and Delete Records, Rename, Resize, Reposition, Freeze and 

Unfreeze Fields

Relationship between Tables and Viewing Related Information �

Query: Creating a Query using a Wizard and Design View, Sorting  �

Query Output, Using Criteria, Saving and Modifying a Query

Form: Using Form Tool, Wizard and Design View to Create a Form �

Report: Using Report Tool and Wizard to Create a Report �

Exporting Data from an Access Object �

Importing and Linking External Data �

Using a Table/Query as Mail Merge Data Source �

Finding and Replacing Data in a Table �

Spelling Checking �

Formatting Datasheet �

Programming in Access �

Using Analyze Tools �

Database Security �

Backup a Database �
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5.1 MICROSOFT ACCESS 

Microsoft Access is an easy to use program developed by Microsoft Corporation to maintain and 

use relational databases. Microsoft Access is a Relational Database Management System (RDBMS) 

program similar to Oracle, MySQL, Visual FoxPro and Microsoft SQL Server, though on a smaller 

scale. Access may not be as powerful as other RDBMS programs; however, it’s easy to use graphical 

user-interface (GUI) makes it popular on PCs. 

Do not get confused by the terms database, relational database and RDBMS. Basically, a database is 

an organized collection of related information. In other words, a database provides a unifi ed approach 

to store all kinds of information. For instance, with reference to a wholesale store, a database may 

store all information (usually called data) regarding suppliers, products, purchase orders, customers, 

invoices, payments, receipts, etc. As the data is stored in a linked or related manner (hence the name 

Relational Database Management System), extracting the required information from a database is very 

easy. For instance, one can easily query the list of suppliers from a particular city who were sent 10 or 

more orders last year, each order having a value between `5,00,000 and `6,00,000. Access can display 

this information on the screen in the form of a simple list or nicely formatted report. Access can also 

help you add and edit data in the database through easy-to-use forms, which may even prevent users 

from entering invalid data. 

The Access program was fi rst released in 1992. Microsoft updated the Access program on a regular 

basis. Access 97, Access 2000, Access 2002 (XP), Access 2003, Access 2007 and Access 2010 are 

some of the common Access versions in use. Though, the newer versions have some new features and 

capabilities, the basic features and capabilities of program are the same in all versions. In this book, we 

shall discuss Access 2010 running on Windows 7. If you use some other version of Access or Windows, 

the screen displays that you get may differ slightly from those shown in the book, particularly if you 

use version 2003 or earlier as Access has replaced the menu interface with the Ribbon interface since 

Access 2007.

5.1.1 Starting Access

Depending on how your PC is setup, you can start Access in several ways: 

∑ If there is an Icon for Access on your desktop, double click that icon to start Access. The Access 

icon normally looks like .

∑ If the Access icon is available on the taskbar or Quick Launch toolbar on the taskbar, you can start 

Access by clicking that icon. 

∑ You may also start Access from the Windows menu like any other program. The Access program 

may be located in the Start menu or anywhere in the menu system; however, normally you will 

fi nd it in the Programs/All Programs submenu, Microsoft Offi ce or Microsoft Applications. On 

Windows 7, click the Start button on the taskbar, click All Program and Windows displays the 

list of programs installed on your computer. Click the Microsoft Offi ce folder in the programs list 

and click Microsoft Access 2010, as illustrated in Fig. 5.1 to start Access.

The Microsoft Access window appears on your screen. Unlike other Offi ce programs, such as Word 

and Excel, Access opens in the Backstage view, as shown in Fig. 5.2. The Backstage view provides 

a convenient place to create a new database, open an existing database as well as display useful 

information about the current database. 
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Fig. 5.1 Starting Microsoft Access

Fig. 5.2 Access Backstage view
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The Access window looks quite similar to a typical Microsoft Offi ce application. On the extreme top 

left is the Quick Access toolbar that contains controls for common commands, such as Save, Undo and 

Redo. Of course, you can customize the Quick Access toolbar as well as the Ribbon, which is currently 

hidden. Refer to Section 3.49 to learn how to customize the Quick Access toolbar or the Ribbon. The 

title bar displays the name of the program in the middle and the window control buttons on the right. 

When a database is open, Access also displays its name in the title bar. 

When Access starts, it selects the New command by default. Like other Microsoft Offi ce programs, 

the Navigation bar on the left side of the window contains familiar commands, such as Save, Save As, 

Close, Recent, Print, Help, Options and Exit.

5.2 CREATING A DATABASE 

You can click New in the Navigation bar in the Backstage view to create a new database. In Access, a 

new database is always based on a template. The template is a special Access fi le that creates a complete 

database. While the Blank Database template, as the name implies, only creates a blank database, other 

templates may create tables, relationships, forms, reports and other objects besides creating a new 

database. Each template is designed for specifi c needs, e.g., sales, events, tasks, budget, etc. If a template 

meets your requirements, you may use it to speed up the database design. The Available Templates box 

displayed in the middle shows the templates installed on your computer and available for use. For 

additional templates, you may search at Offi ce.com, Microsoft’s online resources and download these 

to your computer. Let us create a new database based on the Blank Database template. 

∑ Ensure that Blank database is selected in the Backstage view. 

∑ As shown in Fig. 5.2, Access assigns a default name, such as Database1 and a default folder to 

store the new database. You should assign a meaningful name to your database. Similarly, you 

may choose a different location to store the database by clicking the Folder icon, which opens the 

File New Database dialog box shown in Fig. 5.3.

Fig. 5.3 Choose fi lename and folder for creating a new database



Microso   Access    277 2 

The File New Database dialog box enables you to assign a name to your database and choose a 

location (folder) to store it. You type the name for your database in the File Name box. To open any 

folder, whose icon is displayed in the left pane, click it. Similarly, to store the database in the subfolder 

of the currently selected location, e.g., GardenTools, double click the corresponding icon. 

∑ By default, Access 2010 creates the database in Microsoft Access 2007 format which is good for 

Access 2010 and Access 2007. If you plan to use the database with Access 2000/2002/2003, click 

Save as type and choose the corresponding format. Click OK to close File New Database dialog 

box and return back to the Backstage view.

Note  Access uses “accdb” fi le extension name for 2007 format databases and “mbd” for 2000/2002-2003 

format. Do not change the fi le extension name. 

∑ Click the Create button. 

Access creates the database and switches to the Fields tab as shown in Fig. 5.4. Notice that it displays 

the database name and format (Access 2007) in the title bar. It has created an empty table Table 1 and is 

displaying Table Tools in the Ribbon which can help you to design the table for your database.

Fig. 5.4 Access displaying a blank database

Note  When you create a database based on a template other than Blank Database, usually you would see 

one or more tables and other objects in the Navigation pane on the left.

5.3 WHAT IS A TABLE? 

A table is the basic building block of an Access database. All the data you want to maintain in a 

database is stored in tables. Depending on the complexity of the database application you want to 

maintain, a database may contain several tables. Each table holds one type of data. For instance, in a 

typical Stores database, the Customers table is used to enter the list of customers, and the Employees 
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table to store details about employees. We cannot store employees in the Customers table or customers 

in the Employees table. Similarly, we cannot store the invoice data in the Salary table, and vice versa. 

This keeps the data well organized and easy to use. Though the data is divided among separate tables, 

the data stored in various table is linked. This helps in better organization of data in the database. We 

shall discuss how linked tables work later.

The organization of data in a table looks similar to the row-column setup in an Excel spreadsheet. 

(See Fig. 5.5.) However, in a table, rows are called records and columns are called fi elds. A record 

is one set of data, e.g., student details (name, date of birth, address, etc.) for a student constitute a 

record. To better organize and manage the information in a record, it is divided into various units 

called fi elds. Each fi eld stores one type of information. For example, to store fi rst name, last name, date 

of birth, email, address, city, state, PIN, etc., for a student table, we use separate fi elds to store each 

piece of data. In other words, each fi eld of table is used to store a distinct unit of data. Unlike cells in 

a spreadsheet, the number of fi elds in a table is predefi ned and we can restrict the type and amount of 

data that can be entered in various fi elds. Basically, to organize data in records of a table, it is divided 

into various fi elds. 

Fig. 5.5 Access displaying a table with few records

5.4 CREATING A NEW TABLE IN A DATABASE 

The Tables group on the Create tab contains two tools to create a new table in the current database, 

which are Table and Table Design. The Table tool creates a table in the Datasheet view whereas Table 

Design creates the table in Design view. While you can create table with either tool, the Table Design 

tool gives you more control on the table structure. Even if you create the table in the Datasheet view, 

you can later modify it in the Design view. We would fi rst describe creating a table in the Datasheet 

view. 

5.4.1 Creating a Table in the Datasheet View

The Datasheet view lets you create a table by simply choosing the fi eld types and defi ning fi eld names 

in a datasheet that resembles an Excel worksheet. 

∑ Click the Create Tab and then click  in the Tables group. 
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Access creates a new table, assigns it a name such as Table 1 and displays in the Datasheet view, as 

shown in Fig. 5.6. 

Fig. 5.6 A table being designed in the Datasheet view

The left pane in the Access window is called the Navigation pane, which contains list of all objects in 

the database. Besides the table objects, an Access database can also have reports, queries, forms, code 

and macro objects. If required, you can collapse the Navigation pane, as illustrated in Fig. 5.6. 

When Access creates a table with the Table tool, it automatically adds an ID fi eld. Let us add another 

fi eld to the table. 

∑ Click Click to Add, as illustrated in Fig. 5.6 to choose the data type for the fi eld. Access displays 

a list of supported fi eld types in a drop-down list shown in Fig. 5.7. 

Fig. 5.7 Selecting the fi eld type
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You already know that a record is divided into different fi elds to store different types of data. Moreover, 

the data you store in different fi elds may also be of different types, e.g., text for names, numeric for 

salary and date for date of birth. Access supports several fi eld data types as displayed in the drop-down 

list shown in Fig. 5.7. The various fi eld types are described in detail in Table 5.1.

Table 5.1 List of Access data types

FIELD TYPE DESCRIPTION

Text Can include any printable character including numbers and symbols. Use for data that does not 

require calculations. Can include data up to 255 characters.

Memo Use for long textual details, e.g., product specifi cations, book abstract, technical paper, letter, 

memorandum, etc. The Memo fi eld can hold data up to 63,999 characters in length.

Number Stores any kind of numeric data that may be used in calculations.

Date/Time Store a date/time value. Suitable to store the date, time or date and time value.

Currency A special kind of more precise numeric data type that makes it suitable to store currency data. 

AutoNumber As records are created in a table, AutoNumber automatically generates sequential numbers 

(incremented by 1). Generally used to create a primary key for the table.

Yes/No Stores either Yes or No in the fi eld. Suitable when the fi eld can have only two values, e.g., true 

or false, pass or fail, yes or no, present or absent, and so on.

OLE Object Can hold an object, e.g., a Microsoft Word document, Excel spreadsheet, sound or graphics fi le.

Hyperlink Used to create a hyperlink to a document on Local Area Network (LAN) or a web page on the 

Internet.

Attachment Any supported fi le type. For instance, you may use this fi eld to attach a Word document or Excel 

workbook to this type of fi eld.

Lookup 

Wizard

A special type of fi eld used to create a dropdown combo box. Useful to let the user choose a 

value from the predefi ned list that may be typed manually or is available in another table. For 

instance, you may use Lookup Wizard to select Department name, payment type, name of state, 

etc., as this type of data has limited and predefi ned choices.

Calculated This fi eld, which is new in Access 2010 contains the result of calculation performed on other 

fi elds. For instance, it may be used to calculate the inventory value by multiplying the UnitCost 

with the Quantity fi eld.

∑ Click to choose the appropriate fi eld type in the fi eld type list, and Access assigns a default fi eld 

name such as Field1 to the fi eld, as shown in Fig. 5.8. 

Fig. 5.8 Typing fi eldname for the added fi eld
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∑ Type the desired name for the fi eld, e.g., FirstName, First_name, Salary, etc. 

Tip  Access allows fi eld names up to 64 characters long, however, avoid very long fi eld names. Also, 

though Access allows the use of blank spaces in a fi eld name, it is recommended to avoid this. 

However, the use of the underscore character (_) in fi eld names is generally accepted.

∑ Notice that Access has added another “Click to Add” column to defi ne the next fi eld. Follow the 

same steps to defi ne other fi elds for the table. 

After you have defi ned all fi elds for your table, let us save the table. 

∑ Click  on the Quick Access toolbar (see Fig. 5.8) to display the Save As dialog box. 

∑ Type the desired table name in the Save As dialog box and click OK. 

Access saves the table and the table name appears in the Navigation pane in the Tables section.

5.4.2 Creating a Table in the Design View

The Design view table creation process gives you more control to defi ne the table structure. Besides the 

fi eld name and type, you can also defi ne fi eld properties, as you would see soon. Let us create a table 

in the Design view. 

∑ Click the Create Tab and then click  in the Tables group. 

Access switches to the Design view, creates a new empty table and displays it in the Access window, 

as shown in Fig. 5.9. Notice that Access is also displaying Table Tools on the Design tab, which you 

would fi nd helpful in the table design process.

Fig. 5.9 A table being designed in the Design view

The right pane in the design view has two sections. The upper section is used to defi ne the fi eld 

name, data (fi eld) type and an optional description for the fi eld. A separate row is used to defi ne each 

fi eld. The lower section is used to defi ne additional fi eld properties, such as length, format, caption, 

etc., for each fi eld. Most of the fi eld properties are optional.
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When you want to design a table, you already know the kind of data you want to store in the 

table and how you want to divide the record into different fi elds. For each fi eld, you need to assign 

a fi eld name, e.g., the fi eld to store an employee name may be called EmployeeName, EmplName or 

Employee_Name.

∑ Type the fi eld name, press Tab to move to the next column (Data Type), where you defi ne the type 

of data you want to assign to the fi eld. 

∑ The default data type, also known as fi eld type is Text, which allows all printable characters to be 

stored in the fi eld. To change the data type, click the drop-down arrow on the right side of the Data 

Type column, as illustrated in Fig. 5.10.

Fig. 5.10 Choosing Data Type for a fi eld

You should choose a fi eld type appropriate for the type of data you want to store in that fi eld. Usually, 

selecting the data type for a fi eld is straight forward based on common sense. For instance, for storing 

numeric data that may be used in calculations, use the Number data type. You fi nd some data, e.g., 

phone number, an invoice, bill number, etc., that looks numeric but you never perform any numeric 

calculation on this data. In that case, it is recommended to use Text data type to store this kind of data 

in Access tables.

5.4.3 Field Size for Number Data Type

The numeric data you want to enter in a table can be of different size, with or without decimal digits. 

While a small number requires only one byte of storage space in the table, a large number may require 

as much as 16 bytes. To prevent your tables from growing too large when you add records, it is 

recommended to choose the fi eld size based on the type of data to be stored in a numeric fi eld. To store 

integers (numbers without decimal part), here are the choices:

Byte  Stores number from 0 to 255.

Integer Stores numbers from –32,768 to 32,767.

Long Integer Stores numbers from –2,147,483,648 to 2,147,483,647. This is the default Field Size 

setting for the Number Data type.
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To store numbers that have decimal part, use any of the following choices: 

Single 7 digits of decimal precision.

Double 15 digits of decimal precision.

Decimal 28 digits of decimal precision.

Primary Key As you know, an Access table may contain thousands or even millions of records. 

When you want to retrieve or update specifi c data from the table, it is very important that Access is 

able to distinguish one record from another. To accomplish this, the primary key plays an important 

role, as it uniquely identifi es each record in the table. Assume that you visit the Income Tax Department 

to enquire about the Income Tax return of Raj Sharma. However, the Income Tax Department may 

have hundreds of Raj Sharma in its fi les. To distinguish one Raj Sharma from the other, Income Tax 

Department assigns a unique Permanent Account Number (PAN) to each person on its fi les. The 

primary key plays the same role in an Access table to uniquely identify each record in a table. You may 

designate any fi eld in the table as a primary key if each record in the table contains a unique value in 

that fi eld. For example, in the products table, the product code fi eld may act as the primary key for the 

table. However, if there is no such fi eld in the table, use an AutoNumber fi eld. 

∑ To designate a fi eld as the primary key while designing a table, click the mouse on that fi eld in 

the Table Design window and click Primary Key on the Design tab (see Fig. 5.10) or choose the 

Primary Key command from the right-click menu. 

Note  When you create a new table that does not have a primary key, Access displays a suitable message 

and prompts if it should add a primary key for the table. If you choose yes, it automatically adds an 

AutoNumber fi eld with the fi eld name ID as a primary key.

Defi ning Field Properties For each fi eld you defi ne for table, you may assign optional fi eld 

properties, which are defi ned in the lower part of the Table Design window, as illustrated in Fig. 5.10. 

We have already discussed, Field Size, one such property. Here is brief description of other common 

fi eld properties, all of which are optional. 

1. Caption: The Caption is used to provide a little detailed description for the fi eld, e.g., for the 

FirstName fi eld, you may use “First Name of Employee” as the caption. If a caption is defi ned for a 

fi eld, Access uses the caption in place of the fi eld name when you view the table contents or create 

a report or form. 

2. Default Value: As the name Default Value, suggests, it is the value that is automatically fi lled 

in the fi eld when a new record is added to the table. For example, you may defi ne “Cash” as the 

Default Value for the PaymentType fi eld. Similarly, for the OrderDate fi eld, you may defi ne the 

current date as the default value by using the Access DATE() function. You may type the default 

value in the text box against Default Value in the Field Properties box. To defi ne an advanced 

default value for the fi eld, click the Expression Builder button to open the Expression Builder 

dialog box. The Expression Builder dialog box helps you to choose the required Access functions 

and join these with AND, OR, NOT, LIKE and other mathematical operators. 

3. Validation Rule: The Validation Rule allows the data to be entered in a fi eld only when it satisfi es 

the specifi ed rule. For example, for an Age fi eld, you may specify a validation rule “>= 18” that 

will not allow a value less than 18 in the fi eld. Similarly, the validation rule “>=18 AND <=65” 

will only allow values between 18 and 65. You may enter the rule in the text box against Validation 

Rule or take the help of the Expression Builder dialog box. 
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4. Validation Text: If you use Validation Rule, you may also use Validation Text to specify a message 

that Access displays when the user enters a value outside the validation rule. If the validation text 

is not specifi ed, Access displays a generic validation text message. 

5. Required: The default value for Required is No. If you defi ne the Required property for a fi eld to 

“Yes”, the user cannot leave that value empty and must enter some data in that fi eld. 

6. Format: Allows to control the display layout of the fi eld. For certain types of fi elds, such as Date/

Time, Numeric, Currency and Yes/No, Access provides a few predefi ned formats to choose from. 

Of course, you can defi ne your own custom format. For instance, the > symbol makes all text in a 

fi eld appear in uppercase, and the < symbol makes all text appear in lowercase, regardless of how 

the text was entered. Similarly, the format &&&-&&&-&&& causes the text 123456789 appear 

as 123-456-780. 

7. Input Mask: Input Mask enables to control the data that can be entered in different character 

positions of the fi eld. For instance, if a company uses two characters followed by 5 numeric digits 

(e.g., PQ12012, SL24010, etc.) for the product code, the Input Mask can help you implement this, 

so that the user can enter only alphabetic characters in the fi rst two character positions and numeric 

in the next fi ve. 

8. Allow Zero Length: Applicable only for Text, Memo and Hyperlink fi elds. Controls where zero 

length string data is allowed in the fi eld. By default, zero length data is allowed in fi elds. 

9. Indexed: Controls creation of an index on the fi eld. The default Indexed option for each fi eld is 

No. On clicking the drop-down arrow on the right side of the Index box, Access displays three 

options –No, Yes (Duplicates OK) and Yes (No Duplicates). Indexing also helps Access to speedup 

sorting, which is discussed later. 

∑ While you are defi ning the table structure, you can add a new fi eld or delete a fi eld with ease. 

To do so, click the row where you want to add/delete the fi eld and then use the corresponding 

button on the Ribbon or choose the required command from the right-click menu, as illustrated in

Fig. 5.11. 

Fig. 5.11 Inserting or deleting a fi eld



Microso   Access    285 2 

After you have defi ned all fi elds for your table, follow the steps given below to save the table: 

∑ Press Ctrl+S or click  on the Quick Access toolbar to display the Save As dialog box. 

∑ Type the desired table name in the Save As dialog box and click OK. If you did not defi ne a 

primary key for the table, Access displays the following message:

∑ As recommended by Access, each table should have a primary key. You may click Yes to create 

an ID fi eld with fi eld type AutoNumber as the primary key for your table. Click No if you do not 

want to create the primary key.

∑ Access saves the table and the table name appears in the Navigation pane in the Tables box. Access 

does not close the Design view. To close the table, click X, the close button, as illustrated in

Fig. 5.11 

5.5 USING LOOKUP WIZARD 

In some situations, it is helpful to offer predefi ned choices for a fi eld rather than typing data in a fi eld. 

For instance, if a company has only four departments, Access can provide these four choices in a drop-

down list for selection at the time of data entry in that fi eld. This scheme will also work when entering 

payment types, name of state or country in a fi eld. 

∑ To allow the user to pick a value from a drop-down list, click the table name in the Navigation 

pane and put the table in the design view by clicking Design View on the Status bar. Then click 

the required fi eld and choose Lookup Wizard as the Data Type for the fi eld while defi ning the table 

structure. (See Fig. 5.10.) 

Access displays the Lookup Wizard dialog box shown in Fig. 5.12. As explained in the dialog box, you 

can type the values for the fi eld or get it from another table or query. Let us create the lookup values 

by typing.

∑ Click the second option and then click Next. Lookup Wizard displays a grid to enter values. Press 

Tab and type the fi rst value. In the same way, enter additional values. Figure 5.13 displays a few 

values entered in Lookup Wizard.

  

 Fig. 5.12 The Lookup Wizard dialog box Fig. 5.13 Values entered in Lookup Wizard
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∑ Click Finish to close Lookup Wizard. Next, click Save on the Quick Access toolbar to save the 

table structure. 

∑ Switch to the Datasheet view by clicking Datasheet View on the Status bar. Now when you click 

in the Department fi eld in any row, Access displays a drop-down arrow. On clicking this arrow, it 

displays the available choices to choose from, as shown in Fig. 5.14. 

Fig. 5.14 Selecting the value for the Department fi eld from lookup options

5.6 OPENING AN EXISTING DATABASE 

Access can help you to open an existing database with ease. 

∑ To open a database that you have worked on recently, click the File tab to open the Backstage view 

and click Recent in the left pane. 

Access displays a list of recent databases in the middle pane shown in Fig. 5.15. If the database you 

want to open is listed in the Recent Databases box, you may click to open it. Access also displays the 

list of recent databases below Close Databases in the left pane if the “Quickly access this number of 

Recent Databases” checkbox in the middle pane is checked. 

∑ If the database you want to open is listed in the Backstage view, click to open it, otherwise, click 

Open to display the Open dialog box shown in Fig. 5.16. 

The fi lenames displayed in the list box are only from the selected folder. To display database fi les 

available in other folders, you need to open the desired folder. To open any folder that is displayed in 

the Open dialog box, double click it. Similarly, to display fi les from a location/folder whose icon is 

displayed in the left pane, click it. 

∑ To open any database whose fi lename is displayed in the Open dialog box, double click the fi lename 

or type the fi lename in the File Name box and click the Open button. 

5.6.1 Closing a Database

∑ To close an open database, click the File tab to open the Backstage view and click Close Database

in the left pane. 
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Fig. 5.15 Opening a database in Backstage view

Fig. 5.16 Opening an existing Access database

5.7 OPENING A TABLE 

If you want to view data contained in a table or add/edit data in the table, you need to open it. 

∑ To open a table, double click the table name in the Navigation pane, as illustrated in Fig. 5.17. 

Alternatively, right click the table name to display the context menu and click Open. 
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Fig. 5.17 Opening a table

Access opens the table in the Datasheet view as shown in Fig. 5.18.

Fig. 5.18 A table open in Datasheet window

5.7.1 Changing the Table View

An Access table can be viewed in several views, the most common being the Datasheet view and 

Design view that you have already used. The other two views are PivotTable and PivotChart views. 

When a table is open, to switch to a different view, choose the desired view from the View button on 
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the Home tab, as illustrated in Fig. 5.18. If you right click the tab that displays the table name (see Fig. 

5.18), Access displays a shortcut menu that also contains command to change the view. Besides, the 

Status bar also displays shortcuts to change the table view. As you know, the Datasheet view is used 

to enter data in a table and the Design View is used change the structure of table. The PivotTable and 

PivotChart views are used by advanced users to analyze data in a table. These views do not allow to edit 

or add data in the table, but to view the data in another way. The PivotTable and PivotChart views help 

us to analyze data available in a table and to display it in a format similar to a crosstab query.

5.7.2 Editing Data in a Table

The Datasheet window displays the contents (records) of a table in a row-column format that looks 

similar to an Excel spreadsheet. To edit data:

∑ Move the cursor in any fi eld (column) of any record. You may also use arrow keys to move the 

cursor. Now you can edit text in the usual way. 

∑ After making changes to the data, as you move to another record, Access automatically saves 

changes. If you want to undo the change to a record, click the Undo button on the Quick Access 

toolbar or press Ctrl+Z.

Caution  Access can undo only the last action. For instance, if you edit record numbers 5, 10 and 12, 

Access allows to undo editing done in only record 12, and if required, you will need to manually 

edit records 5 and 10 to undo changes.

5.7.3 Navigating Records

∑ To select a record, click in the row border as illustrated in Fig. 5.18. 

While you can use the mouse or keyboard to move the record pointer on the desired record, Access 

provides a convenient Navigation bar to do the same, which is particularly helpful when the table has 

a lot of records. As shown in Fig. 5.18, the Navigation bar is located at the bottom of the Datasheet 

window. 

∑ Use the First, previous, Next and Last buttons to quickly jump to the fi rst, previous, next and last 

record of the table. 

∑ In the center of the Navigation bar, there is a text box which displays the current record number 

and the total number of records; however, it may also be used to move to a desired record. To move 

to a record using the text box in the Navigation bar, enter the desired record number and press the 

Enter key. Notice that as you move to a new record in the Database window, Access highlights 

the corresponding record. 

5.7.4 Inserting a New Record

If you scroll to the bottom of the records list in the Datasheet view, you would fi nd an empty record 

at the bottom of the list. You would also fi nd an asterisk (*) in the Record Selector box on the left side 

of this empty record. This is the place to enter a new record in the table. As you enter data for a new 

record, Access automatically adds another blank record at the bottom of the table. Another way to 

quickly jump to the bottom of the table to enter a new record is by clicking the New Record button on 

the Navigation bar. The New record button is also available on the Ribbon in the Records group on the 

Home tab, as illustrated in Fig. 5.19. After inserting a new record, you can enter data in the record in 

the usual way. 
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Fig. 5.19 Inserting and deleting records in a table

∑ If Access displays “(New)” in a fi eld, you cannot enter data in this fi eld, as this is an AutoNumber 

fi eld which will be fi lled automatically by Access. Press Tab to move to the next fi eld.

∑ After typing data in a fi eld, press Tab to move the cursor to the next fi eld or use Shift+Tab to 

move to the previous fi eld. Alternatively, click the mouse in the desired fi eld. 

5.7.5 Deleting Record(s)

When you do not need a record in the table, you may delete it. For example, in an Employee table, if 

an employee has left the company, you may delete that employee’s record. To delete a record from the 

table:

∑ Select the record using the arrow keys or the Navigation bar. Another way to select a record is by 

clicking the Record Selector button located on the left side of the record, as illustrated in Fig. 5.19. 

∑ Press the Delete key or click the Delete button on the 

Records group on the Home tab. The Delete Record 

command is also available in the context menu that you 

may get by right clicking the selected record. When you 

attempt to delete a record, Access displays a warning 

message as given here.

∑ As mentioned in the warning message, deleted records cannot be recovered, therefore, click Yes

only when you absolutely sure that you want to proceed with the delete operation.

Besides deleting a single record, you can also delete multiple records in one stroke. To do so, 

∑ Drag the mouse on the record selector bar (see Fig. 5.19) and Access selects and highlights the 

records.

∑ Press the Delete key or click the Delete button on the Ribbon to delete the selected records. 

5.7.6 Resizing and Repositioning Fields

∑ If you have several fi eld in your table, Access may not be able to display all fi elds in the Datasheet 

window. In that case, it displays a horizontal scrollbar in the bottom frame of the window (See

Fig. 5.18). You may use the scrollbar to view fi elds currently not visible.
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∑ To view more fi elds in the Datasheet window, you may reduce the size of a fi eld by dragging the 

vertical bar between fi elds in the fi elds header, as shown in Fig. 5.20. 

∑ If you want to change the order of fi elds, i.e., reposition a fi eld, click the fi eld name to select it. 

Now you may drag the selected fi eld to a new position, as illustrated in Fig. 5.20. 

∑ After making changes, when you close the Datasheet window by clicking the Close button (see 

Fig. 5.20), Access asks if you want to make the changes permanent.

Fig. 5.20 Resizing and Repositioning Columns

5.7.7 Hiding and Unhiding a Field

Sometimes, you may wish to hide a fi eld if it contains unimportant data. Hiding a fi eld temporarily 

hides the data from the Datasheet view while keeping it safe in the table. 

∑ To hide a fi eld, click the mouse anywhere in that fi eld, click the More button (see Fig. 5.20) to 

display a drop-down menu and then click the Hide Fields command. 

∑ To get back hidden column, click the More button to display a drop-down menu and click Unhide 

Fields. Access displays the Unhide Columns dialog box.

∑ Click the fi eld(s) you want to unhide. Finally, click Close to close the Unhide Columns dialog 

box.

5.7.8 Renaming a Field

To quickly change the fi eld name of a fi eld while viewing the table contents, double click the fi eld name 

and type the new name. For additional changes to the table structure, switch the table to Design View. 

5.7.9 Switching to the Design View

If you need to make major changes to a table that is open in the Datasheet view, you need to switch it 

to the Design view. 

∑ To switch to the Design View, click the Deign View button on the Status bar (See Fig. 5.20.) You 

may also switch to the Design View by clicking the View button on the Home tab and then clicking 

Design View on the drop-down menu.
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The changes you can make to the table’s structure include renaming fi elds, changing fi eld size or data 

type, inserting/deleting fi elds and modifying fi eld properties. However, you should be careful when you 

change fi eld data types or size, as the table may lose data in the affected fi eld. Access gives a suitable 

warning if it encounters any errors while converting data and gives you a chance to abandon changes. 

∑ After making changes, if you want to switch back to the Datasheet view, click the Datasheet View

button on the status bar or click the View button on the Ribbon and click the Datasheet View on 

the drop-down menu.

5.7.10 Freezing and Unfreezing Fields

When you edit data in a table or query (to be discussed) having several columns, Access may not be 

able to display all fi elds in the Datasheet window. To view or edit data in the fi elds on the right that 

are currently not visible, you may horizontally scroll data in the window. While this makes those fi eld 

on the right visible, the fi elds on the left disappear. Sometimes this may cause a problem, when one or 

more fi elds on the left contain identifi cation data, e.g., code or name. To ensure that you enter or view 

the data for the correct record, it is helpful if the identifi cation fi elds are always visible on the left side 

of the window. To help you achieve this, Access allows to freeze one or more fi elds on the window. 

∑ To freeze a fi eld, select that fi eld by clicking the fi eld heading (see Fig. 5.20). Next, click the More

button on the Ribbon to display a drop-down menu and click Freeze Fields. In the same way you 

can freeze additional fi elds.

∑ To unfreeze fi elds, click the More button to display a drop-down menu and click Unfreeze All 

Fields. 

5.7.11 Sorting and Filtering Records

When you view records of a table in the Datasheet window, Access displays all records in the same 

order they were entered. However, when you have lots of records in a table, sorting these on one or more 

fi elds may often be required. You can sort the data in ascending or descending order of any fi eld. 

∑ To sort the table on a fi eld, fi rst click the fi eld name in the column header to select that fi eld. Figure 

5.21 displays a table after a column has been selected. Now you may sort the table in ascending or 

descending order by clicking  or , respectively on the Sort & Filter group 

on the Ribbon, as illustrated in Fig. 5.21. Sort commands are also available on the menu displayed 

on clicking the down arrow on the right of the fi eld name. 

Sometimes a table may have thousands or even millions of records. To view a few selected records, 

you may apply a fi lter on the table. For instance, you may apply a fi lter on the Staff table shown in Fig. 

5.21 to view records only for the Sales Department. Similarly, a fi lter on the Orders table can restrict 

the records to those orders with order value greater than a specifi c amount. Let us apply a fi lter on the 

Staff table shown in Fig. 5.21 to display records for the Sales and Admin departments. 

∑ Click the Department fi eld in the columns header and the click the Filter button on the Ribbon on 

the Home tab. Access displays a menu shown in Fig. 5.21. 

∑ Click “(Select All)” to uncheck all fi elds. Next click Admin and Sales check boxes in the menu. 

∑ Click OK and Access applies the fi lter as shown in Fig. 5.22. Notice that it displays the fi lter 

icon in the column header on the right of the Department fi eld. It also displays “Filtered” in the 

Navigation bar. 
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Fig. 5.21 Sorting and Filtering Records

Fig. 5.22 Filter applied on a table

Sometimes, the fi lter you want to apply may not be as simple as selecting or not selecting some fi eld 

values. For instance, you may like to display records with salary >= 40000 and salary <= 55000. To 

accomplish this, 

∑ Click the Salary fi eld in the columns header and the click the Filter button to display the drop-

down menu similar to that shown in Fig. 5.21.

∑ Click Number Filters in the menu and then click Between on the 

submenu. Access displays the Between Numbers dialog box shown 

here. 

∑ Enter 40000 in the Smallest box, 50000 in the Largest box and click 

OK to apply the fi lter. 

After applying a fi lter on one fi eld, you can apply additional fi lter(s) on other fi eld(s). For example, 

after applying the fi lter on the Salary fi eld, you can apply a fi lter on the Department fi eld. 

5.7.12 Deleting a Field

∑ To delete a fi eld while the table is open in the Datasheet view, right click the fi eld name in the 

columns header to display a menu and click Delete Field.
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∑ Access displays a warning message that all data in the fi eld will be deleted permanently. On 

clicking Yes, Access deletes the fi eld from the table. Remember that you cannot recover data from 

a deleted fi eld. 

5.8 UNDERSTANDING THE CONCEPT OF RELATIONSHIP

 BETWEEN TABLES 

As you already know, in RDBMS (Relational Database Management System), data is kept in separate 

but linked tables. For example, a customer may place multiple orders. Now, while storing multiple 

orders placed by a customer in a table, instead of repeating the customer name, address, phone number, 

etc., in each order record, we divide the information in two tables:

1. Customers table: Contains customer name, address, phone number and a unique customer number 

or ID for each customer. The fi eld that stores the unique customer number (normally called ID) is 

called the primary key. Refer to Section 5.4 to learn more about primary key and how to defi ne it 

for a table. 

2. Orders table: Order details and customer number for the customer who placed the order.

Consider the sample Customers and Orders tables shown in Fig. 5.23. Since the information is stored 

in separate tables, to get customer information for an order, we link or relate the two tables on the 

common customer ID fi eld. We can link the Customers table into the Orders table or the Orders table 

into the Customers table. Since each order is placed only by one customer, the relation from Orders 

table into the Customers table is one-to-one. On the other hand, since one customer may place multiple 

orders, the relationship from the Customers into the Orders table is one-to-many. While creating a 

one-to-many relationship, the table on the one side (e.g., the Customers table in the customer-orders 

scenario) must have a primary key and that primary key is used to link the tables. The fi eld in the Orders 

table that stores the customer ID is called foreign key. In other words, the customer ID value stored in 

the foreign key fi eld of the Orders table is used to get details about the customer from the Customers 

table. Similarly, we can fi nd orders for a specifi ed CustomerID (e.g., A100) from the Orders table. 

Besides establishing relationships between tables, Access also allows you to relate queries.

Fig. 5.23 Sample Customers and Orders Tables

Note  You can assign any fi eld name to the foreign key, though it is usually named the same as the primary 

key fi eld for easy identifi cation.
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5.9 CREATING RELATIONSHIP BETWEEN TABLES 

You can create relationship between two or more tables. After establishing a relation, Access can 

retrieve related information, e.g., in Customers-Orders relationship, you can fi nd customer details for 

an order. To create a relationship: 

∑ Click the Database Tools tab and then click  on the Relationship group. 

Access displays the Show Table dialog box shown in Fig. 5.24. This dialog box is used to select tables 

and/or queries to be used to establish the relationship (Queries are discussed in Section 5.12). If the 

database already contains one or more relationships, it displays them in the window. In that case, click 

Show Table in the Relationships group on the Ribbon to display the Show Table dialog box.

Fig. 5.24 The Show Table dialog box

∑ Click the fi rst table (e.g., Customers) in the Show Table dialog box and click Add. In the same 

way, select additional table(s) and click Add. Finally, click Close to close the Show Table dialog 

box. Access displays the selected tables in the Relationship window, as shown in Fig. 5.25.

Fig. 5.25 Establishing a relation between tables
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∑ After the tables/queries are available in the Relationships window, to establish the relationship 

between them, drag the common linking fi eld from the fi rst table and drop it on the other. For 

example, in Fig. 5.25, the common linking fi eld is CustomerID, therefore, to link the tables on the 

CustomerID fi eld, we need to drag the CustomerID fi eld from the customers table and drop it on 

the CustomerID fi eld in the orders table, as illustrated in Fig. 5.25.

After you drop the linking fi eld, Access displays the 

Edit Relationship dialog box shown in Fig. 5.26.  In the 

Edit Relationship dialog box, Access lists the tables/

queries used in the relationship and the fi elds being 

linked. 

∑ If the dialog box displays the correct fi eld name(s), 

click the Create button to ask Access to go ahead 

and create the relationship. Access closes the Edit 

Relationship dialog box and displays a relationship 

line between the linked tables as shown in Fig. 

5.27. In the same way, you can establish additional 

relationship between any two tables/queries.

Fig. 5.27 A relationship established between two tables

5.10 VIEWING RELATED INFORMATION 

After you have established a relationship and open the table/query to view data, Access can provide 

the linked data. For instance, consider the customers and orders tables linked in the previous section. 

Now if the customers table is opened, Access displays a plus (+) sign in the fi rst column, as shown in 

Fig. 5.28.

 

Fig. 5.26 Edit Relationship dialog box



Microso   Access    297 2 

Fig. 5.28 Viewing the records in the customers table linked to the orders table

The plus sign indicates that linked information is available. On clicking this sign, Access displays the 

linked information from the orders table, as shown in Fig. 5.29. Notice that Access has replaced the 

plus sign with the minus (–) sign. To remove the display of the linked information, click the minus sign.

Fig. 5.29 Viewing the linked information

5.11 WHAT IS A QUERY? 

If you look for the meaning of query in dictionary, you would fi nd something like “to ask questions” or 

“make inquiry”. However, in databases, the query means the result of a question. For instance, a query 

may return the list of record from the invoice table that have amount greater than 10,000 and where the 

customer city is Mumbai. 

In the earlier part of the chapter, you learnt to fi lter records from a table. A query can also be used 

for the same purpose with a greater fl exibility. You may choose to include selected fi elds from one or 

more tables or queries to create a query. For all practical purposes, a query is like a table which can be 

used in all places where a table can be used, including reports and forms. To create a simple query, you 

may use Query Wizard. To create a complex query, it is best to use Query Design. 

5.11.1 Creating a Simple Query with Query Wizard

The query wizard guides you through each step of the query design process. Let us create a simple 

query based on the Staff table. 

∑ Click Staff in the Navigation pane in the Tables section to select this table. Click the Create tab 

on Ribbon and then click Query Wizard on the Queries group as shown in Fig. 5.30. 

∑ Access displays the New Query dialog box with Simple Query Wizard selected as shown in

Fig. 5.30. Click OK and Access displays the list of fi elds available in the selected table as shown 

in Fig. 5.31. 
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Fig. 5.30 Using Query Wizard to create a simple query

Fig. 5.31 First step of the Simple Query Wizard

∑ If Simple Query Wizard is not displaying the correct source table that will be the base for the query 

you want to create, click drop-down arrow on the right of the Tables/Queries box and choose the 

correct table or query. On selecting a table/query, Access displays the list of available fi elds in the 

Available Fields box. 

∑ The next step is to move the fi elds that you want to include in the query. Double click the desired 

fi elds in the required sequence to moves these to the Selected Fields box. You may also choose 

fi elds from more than one table/query. After choosing the fi elds, click the Next button to display 

the next step of Simple Query Wizard.

∑ As shown in Fig. 5.32, in this step you choose whether you want to see details or summary in the 

query. The Summary option is used when you want to fi nd minimum, maximum, sum and average 

values for numeric fi elds. On clicking the Next button, Access displays the last step of the Wizard 

as shown in Fig. 5.33.
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 Fig. 5.32 The second step of Simple Query Wizard Fig. 5.33 The last step of Simple Query Wizard

∑ In this step, Access displays a default name for the query, which you may change if you prefer. On 

clicking the Finish button, Access displays the result of the query on your screen in the Datasheet 

view, as shown in Fig. 5.34. Notice that Access displays the name of the query you have created 

in the Queries object section in the Navigation pane. 

Fig. 5.34 Data selected through a query

5.11.2 Creating a Query in Design View

Simple Query Wizard does not give you a lot of fl exibility; therefore, most queries are designed in the 

Design View. 

∑ To create a new query in the Design View, click the Create tab on Ribbon and then click Query 

Design on the Queries group, as shown in Fig. 5.35.

Access displays the Query Design window similar to that shown in Fig. 5.35. It also opens the Show 

Table dialog box that lets you choose tables and/or queries for the query you want to design.
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Fig. 5.35 Designing a query in Design View

∑ To add a table, double click its name in the Show Table dialog box and Access displays it in the 

upper half of the Query Design window. If you choose multiple tables and/or queries, Access may 

link these using a common fi eld, if available. After adding tables/queries, click the Close button 

in the Show Table dialog box to close it. Figure 5.36 displays a table added to the Query Design 

window.

Fig. 5.36 Adding fi eld to the query

The next step is to choose the fi elds that you want to include in your query. The lower part of the 

Query Design window has an empty table to hold the fi elds you want in the query output. One way to 

add a fi eld to the query result table is by double clicking or dragging it from the fi elds list displayed in 

the table(s) added to the Query Design window, as illustrated in Fig. 5.36. Another way to add a fi eld 

is by clicking in the Field box in the lower pane of the Query Design window and then clicking on the 

down-pointing arrow to display the list of available fi elds, as illustrated in Fig. 5.36. Then click the 

desired fi eld and Access includes it in the Field box. If the fi eld list, you would also fi nd entries such as 

“Staff.*:”, which means all fi elds from the table.
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5.11.3 Showing or Hiding a Field

By default, all fi elds that you add to the query are displayed in the query result or output. Notice that 

there is a � symbol in the Show row for each fi eld in Fig. 5.37. To remove a fi eld from the query result, 

click in the Show row of the corresponding fi eld to remove the � symbol, as illustrated in Fig. 5.37.

Fig. 5.37 Sorting query result and hiding fi elds

5.11.4 Sorting Query Output

You can sort the query result in ascending or descending order of any number of fi elds through the Sort 

row in the Query Design window. 

∑ To sort the result on any fi eld, click the mouse in the corresponding column in the Sort row to 

display a down-pointing arrow. Next, click this down-pointing arrow to display the three sort 

options, as illustrated in Fig. 5.37. On choosing the desired option, Access displays it in the Query 

Design window. To sort the query on additional fi elds, repeat the same process on other fi elds.

5.11.5 Using Criteria

The Query window allows you to specify criteria (conditions) in the Criteria row to limit the records 

you see as the query result. For instance, with reference to the Staff table you may want to see only 

those records where Salary is greater than 50000. This is entered as “>50000”, as shown in Fig. 5.38. 

Similarly, use may use the other usual comparison operators, such as <, <=, >= and <>. To specify 

multiple conditions, you can join these with AND. For instance, to select records with salary greater 

than 50000 and less than 70000, you may use the criteria: >50000 AND <70000. If you want to specify 

a criteria where either of two conditions may be true, e.g. salary greater than 50000 or Salary less 

than and equal to30000, specify the fi rst condition (>50000) as usual and specify the second condition 

(<=30000) in the “or;” row, as illustrated in Fig. 5.38. If you want to fi lter records that have a specifi c 

value in a fi eld, e.g. salary equal to 60000, use “=60000” or “60000” as criteria in the corresponding 

column. To specify complex criteria, Access supports a few keywords/wildcard characters, such as 

IS NULL, IS NOT NULL, IN, LIKE,* and ?. Use IS NULL or IS NOT NULL to specify a condition 
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where a fi eld value is blank (null) or not blank, respectively. To specify a text condition where value in 

a fi eld starts with A, e.g. Aman, Ajay, Ankur, etc., use the criteria “LIKE A*”. 

Fig. 5.38 Using Criteria on the Salary fi eld

5.11.6 Running a Query

To view the query result, click the Run button (see Fig. 5.38) or click the Datasheet View button on 

the Status bar.

5.11.7 Saving a Query

∑ To save the query, click the Save button on the Quick Access toolbar and Access displays a Save 

As dialog box which contains a default name such as Query1. Type a suitable name that describes 

the type of query you have designed and click OK. To view the query result, double click the query 

name in the Navigation pane.

5.11.8 Modifying a Query

∑ To modify a query, click its name in Navigation pane in the Queries section and click the Design 

View button on the Status bar (See Fig. 5.38). This opens the Query Design window and you may 

make the necessary changes.

5.12 WHAT IS A FORM? 

A form is a special kind of object whose primary function is to let a user view or enter data in tables 

one record at a time in a user-friendly manner. Though the information displayed in a form may be the 

same as that displayed when you view a table or query in the Datasheet window, it is easier to view and 

enter data as you can layout the fi elds on the form in an easy to understand way. In the beginning, you 

may use the Form tool to ask Access to create a form for you. Form Wizard provides another option to 

create a quick form. Later you can use the Form Design tool to create a form from scratch or modify an 

existing form, including those created using the Form tool or Form Wizard. 
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5.12.1 Building a Form Using the Form Tool 

To build a form using the Form tool, follow the following simple steps: 

∑ Open the database, if required and click the table/query in the Access Objects pane on the left that 

you want to use as the data source. For instance, click Staff if you want to create a form to enter/

view data in the Staff table. 

∑ Click the Create tab on Ribbon and then click  on the Forms group.

Access designs the form and displays it on your screen, as shown in Fig. 5.39. Access also displays 

Form Layout Tools on the Ribbon. These tools are used to change layout and format of the form as 

well as to add more controls on the form. Notice the Navigation bar at the bottom of the form which 

is used to navigate to the records of the table. (Refer to Section 5.7 to learn how to use the Navigation 

bar.) The Form tool puts all fi elds from the selected data source on the form. It uses the fi eld name or 

caption as data labels. 

Fig. 5.39 A Form designed using the Form tool

∑ To save the form, click the Save button on the Quick Access toolbar and then type a suitable name 

for the form in the Save As dialog box displayed by Access. On saving the form, Access display 

the form name in Navigation pane on the left. 

5.12.2 Creating a Form Using Form Wizard

The Form Wizard creates a form based on one or more tables or queries in the database. In case of 

linked table/queries, you may use more than one table/query with your form. 

∑ Click the Create tab on Ribbon and then click Form Wizard on the Forms group. Access displays 

the fi rst step of the Form Wizard shown in Fig. 5.40 where you choose the tables/queries and the 

fi elds you want to include on the form.

∑ To choose a table or query, click the arrow on the Tables/Queries drop-down list box and click the 

desired table/query. Then move the required fi elds from the Available Fields box to the Selected 
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Fields box by double clicking fi eld names or using the Move button, as illustrated in Fig. 5.40. 

Figure 5.41 displays a few fi elds moved from the Staff table.

Fig. 5.40 The fi rst step of the Form Wizard

Fig. 5.41 The Form Wizard with fi elds selected to be included on the form

∑ After choosing the fi elds, click the Next button and Access displays the next step of the Form 

Wizard shown in Fig. 5.42. In this step you choose the layout for the form. As you choose a layout 

option, the Form Wizard displays its preview in the preview box on the form. The fi rst layout 

option, Columnar is the most preferred option. 

∑ After choosing the layout option, click the Next button and you see the last step of the Form 

Wizard as shown in Fig. 5.43. In this step, you enter the name you want to assign to the form. You 

may choose to keep the default name suggested by Access or type your own name.

∑ After entering the name, click the Finish button to save the form, and Access saves the form and 

opens it to view/edit data in the corresponding table/query.

A sample form created by the Form Wizard is shown in Fig. 5.44. Notice that the form contains a 

navigation bar at the bottom that is used to select records. Any changes you make to the data through 

the form are automatically saved in the corresponding table.
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Fig. 5.42 Choosing the form layout in the Form Wizard

Fig. 5.43 The last step of the Form Wizard

Fig. 5.44 Data being edited through a form
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5.12.3 Creating/Modifying a Form in Design View

Creating a form in the design view gives you greater control of the form design process and where you 

place the various data entry controls on the form. The Design View also enables you to add code to the 

form object to have better control on the data entry through the form. 

∑ To create a form in the design view, click Form Design on the Forms group on the Create tab on 

the Ribbon.

Access displays an empty Form design window and Form Design Tools on the Ribbon, as shown in 

Fig. 5.45. The Controls group on the Ribbon displays various controls (form objects), such as label, text 

box, check box, list box, combo box, etc. that you can place on the form.

Fig. 5.45 The Form Design window

First you need to defi ne the record source for the form, which could be a table or query. 

• Click Property Sheet on the Ribbon (See Fig. 5.45) to display the Property Sheet and click the down 

arrow to the right of the Record Source box to choose the record source, as illustrated in Fig. 5.46. 

Fig. 5.46 Defi ning the record source for a form
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Now you can place objects, e.g., text box, label, check box, etc., on the form.

∑ To place an object on the form, click it in the Controls group and then click on the form where you 

want to place it. 

When you create an object, e.g., a text box, on the form that can accept data, it is initially shown as 

unbound, as shown in Fig. 5.47. However, since forms are used to edit data in table, the data entry 

objects are normally bound to some fi eld of a table. 

Fig. 5.47 Defi ning the control source for a control

∑ To bind an object to a fi eld, right click the object to displays a context menu and choose the 

Properties command to displays the Properties window and choose the control source, as illustrated 

in Fig. 5.47. The Properties window is also used to set all sorts of properties, such as font size, font 

style, back color, format, default value, input mask, etc.

After you have laid out the required controls, you can save and run the form in the usual way. Besides 

creating a new form, the Design View can also be used to modify an existing form; right click the form 

name in the Navigation pane and choose Design View.

5.13 CREATING A REPORT 

While you can see the data available in an Access database on the screen using the Datasheet view or 

on a form, often we need to print the required data in a presentable form. To accomplish this, you can 

create reports. 

5.13.1 Creating a Report with the Report Tool 

The easiest and quickest way to build a report in Access is to use the Report tool on Reports group on 

the Create tab. To accomplish this, all you need to do is select the data source (table/query) for your 

report and click the Report tool as illustrated in Fig. 5.48.
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Fig. 5.48 Creating a report using the Report tool

Note  If the default printer is not ready or incorrectly confi gured, Windows may display a message, “There 

was a problem retrieving printer information for this object.” 

Access designs the reports and displays it on your screen. If you want to save the report, click Save 

on the Quick Access toolbar. Figure 5.49 displays a sample report creating using the Report Tool. 

Notice that the Report Layout Tools displayed on the Ribbon. You can use these tools to change the 

design, layout and format of the report. For instance, if you want to show the report title, e.g., First 

Name in bold letters or different color, click Format to display the formatting tools. (See Fig. 5.48.) 

Similarly, click Page Setup to change the page setup, such as margins, page size, orientation, etc., for 

the report. 

Fig. 5.49 A sample report designed with the Report Tool
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∑ After you are satisfi ed with the report layout, click Report View on the Status bar to view the 

report. While displaying the report, Access displays a navigation bar that you can use to jump to 

other pages of the report, when your report contains multiple pages. Like a table, you can apply a 

fi lter on the report data. 

5.13.2 Using the Report Wizard to Create a Report 

The Report Wizard gives you more control over the design of the report. Like the Form Wizard, the 

Report Wizard lets you choose the data source and the fi elds to include in the report. 

∑ Choose the data source for the report in the left Navigation pane and click Report Wizard. 

∑ Access displays the fi rst step of the Report Wizard shown in Fig. 5.50. Like the Form wizard you 

have used earlier, in this step you choose the table or query your report will be based on and the 

fi elds you want to include in the report. 

Fig. 5.50 The fi rst step of the Report Wizard

∑ After choosing the fi elds, click the Next button and Access displays the next step of the Wizard, as 

shown in Fig. 5.51.

Fig. 5.51 The Report Wizard displaying the option to group the report
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In this step, Access displays the list of selected fi elds and asks if you want to group the report on one 

or more fi elds. Grouping of the report is useful when there are multiple records for a data item, e.g., 

several customers from the same city, several orders for a customer or several salary records for an 

employee. The grouping of report is optional. 

∑ On clicking the Next button, Access displays the next step of the wizard shown in Fig. 5.52. 

Fig. 5.52 Sorting the report in the Report Wizard

In this step, you choose fi eld(s) to sort the report on. You may sort the report on one or more fi elds in 

ascending or descending order. For instance, you may sort the report on the Customer name to get the 

report in ascending order of customer names. 

∑ On clicking the Next button, Access displays the next step of the wizard as shown in Fig. 5.53. 

In this step, you choose the layout and orientation for the report. The Landscape orientation is 

generally used when there are a lot of fi elds in the report.

Fig. 5.53 Choosing the report layout and orientation in the Report Wizard 

∑ After choosing the report layout, on clicking the Next button, Access displays the last step of the 

Report Wizard shown in Fig. 5.54. In this step, you defi ne a name for your report. You may use 

the default name suggested by the Wizard or type a new name.
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Fig. 5.54 The last step of the Report Wizard

After entering the report name, on clicking the Finish button, Access displays the report on your 

screen. A sample report created using the Report Wizard is shown in Fig. 5.55. Notice the navigation 

bar displayed at the bottom of the report which is used to display other pages of the report. The Print 

Preview tab on the Ribbon displays a couple of useful buttons including Zoom and Print. Access also 

displays the name of the newly created report in the Navigation pane. 

5.13.3 Opening and Printing a Report

The quickest way to open a report is by double clicking the report object in the Navigation pane, as 

illustrated in Fig. 5.55. This opens the report in Report View.

∑ To print-preview the open report, click the Print Preview button on the Status bar, as illustrated in 

Fig. 5.55. You can also select the Print Preview view by using the View button on the Home tab. 

Fig. 5.55 Preview of a report designed using the Report Wizard



312    Computer Course: Windows 7 and Offi  ce 2010  

∑ To print the report, click the Print button (see Fig. 5.55) and Access displays the Print dialog 

box. You can select the printer, number of pages and other print properties in the Print dialog box. 

Finally, click OK to initiate printing of the report or click Cancel to cancel the print operation. 

5.14 EXPORTING DATA FROM AN ACCESS OBJECT 

If you need to send the report output in electronic format to someone, Access provides several options. 

For instance, you can save the table or report in Excel, Word, HTML, PDF, XPS, RTF (Rich Text 

Format), etc., in a fi le. It can even send the created fi le as an Email attachment to the recipients you 

specify.

∑ To accomplish this, select the required object (e.g., table, query or report) in the Navigation pane. 

You do not need to open the object. 

∑ Click the External Data tab to display the Export, Import and other useful tools. Figure 5.56 

displays an Access window with External Data tab open on the Ribbon.

Common export options are displayed in the Export group on the External Data tab. To display additional 

options, click the More button. Let us export data from a table in the Excel format. 

∑ Click the required table name in the Navigation pane. Then click Excel on the Export group and 

Access displays an Export dialog box shown in Fig. 5.57.

In the Export dialog box, you specify the fi le name and folder to save the fi le and fi le format (e.g., 

Excel 2010, Excel 97, Excel 95, etc.). Access also enables you to specify some export options, e.g., you 

may save the data with formatting by choosing Export data with Formatting and layout checkbox. 

Similarly, you may choose to export only selected records or open the fi le when the export is complete. 

∑ After you have defi ned fi lename, path and export options, click OK and Access initiates the export 

process. Depending on the number of records, the process may take a few second or longer. 

Fig. 5.56 Ribbon displays the External Data tab
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∑ In the next steps, Access offers to save the export steps. You may save the export steps if you plan 

to do the same export on regular basis. 

Fig. 5.57 The Export dialog box

5.14.1 Importing and Linking External Data

If the data that you want to use in a database exists in another fi le, including Access, Excel, dBASE, 

XML, HTML, ODBC databases and text fi le, Access allows you to import data from that fi le or link

it to that fi le. Whether you import or link the data, your database is able to use the external data. The 

decision to import or link depends on the size of the external data as well as if you are allowed to import 

the data. If the size of the external data is huge, it is usually preferred to link rather than importing. The 

tools to link and import external data are available in the Import & Link group on the External Data tab 

(See Fig. 5.56). The process is similar to Exporting data discussed in the previous section—click the 

appropriate control (e.g., Excel if you want to import/link data from an Excel workbook), choose the 

fi le and the import/link option in Get External dialog box. When you import/link external data, you may 

append the records to an existing table or create a new table. 

5.15 USING A TABLE/QUERY AS MAIL MERGE DATA SOURCE 

If you need to merge the data available in a table/query with an existing or new Word document for Mail 

Merge, Access has all the required tools setup. The steps to accomplish this are similar to exporting a 

table/query to a Word document. 

∑ Select the required table/Query in the Navigation pane and click Word Merge on the Export group 

on the External Data on the Ribbon. Access displays Microsoft Word Mail Merge Wizard on your 

screen as shown in Fig. 5.58.
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Fig. 5.58 Microsoft Word Mail Merge Wizard

The Microsoft Word Mail Merge Wizard window can link the Access data to an existing Word 

document or a new document for Mail Merge. If you choose to link to an existing document, it lets you 

choose a Word document. In either case, it links the Access data to the Word document and you may 

insert any of the fi elds available in the data in the Word document to setup the Mail Merge document 

with ease. For more information on how to create a Mail Merge document, see Chapter 3.

5.16 FINDING AND REPLACING DATA IN A TABLE 

Access allows to fi nd or fi nd and replace data in a table in the same fashion as in a Word or Excel 

document. 

∑ To do Find or Find and Replace operation on a table, open it in the Datasheet view and click Find

on the Home tab. Alternatively, press Ctrl+F for Find or Ctrl+H for Find and Replace and Access 

displays the Find and Replace dialog box shown in Fig. 5.59.

Fig. 5.59 The Find and Replace dialog box

∑ By default, Access fi nds the entered text in the current fi eld; to search in all fi elds, click in the Look 

In box and choose the Current document option. The Match box is used to choose a match option 

out of the three available options: Whole Field, Any Part of Field and Start of Field. Depending on 

your requirement, you may choose other search options. On Clicking Find Next, Access highlights 
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the text, if it fi nds the text, otherwise displays a suitable “not found” message. 

∑ To fi nd and replace text, choose the Replace tab in the Find and Replace dialog box or press 

Ctrl+H if this dialog box is not open. 

As shown in Fig. 5.60, the Replace tab of the Find and Replace dialog box is similar to Fig. 5.59, 

except that it contains an additional Replace With box and two extra Replace buttons. After fi nding the 

text with the Find Next button, you may click the Replace or Replace All button to replace the found 

text at the current or all occurrences of the text, respectively.

Fig. 5.60 The Replace tab of the Find and Replace dialog box

5.17 SPELLING CHECKING 

Access includes a very useful spelling checking tool that can help you to avoid spelling mistakes in the 

text entered in your tables. 

∑ To use the spelling checking tool, open the table that you want to check in the Datasheet view and 

press the F7 key or click the Spelling icon on the Home tab Records group. If you want to check 

spelling of data entered in a particular fi eld, select the data in that fi eld by clicking the fi eld header 

prior to starting spelling checking. 

Figure 5.61 displays spelling being checked in a table. The operation of the spelling checking in Access 

is similar to that in Microsoft Word. One additional button found on the Access Spelling dialog box 

may be used to ignore spelling checking in the current fi eld, as illustrated in Fig. 5.61. For general 

information on using spelling checking, refer to Chapter 3.

Fig. 5.61 The Spelling dialog box
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5.18 FORMATTING DATASHEET 

When you view a table in the Datasheet view, it is displayed using a default font, color, background and 

other effects as per the template it is based on. However, you can change text formatting for the data by 

using the Text Formatting controls available on the Home tab. 

∑ Click the appropriate control on the Text Formatting group on the Home tab to format the Datasheet, 

as illustrated in Fig. 5.62. For example, click Bold to display the text in bold. Similarly, you may 

change the font typeface and font size. 

Fig. 5.62 Formatting Datasheet 

∑ For an alternate way to change the Datasheet properties and to change other properties, e.g., cell 

effects, click Dialog Box Launcher to display the Datasheet Formatting dialog box shown in

Fig. 5.62. 

The cell effect, background color, gridline color can have dramatic effects on the appearance of a table 

in the Datasheet view. Figure 5.63 displays a table with raised cell effect and increased font size. 

Fig. 5.63 A table displayed with raised cell eff ect and increased font size
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5.19 PROGRAMMING IN ACCESS 

While you can do most basic operations in an Access database without any knowledge of programming, 

to make the operation of the database more user-friendly for anyone who wants to use the database or 

to handle relatively complex issues, you need to use programming. To do programming in Access, you 

need to know Visual Basic for Applications (VBA), the programming language also used by Microsoft 

with other Offi ce applications including Word and Excel. In Access, the programming code is stored 

in macros and modules. Macros are normally used for simple tasks, e.g., to add a button on a form to 

print a report. Modules, on the other hand, are used for relatively complex tasks including performing 

calculations. Usually, the code that you want to use from multiple locations, e.g., from different forms 

is typically stored in modules. The controls for a macro or module are available in the Macros and Code 

group on the Create tab. To insert a macro or module in your database, click the corresponding control. 

Then you can enter the code in the macro/module. 

5.20 USING EXPRESSIONS AND EXPRESSION BUILDER 

In the earlier part of this chapter, you created simple reports where you used fi elds from a table/query 

to display information. Besides using fi elds, you may also use expressions in reports as well as at other 

places. In simple words, an expression is any combination of fi elds, constant values, mathematical or 

logical operators, built-in functions, etc., that results in a single value. An expression may be used to 

perform calculations involving fi eld values, e.g., you may calculate 10% of an amount fi eld to calculate 

discount. Similarly, you may combine FirstName and LastName fi elds to display full name in a report 

or convert a name to upper or proper case. To use an expression, type it directly in the ControlSource 

box in the Properties Sheet. 

∑ Right click the report name in the Navigation pane and click Design View to open the report in 

design view, as illustrated in Fig. 5.64. 

Fig. 5.64 A report open in Design View displaying Property Sheet
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∑ If your report does not display the Property Sheet window, click Property Sheet on the Tools 

group. (See Fig. 5.64.) Click the Data tab in Property Sheet if required. 

∑ Click the object whose control source you want to change. Figure 5.64 displays the control source 

for the BonusEmp object. Now you can type the new control source, e.g., =Salary*0.1 to calculate 

bonus equal to 10% of Salary. Similarly, you may use the expression = [Amount] + [Shipping] to 

calculate the sum of Amount and Shipping fi elds.

Access has several build-in functions to perform various operations. These functions are classifi ed 

under various categories, such as math, fi nancial, text, database, date/time, general, SQL, array, etc. 

Since it is diffi cult to remember the syntax of over hundred functions available in Access, it provides 

an Expression Builder dialog box that can help you to choose a function and also provides details about 

the selected function. While creating a report or form, to use the Expression Builder for an object, open 

Properties Sheet, click in the Control Source textbox on the Data tab and then click the “…” button, as 

shown in Fig. 5.64. 

Figure 5.65 displays an Expression Builder dialog box. You may enter the desired expression 

directly in the text box in the top-left box, or take the help of the Expression Builder dialog box to 

choose and enter the expression.

Fig. 5.65 Expression Builder dialog box

∑ To view available functions, expand the function node in the left box and then click the Build-

In-Functions to display the list of available functions categories in the middle box. On clicking a 

category, Access displays the list of available function in the right-hand box. Now, if you double 

click any function in the right-hand box, Access types that function in the top left box that you may 
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edit as per your requirement. Finally, click the OK button to apply the function to the object. For 

additional details on the usage of the built-in functions, click the Help button to open the Access 

help system.

5.21 USING ANALYZE TOOLS 

To help you to optimize the performance of your database and to document it, Access provides three 

useful tools – Analyze Table, Analyze Performance and Database Documenter. These tools are available 

on the Analyze group on the Database Tools tab on the Ribbon (See Fig. 5.66). Analyze Table opens the 

Analyze Table Wizard shown in Fig. 5.66. This wizard takes you through a number of steps to analyze 

the selected table and provides suggestions to change the structure, if any.

Fig. 5.66 Table Analyzer Wizard

5.22 DATABASE SECURITY 

Often the data stored in an Access database contains sensitive information that you do not want 

everyone to see. To help you protect the data contained in a database from unauthorized access, Access 

can encrypt the database with a password. After a password has been assigned to a database, it can be 

opened only after providing the correct password. 

∑ To assign a password to the database, you must fi rst open it in the exclusive mode by using 

the Open command on the File tab and choosing the Open Exclusive option, as illustrated in

Fig. 5.67.
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Fig. 5.67 Opening a database in exclusive mode

∑ After opening the database in the exclusive mode, click File to open the Backstage view, click 

Info and then click Encrypt with Password, and the Set Database Password dialog box appears, 

as shown here.

∑ Now enter the password in the dialog box, re-enter it in the Verify box and click the OK button, 

and Access makes the database password protected. Hereafter, the database can be opened only 

after providing the correct password, which is case sensitive.

5.22.1 Removing Password from a Database

∑ To remove password from a database, open it in exclusive mode.

∑ Click File to switch to the Backstage view, click Info and then click Decrypt Database and 

Access displays the Unset Database Password dialog box. 

∑ Enter the database password and click OK to remove the password. 

5.23 BACKUP A DATABASE 

It is recommended that you backup all important databases. The backup database will be useful if your 

current database becomes unusable due to any hardware or software problem. You may backup the 

database to a CD/DVD/Flash memory. In a multi-user environment, all users must close the database 

before you will be able to backup. To back up a database:
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∑ Click the File tab to switch to the Backstage view and click Save and Publish.

∑ Click Save Database As under File Types, click Back Up Database in the right pane and then 

click Save As, as illustrated in Fig. 5.68. 

Fig. 5.68 Backing up a database

∑ In the Save As dialog box displayed by Access, type a suitable fi lename, change the folder if 

required and click Save to save the database.
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MICROSOFT 
POWERPOINT

In this chapter, we will discuss the following topics:

PowerPoint �

Starting PowerPoint �

Creating a Presentation  �

Saving and Opening a Presentation �

Creating a Presentation using Design Template �

Editing and Formatting Slides �

Inserting Picture, Clip Art, Chart, Shapes, Smart Art and �

WordArt in a Slide

Using Tables, Video and Audio in Slides �

Defi ning Header and Footer �

Spelling Checking and Correction �

PowerPoint Views �

Running a Slide Show �

Slide Transition and Animation Effects �

Creating a Presentation based on a Photo Album �

Slide Master �

Printing and Sharing a Presentation �
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6.1 MICROSOFT POWERPOINT 

Microsoft PowerPoint is a presentation software that can help you to quickly create effective ‘slide-

based’ presentations. PowerPoint is a very effective communication tool which is quite different from 

other tools, such as Word and Excel, you are familiar with. PowerPoint is basically a visual tool that 

mainly uses graphics, pictures, visual layout, and colors to convey the message. It is also a multimedia 

tool, so you may use sound, video and animation to effectively communicate your message to the users. 

The presentation consists of a number of slides and each slide can have text, graphics, audio and video. 

Normally, you do not use too much text on slides. And, when there is a need to use text, you normally 

use bulleted or numbered lists to summarize important points. To make your presentation effective, 

PowerPoint has the capabilities to gradually add text or graphics to the slide using animation. For 

instance, instead of showing all the fi ve bulleted points when the slide is displayed, you may initially 

start with one line of bulleted text, and show additional bulleted text, as you explain the text. Besides 

creating a video slide show that runs on a computer screen or multimedia projector connected to the 

computer, PowerPoint can help you to create transparencies/slides for overhead/slide projector, printed 

handouts, speaker’s notes and outline of the presentation. It can also help you create a Windows Media 

fi le or CD of the presentation for easy sharing of the presentation with others. PowerPoint can even 

email the presentation to specifi ed recipients. 

To help you to quickly create a presentation, PowerPoint comes equipped with several templates 

or you can start with a blank presentation and it can help you add the required slides. Depending on 

the type of slide you want to include in the presentation, you can choose an appropriate slide. For 

instance, if you need to show a picture on a slide, you can choose the Picture with Caption slide. 

Then you can add the picture and other details in the slide. Similarly, if you want to show a chart, you 

can pick up the chart slide. PowerPoint helps you to enter and edit details in the slides you choose. 

You can easily format text and other graphics used in slides, and change the order of the slides as 

well as insert and delete slides in the presentation. PowerPoint can also help you insert and edit 

pictures, video and audio in the slides. After you have created the slides that you want to include in 

your presentation, you can print the slides, run the slideshow on the computer screen, package it on 

a CD for distribution, etc. 

PowerPoint was initially introduced in 1990 and since then Microsoft has released several versions 

for the Windows as well as Mac operating systems. Some of the common versions for the Windows 

operating system are PowerPoint 1997, PowerPoint 2000 (Offi ce 2000), PowerPoint 2002 (Offi ce XP), 

PowerPoint 2003, PowerPoint 2007 (Offi ce 2007) and PowerPoint 2010. Microsoft has added new 

features and redesigned the look and feel of PowerPoint with each new release, however, the basic 

features and how to use it has remained more or less the same. 

In this chapter, we will use PowerPoint 2010. If you use any other version of PowerPoint, the 

screen displays that you get may be slightly different from those used in the examples in the chapter. 

However, versions prior to PowerPoint 2007 do not support the Ribbon interface. Therefore, to use the 

commands available on the Ribbon, you will need to use the corresponding menus.
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6.2 STARTING POWERPOINT 

You can start PowerPoint like any other Windows application. 

∑ If there is an icon for PowerPoint on your desktop, double click that icon to start PowerPoint. The 

PowerPoint icon normally looks like .

∑ If the PowerPoint icon is available on taskbar or Quick Launch toolbar on your taskbar, click the 

icon to start PowerPoint. 

∑ You may also start PowerPoint from the Windows menu like any other program. The PowerPoint 

program may be located in the Start menu or anywhere in the menu system, however, normally you 

will fi nd it in the Programs/All Programs submenu, Microsoft Offi ce or Microsoft Applications. 

On Windows 7, click the Start button on the taskbar, click All Program and Windows displays 

the list of programs installed on your computer. Click the Microsoft Offi ce folder in the programs 

list and click Microsoft PowerPoint 2010, as illustrated in Fig. 6.1 to start PowerPoint.

Fig. 6.1 Starting Microsoft PowerPoint

The Microsoft PowerPoint window appears with a new, blank presentation on your screen as shown in 

Fig. 6.2. PowerPoint has also inserted a title slide in the presentation. 
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Fig. 6.2 Opening screen of PowerPoint with a blank presentation

The PowerPoint opening screen looks similar to the opening screen of the Word or Excel program, and 

if you are familiar with these programs, you will fi nd the PowerPoint screen familiar. 

When you start PowerPoint, it automatically creates a new presentation fi le—Presentation1. Notice 

that the name of the program (Microsoft PowerPoint) and the presentation fi le (Presentation1) are 

displayed in the title bar of the window. On the left side of the title bar is the Quick Access toolbar that 

contains controls for common commands, such as Save, Undo and Redo. Located beneath the title bar 

is the Ribbon that contains command and tools required to work with the presentation. The Ribbon has 

various tabs, such as File, Home, Insert, Design, Transitions, Animations, Slide Show, etc. The ribbon 

interface in PowerPoint works exactly like in other Microsoft Offi ce 2010 programs. If you are not 

familiar with the ribbon interface, please refer to Section 3.2. Also, to learn how to customize the Quick 

Access toolbar or the Ribbon, refer to the section on customizing Word.

The PowerPoint window is divided in two vertical panes. The large pane on the right, called the 

Slide pane is used to design and edit one slide at a time. The Notes pane, located below the Slides pane 

is used to enter speaker’s notes about the slide. These notes are also used to print presentation handouts

for distribution. The pane on the left, called the Slides and Outline tabs pane displays thumbnails of the 

slides or the text on the slides in the outline format depending on the selected tab. You can resize these 

panes as per requirements by dragging the border lines between the panes. 

Located at the bottom of the PowerPoint windows is customizable Status bar, which is used to display 

useful information, such as current slide number, the selected theme, buttons to select PowerPoint 

views, Zoom slider, zoom out and zoom in buttons, etc. Like other Microsoft Offi ce applications, to 

customize the Status bar, i.e., to choose what you want to display on this bar, right click the Status bar 

and check/uncheck the corresponding options. 

When you work in PowerPoint, you can either open an existing presentation or create a new 

presentation. Like other Microsoft Offi ce programs, you can open an existing presentation by choosing 

the Open command on the Backstage view which you can display by clicking the File tab on the 

Ribbon. 
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6.3 CREATING A NEW PRESENTATION 

When you start PowerPoint, it automatically creates a blank presentation. If you want to create 

a presentation from scratch, you do not need to do anything further and you can start working on 

the presentation. Besides creating a blank presentation, you can create a presentation based on other 

template too. 

∑ Click the File tab to switch to the Backstage view and click New in the Navigation pane. Your 

screen should look similar to Fig. 6.3. 

Fig. 6.3 Using a template to create a presentation

When PowerPoint is installed, it automatically installs a few templates that you can use, which are 

available in the Available Templates and Themes box. A template is a framework with predefi ned theme 

and design layout and may include one or more slides. If a template meets your requirements, it can 

speedup creation of the presentation. To view the templates installed on your computer, click Sample 

Templates. Some of the available sample templates include Classic Photo Album, Contemporary Photo 

Album, Introduction to PowerPoint 2010, Training, Quiz Show and Project Status Report. In addition, 

you may search for professional templates at Offi ce.com, Microsoft’s online resources and download 

these to your computer. When you click a template icon, PowerPoint displays its preview in the right 

pane. 

∑ To create a blank presentation, click the Black Presentation icon and click the Create button, 

as illustrated in Fig. 6.3. Similarly, to create a presentation based on any other template, click the 

corresponding icon and click Create. 

Figure 6.4 shows a presentation based on the Training template. The presentation contains 19 slides and 

the fi rst slide is displayed in the Slide pane. Notice that the left side of Status bar is displaying “Slide 

1 of 19”. The left pane is displaying thumbnails of slides in the presentation. On clicking a thumbnail, 

PowerPoint displays the corresponding slide in the Slide pane and you can modify it. 
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Fig. 6.4 Presentation based on the Training template

6.4 ADDING SLIDES TO A PRESENTATION 

Whether you start with a blank presentation or a presentation based on a template, you will need to add 

new slides to your presentation. However, fi rst, create a blank presentation, if one is not already open, 

following the steps given in the previous section. Your screen should look similar to Fig. 6.2. 

∑ Click the title box and type the title for your presentation, e.g., Zoom Digital Camera. If you 

want to defi ne a subtitle for the presentation, click the second box and type a suitable subtitle, e.g., 

Glossy Electronics Ltd.

6.4.1 Inserting a Slide 

PowerPoint allows you to insert a new slide in your presentation in several ways. The new slide is 

inserted after the current slide, therefore, if required, click the thumbnail for the corresponding slide in 

the left pane. 

∑ Click  (the New Slide button ) on the Home tab (see Fig. 6.4) or right click in the left pane to 

display a context menu and click Insert Slide. You may also press Ctrl+M to insert a slide. 

PowerPoint inserts a slide in the presentation and selects it, as shown Fig. 6.5. 

∑ Now you can click in the title box to type title for the new slide. To add text for the slide, click 

“Click to add text” and type text. On pressing Enter, PowerPoint presents another line to enter 

text. By default, the text lines are shown as bulleted paragraph, however, you can use the controls 

available in the paragraph and Font group to change the format of the text lines, if required. The 

controls on Font and Paragraph groups work exactly like in Microsoft Word (Refer to Chapter 3 

for details).
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Fig. 6.5 A new slide inserted in the presentation

∑ The new slide shown in Fig. 6.5 is the default slide; however, PowerPoint supports a few other 

types of slides too. To display the slides gallery, click the down pointing arrow located below 

(See Fig. 6.5.)

Figure 6.6 displays the Slides gallery containing icons for the various types of slides PowerPoint can 

insert in your presentation. 

Fig. 6.6 Choosing a slide to insert in the presentation

∑ Click the icon for the slide that you want to insert in your presentation. You may click Blank to 

insert a blank slide. You may use Duplicate Selected Slides, Slides from outline or Reuse Slides to 

insert existing slides from the current or some other presentation fi le. 
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After inserting a slide, you can type text or add other object as you would learn later in this 

chapter. 

6.5 SAVING A PRESENTATION 

You save a PowerPoint presentation exactly like you save a document in Word or Excel. 

∑ To save the presentation, click , the Save button on the Quick Access toolbar located at the top 

left corner of the PowerPoint window. You can also accomplish the fi le save operation by pressing 

Ctrl+S, the shortcut keys for the Save command. The Save command is also available on the 

Backstage view which you can open by clicking the File tab.

On using the Save command, PowerPoint displays the Save As dialog box shown in Fig. 6.7. 

Fig. 6.7 Save As dialog box

Note  If you are working on a presentation that already been saved once, the Save command resaves the 

presentation without displaying the Save As dialog box.

The Save As dialog box enables you to assign a fi lename to the presentation you are saving. Besides 

the fi lename, you can also select the drive and the folder where you want to store this fi le. The fi lename 

you want to assign to the presentation has to be typed in the fi lename box. PowerPoint selects a default 

drive and folder (directory) for saving fi les. For instance, in Fig. 6.7, the currently selected folder is 

‘Documents Library’. So, if you do not change the folder, the fi le will be saved in this folder. (Your 

computer may display a different folder.) If you want to save the fi le in some other folder, perform 

these steps:

 ® To select a folder visible in the Save As dialog box, double click it. For instance, to save the 

presentation in the GardenTools folder, double click to open this folder. 

 ® To save the presentation in a new folder, click the New Folder button. 

 ® To select a different major area, e.g., Desktop instead of Documents Library, click it. Then 

double click to open a folder that may exist in the selected area. 
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∑ After you have selected the folder, type a suitable fi lename. If you prefer, you may keep the 

fi lename suggested by PowerPoint. Finally, click the Save button to save the fi le.

6.5.1 Saving a Presentation in PDF and Other Formats

By default, PowerPoint saves the presentation in PowerPoint 2010 format (fi le extension .pptx); 

however, it can save the presentation in most popular formats, including PDF, PowerPoint 97-2003, 

JPEG, PNG, RTF, TIFF, OpenDocument Presentation, etc. To save a presentation in a specifi c format: 

∑ Click the File tab to display the Backstage view and then click the Save As command. PowerPoint 

displays the Save As dialog box shown in Fig. 6.7.

∑ Click the Save as Type button (see Fig. 6.7) and PowerPoint displays a dropdown list containing 

the various supported fi le formats. 

∑ Click the desired fi le format, e.g., PDF and click Save to save the presentation in the desired 

format.

Note  When you save a presentation in other formats, PowerPoint tries to preserve the formatting as much 

as possible. This is particularly true for the PDF format.

6.6 CLOSING A PRESENTATION 

∑ After you have fi nished working on a presentation, if you want to close it, press Ctrl+W. An 

alternate way to close the fi le is by clicking Close in the Backstage view, which you can open by 

clicking the File tab. 

When you try to close a presentation that has unsaved changes, PowerPoint prompts you to save the 

presentation before closing it. 

6.6.1 Closing the PowerPoint Application

∑ After you have fi nished working on your presentation, if your wish to close the PowerPoint 

application, click the File tab to display the Backstage view and then click Close. Alternatively, 

press Alt+F4 keys or click the close button (X) located at the extreme right of the title bar to close 

PowerPoint. 

6.7 OPENING AN EXISTING PRESENTATION 

You can open an existing PowerPoint presentation with ease. If you want to open a presentation that 

you have edited recently, PowerPoint can help you to open it through the Backstage view. 

∑ Click the File tab to display the Backstage view and then click Recent in the left pane. 

PowerPoint displays a list of recent presentations in the middle pane shown in Fig. 6.8. If the presentation 

you want to open is listed in the Recent Documents box, you may click to open it. PowerPoint also 

display the list of recent presentations in the left pane below Close in the left pane if the “Quickly 

access this number of Recent Presentations” checkbox in the middle pane is checked. 
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Fig. 6.8 Opening a presentation in the Backstage view

∑ If the presentation you want to open is listed in the Backstage view, click to open it, otherwise, 

click Open to display the Open dialog box shown in Fig. 6.9.

Fig. 6.9 Opening a presentation in the Open dialog box

Tip You can press Ctrl+O to display the Open dialog box from any tab. 

The fi lenames displayed in the list box are only from the selected folder. For instance, in Fig. 6.9, the 

Open dialog box is displaying presentation fi les from the Documents Library folder. To display fi les 

available in other folders, you need to open the desired folder. To open any folder that is displayed in 

the Open dialog box, double click it. Similarly, to display fi les from a location/folder whose icon is 

displayed in the left pane, click it. For example, you may click Desktop to display workbooks available 

on your desktop. 
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∑ To open any presentation whose fi lename is displayed in the Open dialog box, double click the 

fi lename or type the fi lename in the File Name box and click the Open button. 

6.7.1 Presentation Opening Options

PowerPoint can help you to open a presentation in a few different modes. You may choose these options 

by clicking the down-arrow on the right side of the Open button, as illustrated in Fig. 6.9. The Open 

Read-Only mode opens the presentation and allows you to modify it; however, you cannot write the 

changes back to the original presentation. The Open as Copy option makes a copy of the presentation 

and opens the copy for editing. The Open and Repair is used in some rare situations when a presentation 

has become corrupted and cannot be opened in the regular way.

6.8 EDITING AND FORMATTING SLIDES 

After you create a presentation, you get one or more slides. Often you need to edit and format text on 

the slides and to add others objects, such as charts, Clip Art, organisation charts, audio or video media 

fi les, etc. Let us learn these skills.

6.8.1 Entering/Editing Text 

Entering text in a slide is very simple. Depending the type of slide, the slide displays one or more text 

boxes to enter text, e.g., there are two text boxes on the slide shown in Fig. 6.2. 

∑ To type text in any text box, click in the box and type the text. To enter multiline text, continue 

typing text and PowerPoint automatically wraps the text to the next line when the current line gets 

fi lled. You may press the Enter key to end the current line and start entering the next line of text. 

∑ To edit existing text, use the usual key strokes, commands or mouse clicks to select text and edit/

replace text. 

6.8.2 Formatting Text and Paragraphs

When you enter text in text boxes, PowerPoint applies the default font, color and style for the text based 

on template, the type of the slide and theme in use. We will talk about theme in a moment. However, if 

you want to format the text on any slide in a different font, size or style, use the usual controls available 

on the Home tab on the Ribbon. (See Fig. 6.10.) 

∑ The Font group contains controls to apply bold, italic, underline and shadow on the selected text. It 

also contains controls to choose the font and size. Besides choosing the size, you can use Increase 

Font Size and Decrease Font Size buttons to change the font size. 

∑ If you prefer to use the Font dialog box to control the text formatting, click Dialog Box Launcher

to open the Font dialog box. You may use the usual cut, copy and paste commands to cut, move or 

copy text.

Note  Text formatting in PowerPoint works exactly as in Word. Refer to Sections 3.12 and 3.13 for 

details. 

Like font, the default paragraph formatting you get for the text you enter in slides too depends on 

the slide type and the template in use. 
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Fig. 6.10 Formatting text on a slide

∑ The easiest way to change the paragraph formatting in by using the corresponding control in the 

Paragraph group on the Home tab on the Ribbon. Some of the paragraph formatting commands are 

also available on the context menu that opens when you right click a paragraph. 

∑ You can use the Bullet and Numbering to control bullets and numbering for the selected paragraph(s). 

The Paragraph group also has controls to change the line spacing and increase/decrease indent for 

the paragraphs. Other useful controls available on the Paragraph group are used to change text 

orientation (e.g., to show text at 90 degrees) and to convert text in two or more columns. 

Note Paragraph formatting in PowerPoint works exactly as in Word; refer to Chapter 3 for details. 

∑ After editing the current slide, if you want to move to the next slide, click  (Next Slide) located 

at the bottom of the vertical scrollbar. To select a new slide, you may also click the slide icon in 

the Slide pane on the left side of the PowerPoint window. 

6.8.3 Inserting a Picture, Clip Art and Screenshot

A presentation is not effective nowadays without graphics. PowerPoint includes several useful tools in 

the Images group on the Insert tab to insert pictures, clip art and screenshot in a slide. (See Fig. 6.11.) 

To insert a pictures in a slide: 

∑ Click  (the Picture button) on the Images group on the Insert tab, as illustrated in Fig. 6.11. 

PowerPoint displays the Insert Picture dialog box.

∑ Choose the picture that you want to insert in the dialog box and click the Insert button. PowerPoint 

inserts the picture on the slide. It also displays resizing handles on the pictures as well as the 

Picture Tools on the Ribbon as shown in Fig. 6.12.

You may use the picture tools to format the picture. The working of these tools is same as in Microsoft 

Word. Refer to Section 3.38 for details. 

To insert a clip art in a slide, take the help of the Clip Art tool on the Images group. Similarly, 

you can use the Screenshot tool to insert the screen shot of any Windows application running on your 

computer. These tools work exactly as already described in Sections 3.38 and 3.39.
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Fig. 6.11 Picture, Clip Art, Screenshot and Photo Album tools on the Images group

Fig. 6.12 A picture inserted in a slide

6.8.4 Inserting a Chart

PowerPoint includes the facility to create charts on a slide. Either you can insert a slide with a chart, or 

use the Chart tool on the Insert tab to insert a chart in an existing slide. The Chart tool inserts an Excel 

chart in the PowerPoint slide. Like an Excel chart, you choose the chart type, enter the data ranges, 

labels and legend, etc. You can easily resize or edit the chart. Let us learn to insert a chart. 

∑ Click the slide in the left pane where you want to insert the chart. If required, you may insert a new 

slide. Next click the Chart tool on the Insert tab on the Illustration group (See Fig. 6.11.). If the 

new slide you have inserted (e.g., Title and Content) displays icon for the chart object, (See Fig. 

6.5), you may click that icon to start the chart creation process. 

PowerPoint displays the Insert Chart dialog box shown in Fig. 6.13 where you choose the type of chart 

you want to create. The various categories of charts you can insert are displayed in the left side of the 

dialog box. 

∑ Click the icon for the desired chart type, click OK and PowerPoint opens an Excel worksheet with 

dummy data and uses this data to creates a sample chart on the slide, as shown in Fig. 6.14.
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Fig. 6.13 Inserting a chart in a slide

Fig. 6.14 Creating a chart 

The sample data contains a few rows and columns, however, you can change the number of rows 

and columns you want to plot in your chart. To accomplish this, drag the bottom right corner of the 

chart data range, as illustrated in Fig. 6.14. Similarly, you can change the data in row1 and column 1 
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to change the legends and X-axis title, respectively. As you change data in the datasheet, PowerPoint 

refreshes the chart based on the revised data. After you have entered the required data in the worksheet, 

you may close it by clicking the close (X) button located on the top right corner. 

PowerPoint allows you to easily resize or reposition the chart on the slide. To resize the chart, drag 

the resizing handles located at each corner as well as the center of each side of the chart. Similarly, to 

reposition a chart on the slide, drag its border to the desired location, and when you release the mouse 

button, PowerPoint displays the chart at the new position. 

∑ To edit the chart, e.g., to change the chart type, chart data, color scheme, etc., click anywhere in 

the chart area to put it in the edit mode. Figure 6.15 displays a chart in the edit mode. Notice that 

the Ribbon displays Chart Tools which contains various tools that you can use to edit the chart. 

For instance, you can click Change Chart Type to change the chart type or Edit Data to change 

the data for the chart.

Fig. 6.15 Editing a chart

Note  The process of creating and updating a chart on the slide in PowerPoint is similar to that in Excel. 

For more details, refer to Chapter 4. 

6.8.5 Inserting Shapes, Smart Art, WordArt, Text Box and Symbol

Like Word and Excel, PowerPoint includes several useful tools on the Insert tab to insert shapes, 

SmartArt, WordArt, text box and symbols. The process of inserting these objects on a slide is exactly 

the same as in a Word document or Excel worksheet. For instance, to insert a SmartArt that you can use 

to create an organization chart or process fl ow, click the SmartArt button, choose the type of SmartArt 

you want to use and click on the slide at the desired location. Then you can take the help of the 

SmartArt Tools displayed by PowerPoint on the Ribbon to reposition or format the inserted SmartArt. 

You can insert a WordArt, shape, text box, etc. in the same way. Refer to Sections 3.37 and 3.38 to learn 

more about how to insert these objects. 
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6.9 USING TABLES IN SLIDES 

Tables fi nd extensive use in slides as these help in presenting information in organized manner while 

taking less space. Compared to free running text, viewers fi nd the information displayed in a table a 

little easy to understand. To create a table: 

∑ Select or create a new slide. Then select the Insert tab and click the Table button on the tables 

group on the left, as illustrated in Fig. 6.16.

Fig. 6.16 Inserting a table

PowerPoint displays a grid below the Table button which is used to select the number of rows and 

column for the table you want to insert. 

∑ As you drag mouse on the grid, PowerPoint highlights the grid and displays a preview of the table 

on the slide. When your table displays the required number of columns and rows, click the mouse 

to create the table on the slide. 

PowerPoint displays the table on the slide. It also displays Table Tools on the Ribbon that you can use 

to change the table style, style options, borders, etc. 

∑ You can enter the text in the table in the usual way; just click in any cell and type text. To move 

the cursor to the next cell, use the Tab key or click in the desired cell. Use the usual commands 

and tools to format the table text. Figure 6.17 displays a slide with a table with text entered in some 

cells. 

∑ To resize the table, drag the resizing handles located at the corners of the table border. If you need 

to reposition the table on the slide, drag the border at any position except the resizing handles. 

∑ To insert or delete rows or columns in the table, right click the table and choose the corresponding 

command. 
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Fig. 6.17 A slide with table

6.10 INSERTING VIDEO AND AUDIO 

To give a professional look to your presentation, you can include media clips in a slide. In other words, 

you can include audio and video fi les in your slides. PowerPoint can automatically play the media fi le 

when the slide is displayed or when you click a button. 

∑ To insert a media fi le, click Insert to choose the Insert Tab. In the Media group on the right, click 

the Video button if you want to insert a video or Audio to insert an audio fi le. 

∑ In either case, PowerPoint displays a dialog box to help you choose the fi le that you want to insert. 

Navigate to the folder that contains the fi le, choose the fi le and click Insert to insert it into the 

slide. 

Like an inserted picture, you can resize and reposition the frame that will display the video. The inserted 

video and audio objects also display the play, pause, stop, forward and reverse buttons. Figure 6.18 

displays a slide with audio and video objects. 

Fig. 6.18 Video and Audio objects inserted in a slide
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∑ To change the video options, you may use the Playback tab under Video Tools on the Ribbon

(See Fig. 6.18). For instance, you can trim the video, play video in full screen, rewind after playing, 

control volume, etc. 

PowerPoint can also help you play the video from a website, however, playing a video from the website 

should be avoided as it may not be able to play it during presentation if there is an issue with the 

Internet connection or the website.

6.10.1 Record Audio

If your computer has sound card and microphone, you can record a sound fi le. To do so

∑ Click the down pointing arrow below the Audio button on the 

Insert tab to display a menu and then click Record Audio on the 

menu. PowerPoint displays the Record Sound dialog box shown 

here.

∑ Click the red record button and start speaking. Click OK when you want to stop recording and 

PowerPoint creates an audio fi le and insert it on the slide. 

6.11 DEFINING HEADER AND FOOTER 

Like a Word document, you can defi ne the header and/or footer for your presentation. You may include 

any text in the header/footer, e.g., name of the company or the title of the presentation. Besides, you 

may also include date or slide number in the header or footer. To defi ne the header and footer: 

∑ Click Header and Footer on the Text group on the Insert tab and PowerPoint displays the Header 

and Footer dialog box shown in Fig. 6.19.

Fig. 6.19 Header and Footer dialog box

The dialog box enables you to choose the items that you want to include in the footer. Besides the 

Footer text, which is displayed in the center of the slide, you may include date (or Time/Date and time) 

and slide number in the footer. The default position for the date is on the left side of the footer and 

the slide number on the right. When you make a selection, PowerPoint highlights the corresponding 

position on the Preview box displayed on the Header and Footer dialog box. 
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∑ If you want the date to update automatically to refl ect the date of the last update of the presentation, 

keep the Update Automatically radio button checked. In that case, you may choose the desired 

date, time or date and time format by clicking the down-pointing arrow in the date box, as illustrated 

in Fig. 6.19. 

∑ On the other hand, if you want to display a fi xed date, click the Fixed radio button and type the 

date. If you do not want the footer to be displayed on the title slide, check ‘Don’t show on title 

slide’ check box. 

∑ Finally, if you want to apply the footer on all slides, click Apply To All button, or click the Apply 

button to apply the footer to the current slide. 

Figure 6.20 display date, footer text and slide number added to a slide. The Notes and Handouts 

page of the Header and Footer dialog box enables you to specify a separate header and footer for Notes 

and Handouts. Notes and Handouts are discussed later.

Fig. 6.20 Date, footer text and slide number added to a slide

6.12 SPELLING CHECKING AND CORRECTION 

Normally the presentation is shown to important audience, therefore, you do not want to leave any 

spelling mistakes in your presentation. To help you create a presentation free of spelling mistakes, 

PowerPoint includes a useful spelling checking and correction tool. The working of the spelling 

checking and correction in PowerPoint is similar to that in Word and Excel. If ‘Check spelling as you 

type’ option is on, PowerPoint marks words that it cannot fi nd in its dictionaries or custom dictionaries 

with red wavy underline as you type. If this option is off on your PC, you can spell check all slides 

by pressing F7 or clicking the Spelling tool on the Review tab. Figure 6.21 displays spell check being 

performed on a presentation. 

∑ The Spelling dialog box displays suggestions for the misspelled word. To accept a suggestion, 

click the desired word in the Suggestions list box and click the Change button. 
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Fig. 6.21 Spelling checking

∑ If you want PowerPoint to automatically correct this word with the selected correction if you type 

the misspelled word in future, click AutoCorrect. 

∑ To change the Spelling checking options, click the Options button to display the Proofi ng options. 

For more information on the use of spelling checking, refer to Chapter 3. 

6.13 INSERTING COMMENTS IN A SLIDE 

PowerPoint allows you to attach comments to any slide. Comments are useful to provide some remarks 

about a specifi c slide, e.g., who created the slide or the source for the chart used on the slide. The 

comments are displayed while the presentation is in the design mode; however, these are not displayed 

when the slide show is run or slides are printed. 

∑ To add a comment to any slide, select that slide and click New Comment on the Review tab. 

Figure 6.22 displays the comment being added to a slide. You can type any length of text in the 

comment box. After fi nishing typing the comment, click outside the comment box to close the 

comment box. 

Fig. 6.22 Inserting Comments
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PowerPoint displays a small comments icon in the top left corner of the slide with comments. When 

you hover mouse on the comments icon or click the comment icon, PowerPoint displays the comment. 

To edit or delete a comment, click the corresponding button on the Comments group on the Review 

tab. 

6.14 POWERPOINT VIEWS 

In PowerPoint, you can work in different views, such as Normal view, Slide Sorter view, Outline view 

and Notes Page view, Reading view, etc. You have already used the Normal view. While working in the 

Normal view, you can switch between Slides and Outline views by clicking the corresponding tab in 

the left pane (See Fig. 6.22). The Normal view (Slides/Outline) is useful to edit or format a single slide 

at time. To select a new view, you can either use the View tab on the Ribbon (see Fig. 6.23) or click the 

view buttons located at on right side of the status bar. 

Fig. 6.23 Selecting PowerPoint views

6.14.1 Slide Sorter View

The Slide Sorter view displays miniature versions of your slides. In this view, you see several slides on 

the screen. The number of slides you see on the screen depends on the zoom percentage and the type of 

display you are using. In the Slide Sorter view, it is easy to organize the slides within the presentation. 

Figure 6.24 displays a presentation in the Slide Sorter view. For example, you can change the order of 

slides within the presentation. For instance, in Fig. 6.24, if you want to bring slide 3 to the 2nd position, 

just drag slide 3 to its new position. This view also helps you to delete, add, copy and paste slides.

6.14.2 Outline View

You already know PowerPoint supports the Outline View. Figure 6.25 displays a presentation in the 

Outline view. In this view, PowerPoint divides the window in two sections. The left section displays 

the text used on the slides and the right sections displays the currently selected slide. You can resize 

these sections. (To switch to the Outline view, click the Outline tab in the Normal view, as illustrated 

in Fig. 6.22.) 

The Outline view is helpful when you want to enter or edit a lot of text in your slides. Like the 

Slide Sorter view, this view also helps you to insert, copy, paste and delete slides. You can also alter 

the sequence of slides in your presentation. To change the slide position, drag the slide icon (See

Fig. 6.25).
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Fig. 6.24 Slide Sorter view

Fig. 6.25 Outline view

6.14.3 Notes Page View

In the Notes Page view, you see a page that includes the slide image at the top of the page and room for 

notes toward the bottom, as shown in Fig. 6.26. To select the Notes Page view, click Notes Page on the 

View tab. You can change the size and placement of both the slide image and the notes box by dragging 

the resizing handles. The Notes Page view enables you to type the speaker’s notes in the bottom part 

of the page. The text entered in the notes page area is formatted using the normal editing commands. 

The notes page text is not displayed when you run a slide show. However, you can print the slides with 

speaker’s notes. 
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Fig. 6.26 Notes Page view

6.15 SLIDESHOW 

After you have created and edited your slides, you can run the slideshow. The slide show can show all 

or selected slides one after the other on the computer screen. PowerPoint displays the fi rst slide on the 

screen and you can speak about the slide. When you want to show the next slide, click the mouse or 

press the PgDn or N key, and the new slide replaces the old slide. You may even confi gure a slide to 

automatically advance to the next slide after a specifi ed time. 

6.15.1 Running a Slide Show

To run a slide show for the current presentation, perform any of the following steps: 

∑ Press the function key F5.

∑ Click the Slide Show button in the lower-left corner of the Status bar. 

∑ Click the From Beginning or From Current Slide button on the Slide Show tab (See Fig. 6.27).

Fig. 6.27 Running the Slide Show
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PowerPoint starts the presentation starting from the fi rst slide, or the current slide, if you click From 

Current Slide. When PowerPoint runs the slide show, it uses the entire screen to display the slide. 

∑ To advance to the next slide, click the mouse or press PgDn or N. If you want to display the 

previous slide, press PgUp or P. 

∑ To cancel the slide show, press the Esc key. To display all shortcut keys that you can use during a 

slide show, press F1. 

By default, the slide show displays all slides and waits for the mouse click or key pressing to advance 

to the next slide. However, you can control these as well as other aspects of the slide show through 

the Set Up Show dialog box that you can open by clicking Set Up Slide Show, as illustrated in Fig. 

6.27. Figure 6.28 displays the Set Up Show dialog box. You can use From and To boxes in the Show 

Slides group to choose the slides for the slide show. You may also choose to advance slides manually or 

automatically through the Advance Slides group. If multiple monitors are connected to your computer, 

you may choose the monitor to display the slide show on. 

Fig. 6.28 Set Up Show dialog box

6.15.2 Using Pointer 

While the slide show is running, you can use the mouse pointer as the pointer. You can also convert this 

pointer into an electronic pen or highlighter.

∑ While the slide show is running, right click anywhere on the slide to display a context menu shown 

in Fig. 6.29. Then click Pointer Options on the menu and click the Pen or Highlighter command. 

(The context menu also includes other commands to move forward or backward, or to jump to a 

specifi c slide.)

Now you can drag the mouse to highlight any area of the slide with the electronic pen or highlighter. 

Figure 6.29 displays the use of the highlighter and electronic pen on a slide. When you end the slide 

show, PowerPoint asks if you want to keep or discard the ink annotations.
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Fig. 6.29 Using the pen and highlighter during the slide show

6.15.3 Automatically Advance Slides

If you want to automatically advance the slide after a specifi ed time, you can record slide advance 

timings. The Rehearse Timings command on the Slide Show enables you to record the slide timings. 

In this mode, you run the slideshow, speak about the slide and manually advance to the next slide. Go 

through the entire presentation and PowerPoint keeps recording the time you spend on each slide. At 

the end of the slide show, if you like, PowerPoint can record these timings as slide advance timings. 

If you save the slide advance timings, PowerPoint displays these in the Slide Sorter view under each 

slide. PowerPoint will use these slide timings to automatically advance to the next slide during the slide 

show, unless you select the Manually option for Advance Slides in the Set Up Show dialog box (See 

Fig. 6.28). 

6.15.4 Recording Narration

If your computer has sound card and microphone, you can record narration for one or more slides. 

∑ To record narration, set up the microphone and click 

Record Slide Show in the Set Up group on the Slide 

Show tab (See Fig. 6.27). 

PowerPoint displays the Record Slide Show dialog box 

shown in Fig. 6.30. The Record Slide Show dialog box 

can be used to record Slide and animation times, Narration 

and laser pointer movement or both. By default, it records 

both. 

∑ Click Start Recording. PowerPoint runs the slide show while you can talk about slides. You can 

manually advance the slide and talk about the next one. This way, you can talk about any or all 

slides. The narration gets saved with the slides.

Fig. 6.30 Record Slide Show dialog box
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Next time, when you run the slide show, the PC will reproduce the narration. If you did not uncheck 

“Slide and animation timings”, the slide timing also get saved. Recording narrations is useful to create 

a self-running slideshow at trade shows, kiosks and stores.

6.16 SLIDE TRANSITION EFFECTS 

To give a professional look to your slide show, you can use various transition effects when the next slide 

replaces the previous slide. The transition effects supported by PowerPoint include cut, fade, push, 

wipe, split, reveal, random bars, cover, uncover, shape, fl ash, dissolve, checkerboard, blinds, ripple, 

honeycomb, door, rotate, etc. Moreover, for most transition effects, you can choose the effect option, 

e.g., for Push, you may choose to push the slide from top, left, right or bottom. To defi ne the transition 

effect for any slide, perform the following steps:

∑ Open the presentation if required, select the Normal or Slide Sorter view and click the Transition

tab.

∑ Click the slide for which you want to defi ne the transition effect. 

∑ Click the desired Transition button in the Transition to This Slide group, as shown in Fig. 6.31. To 

view additional transition effects, use the scroll bar or click More. To use no transition effect or to 

remove the current effect, click None.

Fig. 6.31 Defi ning Slide Transition Eff ect

∑ As you apply a transition effect, PowerPoint displays it on the slide. To review the effect, click 

Preview on the left on Transition tab. 

∑ While PowerPoint provides so many transition effects, for a professional slide show, do not use to 

too many transition effects. To maintain consistency in the presentation, it is recommended to use 

the same transition effect with all slides. To do so, choose a transition effect and click Apply To 

All in the Timing group, as illustrated in Fig. 6.31.

The Timing group on the Transition tab provides additional controls to fi ne-tune the applied transition. 

For example, you can choose to play a sound during transition through the Sound drop-down box. If 

you want PowerPoint to automatically advance to the next slide after a specifi ed time, check the After

check box and enter the required time in the After box in the Timing group.
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6.17 APPLYING ANIMATION TO SLIDE OBJECTS 

Most slides contains several objects. For example, a slide may have several bulleted points or it may 

have some text and one or more pictures, charts or other objects. While displaying a slide, PowerPoint 

can display all objects in one go or one at a time. The controls on the Animation tab help you to defi ne 

animation effects for the slide, i.e., how the objects appear, move or disappear. To control animation: 

∑ Select the slide and click the object you want to add animation to. For instance, in Fig. 6.32, the 

text box containing three bulleted paragraph is selected. 

∑ Click the Animations tab. The Animations group displays the applied animation effect if any. To 

apply an animation effect, click More to display the available effects, as shown in Fig. 6.33.

Fig. 6.32 Applying animation to a slide object

Fig. 6.33 Choosing the animation eff ect
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∑ Click the desired animation effect. You may control the timing for the animation through the 

Duration spinner box in the Timing group. 

∑ Click the Preview button located in the left of the Animation tab to preview the effect of the 

selected animation effect. 

∑ You can customize the selected animation effect by choosing the effect option through the Effect 

Options button. For instance, for bulleted text, you may choose whether text appears from left, 

right, top or bottom. 

6.17.1 Reorder Animation

After you have applied animation to objects, if required, you may change the sequence of the animation. 

For instance, consider the animation added to the three bulleted paragraphs in Fig. 6.32. During the 

slide show, the fi rst paragraph will appear fi rst, followed by the second and third. Assume that you want 

the second paragraph to appear before the fi rst one. To accomplish this, you can reorder animation. 

∑ Click the Animations tab and select the slide containing animated objects. PowerPoint displays 

animation sequence to the left of objects on the slide, as shown in Fig. 6.34.

Fig. 6.34 Reorder animation

∑ Click “2” to the left of the second paragraph and click Move Earlier in the Reorder Animation 

group as illustrated in Fig. 6.34. Access renumbers the objects. 

∑ Click Preview on the Animation tab to verify the animation order. 

6.18 CREATING A PRESENTATION BASED ON

 A PHOTO ALBUM 

If you have a set of pictures in a folder, PowerPoint can create a presentation based on those pictures. 

It will put each picture in its own slide. Then you can apply the tools available in PowerPoint to make 

the slide show interesting. For instance, you can apply background to the slides or add captions for the 

pictures. To create a presentation based on pictures: 

∑ Click the Insert tab and then click Photo Album in the Images group. PowerPoint displays the 

Photo Album dialog box shown in Fig. 6.35. 

∑ Click File/Disk and PowerPoint displays Insert New Pictures dialog box. Navigate to the folder 

that contains pictures and select the pictures you want to insert in the presentation. Figure 6.36 

displays the Insert New Pictures dialog box. 
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Fig. 6.35 Photo Album dialog box 

Fig. 6.36 A few pictures selected in the Insert New Pictures dialog box 

∑ Click the Insert button in the Insert New Pictures dialog box. PowerPoint lists the selected pictures 

in the Photo Album dialog box. It also displays the preview of the pictures in the Preview box (See 

Fig. 6.35). 
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∑ For your convenience, the Photo Album dialog box contains a few useful tools to change the 

brightness, contrast and orientation of the picture. You can also remove one or more pictures and 

reorder them. You may add more pictures by clicking the File/Disk button. Finally, click Create

to create the presentation based on the photos. 

Figure 6.37 displays a photo album presentation based on photographs. Notice that it has added a title 

page for the album. You may edit this presentation in the usual way.

Fig. 6.37 A photo album presentation 

6.19 CHANGING THE LOOK OF THE PRESENTATION 

When you run your presentation, sometimes you may not like the look of slides. PowerPoint can help 

you to change the look of your presentation by applying a different theme, color scheme, fonts, effects 

and background styles. All these tools are available on the Design tab. Figure 6.38 illustrates the use 

of these tools. 

∑ Hover the mouse on a theme in the Themes group to preview it on the slide. To view additional 

themes, click the More button. On clicking a theme, PowerPoint applies it on all slides. 

∑ Each theme has a predefi ned set of colors, fonts and effects; however, you can changes these if 

you prefer by using the corresponding control on the Design tab. Similarly, you can change the 

background style through the Background Styles control.

6.19.1 Using Slide Master

The Slide Master helps to give a distinct look to all slides. It controls the font and style for various text 

objects. It also controls the background color and other effects that PowerPoint applies to all slides. It 

also contains placeholders for the footer text. Thus, Slide Master gives you a central place to control 
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the look of your presentation. If you want to display a fi xed text or graphics, say logo of your company 

or the picture of a product on all slides, you will fi nd Slide Master useful. 

∑ On the View tab, click Slide Master in the Master Views group and PowerPoint displays the Slide 

Master tab shown in Fig. 6.39. 

Fig. 6.38 Design tools to change the look of a presentation

Fig. 6.39 Slide Master

∑ Now you can edit the master styles or drag to change the location of footer objects. To show a logo 

or picture on all slides, switch to the Insert tab and then click Picture. After inserting the picture, 

you can resize and reposition it on the Slide Master.
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6.20 PRINTING A PRESENTATION 

You can print your presentation in the following ways: 

Slides One slide is printed on each page.

Notes Page Each page prints one slide and the speaker’s notes.

Handouts Two/three/four/six/nine slides can be printed on each page.

Outline View Only the text in the slides is printed. 

∑ To print your slides, press Ctrl+P or click File to switch to the Backstage view and then click 

Print. PowerPoint displays the preview of the current slide and print settings. 

∑ Click the control shown in Fig. 6.40 to choose what to print, i.e., slides, notes, handouts or outline. 

Choose other settings, e.g., printer, slide range, collated, etc., in the usual way. Finally click the 

Print button to initiate the printing. 

Fig. 6.40 Printing a presentation

6.21 SHARING A PRESENTATION 

Besides displaying the slide show on a monitor or printing the presentation, you can share the 

personation with other users in few different ways. Like other Microsoft Offi ce program, you fi nd the 

corresponding commands in Save & Send in the Backstage view, as shown in Fig. 6.41. 

6.21.1 Sending a Presentation using E-mail

PowerPoint can send the presentation you are working on as an attachment using E-mail. It can also 

covert the presentation into a PDF/XPS document and send it as an attachment using E-mail 

∑ Click the File tab and then click Save & Send. 

∑ Click Send Using E-mail as shown in Fig. 6.41. 
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Fig. 6.41 Save & Send a presentation

∑ If you want to E-mail a copy of the presentation, click Send as Attachment. On the other hand, if 

you want to send the presentation as a PDF fi le, click Send as PDF. Similarly, click Send as XPS, 

if you to send the presentation as an XPS fi le. 

∑ PowerPoint converts the presentation into PDF/XPS, if required, creates a message in the default 

E-mail client (e.g., Microsoft Outlook 2010), attaches the fi le and displays the message on the 

screen, as shown in Fig. 6.42.

Fig. 6.42 An E-mail message with a presentation as an attachment
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∑ Type recipient’s e-mail address in the To box, type the message and click the Send button to send 

the e-mail. 

6.21.2 Saving a Presentation as a Media File

You can save a presentation as a Windows Media File (.wmv) which can be played on Windows Media 

Player. You can share the media fi le with others through disk, Web or e-mail. To convert a presentation 

into the Windows Media File: 

∑ In the Backstage view, click Save & Send and then click Create a Video (See Fig. 6.41). 

PowerPoint displays options for the video quality. Depending on the intended use of the video, you may 

choose the low, medium or high quality option. You may also choose slide timings. 

∑ After choosing the video options, click the Create Video button and PowerPoint displays the 

typical Save As dialog box. Choose the folder and type the fi le name in the dialog box and click 

the Save button. 

PowerPoint creates a Windows Media File of the presentation. If your presentation is not very 

large, the fi le conversion and creation processes should be complete in few seconds. You may 

double click the created media fi le to run it. You may share this fi le in a disk, fl ash memory or 

through e-mail. 

6.21.3 Package Presentation in a CD

If you want to distribute your presentation in a CD, PowerPoint can help you create the CD. Assuming 

that the presentation that you want to package into the CD is open, follow these steps:

∑ Click the File tab to open the Backstage view and then click Save & Send. 

∑ Click Package Presentation for CD under File Types as shown in Fig. 6.41. Then click the 

Package for CD button. 

PowerPoint displays the Package for CD dialog box shown in Fig. 6.43.

Fig. 6.43 Package for CD dialog box
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∑ The dialog box already includes the current presentation in the Files to be copies list. You may add 

additional presentation fi les, if required by clicking the Add button. 

∑ PowerPoint assigns a default name for the CD, which you can change. Finally, click Copy to 

CD to initiate the CD creation process. PowerPoint displays a confi rmation message box shown 

below.

∑ Click Yes to ask PowerPoint continue with the CD creation process and follow the prompts.

6.21.4 Saving a Presentation on the Web

If you want to access a presentation on a different computer, you can save it on the web. Microsoft 

provides web storage space on SkyDrive, also known as Windows Live SkyDrive. However, to use 

SkyDrive, you need a Windows Live ID, which you can have it for free, and the Internet access. 

After you have saved the presentation on SkyDrive, you can access it from nay computer connected 

to the Internet, share it with anyone or even make it public. To save the current presentation on 

SkyDrive: 

∑ Click the File tab to open the Backstage view and then click Save & Send. 

∑ Click Save to Web (See Fig. 6.41) and click Sign In in the right pane. PowerPoint displays the 

Connecting to docs.live.net dialog box shown in Fig. 6.44. 

Fig. 6.44 Connecting to docs.live.net dialog box
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∑ Type the E-mail address, password for your Windows Live ID and click OK. If Windows Live 

validates the entered credentials, it saves the fi le on the SkyDrive. 

∑ Now you can access the saved fi le from any computer connected to the Internet after logging 

in to your Windows Live account. You can even open and run the presentation on SkyDrive.

Figure 6.45 displays a presentation open on SkyDrive.

Fig. 6.45 A PowerPoint presentation open on SkyDrive
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TALLY

In this chapter, we will discuss the following topics:

Introduction to Computerized Accounting and Tally �

Downloading Tally �

Starting Tally �

Creating a Company �

Creating Accounts Information Masters: Groups and Ledgers �

Voucher: Voucher Types and Confi guring Voucher Entry �

Entering Accounting Vouchers �

Creating Inventory Information Masters: Stock Groups,  �

Categories, Units, Items and Voucher Types

Entering Inventory Vouchers �

Reports �

Using Tally to Maintain Payroll �

Maintaining Multiple Companies  �

Backup and Restore  �

Split Company Data  �

Multi-Lingual Capabilities �

Migrating Data from Earlier Versions of Tally �

Remote Access �
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7.1 INTRODUCTION TO COMPUTERIZED ACCOUNTING

 AND TALLY 

Accounting is one of the most important functions of a business, as it communicates important fi nancial 

information about the business in easy to understand reports and graphs to users, such as managers, 

shareholders, public and government. However, to provide accurate fi nancial information, accounting 

needs to record and process all types of business transactions that result in transfer of money or goods. 

These transactions include sales, purchase, payments, deposits, payroll, movement of goods, etc. 

A large business may do thousands or even millions of transactions in a year. Recording, analysing 

and processing so many transactions is a very time consuming process. In the past, large businesses 

used to take months to prepare their Balance Sheet or Profi t and Loss Account Statement. However, 

computerized accounting, which has been one of the most common applications of computers, has 

made the life of accountants easy. Computerized accounting helps to enter and maintain business 

transactions with the help of a computer program. The computer program helps to enter and maintain 

all data through easy-to-use user-interface. All information entered in the computerized accounting 

system is integrated, which helps to generate various types of reports with ease. As the computer 

program performs all calculations quickly, the reports are accurate and fast. The quick and accurate 

reports help business managers to take timely decisions. 

To do computerized accounting, several application programs are available, Tally being one of 

the most popular with accountants of India. First launched in 1986, Tally has improved and become 

more powerful and user-friendly with each new release. Tally is developed and marketed by Tally 

Solutions Pvt. Ltd. To learn more about the company and the products and services offered by Tally 

Solutions, visit its website at www.tallysolutions.com. As of January 2014, the latest version of the 

Tally software is Tally.ERP 9, available in two editions: Silver and Gold to cater to different types and 

sizes of the business. Both these editions of Tally.ERP 9 have the same features, though these differ in 

scalability. For example, the Silver edition supports a single user whereas the Gold supports unlimited 

concurrent users. Besides these, Tally.ERP 9 is also available in the Auditor’s edition. Tally.ERP 9 

has capabilities to completely handle TDS (Tax Deduction at Source) and excise for manufacturing 

businesses. Tally.ERP 9 also has remote access capability, that lets authorized users to access the Tally 

data from a computer located at a remote location using Internet. All these features make Tally.ERP 9 

an ideal choice for the accounting requirements for almost any kind and size of business. 

Though Tally.ERP 9 is currently the most popular version, earlier versions such as Tally 8.1, 7.2 and 

Tally 6.3 are also in use. Tally.ERP 9 can help you to migrate data from earlier versions to the current 

version. In this book, we shall discuss Tally.ERP 9 running on a Windows 7 PC. If you are using an 

earlier version of Tally, some of the commands or features discussed in the text may not be applicable 

or behave in a different way, and the screens you would get may be different from those shown in the 

book. Hereafter, any reference to Tally would imply to Tally.ERP 9. 

7.2 DOWNLOADING TALLY 

Tally is available for purchase in stores. If you prefer, you may download it for free from Tally Solution’s 

website. The free download version works in the Educational mode. In this mode, Tally has almost the 

same functionality like one with the regular paid license, except that you are not able to enter vouchers 

for all dates of the month. The Educational mode of Tally is particularly helpful for students, as they 

can learn and gain experience with Tally without buying the License. The Educational mode even 
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allows unrestricted access to the accounting data of the companies that are online through login as 

Remote Tally.Net user. The Educational license may be converted anytime into any of the available 

regular unrestricted licenses by making the required payment.

∑ To download the Tally.ERP 9 software, visit the www.tallysolutions.com website and click the 

Download link. This takes you to the Download page where you would fi nd the Download Centre 

button near the bottom of the page. 

∑ On clicking the Download Centre button, it displays another webpage that lists all Tally downloads. 

Your screen should look similar to that in Fig. 7.1.

Fig. 7.1 Tally.ERP 9 Download Center

∑ You should download the latest release that comes with Reference manual. Click the corresponding 

link, usually located at the top of the list to start the download. (Your browser may display a 

warning message that this type of fi le may harm the computer. In that case, you need to choose 

Save, OK or Yes to start the download.)

∑ After the download is complete, run the downloaded fi le and follow the instructions. During the 

installation process, Tally may ask you to put the Windows Operating System in the CD-ROM 

drive. Tally installation is simple and quick, and is complete within a few minutes. You may install 

Tally for single or multi-user operation. During the installation, you also select the default country 

and the startup language.

When the installation is over, you would fi nd the Tally icon on your desktop and the Tally program 

in the Windows Start menu. The Tally icon looks like .
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7.3 STARTING TALLY 

The Tally program is started like any other Windows program. That is, you may start the Tally program 

by double clicking the Tally icon on the desktop or choosing it from the Quick Launch/taskbar or 

Windows’s Start menu. On starting Tally, you get the Startup screen shown in Fig. 7.2.

Fig. 7.2 Tally Startup screen

The Startup screen lets you to manage you license. If you do not have Tally license, you may use 

Tally by either logging as Remote Tally.NET user or work in the Educational mode. If you choose to 

login as Tally.Net user, you need to enter valid username and password in the login screen displayed 

by Tally, shown in Fig. 7.3.

Fig. 7.3 Tally Remote Login screen

To work in the educational mode, use the arrow keys or click more at the bottom right corner of the 

Tally Startup screen and select W: Work in Educational Mode and then press the Enter key. Tally 

displays two options: Silver Edition Mode (Single user) and Gold Edition Mode (Unlimited Multi-

User). You may select any mode and press Enter to start working in Tally. If you are working in Tally 

where no data has been entered, you should see a screen similar to that shown in Fig. 7.4. If the Tally 

installation contains any data, it automatically loads it. 

The Tally screen displays a horizontal button bar at the top and a vertical button bar on the right-

hand side. These bars contain buttons to perform common tasks in Tally, e.g., Print, Export, E-Mail, 

change keyboard, change language, Tally help, etc. Some of these buttons may not be available at all 
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times. Tally automatically shows, hides, enables or disables these buttons depending on the activity 

you are doing. The vertical button bar, located on the right also contains buttons to perform common 

tasks, such as to change the current date or period, select or close a company and change confi guration. 

Besides clicking these buttons with mouse, you may also use the shortcut keys displayed on the buttons. 

Notice that Tally displays shortcut keys, such as G, K, and F12 on the buttons. To activate a button, 

you press the corresponding function key (e.g., F12), the key with Alt (e.g., G) or the key with the Ctrl 

(e.g., K). Remember that when Tally shows a key on a button with single underline (e.g., G), you need 

to press the key with the Alt key to activate that button. Similarly, when a key is shown with double 

underline (e.g., K), you need to press it with the Ctrl key to use the function shown on that button. 

Fig. 7.4 Tally Startup screen

At the bottom of the screen, Tally displays an Information Panel that contains links to get information 

about the Tally version, license and confi guration in use. On the right side of the Information Panel is a 

useful Calculator pane that you may use to do simple calculations. If you want to close the Information 

Panel, click the Close button (X) located in its top right corner. After you have closed the Information 

panel, if you need to display the Calculator pane, press Ctrl+N. 

The remaining area in the middle of the Tally screen is called the Main Area, also known as 

Gateway of Tally. This area is divided into two parts–the left hand side area provides details about the 

current date, current period, selected company, etc., and the right-hand side area displays Company 

Information and helps you to perform various functions, such as select or create a company, create 

ledgers and enter vouchers. 

7.4 CREATING A COMPANY 

If you have done a fresh installation of Tally, fi rst task you need to do is to create a company. During 

this process, you defi ne the name, address and other details for the company whose accounts you want 

to prepare using Tally. Tally can maintain accounts of more than one company, therefore, if required, 

you may create more than one company. If you create multiple companies, Tally lets you choose the 
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company you want to work on. Creating multiple companies is helpful if a company maintains separate 

sets of accounts for its branches or divisions. Let us create a company. 

∑ Choose the Create Company option in the Company Info menu (See Fig. 7.4). To choose this 

option, you may double click Create Company, use arrow keys to highlight Create Company and 

press Enter, or press C, the hot-key for the Create Company option. Notice that Tally displays the 

hot-key in bold letters. 

Note  If the Tally program already contains a company, to create another company, press Alt+F3 to display 

the Company Info box and then choose the Create Company command. 

On choosing the Create Company command, Tally displays a screen to enter details for the company 

you want to create, as shown in Fig. 7.5.

Fig. 7.5 Creating a company

∑ Type the company name and press the Tab or Enter key to move the cursor to Mailing Name. By 

default, mailing name is the same as the Company you have created. 

Note  Tally uses the default directory to store the company information. Normally you should not change 

the directory. If you need to change the directory, press the Backspace key when the cursor is in the 

Name fi eld to move the cursor to the Directory fi eld. 

∑ Next, enter the company’s mailing address. The company address is automatically picked up by 

certain reports, such as Balance sheet and Statement of Accounts. Next, press Tab to move the 

cursor to the Statuary Compliance fi eld. 

∑ Tally displays the list of countries to choose for Statuary Compliance from in the right-hand side 

of the screen, as shown in Fig. 7.6. For an Indian company, you must choose India. To choose the 

country, highlight it and then press Enter. When you choose a country for Statuary Compliance, 

Tally selects the country specifi c features, base currency and currency related formatting. 

∑ On choosing India from the list of countries for Statutory Compliance, Tally displays a list of 

States to choose a State. To choose a state, click the desired State and press Enter, or double click 

the desired State. On choosing a State, Tally automatically selects any features or rules particularly 
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applicable to that State. After choosing the State, enter other details, such as PIN code, Telephone 

Number, Mobile phone number and Email. All these details are optional. If you do not have any of 

these details, press the Enter key to move the cursor to the next fi eld. You may easily enter these 

later.

Fig. 7.6 Choosing Statutory Compliance

Note  To move forward to the next fi eld box, press Enter or Tab, or click in the desired box. To go back to 

the previous fi eld, press Shift+Tab or click in the desired box. 

7.4.1 Entering Company Details

In the Company Details section in the top part of the right pane, we provide some accounting details 

for the company. These details include the currency symbol, type of accounts, and the starting date for 

the fi nancial year and account books. 

∑ In the Currency fi eld, Tally displays the default currency symbol, which is ` (Rs.) for Indian setup. 

Normally, you do not need to change the currency symbol. Press Enter to move the cursor to the 

Maintain fi eld. 

∑ Tally displays two options for the types of accounts you want to maintain. These options are 

Accounts Only or Accounts with Inventory. The default option is Accounts with Inventory. Choose 

Accounts Only if you need to enter only fi nance related information, otherwise choose Accounts 

with Inventory.

∑ Tally fi lls the default dates in the Financial Year from and Books beginning from fi elds. By default 

both dates are the same. However, if required, you may change any or both dates. 

7.4.2 Security Control 

Every company wants to maintain the confi dentiality of its fi nancial information and does not want it to 

land in the hands of unauthorized persons. To help achieve this objective, Tally has a built-in security 

control system – TallyVault, which can encrypt the data. The encrypted data makes it almost impossible 

to get any meaningful information. If you decide to use TallyVault, you need to provide a password and 

retype the password. 
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Caution If you forget the TallyVault password, you will not be able to recover the company data. 

The Use Security Control option, whose default value is No, is used to allow access to the company 

data through the password-protected system. You may also choose to enable Tally Audit features and 

disallow opening of Tally in educational mode. These are advanced features and should be avoided by 

the beginners. The security features can easily be turned on later. 

7.4.3 Base Currency Information

The Base Currency Information section located at the bottom of the Company Creation screen displays 

options related to the currency of the selected country. The default options are good for most situations; 

however, you may change any option as per the requirement of the company. For instance, you may like 

to change the number of decimals or show the amounts in millions. 

7.4.4 Saving the Company 

After you have entered the required details in the Company Creation screen, to save the company, 

press Ctrl+A keys. Tally starts the processing of saving the company details and creating the company. 

During this process, it imports the Statutory Masters based on your selections. During the import 

process, Tally displays a progress bar, which automatically closes when it reaches the 100% mark and 

the Tally screen displays the company you have created under the List of Companies in the left pane 

and Gateway of Tally in the right, as shown in Fig. 7.7. Tally also displays details about the functions 

keys you may use to perform common tasks, e.g., F2 to change the current date or Alt+F3 to change 

the Company information.

Fig. 7.7 A new company created in Tally

Note  If the company was created with Account Only, the Gateway of Tally does not display some options, 

such as Inventory Info, Inventory Voucher and Stock Summary. 

After you have created the company, the next step is to set up masters for Accounts information and 

Inventory information, if applicable. 
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7.5 CREATING ACCOUNTS INFORMATION MASTERS 

Before you can enter accounting data for a company, you need to create accounting masters for 

Account Groups, Account Ledgers and Voucher Type. These masters are then used to enter accounting 

data through vouchers. The Account Info option in Gateway of Tally enables us to defi ne accounting 

masters. 

∑ To defi ne Accounting Information masters, choose the Account Info option in the Gateway of 

Tally menu. To choose this option, you may either press A, double click Accounting Info or 

use arrow keys/mouse to highlight “Accounting Info” and press Enter. Then Tally displays the 

Accounts Info menu under Gateway of Tally, as shown in Fig. 7.8.

Fig. 7.8 Gateway of Tally displaying the Accounting Info menu

Now you may create Groups, Ledgers and Voucher Types or choose the Quit command to quit the 

Accounting Info menu and return back to Gateway of Tally.

7.5.1 Creating Groups and Ledgers

Groups and Ledgers are backbone of accounting. When a company conducts its business, it does 

various types of activities which result in movement of money and/or goods. To record the movement 

of money, goods, etc., in the accounting system, we create transactions. Of course, there are different 

types of transactions, e.g., payments, receipts, sales, purchase, and so on. In accounting, different types 

of transactions are assigned to different head of accounts, which are called Ledgers. Depending on 

the size of the company, it may have a few or lots of ledgers. Regardless of the number of ledgers a 

company uses, all ledgers are classifi ed into Groups, also known as Account Groups. In other words, a 

Group is collection of ledgers of the same nature. Typical Groups are Bank Accounts, Current Assets, 

Current Liabilities, Cash-in-Hand, Direct Incomes, Direct Expenses, Investments, etc. The Groups and 

Ledgers are used to create the Balance Sheet and the Profi t and Loss Statement. 

When you setup a company in Tally, it automatically creates a few Groups and Ledgers. Depending 

on your requirements, you may create more Groups and Ledgers or even rename or delete these. To 
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maintain Groups or Ledgers, choose the corresponding option in the Account Info menu in Gateway of 

Tally. Let us have a look at the predefi ned Groups. 

∑ Double click Groups in the Account Info menu and Tally displays the Groups menu shown in

Fig. 7.9.

Fig. 7.9 The Groups menu

In Tally, there are two types of Groups – Primary Groups and Sub Groups. Some of the predefi ned 

Primary Groups are Capital Account, Cash-in-hand, Current Assets, Current Liabilities, Loans, Direct 

Income, Purchase Account, Sales Account, Stock-in-hand and Investments. All primary groups belong 

to one of the four basic types – Assets, Expenses, Income and Liabilities. As the name Sub Group 

implies, it belongs to a Group. One or more Sub Groups may be placed under a Group, e.g., Bank 

Accounts, Loan Advances, Stock-in-Hand and Sundry Creditors sub groups come under the Current 

Assets primary group. 

∑ To view the list of defi ned groups, double click the Display option under the Single Group or 

Multiple Groups in the Groups menu.

∑ To close the Groups display list, press Ctrl+Q or Esc, or click the close (X) button at the top-right 

corner, located under the Help button. 

Creating a Group The Create option is used to create a new group, as shown in Fig. 7.9. Figure 

7.10 displays a group being created in the Single Group mode. At the top, you defi ne the name and alias 

(optional) for the group. Next you choose if this is a primary group or will be under an existing primary 

group. To create a primary group, choose Primary, the fi rst entry under the List of Groups list displayed 

on the right side, as shown in Fig. 7.10. 

∑ After you have defi ned all options, when you press Enter, Tally displays the Accept box; click 

Yes to create the group or No to cancel the group creation process. After creating the group, Tally 

displays a new screen to create another group. If you do not want to create another group, click the 

Quit button or press Ctrl+Q to close the Group Creation screen. 

To confi rm that Tally has created the group, you may use the Display command in the Groups menu 

box. And, in case you want to modify a defi ned group, use the Alter option, which also enables you to 

delete that group. 
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Fig. 7.10 Creating a group

∑ After you have done with the Groups, click Accounts Info, press Ctrl+Q or choose the Quit

command to go back to display the Accounts Info menu. 

Creating a Ledger Tally predefi nes two ledgers: Cash and Profi t & Loss A/c. The Cash ledger is 

created under the Cash-in-hand group. Tally allows you to rename the 

Cash ledger, enter an opening balance, or even delete this ledger. On 

the other hand, the Profi t and Loss A/c ledger is of primary type that 

cannot be deleted, though you can modify. Since, there are only two 

predefi ned ledgers; users typically create one or more ledgers. To 

create a ledger, choose Ledgers in the Accounts Info menu box to 

display the Ledgers menu box, as shown in Fig. 7.11.

The Create option under the Single Ledger is used to create one 

ledger at a time. If you want to create several similar ledgers of the 

same type (under the same Account Group), use the Create command 

from the Multiple Ledgers section. For example, if the company 

maintains accounts at more than one bank, you may create ledgers for 

all those banks in one go with the Create command under Multiple 

Ledgers. Let us fi rst create a single ledger. 

∑ Choose the Create command under the Single Ledger in the 

Ledgers menu box, and Tally displays a screen to create a ledger, 

as shown in Fig. 7.12.

∑ First, you need to defi ne a name (account head name) for the ledger in the Name box in the top-left 

corner of the screen. 

∑ After entering the name, on pressing the Enter or Tab key, Tally moves the cursor to the Alias 

box, where may optionally assign an alias, an alternate name for the ledger. If you do not want to 

defi ne an alias, press the Enter key to move to the cursor to the next fi eld. 

Now Tally displays a default Group name in the Under box and a list of Groups in the right-hand side 

of the screen, as shown in Fig. 7.13.

Fig. 7.11 The Ledgers menu
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Fig. 7.12 Creating a Ledger

Fig. 7.13 Choosing a Group for the Ledger being created

∑ Use the arrow keys or the mouse to select the desired Group and the press the Enter key. 

Alternatively, double click the desired Group to assign it to the Ledger being created. 

After assigning the Group that the ledger belongs to, defi ne other details as applicable. One of the 

information that is usually fi lled-in is the Opening Balance. If applicable, fi ll-in other details, such as 

State, PAN number, Sales Tax number, etc. Providing these details for ledgers that refer to debtors and 
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creditors will ensure that your accounts are complete and you won’t face problems with Tax authorities. 

If you do not have all details at present, you may easily enter these later by altering the ledger. 

∑ After you have provided the details, when you press the Enter key on the last fi eld, Tally displays 

the Accept box, where you choose Yes to create the ledger to No to cancel the operation. If you 

choose Yes, Tally creates the ledger and displays the empty Ledger Creation screen, where you 

may create another ledger. If you do not want to create more ledgers, press Ctrl+Q or choose the 

Quit command to return to Gateway of Tally, Account Info, Ledgers screen. 

After you know how to create a single ledger, you will fi nd creating multiple ledgers quite simple. To 

create multiple ledgers, choose the Create option under Multiple Ledgers in the Ledgers menu box 

(See Fig. 7.11). Figure 7.14 displays multiple ledgers being created in Tally. Notice that all ledgers fall 

under the same Group, though you can defi ne separate opening balance for each ledger. After defi ning 

ledgers, press Ctrl+A or click the Accept button at the bottom of the screen to create the ledgers. After 

creating ledgers, you may use the Display command to display the list of defi ned ledgers or the Alter 

command to modify a ledger.

Fig. 7.14 Multiple Ledgers being created under the same Group

7.6 VOUCHERS 

To conduct its business, a company performs various activities, such as buying goods and services, 

selling goods and services, receiving cash or cheques for goods or services provided by the company, 

giving loans to other companies, giving salary to its employees, and so on. All these activities result in 

transfer of money from or to the company directly or indirectly. To ensure that the Accounts Department 

approves only correct and authorised payments, each transaction is supported by a document, called 

the voucher. Thus, when a company buys goods from an outside party, the Supplier supplies goods and 

sends an invoice or bill. On the basis of the invoice, a payment voucher is created, which is later used 

to generate cheque or otherwise send payment to the Supplier. 
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To record various types of business transactions, Tally contains more than 20 predefi ned voucher 

types. Some of the predefi ned voucher types are Contra, Credit Note, Debit Note, Delivery Note, 

Journal, Material In, Material Out, Payment, Payroll, Purchase, Purchase Order, Receipt, Receipt Note, 

Sales, Sales Order, Physical Stock and Stock Journal. Depending on your requirements, you may create 

additional voucher types or modify the predefi ned voucher types. For instance, you may create a new 

voucher type for Sales Invoice or Bank Deposit Slip. Let us create a new voucher type for Sales 

Invoice. 

7.6.1 Creating a Voucher Type 

∑ From Gateway of Tally, choose Accounts Info to display the Accounts Info menu. Now double 

click Voucher Types to display the Vouchers Types menu, as shown in Fig. 7.15. 

Fig. 7.15 Voucher Types

∑ Next, double click Create to display the Voucher Type Creation screen shown in Fig. 7.16.

Fig. 7.16 Voucher-type Creation screen
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∑ To create a voucher type, fi rst enter the desired voucher type name in the Name box. If required, 

you may also defi ne an alias (alternate name) for the voucher type you are creating. 

∑ Next move the cursor to the Type of Voucher fi eld, and Tally displays the list of available voucher 

types on the right side of the screen, as shown in Fig. 7.17. 

Fig. 7.17 Choosing the voucher type

∑ Now, choose the appropriate voucher type from the list. For example, for Sales Invoice, you may 

choose the Sales voucher type. 

It is important to select the correct voucher type, as the voucher type you are creating inherits the 

properties of the selected voucher type. In other words, new voucher type functions like the predefi ned 

voucher type you select. On selecting a voucher type, Tally automatically fi lls the abbreviated name in 

the Abbr. (Abbreviation) fi eld. You may change the abbreviation, if required. However, abbreviation, 

which is used for certain unformatted reports, should be kept to maximum of 5 characters.

∑ Next you defi ne the method of voucher numbering, which has three choices—Automatic, Manual 

and None. The most common choice is Automatic. If you decide to use the Manual option, Tally 

provides another option, “Prevent Duplicates”, which is helpful to prevent assigning the same 

number to multiple vouchers. For Automatic Voucher Numbering, Tally has another option to use 

Advance Confi guration for voucher numbering. Advance Confi guration helps to defi ne starting 

voucher number, specify prefi x and suffi x characters and reset voucher numbers after specifi ed 

period, e.g., weekly, monthly or yearly. For instance, one can generate voucher numbers, such as 

ABC00020, RC00030/2012 and SALE00450/2013.

∑ In the next box, you defi ne a few more details about the voucher. For instance, you may decide 

to use Effective Dates for vouchers, which lets you enter an effective date at the time of voucher 

entry, which may be different from the voucher entry date. The Narration options let you use a 

common narration or separate narrations for each voucher entry. 
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After entering General details for the Voucher Type you are creating, next you defi ne options in the 

Printing section in the middle of screen. The fi rst option, “Print after saving Voucher” controls whether 

Tally prints the voucher after you enter the voucher. This option, whose default value is No, is used 

when you want to use the online voucher as the formal voucher. The next two options are used for POS 

(Point of Sale) Invoice confi guration. Finally, the last optional section (Name of Class) in the Voucher 

Type Creation screen is used to create a new voucher class. 

∑ After you have entered all details in the Voucher Type Creation screen, when you press the Enter

key, Tally displays the Accept box that enables you to save the Voucher Type you have defi ned. 

∑ After saving the Voucher Type, Tally redisplays the blank Voucher Type Creation screen to create 

another Voucher Type. If you do not want to create another Voucher Type, click the Quit button 

or press Ctrl+Q, and Tally returns you back to the Voucher Type menu. You may use the Display

command to view the list of defi ned Voucher Types or the Alter command to modify any Voucher 

Type. 

7.6.2 Confi guring Voucher Entry

There are two types of vouchers – Accounting and Inventory. The Accounting vouchers are used to 

record all accounting related transactions, whereas the Inventory vouchers are used to record inventory 

related transactions, e.g., receipt, issue or transfer of goods. Some types of accounting vouchers can be 

entered and passed in Single Entry or Double Entry mode. Tally supports both modes; however, you 

need to confi gure Voucher Entry as per your requirements. 

∑ To confi gure voucher entry, press F12 in Gateway of Tally to display the Confi guration menu, and 

then double click Voucher Entry to display the Voucher Entry Confi guration screen shown in

Fig. 7.18. To change any option from Yes to No or No to Yes, double click the corresponding 

option. After making the changes, press Ctrl+A to ask Tally to accept the changes and close the 

Voucher Confi guration screen. 

Fig. 7.18 Voucher Confi guration



374    Computer Course: Windows 7 and Offi  ce 2010  

7.7 ENTERING ACCOUNTING VOUCHERS 

∑ To enter accounting vouchers, choose Accounting Vouchers under Transactions in Gateway of 

Tally (see Fig. 7.7).

Tally displays the Accounting Voucher Creation screen shown in Fig. 7.19. The screen displays a default 

voucher type, which is Payment. 

Fig. 7.19 Accounting Voucher Creation screen

∑ To change voucher type, press the corresponding Function key, e.g., F4 to select Contra, F6 to 

select Receipt or F8 to select the Sales voucher type. 

Notice that Tally displays the voucher date in the top right corner of the voucher screen. To use a 

different date, press F2 and type the desired date. After you have selected the voucher type and date, 

you may enter the other voucher details. First of all, choose the Account, i.e., Ledger. For a Payment 

voucher, you would select the account (ledger) the payment will be made from. Normally, it would be 

Cash or Bank Account.

∑ While the cursor is positioned in the Account fi eld, press spacebar to display the list of ledgers 

on the screen. The list of ledgers displayed on the screen depends on the type of voucher being 

created. To choose a ledger, double click the desired ledger or click the ledger and press Enter. 

On choosing a ledger, Tally displays the ledger name and its current balance on the screen, and moves 

the cursor under the Particulars column to enter voucher details. For example, for a Payment voucher, 

you would choose the Account (ledger) the payment is being made to and the amount. Figure 7.20 

displays a payment voucher being entered. 

∑ Initially, the cursor is positioned in the Particular column where you select the account (ledger) 

the voucher belongs to, e.g., for a payment voucher, the ledger the payment is being made to. 

To display the list of available ledgers, press the spacebar and then choose the desired ledger. 

After choosing the ledger, Tally displays its current balance. Then you enter the amount under the 

Amount column. 
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Fig. 7.20 Entering a Payment Voucher

∑ In the same way, you may enter additional detail lines for the voucher. Next you defi ne the payment 

option, e.g., cheque, electronic cheque or inter-bank transfer. Finally type the voucher description, 

e.g., “Challan No: 230 Payment for two computer tables” in the Narration box at the bottom of the 

voucher entry screen. Figure 7.21 displays a Payment Voucher with Narration details entered. 

Fig. 7.21 Payment Voucher with Narration

∑ Finally, click the Accept button at the bottom of the screen to accept the entered voucher. After 

accepting the voucher, Tally displays a blank screen to enter the next voucher. If you do not 

want to enter more vouchers, press Ctrl+Q to close the Voucher entry screen and return back to 

Gateway of Tally. 
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7.8 CREATING INVENTORY INFORMATION MASTERS 

Besides managing accounting information, Tally can also manage the inventory information of 

company. The inventory options becomes available if you choose “Accounts with Inventory” when you 

created the company.

Note  If the inventory options are not available, you may modify the company information by pressing 

Alt+F3 (Comp Info) in Gateway of Tally to display the Company Info menu. Then choose the Alter 

command to modify the type of accounts you want to maintain. 

To manage the inventory information through Tally, the fi rst task you need to do is to create Stock 

Groups, which are similar to the Account Groups that you have already used. Basically, these are 

used to classify the inventory into meaningful groups. The number of Stock Groups you would create 

depend on various factors, such as the type and size of the company, the kind of products, and the 

preference of the company’s management. A computer sales company may classify its products into 

Desktop, Laptop, UPS, Software, Misc, etc. 

7.8.1 Creating Stock Groups

∑ To create Stock Groups, choose the Inventory Info option in Gateway of Tally to display the 

Inventory Info menu box, as shown in Fig. 7.22. 

Fig. 7.22 Inventory Info menu box

Note  Depending on the inventory features selected for the company, the Inventory Info menu may not 

display some options, such as Stock Category, Godowns and Reorder Level. 

The Stock Groups option in the Inventory Info menu is used to create stock groups. On choosing this 

option, Tally displays the Stock Groups menu box, which displays commands to create, display and 

alter stock groups. Like account groups, you may create stock groups in single or multiple mode.

Figure 7.23 displays a stock group being created. In the Stock Group Creation screen, you defi ne the 

stock group name, alias (optional), and whether this is a primary group or under some primary stock 

group. For instance, the company may have Computers as the primary stock group, and Desktop, Laptop 
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and Netbook stock groups under the Computers stock group. In the Stock Group Creation screen, you 

also defi ne whether quantities of items can be added. Usually, items are not added in primary groups. 

After creating a stock group, Tally displays an empty Stock Creation Screen to create additional 

groups. Choose the Quit command, if you don’t need to create more groups, which returns you to the 

Stock Groups menu box, which has commands to display or change the defi ned stock groups.

Fig. 7.23 Stock Group creation screen

7.8.2 Creating Stock Categories, Units of Measure and Godowns

The Stock Categories is used to classify the stock items into various categories. For instance, a store 

may classify its items under hardware, software, chemicals, tools, etc. The Units of Measure is used to 

defi ne units, such as Kilograms, Box, Dozen, etc. Use the appropriate option from the Inventory Info 

menu box to defi ne Stock Categories, Units of Measure and Godowns. 

7.8.3 Creating Stock Items

After creating Stock Groups, the next step is to create Stock Items. Figure 7.24 displays a stock item 

being created. In this screen, we defi ne the item name, an optional alias name, group the item belongs 

to, units, rate of duty, etc. 

Fig. 7.24 Stock Item creation screen
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7.8.4 Creating Inventory Voucher Types

The Voucher Types option in the Inventory Info menu box (see Fig. 7.22) is used to create voucher 

types for maintaining inventory data in Tally. The process of creating inventory voucher types is similar 

to that for the accounting voucher types that we have already discussed in Section 7.6. Tally comes 

equipped with several common voucher types, such as Credit Note, Debit Note, Payment, Purchase, 

Receipt, Receipt Note, Purchase Order, etc. Of course, you may create additional voucher types as per 

your requirements. 

7.9 ENTERING INVENTORY VOUCHERS 

After you have created masters for inventory information, you may enter Inventory vouchers. To 

enter inventory vouchers, choose the Inventory Vouchers option under Transactions in Gateway of 

Tally (see Fig. 7.7.), and Tally displays the Inventory Voucher Creation screen shown in Fig. 7.25.

The Voucher Creation screen displays an empty voucher for the default or last used inventory 

voucher type. To change the voucher type, click the corresponding button on the vertical Buttons 

bar on the right.

Fig. 7.25 Inventory Voucher creation screen

Entering information in the inventory vouchers is similar to that in accounting vouchers. You choose 

or enter the required details, and after you have entered all details, choose the Accept command to 

create the voucher. Figure 7.26 displays a Physical Stock voucher being entered in Tally. 
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Fig. 7.26 Physical Stock Voucher being entered in Tally

7.10 REPORTS 

One of the reason accountants love the computerized accounting packages like Tally is that they can 

generate several types of useful reports with no effort. Tally comes equipped with all common reports, 

such as trial balance, day book, all types of account books, inventory books, balance sheet, profi t and 

loss account and stock summary. You may run any of these reports any time, and Tally instantly displays 

the report on the screen, which you may print on the printer, if required. The Gateway of Tally menu 

displays options to run the following important reports:

1. Balance Sheet

2. Profi t and Loss A/c

3. Stock Summary 

4. Ratio Analysis 

To run other reports, choose the Display command in Gateway of Tally 

to get the Display menu shown in Fig. 7.27. 

On selecting an option in Display Menu, Tally runs the corresponding 

report. Figure 7.28 displays the Day Book report for a company. On 

selecting some options, e.g., Account Books, Statement of Accounts, 

Inventory Books, etc., Tally displays a submenu to choose a specifi c 

report to run. For example, on choosing Account Books, the submenu 

displays options to run Cash/Bank Books, Ledger, Group Summary, 

Group Vouchers, Sales Register, Purchase Register, Journal Register, etc. Description of all these 

reports is beyond the scope of this book. You may run these reports to get the feel of these reports or 

see the Tally help system. To access Tally Help, click the Help button located in the right corner on the 

horizontal button bar at the top of the screen.

Fig. 7.27 The Display Menu
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Fig. 7.28 The Day Book report

7.11 USING TALLY TO MAINTAIN PAYROLL 

Tally may be used to maintain company’s payroll. To check if, this feature is on, perform the following 

steps: 

∑ In the Gateway of Tally menu, press F11 (Features) and then press F1 (Accounts) to display a 

screen that displays the Accounting features. 

∑ In the Cost/Profi t Centres Management section, set Maintain Payroll to Yes, if required. 

∑ Click the Accept button to save the changes. 

After enabling the payroll, next, you need to confi gure it. 

∑ In the Gateway of Tally menu, press F12 (Confi gure) to display the Confi guration menu. Now 

double-click Payroll Confi guration to display the Payroll Confi guration screen, shown in Fig. 7.29.

Fig. 7.29 The Payroll Confi guration screen

For an Indian company, it is recommended to set Show Salutatory Detail, Show Passport and Visa 

Details and Show Contract Details to Yes. 
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7.11.1 Creating Payroll Masters

Like Accounting and Inventory Masters, you need to create Payroll 

masters before entering payroll vouchers. After you have enabled 

payroll, Gateway of Tally displays an option – Payroll Info, which is 

used to create payroll masters, as shown in Fig. 7.30.

Payroll Info enables you to defi ne employee groups (e.g., Production, 

R&D, Accounts, Sales, Management, etc.). The employee group is 

either defi ned as primary, or under an existing group. The Employees 

option is used to defi ne employees, the group the employee belongs to 

and the date of joining. The Units (Work) option is used to create units, 

such as Hours and Weeks, for use with payroll. 

All payments to the employee as well as deductions related the 

payroll must be assigned to a Pay head. Common pay heads are Earning 

for Employees, Deductions from Employees, Bonus, Gratuity, Loans 

and Advance, Reimbursement to Employees. You may defi ne new Pay 

heads by choosing the Pay Heads option in Payroll Info. 

After defi ning Pay heads, the next step is to defi ne Salary Details for the employees. Figure 7.31 

displays Salary Details being defi ned for an employee.

Fig. 7.31 Defi ning Salary Details

7.11.2 Processing Payroll 

To process payroll, we need to create payroll vouchers, which is done by choosing Payroll Vouchers from 

Gateway of Tally. This displays a blank payroll voucher. However, Tally can help us to automatically 

create payroll voucher by pressing Alt+A (Payroll Auto Fill). On using this option, Tally displays the 

Employee Filters, which is used to select start and end date for payment, employee/employee group 

and payroll head. Based on the selection, Tally creates the payroll voucher. Besides the AutoFill payroll 

voucher, you may also create payroll voucher through Manual Attendance Voucher Creation. 

Fig. 7.30 Payroll Info
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7.11.3 Payroll Reports

Tally comes equipped with several useful payroll reports. To view or print payroll reports, choose 

Payroll Reports from the Display Menu. On choosing the Statement of Payroll option, Tally displays 

a menu to generate various types of Payroll statements, as shown in Fig. 7.32. On choosing an option, 

Tally generates the corresponding payroll statement.

Fig. 7.32 Statement of Payroll Reports

7.12 MAINTAINING MULTIPLE COMPANIES 

Tally can maintain accounting and inventory data for multiple companies. In other words, you may 

setup multiple companies and then select any of those companies to enter the accounting and inventory 

data. 

∑ If multiple companies are setup, to select a company, press F1 in Gateway of Tally to display the 

list of companies. Figure 7.33 displays the List of Companies setup in Tally.

Fig. 7.33 Selecting a Company
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Notice that the list of companies displayed by Tally also includes a system generated number. The 

number is helpful if you assign the same name to more than one company. When you choose the desired 

company, Tally loads its data. 

If you need to create a new company, press Alt+F3 in Gateway of Tally to display the Company 

Info menu and choose the Create Company option. You may notice a button, F1: Shut Cmp in the 

vertical button bar of Gateway of Tally, which is used to unload the company’s data from the current 

session of Tally. It does not mean that the company’s data will be deleted. When you select that 

company again, Tally would reload data. 

7.12.1 Altering or Deleting a Company 

If you want to alter a company or permanently remove all data for a company, follow these steps: 

∑ In Gateway of Tally, press Alt+F3 or click “F3: Cmp Info” to display the Company Info menu. 

∑ Double click Alter in the Company Info menu. (See Fig. 7.4.)

∑ From the list of companies displayed by Tally, choose the company you want to alter/delete. Tally 

displays the Company Alteration screen. 

∑ Now you may alter the company data. To permanently remove the company data, press Alt+D and 

Tally prompts you to confi rm the delete operation. 

7.12.2 Backup and Restore

Data stored in a computer may become corrupted due to several reasons, including hardware, software 

and power failure. While it may be possible to recover corrupted data, it cannot be guaranteed. Therefore, 

it is advisable to backup data entered in Tally at regular intervals. Most organizations backup data every 

night, or at least once every week. Tally helps you to create backups with ease. Follow the steps given 

below to make backups of Tally data. 

∑ In Gateway of Tally, press Alt+F3 to display the Company Info menu. 

∑ Double click Backup in the Company Info menu and Tally displays the screen similar to that 

shown in Fig. 7.34. 

Fig. 7.34 Taking backups

The Source is the folder on your computer that contains company data, and Destination is the folder 

where you want to save the backup. Normally, you do not need to change the source; however, you may 

change the Destination as per your requirements. 
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∑ Choose one or more companies whose backup you want to take from the List of Companies box 

on the right. 

∑ Finally choose “End of List” and Tally Displays the Accept box with Yes and No options. Choose 

Yes, and Tally creates the backup. 

Restoring data from backups is very simple—just choose the Restore command from the Company 

Info menu, specify Source and Destination, and Tally will do the rest. 

7.12.3 Split Company Data

As you keep entering company data in Tally, the amount of data keeps growing and Tally’s operation 

may become slow. One way to fi x this problem is to split the company data into two. Usually, the data 

for previous fi nancial years is put into one company and that for the current year into the second. This 

also ensures that data for the past fi nancial years whose accounts have been fi nalised is not changed 

accidentally.

∑ To split the company data, choose the Split Company Data option from the Company Info menu, 

and choose the company whose data you want to split. Then Tally displays the Split Company 

screen shown in Fig. 7.35. Now choose the dates and Tally will do the rest to split the company data.

Fig. 7.35 Split Company Data

7.13 MULTI-LINGUAL CAPABILITIES 

Tally has multi-lingual capabilities. Depending on the operating system and languages installed on 

your PC, you may be able to use the Tally interface and enter and display data in several languages, 

such as Hindi, Marathi, Tamil, Telugu, Kannada, Punjabi, Gujarati, Bengali and Malayalam.

Figure 7.36 displays Tally being operated in Hindi. To change the language, click the Language button 

on the toolbar and choose the desired language from the list displayed by Tally.

Note Multi-lingual support is not available on Windows 95, 98, NT and ME.

If you want to enter data in any of the supported languages, choose the desired keyboard language by 

clicking the keyboard button on the toolbar. If you do not have the keyboard for the desired language, 

you may use the On-Screen keyboard, which lets you enter characters by clicking keys on a virtual 

keyboard displayed on the screen. Figure 7.37 displays the On-Screen keyboard being used with 

Tally. 
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Fig. 7.36 Tally being operated in Hindi

Fig. 7.37 On-Screen keyboard being used with Tally

∑ To display the On-screen keyboard in Windows 7, click the Start button on the Task bar to 

display the Start menu and then choose All Programs, Accessories, Ease of Access, On-Screen 

Keyboard. If you are using Windows XP, click the Start button on the Task bar to display the 

Start menu and then choose Programs (or All Programs), Accessories, Accessibility, On-Screen 

Keyboard.

∑ To change the keyboard language, choose it from the Language bar or the language icon located 

on Windows taskbar. You may also press Alt+Shift to change the keyboard language. Each time 

you press Alt+Shift keys, Windows selects the next installed input language.
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7.13.1 Installing Support for Hindi and other Languages

If you cannot fi nd the Hindi or other Indian languages in the Language bar or when you press Alt+Shift, 

it means that the support for the corresponding language is not installed. On Windows 7, perform the 

following steps to install support for the Hindi or other languages. 

∑ Click Start button, type Keyboard languages in the Search Programs and Files box and click 

Change keyboards or other input methods in the search results. Then Windows 7 displays the 

Region and Language dialog box. 

∑ In the Region and Language dialog box, click the Change keyboards button to display the Text 

Services and Input Languages dialog box shown in Fig. 7.38.

Fig. 7.38 Text Services and Input Languages dialog box

∑ To install a new language, click the Add button to display the Add Input Language dialog box. 

Then choose the desired language, e.g., Hindi, as shown in Fig. 7.39.

∑ After choosing the language, click the OK button and Windows installs the selected language and 

displays it in the Text Services and Input Languages dialog box. Now click the OK button to close 

the dialog box. Click OK again to close the Regional and Languages Options dialog box. 

Now, you should be able to choose the installed language on the Language bar and enter characters in 

Hindi or other installed languages through a regular keyboard as well as the On-screen keyboard. Steps 

to install support for other languages in Windows XP are similar to that for Windows 7. 

7.14 MIGRATING DATA FROM EARLIER VERSIONS OF TALLY 

If you have the accounting data in earlier versions of Tally, e.g., Tally 7.2 or Tally 6.3, these fi les cannot 

be used directly with Tally.ERP 9. However, to help you migrate the data to the new version, Tally 

contains the Migration Tool. To start the data migration tool, run the tally72migration.exe fi le, which 
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is contained in the same folder where Tally is installed. After starting the migration tool, choose the 

appropriate command from the menu to perform the migration. Figure 7.40 displays the opening screen 

of Tally.ERP 9 Data Migration Tool. 

Fig. 7.39 Adding support for a language

Fig. 7.40 Tally Data Migration Tool
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Note To use Tally Data Migration Tool, you must have a valid Tally license, i.e., you cannot use this tool 

in the Educational Mode of Tally. To migrate Tally 6.3 data to Tally.ERP 9, you need to fi rst convert it to the 

Tally 7.2 format.

7.15 REMOTE ACCESS 

Tally has built-in capabilities to allow authorized users to access the company data residing on your 

computer from anywhere using Internet and Tally.Net. The remote access of data is particularly 

useful for a larger company having locations in multiple cities. The remote access is also helpful to 

fi nancial auditors to view live company data from their offi ces. To enable the remote access feature, it is 

required to complete the Advanced Confi guration in the Confi guration menu, and create usernames and 

passwords. To use remote access of data, one also needs to have a valid Tally license and subscription 

to Tally.Net. Confi guring Tally for remote access is recommended to be done be advanced users. For 

more details, refer to the Tally help system.
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8
INTERNET AND WEB 
BROWSERS

In this chapter, we will discuss the following topics:

Introduction and History of Internet �

Hardware and Software Requirements for Using the Internet �

Common Applications of Internet �

Web Address �

Using Internet: Internet Explorer, Mozilla Firefox and Google  �

Chrome 

Exploring the Web �

Searching for Information: Google and other Search Engines �

Home Page  �

Tabbed Browsing, Bookmarks, Saving and Printing Information �

Browsing History �

Changing Text Size in Browser �

Blocking Popup and Forms �

Secure Webpages  �

Cookies and Cache �

Downloading and Uploading Files  �

Audio and Video on the Web �

Online Shopping and Banking �

Internet in Indian Languages �

Internet Translation Services, Maps and Directions �

Keeping PC Safe: Antivirus, Spyware/Adwere and Firewall �
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8.1 WHAT IS INTERNET? 

The Internet is a huge network of interconnected networks. When a few computers are connected 

together so that they can interchange information or share resources, it forms a network. The Internet 

consists of millions of such interconnected networks located throughout the world. The Internet, 

which is the largest network of networks in the world, enables information to be interchanged between 

computers located in each and every corner of any country of the world. Now that this huge network 

is available, people use it for various applications, such as world wide web, electronic mail (E-mail), 

fi nd information, buy and sell goods and services, train, airline, movies booking/ticketing, banking 

and other fi nancial applications, tax payments, education, socializing, playing games, play/download 

music/video, voice/video communication, etc. Nowadays, the Internet has become an integral part of 

the modern society, and its use is only limited to one’s imagination.

8.2 HISTORY OF THE INTERNET 

In 1960s, the United States Department of Defence initiated the project ARPANET (Advanced Research 

Projects Agency Network). They wanted to create a network that will enable various computers owned 

by the United States Department of Defence to communicate with each other. The ARPANET became 

operational in 1969. In the next 10 years, ARPANET grew by connecting a number of defence and 

educational computers to itself. As more and more computers joined the ARPANET, it was decided to 

break it into two networks – MILNET (for the military computers) and a smaller ARPANET for non-

military use. These two separate networks could still communicate to each other through a protocol 

called the Internet Protocol (IP).

The communication protocols between networks were standardized to TCP/IP (Transfer Control 

Protocol/Internet Protocol), and the network started growing. People started calling it the Internet. As 

commercial companies found the Internet useful, it expanded to Europe and slowly covered the entire 

world. The beauty of the Internet is that if one network fails, it automatically fi nds an alternate route to 

transmit the information. Thus, a computer can send information to another computer without worrying 

how it would reach there.

8.3 HARDWARE AND SOFTWARE REQUIREMENTS FOR

 USING THE INTERNET 

To use the Internet, you need the following:

1. A computer or some other device that can connect to the Internet.

2. An Internet Service Provider (ISP) that will allow your computer to connect to the Internet. 

3. Additional hardware, e.g., a modem and cables, may be required to connect the computer to the 

medium used by the ISP. 

4. Software that will enable your computer to connect to the Internet and you to use it. 

The fi rst requirement to use the Internet is that you need a computer or some other Internet enabled 

device. While most people use their desktop or laptop PC to access the Internet, you may use a host 

of other internet-enabled devices, such as a mobile phone, iPhone, BlackBerry, iPad and other tablet 

computers. 
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The Internet Service Provider (ISP) is the company that brings the Internet to you. You can connect 

to the Internet via different ways, such as dial-up, Digital Subscriber Line (DSL), Cable and Wi-Fi. 

The type of the Internet connection you will choose depends on the number of factors, such as the 

connection speed, your internet usage type and amount of time you want to use the Internet, ease of 

use, and of course, the price charged by the ISP for various types of services.

8.3.1 The Dial-up Connection

The dial-up connection uses the regular telephone line to access the Internet through ISP. Besides the 

telephone line, you need a piece of equipment called the modem (Modulator Demodulator), which is 

installed between the computer and the telephone line. Many PCs may already have a built-in telephone 

modem, and in that case you may not need any additional hardware, except a cable to connect the PC to 

the telephone line. Current telephone modems have the maximum speed of 56 Kilobits/sec. 

The dial-up Internet connection is the slowest among the available types. A few years ago, when 

DSL and cable connections were very costly or not available in many areas, most home Internet users 

used to opt for the dial-up connection. Besides the slow speed, it has another drawback—it ties your 

telephone line, i.e., while using the telephone line to connect to the Internet, you cannot make regular 

phone calls. The dial-up connection is suitable only for occasional light use, e.g., to check the e-mail 

or search for information.

8.3.2 The Digital Subscriber Line (DSL)

The Digital Subscriber Line (DSL) is a special telephone line designed to handle high-speed digital 

signal for the Internet. Usually, DSL lines use high speed fi ber-optic cables. A DSL line offers a 

connection that is always available (no need to dial) and a minimum speed of 256 Kilobits/second. 

Depending on the type of DSL line, speeds can be as high as 175 Megabit/second (MBs). Nowadays, 

one can get a DSL line for a few hundred Rupees a month for light use. The vendors offer DSL Internet 

connection in various confi gurations, depending on the volume and/or time of use. You may choose 

a suitable plan depending on your requirements. The Internet connection through a DSL line is also 

called the broadband or high-speed connection. To connect your computer to a DSL line, you need a 

DSL modem. This equipment is usually provided and installed by the vendor who provides the DSL 

line.

8.3.3 Internet via Cable

Since 2010, Indian TV cable companies have started offering high-speed Internet connection through 

the cable that brings the TV signal. The performance of the cable Internet connection is similar to or 

better than a DSL line connection. However, when several subscribers who are connected through the 

same cable and use the Internet simultaneously, the performance may degrade. As with the DSL line, 

you need a cable modem to connect your computer to the Internet though cable. 

To provide a very high speed internet connection, some ISPs lay dedicated fi ber-optic cables. In July 

2012, Google started offering the Internet access on its fi ber-optic network with download speed of 

1000 Megabits/second in Kansas City, USA. This speed is about 100 times faster than a typical high-

speed connection. 

8.3.4 Internet on Portable Devices through Wireless

Another way to get the Internet access is through an Internet enabled wireless device, such as a mobile 

(cell) phone, BlackBerry, iPhone, iPad and other similar devices. These devices provide the Internet 

access through a wireless connection, which is usually slower and costlier than a DSL/cable connection. 

However, the latest 4G networks provide signifi cantly faster connection.
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8.3.5 Internet through Local Area Network (LAN)

If your PC is hooked up to a Local Area Network (LAN) which is connected the Internet, you can access 

the Internet through the LAN. This is the common way of providing the Internet access to employees 

in a typical offi ce, as it enables a single high-speed internet connection to be shared by several PCs. To 

connect a PC to a LAN, you need a Network Adapter, which is 

usually built in most PCs. Besides, the network adapter, you need 

an Ethernet network cable to connect your PC to the LAN. 

If your PC does not have a network adapter card and you want 

to install one, you need to get one, open the PC and install it. If 

you do not want to open the PC, you may get a USB (Universal 

Serial Bus) Ethernet Adapter, similar to the one shown in Figure 

8.1, which fi ts into a regular USB port. 

8.3.6 Wireless Internet Access

Wireless Internet access enables a PC, Laptop, Tablet and other mobile devices to use the Internet 

without using any cable. However, to access the Internet through wireless, the computer requires a 

wireless network adapter card, which is usually built in most Laptop PCs. If your PC does not have one, 

you may get wireless network adapter card or a Wireless USB Network Adapter, which is similar to a 

regular USB Ethernet Adapter, except that it does not have a 

socket to connect the cable and may have a small antenna 

attached to it. The second requirement is a Wireless Local 

Area Network (Wi-Fi), which may be available through a 

wireless router in homes and offi ces or Wi-Fi Hotspots 

generally found in coffee shops and other public places, such 

as airports, railway stations and shopping centres. Normally 

the W-Fi hotspots provide access free of charge; however, 

some hotspots may require subscription to have full access. 

8.3.7  Using Router/Wireless Router to 

Share an Internet Connection

Router is hardware equipment that enables more than one PC 

to share an Internet connection. The router is connected to the 

DSL/Cable modem. It has a few jacks to connect PCs directly 

using Ethernet cables. The wireless router is similar to a regular router; except that it transmits signal 

to enable PCs and other devices equipped with wireless adapters to connect to the Internet. A wireless 

router is shown in Fig. 8.2. 

8.3.8 Internet through Mobile Phone Network 

PCs, mobile phones and other devices can access the Internet 

using the mobile phone network. The concept is similar to the 

dial-up connection, except that the connection goes through the 

mobile network. To use the mobile phone network, the PC needs a 

modem. As this modem is usually not built into PCs and Laptops, 

you require a device, which is called USB Mobile Stick, also 

known by other names as USB modem, USB stick, Wireless modem, Netconnect, Photon and Mobile 

Internet Stick. A USB Mobile Stick is shown in Fig. 8.3. This is a small device that connects to the 

Fig. 8.1 USB Ethernet Adapter

Fig. 8.2 Wireless Router

Fig. 8.3 USB Mobile Stick
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USB port on the Laptop, Netbook or even the Desktop computer. It connects to the Internet through the 

wireless network provided by mobile phones service providers. This kind of Internet access is good for 

frequent travellers or who need the Internet access on their Laptops outside their home and offi ces. The 

speed of the Internet access on the mobile network depends on the deployed technology. There are three 

types of technologies—Second generation (2G), Third generation (3G) and Fourth generation (4G), 

also known as LTE (Long Term Evolution). The 4G technology provides the fastest connection.

8.3.9 Internet through Satellite

Satellites are used to provide the Internet access in remote areas. The speed of the Internet access 

through satellite is comparable to those through DSL and cable, however, this technology is very costly. 

As the communication through satellite requires clear line of sight and is affected by rain and moisture, 

the Internet access is not very reliable.

8.4 USING THE INTERNET 

You may ask – “What can I use the Internet for?” Well, that depends on what you want to use it for. The 

three most popular applications of the Internet are the World Wide Web, the electronic mail (e-mail) 

and fi nding information. 

8.4.1 World Wide Web

World Wide Web (also called just the web) is a huge system of multimedia documents located on millions 

of computers throughout the world. These documents, called the web documents or webpages, follow 

the HyperText Markup Language (HTML) standard. A typical web document contains links to other 

web documents or to other locations within the same document. These links are called hypertext links or 

just links. A link on a webpage is usually represented by an underlined text of different colour (usually 

blue) or graphics. When you click a hyperlink, it usually takes you to the corresponding webpage 

or to a new location in the current document. The processes of viewing different web documents by 

jumping from one document to another is commonly referred to as web surfi ng. To navigate web 

documents, you need the software called the web browser (usually shortened to just the browser).

The three popular web browsers for Windows based PCs are Internet Explorer, Mozilla Firefox and 

Google Chrome. 

8.4.2 Electronic Mail (E-mail)

Electronic mail (e-mail or email) enables you to send a message in electronic form to any user who 

has an e-mail address. E-mail works on the store and forward method and involves two or more mail-

servers. The message is fi rst sent to the sender’s mail-server, which in turn sends it to the recipient’s 

mail server. The recipient’s mail server then delivers the message in the recipient’s mail box, and the 

recipient may read the message. Depending on the volume of messages being handled by the mail 

servers involved, the message may take just a few seconds to reach the recipient’s mail box, or may 

take signifi cantly long time. 

8.4.3 Finding Information

Another common use of the Internet is to fi nd information. Students prefer the Internet for looking for 

information, instead of opening a book, dictionary or thesaurus. Similarly, a modern housewife resorts 

to the Internet to look for cooking recipes rather than ask her mother-in-law or neighbor! You can fi nd 
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useful information to fi x practically any household equipment. As most of the information on the web is 

free, more and more people look for the information on the Internet fi rst before trying other resources. 

8.4.4 Other Applications of the Internet

Some of the other ways people use the Internet include: 

1. Social Networking: Several social networking sites have evolved on the Internet that enables 

people to connect with like minded individuals. People can share information, pictures and videos 

about their lives and experience through these social networking sites. Some of the most popular 

social networking sites are Facebook, Myspace, Google+ and Twitter. Theses sites can help you to 

fi nd your old friends from school or university, and connect with them. 

2. Buy and Sell Goods and Services: Internet is being used to sell all kinds of stuff, such as books, 

magazines, computer software, electronics, computers, fl owers, grocery, clothes, music CDs, 

movie DVDs, clocks, perfumes, etc. Similarly, people are providing all kinds of services through 

the Internet. For instance, you may prepare and fi le your Income Tax return through an Internet 

program. A computer technician sitting in another part of the world may run programs on your 

computer or even fi x a software problem. 

3. Online Banking and Investment: Online banking through the Internet enables you to complete 

your regular banking tasks, such as fi nding balance, viewing recent transactions, transferring funds, 

paying bills, ordering cheques, etc., through the comfort of your house/offi ce without visiting the 

bank branch. Similarly, you may do a host of other fi nancial activities, such as buying and selling 

shares, bonds, mutual funds. The Internet also enables you to do the fi nancial research to help you 

to take the investment decisions. 

4. Booking and Ticketing: The use of Internet to book and buy tickets for plane, train and bus is 

increasing day by day. People can book ticket on the Internet, pay for it using a credit card or by 

transferring funds from the bank account, and then print ticket details/ticket using the PC. Another 

common use of the Internet is to book hotel rooms and rental cars. 

5. Download/Buy Music/Software: The Internet is increasingly being used to distribute music and 

software. If the music or software is being offered free of charge, one can simply download it from 

the host site. (Free downloadable software is also called freeware.) Sometimes, the software is 

offered free for trial for a limited period of time. After the evaluation period is over, either the user 

should pay to continue using it or delete it from the computer. This kind of software that is offered 

free for limited period is called shareware. 

6. Instant Messaging (IM): Instant Messaging (IM) enables two users to communicate to each other 

in almost real time through typed text. The communication takes place between the two computers 

connected through the Internet. Some of the common Instant Messaging programs are MSN 

Messenger/Windows Live Messenger, Yahoo Messenger, Google Talk, Jabber, ICQ, AIM (AOL 

Instant Messenger) and eBuddy. The Instant Messaging programs offer a number of additional 

features, e.g., voice/video communication, fi le sharing, e-mail and games. 

7. Maps and Driving Directions: The Internet is increasing being used for fi nding maps and driving 

directions. Besides, companies are using maps to display their locations on the Internet search 

results. 

8. Education and Research: Most of the economic, scientifi c and technical research and education 

papers are being made available on the Internet to the common public. This helps to improve one’s 

knowledge and understanding of common as well as not so common topics. The Internet also 
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helps scientists, engineers and doctors to exchange their experience and test results. Some people/

publishers post free eBooks (Electronic Books) that you can read on your PC; to read others, you 

may have to pay the publisher. 

9. E-Governance: Governments of various countries are increasingly using the Internet for 

governance. They use the Internet to provide information about rules and regulations, benefi ts 

available to citizens under various programs, electronic record keeping and providing information 

to the public, collecting information from the public, communicating performance of various 

Government Departments/Ministries, tax collection, enabling citizens to apply for birth certifi cate/ 

passport, fi le Income Tax Return, etc. 

10. Play Games: The internet enables users sitting in different locations, even different courtiers to 

play multi-user games. Card games, chess, checkers are quite popular among Internet gamers.

11. Sharing Pictures and Videos: The Internet enables people to share their pictures and videos. 

Once the pictures/videos have been put on the Internet sites, these are available to the whole world. 

Some of the free popular sites for putting pictures are Flickr, Picasa and Instagram. The most 

popular website to watch video on the Internet is YouTube. Any one with an Internet connection 

can upload a video clip to the YouTube site for the entire world to watch. 

12. Internet Radio and TV: The Internet radio enables you to play the radio station of your choice 

on your computer. Hundreds of Internet radio stations from all over the world provide live 

contents 24 hours a day. You can choose the radio station of your choice to enjoy it while working 

on your computer. Besides providing live broadcast, some websites allow you to choose past 

programs to listen to, or download programs of your choice to your PC and listen to them later at 

your convenience. (Distributing an audio program from an Internet site to PCs is also known as 

podcasting.) Similar to the Internet Radio, the Internet TV enables you to watch TV programs on 

your computer.

13. Internet Telephony: The Internet Telephony makes use of the Voice over Internet Protocol

(VoIP), which uses the Internet to place voice calls. Since it makes use of the existing Internet, it 

usually costs less to make a call through VoIP as compared to using the regular phone service. The 

voice quality of Internet calls varies depending on the traffi c on the Internet. An Internet phone 

looks like a regular digital phone and is usually connected to the USB port of the computer or a 

phone modem. Even wireless Internet phones are available that automatically search for available 

wireless Internet network to make calls. An Internet phone can place calls to another Internet 

phone or a regular landline/mobile phone. One advantage of an Internet phone is that you may take 

it with you anywhere in the world (where the Internet is available) to make/receive calls. 

14. Ease of Operations for Charitable Organisations/NGOs: The Intranet has enabled charitable 

organisations/NGOs to inform the public about their activities and collect funds. As people can 

visit the website of a charitable organisation/NGO to get in-depth knowledge about its activities, 

they are more willing to donate. Besides, the facility of online payment using credit cards also 

increases chances of people making the donation. 

8.4.5 Web Address

You may be wondering that if there are billions of documents available on so millions computers, how 

we view a particular document. Well, it is not as complicated as it may seem. Each piece of information 

on the web is given a unique address, called the Uniform Resource Locator (URL), also known as the 

web address. Let us have a look at a sample URL to understand it. 
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http://www.sample.com/homepage.html

The above URL consists of three parts:

1. http://  The fi rst part of the URL specifi es the name of the protocol. The Hypertext 

Transfer Protocol (HTTP) is the Internet protocol used to transfer information 

on the web. In other words, the HTTP protocol is used to display webpages in 

the browser. The Internet supports a number of other protocols, such as FTP 

(File Transfer Protocol), SMTP (Simple Mail Transfer Protocol), TELNET 

(Telecommunication Network), POP3 (Post Offi ce Protocol Version 3) and 

IRC (Internet Relay Chat). Although there are so many protocols, HTTP is the 

most popular, and usually the browser defaults to this protocol. Thus, if you 

enter www.sample.com, the browser automatically changes it to http://www.

sample.com.

2. www.sample.com The second part of the URL is the host name or the name of the computer 

where the webpage is stored. This is also called the domain name. In fact, the 

domain name is used in the URL only for the ease of use; the actual address 

assigned to each computer is called the Internet Protocol (IP) address, which 

consists of a four part number, such as 64.236.16.20. When you enter a URL 

containing a domain name, it is automatically converted into the corresponding 

IP addresses by the Internet. 

3. homepage.html  The last part of the URL is the fi le path, which specifi es the fi le name and path

where the requested page is located on the host. In the above example, the 

page (the homepage.html fi le) is located at the root level. If the required page 

is located in a subfolder, the fi le path includes a folder name, e.g., 

 http://www.sample.com/sale/salepurchase.html

That is, the URL http://www.sample.com/sale/salepurchase.html refers to 

a webpage (salepurchase.html), located in the folder (directory) sale on the 

domain www.sample.com. 

8.4.6 Top Level Domains (TDLs) 

The part of the domain name, after the last dot, is called the top level domain (TDL). For instance, in 

www.cnn.com, “com” is the TDL. Other TDLs that you may come across are edu, gov, org, net, info, 

etc. The TDL normally refers to the type of organizations that owns the domain. For example, the TDL 

com is usually owned by commercial companies, edu by educational institutions, gov by government 

organizations and org by non-profi t/charitable organisations. 

When the Internet initially evolved, no one had any idea that it may become international, hence 

no provision was made to include the country code or reference in the domain. Later on, a unique two 

character code was assigned to each country, e.g., in to India, uk to United Kingdom, fr to France and 

ca to Canada. Hence, a domain ending in “in” suggests that the domain is owned by an Indian company. 

For a country specifi c domain, the type of the organization is available in the characters preceding 

the dot before the country characters. For instance, india.gov.in indicates that this is a government 

organization belonging to India. In country specifi c domains, commercial organisations use ‘co’ in the 

domain name, e.g., www.sbi.co.in.

Note  You should not form an opinion about an organization based on its domain name. For instance, a 

charitable organization may use the com TDL and an Indian company may not use “.in” its domain.
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8.5 BROWSING THE WEB 

As you know, to view a web document, you need the browser software. You have a number of browsers 

to choose from depending on the operating system on your computer and your preference. Some of 

the common web browsers are Internet Explorer, Mozilla Firefox, Google Chrome, Safari and Opera. 

Safari is mainly used on Mac OS (Apple), and Internet Explorer, Mozilla Firefox and Google Chrome 

are common browsers on Windows based PCs. 

8.5.1 History of Browsers

Browsers started appearing for the PC market in early 1990s. Whereas various companies launched 

several browsers, Netscape Navigator became the most popular browser on the Windows based PCs. 

Later, when Microsoft started bundling Internet Explorer with its operating system, it became very 

popular. In spite of having near monopoly of the browser market share around 2004, Internet Explorer 

was never a perfect product and lacked a number of features users wanted to have. 

Since 2004, the Mozilla Firefox (commonly called just Firefox) has steadily gained popularity in the 

browser market. The two most important features of Firefox that encouraged users to switch are tabbed

browsing and security. Tabbed browsing allows multiple webpages to be viewed in the same browser 

window. Microsoft added the tabbed browsing feature in the new versions of Internet Explorer. Google 

Chrome, developed by Google and released in September 2008 has quickly very popular. 

Your computer may have one or more browsers installed. As a browser is mainly used to view the 

documents stored in computers connected to the Internet, you should connect to the Internet before 

trying to start the browser. If you are accessing the Internet through a LAN or a DSL/cable connection, 

your computer normally automatically connects to the Internet when it starts. On the other hand, if 

you are using a dial-up connection or mobile network, connect to the Internet as per the instructions 

provided by your ISP. Typically you just need to double click the corresponding icon on your desktop 

to connect to the Internet.

8.5.2 Starting Internet Explorer

If you are using a PC running Windows 95, Windows NT, Windows 98, Windows Me, Windows 2000, 

Windows XP, Windows Vista, Windows 7 or any other Windows-based PC which is not more than 10 

years old, you should have some version of Internet Explorer installed on your PC. As of January 2014, 

version 11 is the most recent release of Internet Explorer for Windows 7 and Windows 8. You start 

Internet Explorer in the same way as you start any other program (e.g., Microsoft Word or Excel). 

∑ You may be able to start Internet Explorer by choosing Internet Explorer from the Windows Start 

menu, double clicking the Internet Explorer icon on your desktop or clicking the Internet Explorer 

icon on the taskbar. The Internet Explorer icon looks like  or .

On starting Internet Explorer (also called launching Internet Explorer), you see the Internet Explorer 

window similar to the one shown in Fig. 8.4, which is displaying the Google page (www.google.co.in) 

in Internet Explorer 11. Internet Explorer loads the home page defi ned in the browser in the Internet 

Explorer window when it starts. A different home page may be defi ned in your browser, thus the 

Internet Explorer window may look signifi cantly different from the one shown in Fig. 8.4. Notice that 

Internet Explorer displays the URL of the current page in the Address bar.
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Fig. 8.4 Internet Explorer 11 displaying a webpage

If you are running Internet Explorer 10 or earlier version, the top portion of the screen may look slightly 

different from that shown in Fig. 8.4.

Note  Internet Explorer 10 and later are not supported on Windows XP and older operating systems. 

Internet Explorer 6 and earlier don’t support tabbed browsing, however, these have almost all other 

basic features. 

The Internet Explorer windows looks similar to any other Windows based program window: 

 ® The title bar at the top has typical buttons to minimize, maximize/restore and close the 

window. 

 ® The fi rst bar under the title bar is called the address bar, which enables you to view any 

webpage by entering its address. The address box may also be used to search the web. 

 ® The next bar, called the Favorites bar is used to quickly open your favorite websites. This bar 

is off by default in Internet Explorer 11.

Internet Explorer 11 has several other toolbars, such as Menu bar, Command bar, Status bar and Bing 

bar. All these bars are off by default to give more space to view the websites you visit. 

∑ To turn on any bar, right click the mouse on any empty space on any toolbar or the title bar to 

display the context menu and click the corresponding option on the menu. Use the same procedure 

to turn off any bar.
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Rest of space in the Internet Explorer window is used to display the contents of the webpage. 

Note  If you are using an older version of Internet Explorer and your operating system is capable of running 

the newer version, we recommend that you download the latest version from www.microsoft.com/

download 

8.5.3 Starting Mozilla Firefox 

You may start Mozilla Firefox (hereafter called just Firefox) in the same way as you start any other 

program. 

∑ You may be able to start Firefox by choosing the Firefox program from the Windows Start menu, 

double clicking the Firefox icon on your desktop or clicking the Firefox icon on the Taskbar. The 

Firefox icon looks like .

On starting the Firefox browser (also called launching Firefox), you see the Firefox window similar to 

the one shown in Fig. 8.5. Figure 8.5 displays the Mozilla Firefox Start Page. Like Internet Explorer, 

Firefox loads the home page defi ned in the browser in the Firefox window when it starts. On your PC, 

you may see a different home page, as some other page might have been defi ned as the default page. 

Fig. 8.5 Mozilla Firefox displaying the Mozilla Firefox Start page

8.5.4 Starting Google Chrome 

If you have the Google Chrome browser installed on your PC, you may start it like any other Windows 

program. The Google Chrome icon looks like . Figure 8.6 shows a webpage displayed in the 

Google Chrome browser.
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Fig. 8.6 A webpage displayed in the Google Chrome browser

8.6 WHICH BROWSER TO USE? 

As you know, three most popular browsers for Windows-based PCs are Internet Explorer, Firefox and 

Chrome. Windows-based PC usually come with the Internet Explorer browser installed and therefore 

most users have their fi rst browser experience with Internet Explorer. While Internet Explorer 6 lacked 

some major features, particularly the tabbed browsing, for an average user, the latest versions of Internet 

Explorer, Mozilla Firefox and Google Chrome have comparable features. Though you will fi nd nearly 

all features in all the three browsers, the user interface in these is somewhat different and Chrome and 

Firefox may load websites a little faster than Internet Explorer.

Whether you should continue to use Internet Explorer or switch to Firefox or Chrome is your 

personal choice. Since you may download Firefox and Chrome for free, there is no harm in trying 

these, and then you may decide which browser you like. 

8.6.1 Getting Firefox 

The easiest and most common way to get the Firefox is by downloading it from the Firefox website. 

The Firefox download fi le is quite small, so the download should not take much time. Use the following 

simple steps to download Firefox:

∑ Connect to the Internet if required and start your existing browser. Now, enter www.getfi refox.

com or www.mozilla.com in the address bar to open the Mozilla website. 

∑ Click the Firefox – Free Download link. This link, which displays the Firefox logo, is good to 

download Firefox for Windows for English. For other systems/languages, click the Systems and 

Languages link. Firefox is available in several Indian languages.
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Firefox displays a new page in the browse window that explains the steps required to download and 

setup Firefox. Before the download starts, Windows displays a security warning message similar to the 

one shown in Fig. 8.7. Your computer may also display other warning messages.

Fig. 8.7 Security warning message

∑ Click the Run button and the download starts which may take several minutes to complete, 

depending on the Internet speed. After the download is complete, Windows may display another 

message box with the Run and other options. On clicking the Run button, the installation process 

starts. Just follow simple on-screen instructions, and the installation process should be over soon, 

and you are ready to use Firefox. 

When you start Firefox for the fi rst time, if you prefer, it can import your current settings, such as 

Internet Options, Cookies, Browsing History, Passwords, Favorites, etc., from Internet Explorer to 

Firefox. Figure 8.5 displays the default Firefox home page.

8.6.2 Getting Chrome 

You may download the Chrome browser within seconds from its offi cial website. Use the following 

simple steps to download and install Chrome: 

∑ Connect to the Internet if required and start your existing browser. Next, enter www.google.com/

chrome in the address bar to open the Google Chrome website. 

∑ Click the Download Chrome button to download Google Chrome for Windows 8/7/Vista/XP. 

∑ You see a new webpage that requires you to click the Accept and Install button to accept the terms 

and conditions and install the Chrome browser on your PC. It also has a check box to set Google 

Chrome as the default browser on your PC. On clicking this button, the download and installation 

process starts, and after the installation process is complete, the Chrome browser automatically 

starts. Like Firefox, Chrome too can import the settings from your existing browser. 

8.7 EXPLORING THE WEB 

You have setup your browser, it is up and running and is displaying a default page. Now you are ready 

to explore the Web, which contains billions of web documents. However, unlike the pages contained 

in a book, the webpages are not arranged in a sequence. First, these pages are located on millions of 

separate computers. Even pages located on the same computer are not arranged in a sequence. These 

are physically separate pages though most pages have links that contain the URL of other pages. Those 

“other pages” may be available on the same computer or a computer located anywhere on the Internet. 

This scheme is illustrated in Fig. 8.8. 

Notice that some text, such as North Korea, Pope Benedict XVI, Main Page, Contents, on left page 

are displayed in different color. When you move the mouse pointer on such text, the mouse pointer 

shape changes to the hand symbol like . The changed mouse pointer shape indicates that the text 

contains a hypertext link, which contains the URL for a web document. A typical webpage contains one 

or more hypertext links (commonly called just links). If a page contains multiple links, these may refer 

to the same or different webpages. When you click a link, the browser tries to load the corresponding 
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document. The new web document may have more links, which point to other web documents. For 

instance, the North Korea document in Fig. 8.8 contains Create account, Log in and other links. Thus, 

you jump from the fi rst document to the second, from the second to the third, and so on using links. 

This is also knows as web surfi ng.

Fig. 8.8 Concept of Linked pages

In the earlier days, most links were shown in blue underlined text. However, webpage developers 

follow their own standards. Thus, you fi nd links in different colors in different webpages, however, 

when you move the mouse pointer on a link, the shape of the mouse pointer changes. Optionally, the 

link style, e.g., its color, underline, background or size may change when you move the mouse pointer 

on a link.

8.7.1 Image Hyperlinks

In the early days of the Internet, when webpages contained mostly text, the links were also designed 

using text. However, as websites started using images, Image Hyperlinks started appearing in webpages. 

An Image hyperlink displays an image which contains the URL for the corresponding page. On clicking 

the Image Hyperlink, the browser loads the URL specifi ed in the Image Hyperlink. Image hyperlinks 

are commonly used in picture galleries and websites that sell products. Figure 8.9 displays a webpage 

that uses Image hyperlinks. 

8.7.2 Moving Back and Forward 

When you use links to view a new page in the browser, it remembers the pages you viewed (also called 

visited) earlier. Thus, after reading the current page, if you want to go back to the previous page, you 

may do so by clicking the Back button. Similarly, you may use the Forward button to go forward a 

page. The Back button looks like a left pointing arrow, and the Forward button like a right-pointing 

arrow on the Buttons toolbar. 
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Fig. 8.9 A webpage with image hyperlinks

Sometimes you may notice that Forward and/or Back buttons on the toolbar are greyed-out, and 

nothing happens when you click the button. When a button is greyed-out, it means that it is disabled. 

The browser automatically enables and disables these and other buttons on the toolbar as applicable. 

For instance, if you have just started the browser, it has no page to go forward or back, and therefore 

both Forward and Back buttons are disabled. 

Tip  In Internet Explorer, Firefox and Chrome, you may press Alt + ← (Alt Left Arrow) keys to go back or

Alt + → (Alt Right Arrow) keys on your keyboard to go forward. 

8.7.3 Using the Menu to Go to Recently Visited Page

If you have visited several pages in the current browser session and you want to go to a specifi c page, 

your browser can display a list of recently visited pages to choose any page. 

∑ To display this list, right click the mouse on Forward or Back button located near the top-left 

corner (see Fig. 8.10). Then click the desired page to ask the browser to display it.

Fig. 8.10 Display of recently visited pages in Internet Explorer 
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The Back and Forward buttons enable you to quickly go to a recently visited page in the current 

session. However, if you want to go to a page that you visited yesterday or last week, you can dig into 

the page visit history maintained by the browser. We will discuss this in Section 8.16.

8.7.4 Visiting a Specifi c Page

Your friend or colleague tells you about a very interesting webpage and gives you its URL address. If you 

want to visit that page, enter the URL Address (commonly shortened to just the Address) in the address 

box. The address box is the big text box that displays the address of the current page (see Figs. 8.4

and 8.5). Just enter the address in the address box and press the Enter key. Here is an example of a 

typical webpage address—http://www.cnn.com/. While entering the webpage address in the address 

box, you may skip “http://”, thus www.cnn.com should normally work. Most browsers are quite 

forgiving and may accept even if you skip “www” or “.com”, i.e., www.cnn or cnn.com may also take 

you to http://www.cnn.com/

8.8 WHAT IS A SEARCH? 

There is so much of information available on the Internet that fi nding the exact information may 

sometimes be diffi cult, or even frustrating. To help you fi nd the required information, in fact webpages 

containing the required information, a number of search engines are available. A search engine is a 

computer program that runs an algorithm to fi nd the list of webpages containing the text you ask it 

to search and display that list in your browser window. Massive arrays of powerful computers of the 

search engine keep visiting the webpages available on the World Wide Web (WWW) on continuous 

basis. This has to be a continuous process as the webpages keep changing, and new webpages are 

added continuously and old pages get removed. The webpages are visited by an automated process 

called web crawler (also known as web spider or web robot.) Web crawler makes a copy of the 

webpages, which are later processed by the Search engine to create an index. This index is used by 

the search engine to provide the list of webpages to you when you perform a search. To perform a 

search, all you need to do is to provide a list of important keywords you are looking for in a web 

document to the search engine. For example, if you looking for Indian Railway Timetable, just use 

“Indian Railway Timetable” as the search text, and the Search engine would provide you a list. 

Figure 8.11 displays the result of the search on “Indian Railway Timetable” on Google. Notice that 

the search found 689,600 relevant pages. The result window contains links that you may click to 

jump to the corresponding webpage.

The most popular search engine is Google with about 70% marker share in early 2014. The other 

popular search engines for English documents are Yahoo! and Microsoft Bing. The other source you 

may fi nd useful to get information is Wikipedia, the free encyclopaedia created by users like you. 

8.8.1 Performing a Quick Search

The easiest and quickest way to perform the search is the enter the search text in the address box in the 

address bar and press the Enter key to ask the browser to perform the search using the default search 

engine. Of course, there are other ways to search for the information, as you would see in the next 

section.
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Fig. 8.11 Search results returned by Google

8.9 USING GOOGLE TO SEARCH FOR INFORMATION 

Google is the most popular among the Internet users to search for almost anything on the Internet. 

It is so popular that people often say—“If you don’t know something, Google it.” The reason for 

its popularity is that its search engine usually provides the most appropriate websites containing the 

information you ask it to search at the top of the list, even if the search returns thousands of webpages. 

For instance, look at the results displayed in Fig. 8.11 for the search “Indian Railway Timetable” 

to appreciate the appropriateness of Google search results. You can use the Google search engine in 

several different ways. 

8.9.1 Using the Google Home Page to Perform a Search 

Regardless of the browser you are using, you can perform a search using Google’s home page. 

∑ Type www.google.com in the address box in the address box and press the Enter key. 

Google.com may automatically redirect you to a country specifi c home page depending on the IP 

addresses of your ISP. That is, if you enter www.google.com on a computer in India, you may end up 

at www.google.co.in. This is in fact helpful as it gives you an option to search only in webpages from 
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India. Figure 8.12 displays the Google India home page (www.google.co.in). Google also redirects you 

to this page if you enter the web address www.google.in.

Tip  If you want to use the www.google.com webpage for your search, click the Google.com link in the 

www.google.co.in page. This link is located on the right-right of the page.

Fig. 8.12 The Google homepage for India

∑ After you have loaded the Google search page, to perform a search, all you need to do is type the 

desired search keywords in the search box located in the middle of the page and press the Enter 

key or click the Google Search button. 

∑ Notice that as you start typing search keywords in the search box, Google may display some 

suggestions that may help you choose the search text. To accept any of the suggested search text, 

just click the corresponding item. 

The browser sends the search keywords entered/selected by you to the Google search engine, which 

looks in its index for the webpages containing those keywords and sends back the result to your 

browser window. In most cases, the Google search engine fi nds several (sometimes thousands) of 

pages matching your search keywords. Figure 8.13 provides the search results for “Hindi Computer 

Books.” Besides displaying the search results, the webpage may display advertisements related to the 

search text.

Note  As Google continues to refi ne the search results display on regular basis to meet the users’ 

expectations, the search information display and its working may differ from that described in the 

text.

Each search result provides a link to each matching page, relevant text from the webpage, URL of the 

web document, etc. For instance, consider a sample search result for “Hindi Computer Books”.
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Fig. 8.13 Google search result for “Hindi Computer Books”

In this search result, “ComputerSeekho…” is title of the webpage as well as link to that page. That is, 

you can click this link to visit the corresponding webpage. Rest of the lines provide the text from the 

webpage that Google used to select this page with your search keyword highlighted in bold letters. 

Notice the arrow in the second line of the search result. When you click this arrow, you see two options—

Cached and Similar. If you click the Cached link, Google displays the snapshot of the webpage (i.e. 

the copy of the original webpage) from its own server. As we mentioned earlier, the search engine’s 

web crawler continuously visits all webpages and makes a copy for the search engine. When you click 

the “Cached” link, the search engine (Google in this case) provides the copied webpage from its server 

computers. As the original webpage might have changed since the search engine made its copy, you 

should use the cached version only when the original webpage takes too long to load; has been removed 

or the corresponding website is temporarily down.

Note  Depending on the Google search settings on your PC and the Internet connection speed, Google 

may start displaying search results as you type search text. To control this behaviour, click the 

Options button (see Figure 8.13) and choose Search settings.

∑ When you click a link from the search results, the browser loads the corresponding page. After 

looking at the page, if you feel that this is not the page you were looking for, click the Back button 

to go back to the Google search results page. Now you may see if some other page might be more 

relevant for your search keywords. 
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∑ If you want to view the webpage in a separate tab, click the mouse while holding the Ctrl key 

pressed. Tabbed browsing is discussed later in this chapter.

When you scroll to the bottom of the search results page, if Google has additional search results to 

offer, it displays links to navigate to additional result pages, as shown in Fig. 8.14.

∑ To display the next result page, click Next or the right arrow link. You may also click the 

corresponding page links located on the left of the Next link. 

If you fi nd that the Google has returned too many pages in the result set and you are not able to fi nd the 

page you were looking for, you have these options: 

 ® Redo the search by refi ning the search keywords. You may change or add the search 

keywords.

 ® Perform Advanced Search.

Fig. 8.14 Navigating to additional result pages

8.9.2 Performing Advanced Search

The Google Advanced Search can help you to defi ne several parameters to narrow down the results. 

For instance, you can specify the exact sequence of words that should appear in the webpage, and/or 

the webpage should not contain specifi c words. You can also restrict the search to a specifi c language 

or region (country) or exclude pages that are too old. You can also specify the type of domain, e.g., .org 

or .edu. 

∑ To access the Google Advanced Search page, click the Options button (see Fig. 8.13) to display 

search options and click Advanced Search. Then enter the relevant details in appropriate boxes or 

choose desired search options. 

Figure 8.15 displays a Google Advanced Search page to search for pages containing “Hindi Computer 

Books”, which should have the exact words “Published by BPB” but should not contain “Pustak 

Mahal”.
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Fig. 8.15 Performing Advanced Search

8.9.3 I’m Feeling Lucky

Notice the “I’m Feeling Lucky” button in Fig. 8.12. If you click this button instead of the Google 

Search button, Google automatically opens the webpage corresponding to the top of the search result 

instead of displaying the search results. This may be helpful when you are pretty sure that Google 

will return the webpage that you are looking for at the top of the list. For instance, if you search for 

“Government of India Portal” and click the “I’m Feeling Lucky” button, Google automatically opens 

the www.india.gov.in/ webpage.

Note  To use the “I’am Feeling Lucky” button, you need to disable Instant Results. To accomplish this, 

click the Options button on any Google search results webpage and choose Search Settings. Next 

click Never Show Instant Results and click the Save button located at the bottom of the Search 

Settings page.

8.9.4 Google Can Do More than Simple Web Search 

Besides doing the web search, you can ask Google to search images, news, maps, videos, etc. Notice 

Images, Maps, Books and More links above the search results in Fig. 8.13. These links are used to 

perform the corresponding type of search. For example, if you click Images, Google search result 

contains images that are based on the search text. Figure 8.16 displays the image search result for 

“Hindi Computer books”. You can click an image to go to the corresponding website. Similarly, you 

can search for news items containing the search text. Google also has options to search in patents and 

blogs. 
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Fig. 8.16 Image search results

8.9.5 Google Search via Other Websites

The Google search engine is so popular that many websites put a Google search box on its webpages. 

These webpages let the user use the search engine to either search in that website (i.e., all webpages 

available on that website) or in the entire web. If a webpage supports the Google search, you see the 

Google logo near the Search button. The webpage shown in Fig. 8.17 uses the Google Search to search 

the website as well as the web. 

Fig. 8.17 Using Google Search via other websites

8.9.6 Using Google in Indian Languages

The Google’s search site for India (www.google.co.in) is available in several Indian languages, such as, 

Hindi, Bengali, Telugu, Marathi, Gujarati, Tamil, Kannada, Malayalam and Punjabi. In future, additional 

languages may be supported. To use www.google.co.in in any of the supported Indian languages, click 

the corresponding link located below the search box. Figure 8.18 displays search being done in Hindi. 

As shown in the fi gure, while working in Google.co.in in Hindi, you may continue to type in English 

and Google may suggest matching search text in Hindi.
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Fig. 8.18 Google search being performed in Hindi

8.9.7 Search by Voice 

If your computer is equipped with microphone and speaker and you use the Google Chrome browser, 

Google displays the microphone icon in the search box, as shown here.

In that case, you may click microphone icon to initiate search by voice and Google prompts you to 

speak. As you speak, Google converts the spoken words in typed text which are used to perform the 

search. For some searches, it may even speakout the result.

8.10 OTHER SEARCH ENGINES 

Besides Google, there are several other search engines—Yahoo and Bing being two popular ones. 

To use the Yahoo search engines, use www.search.yahoo.com or www.yahoo.com websites, and to 

use the Bing search engine, use www.bing.com. Doing search on these sites is similar to performing 

the Google search; you enter the search text in a search box and click the search button. Figure 8.19 

displays the Yahoo search being performed. Internet Explorer uses Bing as the default search engine 

while using the browser address box as the search box; however, you can add search engines of your 

choice. Firefox and Chrome too allow you to add search engines as well as to choose the default search 

engine.
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Fig. 8.19 Yahoo Search 

8.11 OTHER WAYS TO SEARCH FOR INFORMATION 

The current browsers provide other ways to search for information. One way to perform the search is by 

directly typing the search text in the address/location bar. In addition, Firefox contain a search box that 

you may use to perform a search. The search box enables you to choose the search engine to perform 

the search. The browsers also enable you to install additional search engines. 

8.11.1 Searching for Words Selected in a Webpage 

If you want to search the web for any word(s) that appear in the webpage you are viewing, perform the 

following steps: 

∑ Select the words that you want to search; double click to select a single word the word and drag 

the mouse to select multiple words. 

∑ Right click the selected word(s) to display a menu which contains a command, such as ‘Search 

Google for [your selected words]’. If your default search engine is other than Google, you will see 

that name instead of Google or a similar message, e.g., Search with Bing. 

∑ Click the ‘Search….’ command to ask the browser to perform the search. 

8.11.2 Searching for Text in the Current Webpage

∑ If you need to check if specifi ed word(s) exist on the current webpage, press Ctrl+F keys.

This displays a fi nd textbox where you type the search word(s) and the browser highlights the matching 

text on the page. The browser displays suitable buttons to move to the next or previous fi nd location. 

8.11.3 Wikipedia – The Free Encyclopedia 

Wikipedia is a free encyclopedia on the Internet that you may use to fi nd information on almost any 

topic. Wikipedia is not only free, it is also editable. The beauty is that not only it is editable; anyone 
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can edit it, including you. Wikipedia is available in several languages. The URL for the main (English) 

Wikipedia is http://en.wikipedia.org, which has over 4.4 million articles in English, and it is still 

growing. Figure 8.20 displays the webpage for the English Wikipedia. For a detailed article on India, 

visit http://en.wikipedia.org/wiki/India. Most articles are available in multiple languages. 

Fig. 8.20 Wikipedia—free encyclopaedia that anyone can edit

Searching in Wikipedia is simple—just type the required keywords in the Search box located in 

the top-right corner and choose the article from the list displayed by Wikipedia or click the Search 

button. One thing you are sure to notice in Wikipedia articles is that these contain a lot of links (shown 

in blue color) to other Wikipedia articles. You may click these links to read details about the terms 

and references used in an article. A Wikipedia article may also have links to external website that may 

provide additional details about the topic discussed in the article. 

The Wikipedia has been created by contributions from the Internet users. If you prefer, you may add 

an article or edit an existing one. To do so, all you need is to create an account and log-in. Even creating 

an account is also very simple—you just need to provide a username and password. All new articles or 

changes to existing ones are watched by volunteers, and if they fi nd any inappropriate material, they 

remove it. 

8.12 HOME PAGE 

When you start your browser, usually it loads a predefi ned page called the home page. You are free to 

redefi ne the home page, or even use a blank page as the home page. Though not so common, you may 

even defi ne multiple home pages. 
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The home page serves two purposes. First, you may ask the browser to load the webpage defi ned by 

the homepage when it starts. Second, regardless of the page displayed in the browser, you just need to 

click the Home button on the toolbar to replace the current page with the home page. 

∑ To load the home page, press the Home button, which looks like  or press Alt+Home keys.

Obviously, the home page you would like to defi ne should be the one that you would like you 

regularly. Most users normally use a home page that lets them do a web search and/or check their email. 

www.google.com, www.google.co.in, www.yahoo.com and in.yahoo.com are a few common home 

pages. Once you know the page that you would like to be your home page, defi ning that as the home 

page is very simple.

8.12.1 Defi ning a Home Page in Internet Explorer 

The easiest way to defi ne the home page is to fi rst load it in the browser. You may directly enter its URL 

in the address bar, or use a search engine to load one.

∑ Click the Tools button located near the top right corner of the browser window (see Fig. 8.4) or 

open the Tools menu. Then click Internet Options in the menu.

Internet Explorer displays the Internet Options dialog box shown in Fig. 8.21. The list box displays the 

current home page. 

Fig. 8.21 Defi ning Home Page in the Internet Options dialog box in Internet Explorer

∑ To defi ne the current webpage displayed in the browser as the home page, click the Use Current 

button. To restore the webpage to the one that was defi ned when Internet Explorer was fi rst installed 
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on the PC, click the Use Default button. And if you do not want to use any home page, click the 

Use Blank button. 

∑ Finally click the Apply button, followed by the OK button to close the Internet Options dialog box.

Note  Internet Explorer 7 and higher support multiple home pages, which are typed in separate lines in the 

Home page list box in the Internet Options dialog box. If you defi ne multiple home pages, Internet 

Explorer loads all home pages in separate tabs when you click the Home button. 

8.12.2 Defi ning a Home Page in Mozilla Firefox

∑ Load the webpage that you want to defi ne as the home page. Then press Alt+T or open the Tools 

menu and choose the Options command to display the Options dialog box shown in Fig. 8.22. 

Fig. 8.22 Using the Options dialog box to defi ne the Home page in Firefox

∑ If the Options dialog displays details for a category other than General/Main, click the General/

Main category icon located near the top-left corner.

∑ The Options dialog box displays the current home page in the Home Page text box. To use the 

current webpage as the Home page, click the Use Current Page button. If you want to defi ne a 

different page as the Home page, enter its URL in the Home Page textbox. To restore the home 

page to the default one, click the Restore to Default button. 
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In Firefox, you may defi ne a Home page but may ask it not to use it when it starts. You can choose any 

of the following three options when Firefox starts: 

 ® Show my home page, i.e., load the defi ned home page.

 ® Show a blank page, i.e., do not load any webpage.

 ® Show my windows and tabs from the last time. In other words, restore the last Firefox 

session.

Tip  Defi ning a Home page but starting with a blank page gives you best of both worlds as the browser 

starts very fast since it does not load any page, and you can quickly load your home page when you 

need by clicking the Home button. 

8.12.3 Defi ning a Home Page in Chrome

By default, the Home Page button is not displayed in Chrome. 

∑ To display this button, click , the Customize and Control Google Chrome button (see Fig. 8.6) 

and choose the Settings command. 

∑ Check the Show Home Button checkbox in the Appearance section to display the Home button to 

the left of the address box. 

∑ To defi ne or change the home page, click the Change link displayed below the Show Home Button 

checkbox, as shown in Fig. 8.23.

Fig. 8.23 Controlling and defi ning home page in Google Chrome

8.13 TABBED BROWSING 

Tabbed browsing enables you to view multiple webpages in different tabs in a single browser window. 

Tabbed browsing was fi rst introduced by Firefox and adopted by Microsoft in Internet Explorer 7. 

∑ To open a new empty tab, press Ctrl+T, which works in most browsers, including Internet 

Explorer, Firefox and Chrome. 

∑ You may also open the new tab by clicking the New Tab button located on the right of the current 

tab (see Fig. 8.23.) Internet Explorer and Firefox also have similar buttons to open a new tab. 
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When you open a new tab, depending on the browser settings, it may display a blank page, the home 

page or icons of the sites you have visited the most, as shown in Fig. 8.24. This can help you to quickly 

open a site that you visit frequently. To open a site, click the corresponding icon. 

Here are few instructions on using tabbed browsing:

 ® When you type the URL of a webpage in the address/location bar, press Alt+Enter to open the 

webpage in a new tab.

 ® To open a link in a new tab, press and hold the Ctrl key while clicking the link. Alternatively, 

click the link with the middle mouse button. 

 ® To close a tab, press Ctrl+W or click the close button (X) located on the tab. You can also 

close a tab by choosing the Close/Close Tab command from the shortcut menu that you get 

when you right click a tab. 

If you try to close the browser window when multiple tabs are open, the browser may display a warning 

message.

Fig. 8.24 A new tab displaying icons for the most visited sites

Tip  You may reposition tabs in the browser window. To reposition open tabs, simply drag a tab to the 

desired new position. Also, right clicking a tab opens a shortcut menu that includes commands to 

close the current/other tabs and refresh current/all tabs. 

8.14 USING BOOKMARKS 

When you surf the web, you are sure to fi nd some webpages that you would like to visit again. Also, 

sometimes, you locate a particular webpage after considerable search, and you do not want to spend 

that time again to revisit that page in future. Instead of remembering the URL of the page or noting it 

down in a notebook, you may ask the browser remember it for you by bookmarking it. The process of 

creating bookmarks is slightly different in different browsers. Besides, bookmarks are called Favorites

in Internet Explorer. 
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8.14.1 Creating a Bookmark in Chrome/Firefox

∑ To bookmark the current webpage in Chrome/Firefox, click  (Bookmark this page) button 

located on the right in the address box. Alternatively, press the shortcut keys Ctrl+D. Chrome 

displays a confi rmation dialog box as shown. Firefox also displays a similar box. 

∑ The Name box displays the title of the page you have bookmarked. You may keep this name or 

change it to some other easy to remember name. You will use this name later to open the webpage. 

Finally, click the Done button to create the bookmark. 

∑ By default, the bookmarks are created in the Bookmarks bar. If you want to create the bookmark 

in a different folder, use the Folder or Edit button before clicking the Done button.

If you created the bookmark in the Bookmarks toolbar, you should see it on the toolbar, which is 

displayed just below the address bar. If you don’t see the Bookmarks toolbar, you may turn it on. 

∑ To turn on the Bookmarks toolbar in Firefox, right click an empty area on the tabs bar to display a 

menu and click Bookmarks Toolbar. In Chrome, use  to turn on the Bookmarks toolbar. (See 

Fig. 8.23.) Figure 8.25 displays a few bookmarks in a Chrome browser window. 

Fig. 8.25 Bookmarks bar displaying a few bookmarks in Chrome

After you have created bookmarks, you may open a bookmark, i.e., open the webpage represented by 

the bookmark from the Bookmarks toolbar or other bookmarks folders. 

∑ If the bookmark is available on the Bookmarks bar (see Fig. 8.25), click the corresponding 

bookmark button to open the webpage. To open bookmarks stored in other folders, you can take 

the help of the Bookmarks/Other Bookmarks button displayed on the right of the Bookmarks 

toolbar. 

∑ An alternate way to access bookmarks in Firefox is through the Bookmarks sidebar that you may 

open by pressing Ctrl+B.

Tip You may reposition bookmark buttons on the Bookmarks toolbar by simple drag-and-drop.

8.14.2 Using Favorites in Internet Explorer 

Internet Explorer does not use Bookmarks; instead it uses Favorites, though both are functionally 

equivalent. 
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∑ To add the current website to the Favorites bar, click  (Add to Favorites Bar) located in the 

extreme left of the Favorites bar. Alternatively, press Ctrl+D to display the Add a Favorite dialog 

box shown in Fig. 8.26.

Fig. 8.26 Creating a Favorite (Bookmark) in Internet Explorer

∑ You may type a name for the favorite, if you prefer. By default, the favorite is created in the default 

folder called Favorites. To choose a different folder, click in the Create in box and choose the 

desired folder. You may even create a new folder, if required by using the New Folder button. 

Finally, click Add to create the favorite. 

∑ To open a website represented by a Favorite on the Favorites bar, click the corresponding button. 

To rename or deleted a favourite, right click the favourite and choose the corresponding command 

from the contextual menu. 

∑ To view, open or manage favorites not contained on the Favorites bar, open the Favorites Center 

(Internet Explorer 7 and later) by pressing Alt+C.

8.15 SAVING AND PRINTING INFORMATION FROM

 A WEBPAGE 

While viewing a page, if you come across some information on a page that you want to copy and use 

in some other document, your browser has some built-in tools to accomplish this.

Caution  Most webpages contain copyrighted material. Webpages usually display the copyright notice at 

the bottom of the page. The webpage owner may not care if you use a few words from the page 

into your document; however, copying the entire page may not be tolerated, and is against the 

copyright law.

8.15.1 Saving Text

Saving text from a webpage is quite simple:

® Drag the mouse to select the text you want to copy.

® Press Ctrl+C to copy the text into the Clipboard. You may also choose the Copy command from 

the contextual menu that you can display by right clicking the selected text.

® Switch to the word processor or open it, if required. Then open the document where you want to 

paste the text, move the cursor to the desired location and press Ctrl+V to paste the text you copied 

earlier from the webpage.
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8.15.2 Copying and Pasting an Image

You can copy an image from a webpage and paste it into a document with these steps: 

® Right click the image to display the contextual menu and choose the Copy command in Internet 

Explorer or Copy Image command in Firefox/Chrome.

® Switch to the document where you want to paste the image, and press Ctrl+V to paste the copied 

image.

Tip  Visit commons.wikimedia.org/wiki/ for freely usable images. It contains over 20 million images and 

new images are added everyday.

8.15.3 Saving an Image

You can save an image from a webpage to your computer with these steps:

 ® Right click the image to display the contextual menu.

 ® Choose the Save Image As command in Firefox/Chrome or Save Picture As command in 

Internet Explorer. The browser displays a dialog box to save the image, which also displays a 

default fi le name, fi le type and folder to save the image. 

 ® Type a new fi le name and/or choose a different folder, if required. The operation of the Save 

As dialog box is similar to the Save As dialog box you get when you save a new document in 

Word or Excel.

Tip  You can set an image you see on a webpage as you desktop background. To do this, right click the 

image to displays a shortcut menu and choose the Set As Background command in Internet Explorer 

or the Set As Desktop Background in Firefox.

8.15.4 Printing a Webpage

Printing a webpage requires no special technique—press the Ctrl+P shortcut keys or choose the Print 

command from the File menu/command bar, which is off by default. In response to this command, the 

browser displays the usual Print dialog box. If you prefer to precisely control the print output, you may 

use the Page Setup command (from the File menu/command bar) before printing the webpage. The 

Page Setup command enables you to defi ne margins, header, footer, orientation, etc. 

Sometimes when you print a webpage, the output you would see on the printer may be signifi cantly 

different from the displayed page. This happens if the webpage uses frames, a technology that lets the 

page be divided into independent boxes (frames), with each displaying a separate HTML document. 

Each frame in a webpage may have its own scroll bars, and when you scroll the webpage, the contents 

of the frames contained in the page do not move. If you do not see the correct printout when you print 

a webpage containing frames, click in the frame whose contents you want to print and try the Print 

command again. (You may like to use Print Preview before using the Print command.)

Tip  To help to properly print contents of a webpage employing frames, some webpages (e.g., mail.google.

com) include a Print button/link on the webpage. If a webpage contains a Print button/link, use it rather 

than the browser’s Print command to print the page.

8.15.5 Saving a Webpage

∑ If you want to save a webpage on your computer, press Ctrl+S or choose the Save Page As (Save 

As in Internet Explorer) command from the File menu. In response to this command, the browser 

displays a typical Save As dialog box. 
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8.16 BROWSING HISTORY 

The browser can remember all sites that you visit. This feature, which is on by default, can help you to 

quickly go to a webpage you visited during the last few days. You can access the list of URLs you have 

visited in a few different ways. 

8.16.1 Choosing a Web Address from the Drop-Down List

Internet Explorer and Firefox browsers can display the list of recently visited webpages in a drop-down 

list. 

∑ To view recently visited webpages, click the down pointing arrow located on the right side of the 

address box that displays the URL of the current webpage. (See Fig. 8.27.) Internet explorer too 

has a similar down-pointing arrow located on the right side of the address box. To choose a website 

displayed in the drop-down list, click the desired URL.

Fig. 8.27 Firefox displaying recently visited webpages

8.16.2 Browser Suggests URL (Web Address)

When you type URL in the Address bar, the browser usually suggests URLs matching the characters 

you have entered from the list of URLs you visited in the past in a drop-down list. Figure 8.28 

displays Internet Explorer offering a few suggestions for the web address being typed. You get similar 

functionality in Firefox and Chrome.

∑ To visit a webpage for the URL displayed in the drop-down list, click the corresponding URL. If 

do not want to use any of the suggested URLs, continue typing the URL. 

If you do not see any suggestions when you type the web address in the address bar in Internet Explorer, 

you need to turn on the AutoComplete option for Web Addresses. Perform the following steps to 

accomplish this: 

∑ Open the Internet Options dialog box from the Tools button/menu and choose the Content tab.
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Fig. 8.28 Firefox suggesting URLs

∑ Click the Settings button in the AutoComplete section to open the AutoComplete Settings dialog 

box. (See Fig. 8.29.)

∑ Check the Address bar, Browsing History and Favorites check boxes as shown in Fig. 8.29. 

Other check boxes are used to control the AutoComplete feature when you enter data, usernames 

and passwords in forms (to be discussed). 

∑ Click the OK button to close the AutoComplete Settings dialog box. Then click OK again to close 

the Internet Options dialog box.

Fig. 8.29 Controlling AutoComplete Settings in Internet Explorer
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8.17 LONG-TERM HISTORY 

The long-term history presents the list of webpages you have visited in the past few days in an organized 

manner. That is, you can view the pages you visited yesterday, two days ago, a week ago, and so on. The 

browser displays the list of URLs of webpages in a History sidebar or in a separate tab (in Chrome). 

∑ To display the History details, press Ctrl+H. Figure 8.30 displays the History sidebar for 

Firefox. 

∑ Firefox can display the history in fi ve different views that you may choose by clicking the View

button. 

The Search box located next to the View button is very useful—just type a few keystrokes for a keyword, 

e.g., Gov if you want to search for a website related to Government, and Firefox would refresh the 

History sidebar with matching webpages out of all webpages history available in your Firefox browser. 

Then you just need to click the desired link to open it. 

Fig. 8.30 History sidebar in Firefox

∑ To close the History sidebar, click the Close button (X) or press Ctrl+H. 

The History sidebar in Internet Explorer and Chrome is quite similar to that in Firefox. 

∑ To change the number of days the browser remembers the history, change the appropriate option 

in the browser options dialog box, e.g., on the Privacy tab in Firefox and Settings button on the 

General tab in Internet Explorer. 

∑ If you do not want to keep the history, you may choose 0 for the number of days or otherwise 

disable the option. 

8.17.1 Clearing Web Addresses History 

Since the web addresses history stored by the browser on a computer is visible to any user who has 

access to that computer, this raises the question of privacy. Of course, beyond privacy, a large web 

history takes space on the hard disk. The browser allows you to delete an individual history entry as 

well as clear the entire history in one stroke. 
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∑ While viewing the history in Firefox and Internet Explorer, you may right-click an item and choose 

the Delete command to delete the history entry or entries. The Chrome history page too displays 

links to remove an item from the history as well as to clear the entire browsing history. 

∑ To clear the entire browsing history in Internet Explorer and Firefox, use the Options and Internet 

Options dialog boxes, respectively. 

8.17.2 Opening Browser in Private Mode 

Sometimes you do not want to leave any trace of your web surfi ng or searches in the browsing history. 

To accomplish this, you may open the browser in private mode. Most browsers, including Internet 

Explorer 11, Firefox and Chrome support this mode. 

∑ To open Internet Explorer 9 and later for private browsing, press Ctrl+Shift+P. Figure 8.31 

displays Internet Explorer opened in private mode. Notice the InPrivate icon displayed to the left 

of the address box. 

∑ To work in the private mode, called the incognito mode in Chrome, start Chrome in the usual 

way and then press Ctrl+Shift+N or choose the New Incognito Window command from the 

Customize and Control Google Chrome button. 

Fig. 8.31 Internet Explorer operating in InPrivate mode

∑ To operate Firefox in private mode, press Ctrl+Shift+P. Fire Firefox may prompts for confi rmation. 

On choosing yes, it turns on the private browsing mode. 

8.18 PAGE LOADING ISSUES 

When you try to visit a webpage, if your computer is connected to the Internet and the page address 

is valid, usually the browser loads the page within reasonable time. The time it takes the browser 

to display the requested page depends on several factors, the most important being your Internet 

connection speed. Besides the Internet connection speed, other factors that affect the page display time 
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are volume of the Internet traffi c being handled by your Internet Service Provider (ISP) and number 

of people trying to access the website where the page you are trying to access is hosted. Because these 

conditions may change dynamically, some times a webpage may load fairly quickly whereas at other 

times, the load time may increase signifi cantly. 

If you try to load a page and you don’t see it in the browser for a long time, you may get impatient, 

and may even start wondering whether you are still connected to the Internet. In this situation, look at 

the animated icon at the left side of the tab shown in Fig. 8.32. The revolving circle icon indicates that 

the page loading is in progress. Firefox and Chrome also display similar icons on the tabs. 

Fig. 8.32 Viewing Page loading progress in Internet Explorer

If you turn on the Status bar, it also provide useful information regarding the page loading progress, 

such as “Looking for ...”, “Waiting for …”, “Transferring data from ….”. If you see some activity 

on the Status bar and the progress bar is moving, it means that the page is loading. However, if the 

progress bar is moving very slowly, it is an indication that some process in the page loading sequence 

is overloaded. You can’t do much to speedup the process, except waiting or stop loading the page.

Note Google Chrome displays browser activity in a popup status bar.

8.18.1 Stop Loading a Page

If a page is taking too long to load or you started loading an incorrect page, you may stop the loading 

process by pressing the Esc key or clicking the Stop button on the Address bar/box, which looks like 

“X”. After the page has been loaded, the browser replaces the Stop button with the Refresh/Reload 

button. 

8.18.2 Refreshing/Reloading a Page

The page displayed in the browser window is a static page. When you ask the browser to load a page, 

the browser sends a request for the page to your ISP, which in turn fetches that page from the server 

computer where the page is available and sends it to your browser to display, and the process fi nishes. 

Meanwhile, if the source page has changed, the page displayed in your browser does not change 

automatically. For instance, consider that you are viewing a page that displays the quote for a stock. 

Meanwhile the stock price has gone up or down, but the stock quote displayed on your browser window 

continues to show the old price. To get the latest stock quote, you need to refresh the page. 

∑ To refresh the current page, press the F5 key on the keyboard or click the Refresh/Reload button, 

which looks like .

You may also fi nd the browser refresh/reload feature useful if the page loading process stops without 

completely loading the page due to some unexplained reason.

8.18.3 Page Loading Errors Due to Problems at the Website

As you know that each webpage is hosted on a server computer, which sends back the requested 

webpage to your browser. If too many Internet users ask for the same page at the same time, the server 
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computer may become too busy to respond within acceptable time limit. In that event, the browser 

displays an error message and cancels the page load request. If the website hosting the page is too 

busy, retrying may load the page later. Sometimes, a website is temporarily taken off-line for software/

hardware maintenance or upgrade. In that event, you may try to reload the page after sometime. Usually, 

most routine website maintenance is done around midnight or during weekend. 

The website developers keep updating their websites, which results in new pages being created or 

existing pages moving from one folder to another. Sometimes, some websites are permanently taken 

down. When you enter the URL for a webpage or click a link that takes you to a page which is not 

available, the browser displays an error message, such as 

 ® The webpage cannot be found

 ® HTTP 404 Not Found

 ® Not Found

 ® The requested URL/homepage.html was not found on this server

8.19 GETTING HELP 

The browser has so many features that remembering all these is not an easy task. However, you need 

not worry as Firefox, Internet Explorer and Chrome provide an excellent online help documentation 

that you can access any time while using the browser. The Internet Explorer help documentation style 

resembles that for the help documentation for other Microsoft products, such as Word, Excel and 

PowerPoint. 

∑ To get help, all you need to do is press F1 or choose the Help command from the menu, and the 

browser opens the help window or displays the help information in a new tab. You may also do a 

web search for your question.

8.20 CHANGING TEXT SIZE IN THE BROWSER WINDOW 

Website designers are free to use any font style and font size to display text on webpages. Sometimes, 

to display large amount of text on a page, the designer may use very small font size. Some people may 

fi nd it hard to read text displayed in small size, whereas others may not like to read large size characters 

on the page. You can precisely control the size of the text displayed on a webpage. 

8.20.1 Controlling Text Size

∑ To increase the text size press Ctrl++ (press and hold the Ctrl key and then press the + key), or in 

Internet Explorer, open the View menu and choose the Text Size command. 

∑ To decrease the text size press Ctrl+-, or in Internet Explorer, open the View menu and choose the 

Text Size command. 

∑ If your mouse has the scroll wheel, press and hold down the Ctrl key and scroll the mouse wheel 

to change the zoom percentage

∑ To display the page in the normal size, press Ctrl+0. 

∑ Internet Explorer displays a Change Zoom Level button on the right side of the Status bar. This 

button can help you to quickly set the zoom level to 50%, 75%, 100%, 125%, 150%, 200% and 

400% as well as to choose the custom zoom level. 
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∑ On laptops and other devices equipped with touchpad, you may be able zoom the page using 

two fi ngers pinch zoom, as shown in Figure 8.33. As illustrated in the Figure, to zoom using this 

scheme, place two fi ngers slightly separated on the touchpad. Move (drag) the fi ngers outward to 

zoom-in, and to zoom-out, move the fi ngers toward each other.

Fig. 8.33 Two fi ngers pinch zoom on touchpad

Note  Some webpages, particularly those that display news may display buttons to enlarge/reduce text 

size. 

8.21 BLOCKING POP-UPS 

The pop-up is a window that appears on the top of the browser window. A variation of the pop-up 

window is called pop-under, which appears below the browser window. Both pop-ups and pop-unders 

usually appear without your permission and often contain advertisements or other contents of nuisance 

value. Most current browsers, including Firefox, Chrome and Internet Explorer 7 and higher have built-

in mechanism to block pop-ups and pop-unders. No browser can always block all pop-ups as pop-up 

creators may use some technique to bypass the pop-up blocker fi lter employed by the browser. Besides, 

you should remember that some websites, particularly those that involve credit card payments, make 

legitimate use of pop-ups. By default, the pop-up blocker is enabled in Chrome, Firefox and Internet 

Explorer 7 and higher. If you are seeing pop-ups on your browser window, please check if someone has 

turned off the pop-up blocker feature. 

∑ In Internet Explorer 7 and higher, on the Privacy tab of the Internet Options dialog box, ensure that 

“Turn on Pop-up Blocker” check box is checked (�).

∑ In Firefox, on the Content category of the Options dialog box, ensure that “Block popup windows” 

check box is checked (�).

8.21.1 Managing Popup Blocker Options

When the popup blocker is enabled, if a website tries to open a pop-up (or pop-under) and the browser 

is able to block it, it usually displays a suitable message and gives you an option to override the block, 

i.e., allow the website to open the popup. 

Note  Advanced users may achieve greater control on pop-ups blocking by choosing the pop-up blocker 

fi lter level through the Settings button on the Privacy tab of the Internet Options dialog box. 
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8.22 FORMS ON WEBPAGES 

Most webpages display information in the browser window, however, some pages are designed to 

accept information from you and send it to the web server. (The web server is the software/computer 

which sends the webpage to your browser based on the request it receives from the browser.) Let us 

assume that you want to book a train or air ticket. Obviously, you need to provide the relevant booking 

information to the web server to perform the booking. Similarly, if you want to fi nd the fl ight or train 

arrival information from a website, you need to provide the fl ight/train number. In a typical scenario, 

you enter the required details (e.g., fl ight number and date) in a webpage in a form and send it to the 

web server. The web server accepts the sent information, processes it and sends the result (e.g., fl ight 

arrival time) to your browser, which in turn displays it on the browser window. Figure 8.34 displays 

a page that uses a form. The sample form shown in fi gure contains a few input boxes to select/type 

information, such as from and to city, departure and arrival date, number of passengers, etc., to fi nd the 

available fl ights. For accepting information that has limited choices, e.g., city names, number of adults, 

etc., the form uses a drop-down list box. A typical form uses one or more buttons. The Find button on 

the form used in Fig. 8.34 sends the entered details to the web server, which accepts and processes the 

entered details and sends the list of available fl ights to the browser to display. The button that sends 

the data to the web server may have any caption—Submit, Find and Go being common captions. 

Sometimes an image button is used in place of the text button to send (submit) data to the web server. 

Sometimes, the form may have a Clear Data button to clear all data entered in the form. A form may 

use other types of visual objects to accept information from the user. Some of commonly used objects 

are check box, radio button, group button, spinner, slider and calendar.

Fig. 8.34 A webpage containing a form

8.23 SECURE WEBPAGES 

As you know, when you enter information in a form on a webpage and submit it, the information travels 

from your computer on the Internet to web server, which may be located anywhere in the world. The 

information is sent as plain text which can easily be intercepted as it fl ows from your computer to 
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the web server. However, you would not like anyone to know your bank account number, credit card 

details, etc. when you enter these on a web form. You need not worry as most websites that ask for 

sensitive information through a web form use a special protocol called HTTPS (Hypertext Transfer 

Protocol over Secure Socket Layer) as against HTTP (Hypertext Transfer Protocol) used by regular 

websites. When a browser communicates with a secure website using HTTPS protocol, it encrypts

the information before sending. The website that receives the information decrypts and uses it. In 

the same way, the browser decrypts an encrypted webpage sent by the website before displaying it 

in the browser window. The websites that use HTTPS protocol use HTTPS in the URL, e.g. https://

secure.icicidirect.com/NewSiteTrading/customer/logon.asp. Figure 8.35 displays a secure (https) 

webpage in a browser window. Notice that a secure page URL is displayed with a closed lock icon in 

the address bar. You may click the Lock icon to view details regarding the authority who issued the 

security certifi cate and certifi cate details. 

Caution  Never enter any private/sensitive information in a web form if the webpage is not using HTTPS 

protocol and you do not see the closed lock icon. In case of doubt, view the certifi cate details by 

clicking the Lock icon.

Fig. 8.35 A secure (https) webpage displayed in a browser window

You should not get a false sense of security that any information entered in a secure page is 100% 

safe. A secure page only ensures that the information cannot be intercepted while it travels between 

your computer and the web server. However, unauthorized people/computers can still steal sensitive 

information from the web server where the information is stored temporarily or permanently.

8.24 ASKING THE BROWSER TO REMEMBER THE FORM DATA 

Assume that you regularly use a website to buy items. Every time you purchase an item, you need 

to provide your name, billing address, shipping address, etc. Instead of manually entering the same 

information on the form, you can take the help of the browser to fi ll-out forms for you. Most browsers 

support this feature. If you ask the browser to remember the form data, it would provide you suggestion(s) 
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as soon as you start typing data in a fi eld. Then you may click the suggestion to accept it or continue 

typing. Figure 8.36 displays Internet Explorer making a suggestion while entering data in a form. 

Fig. 8.36 The browser helping to fi ll data in a form

∑ To turn on this feature in Internet Explorer, open the Internet Options dialog box and choose 

the Content tab. Then click the Settings button in the AutoComplete section to display the 

AutoComplete Settings dialog box (See Fig. 8.29) and check the Forms checkbox.

∑ To turn on this feature in Firefox, use the Tools menu or the Firefox button to open the Options 

dialog box and choose the Remember History option in the History section on the Privacy tab.

8.25 ASKING BROWSER TO REMEMBER PASSWORDS 

These days, several websites ask you to register and log-in before granting you the access. To register to 

a website, you need to choose a username (or email address) and password, which you need to remember 

to log-in later. To make the process more complicated, many websites put certain restrictions on the 

minimum length and the type of characters you can use in a password. Who can remember dozens of 

these passwords? When you enter a password, if your browser asks if you want it to remember/save the 

password, the remember password feature is already on; otherwise, you can turn it on.

∑ To ask Firefox to remember passwords, use the Firefox button or the Tools menu to open the 

Options dialog box and click the Security icon to display the options for the Security category, 

shown in Fig. 8.37. If the option Remember passwords for sites is not checked, click to check it. 

Finally, click OK to close the dialog box.

∑ To ask Internet Explorer to remember passwords, ensure that User names and passwords on 

forms checkbox is checked on the AutoComplete Settings dialog box. (See Fig. 8.29.) For safety, 

you may also like to keep Ask me before saving password checkbox checked. 

∑ In Chrome, the corresponding settings for saving passwords are available in the Advanced Settings. 

Use the Customize and Control Google Chrome button to open the Settings page and click 

Show advanced settings located at the bottom of the page.

After you have turned on saving passwords, when you visit a website that requires log-in and you enter 

the username and password, the browser prompts if you want to save the password.
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Fig. 8.37 Remembering Passwords in Firefox

Passwords are saved by the browser in quite secured manner. Internet Explorer and Chrome do not 

provide any option to view the saved passwords; however, third party programs may be able to reveal 

saved passwords. Firefox has an option to view saved password through the Saved Passwords button 

(see Fig. 8.37), which can be unsafe if other users can access your computer. In that event, for security, 

you must use the Master Password. 

∑ To set a master password in Firefox, check the Use a master password checkbox (See Fig. 8.37.) 

On choosing to use a master password, Firefox asks you to defi ne a master password. After a master 

password has been set, you need to provide the master password to view saved passwords. 

Caution Do not save password for sites that contain sensitive personal or fi nancial information.

8.26 COOKIES 

Each webpage displayed in a browser window is just a bunch of text, images and similar information. 

The page display process is a stateless transaction, i.e., the fi rst page retrieval by a browser from a 

website is not linked to the second page retrieval. Now, assume that you are trying to buy items from 

an online shopping website and in the process search the website and add one item at a time. As you 

choose items and add these to your online shopping cart, the website needs to refresh the webpage to 

display your current selection. Since, the webpage display is an isolated event, how does the website 

know your previous selections? (And remember that a website might be serving thousands of users like 

you at a time.) To solve this problem, websites create a simple text fi le, called cookies (also known as 
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web cookies or tracking cookies) on your computer. Besides storing the website address, the website 

stores the required information, such as a unique user ID, list of selected items, quantities, etc., in a 

cookies text fi le. When you move from one webpage to another of a website, the cookies fi le is also 

transferred between the website and your browser. The website updates the cookies fi le as required. 

Websites use cookies for other uses too. One common use of a cookie is to track visits to a website. 

If you have never visited a website, obviously, no cookie exists for that website on your computer. 

When you visit that website for the fi rst time, it generates a unique ID for your visit and creates a 

cookie on your computer. It also records that unique ID in a database maintained at the web server. 

Now, when you visit that website again, your browser sends the cookie to the website. Since the cookie 

contains a unique ID linked to your computer (which is basically you), it can track how often you visit 

the website, and customize the webpage sent to your browser based on your visit pattern. 

Some websites let you make some selections to provide customized webpages. For instance, if you 

select Delhi as your place of residence in a shopping website, it may offer you more products from 

vendors who have stores/warehouses in or around Delhi. Similarly, a search website may allow you 

to choose a language to offer you search webpages only for that language. The website can remember 

your choices by storing these in a cookie fi le. Thus, when you visit the website again, your browser will 

send the cookie fi le to the website, which in turn can analyze it to customize the webpage for you. 

Cookies are also used to automatically login you to a website. A website may store the login 

information in a cookie fi le. When you revisit the website, the cookie fi le containing login details is 

sent to website, and it can use these detail to automatically log you in. However, automatic login using 

cookies is used only by websites that don’t use sensitive data. 

8.26.1 Are Cookies Safe? 

Websites can store all kinds of information, which may include your name, email address, city, etc., 

in a cookie fi le. However, it can store only the information you provide, therefore, if you do not enter 

your credit card information in a webpage, the website cannot store it in a cookie fi le. Besides, a cookie 

is a text fi le, not a program; therefore, generally it is safe to allow websites to create cookies on your 

computer. Moreover, these days, most websites use cookies; therefore, if you do not let websites create 

cookies, you won’t be able to use many of these websites. 

8.27 TEMPORARY INTERNET FILES/CACHE 

As you know, when you visit a webpage, the browser retrieves it from the web server and displays it 

in the browser window. That is, to display each page, it has to fetch it from the web server over the 

Internet. Since the contents of each page have to travel from the web server to your computer over the 

Internet, it may increase the network traffi c and slow down the page display process. Now assume that 

after viewing a page, you click a link to go to another page, and then click the Back button to re-display 

the fi rst page. That is you want to view a webpage that your browser fetched a few seconds ago from the 

web server. It seems like wasting network resources re-fetching the page again a few seconds later.

To reduce the network traffi c and to increase the speed of display of webpages, browser makes a 

copy of webpages you visit. The browser stores copies of the webpages you visit in a temporary folder 

on your hard disk, which is also cache. When you ask the browser to display a webpage, it checks if 

that page is already available in the cache; if yes it provides the webpage from the cache available on 

your computer rather that downloading it from the web server over the Internet. This process of using 

cache signifi cantly improves browsing performance. 
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The browser automatically maintains the cache/temporary internet fi les, and automatically removes 

old fi les from the cache and stores new fi les, as you visit websites. You can improve the browsing 

performance by allocating larger hard disk space for the cache, if you have extra hard disk space to 

spare. Typical amount of space allocated to the cache is 50–250MB, which is good for most users, 

however, you can change the allocated space through the browser options/settings. 

8.28 WHAT IS DOWNLOADING AND UPLOADING? 

When the Web started expanding, websites started offering fi les for download. Downloading a fi le 

means receiving the fi le from the website to your computer through the Internet. In other words, the 

Internet lets you read the fi le from the website and save on your computer. Once the fi le has been saved 

on your computer, you may use it. What you can do with a downloaded fi le depends on the type of fi le. 

These days, all sorts of fi les are available for download, such as a text document, image, PDF (Portable 

Document Format) fi le, installable software, audio and video fi les, etc. Thus, if the downloaded fi le is 

a document or image, you may open to view it; if it is program fi le, you may run or install it, and you 

can play a music fi le, and so on. 

Uploading is the reverse process of downloading, i.e., you transfer a fi le from your computer to 

a website. Though uploading is not as common as downloading, it is gaining popularity. The most 

common use of uploading by common Internet users is employed by websites offering digital picture 

printing. These websites allow customers to upload digital pictures for printing. Customer can pay for 

prints through credit card or other online payment systems. The printed pictures are usually sent by 

mail. The Internet users also use uploading when they want to share their pictures and videos. Social 

networking websites, e.g., Facebook and Google+ also let users upload pictures and videos.

Caution  You should be very careful when you download fi les from unknown websites. Downloaded fi les 

have inherent security risk of containing virus, spyware, adware and malicious code that may 

cause nuisance or ever temporary or permanent damage to your computer. Therefore, avoid 

downloading fi les from websites you do not trust.

8.28.1 Downloading Files in Internet Explorer 

Internet Explorer can help you to download a fi le and save it in a specifi ed folder on your computer. 

When a website offers a fi le for download, usually it displays a button or link. If it is a simple download, 

the download should start when you click the button or link. However, if the download fi le depends 

on the type of browser or operating system it will be used with, the website displays a list of options. 

Then, depending on your requirements, you may need to click the appropriate button/link to initiate the 

download. As downloading a fi le to your computer can be harmful to your computer, Internet Explorer 

asks you to confi rm your action, as shown in Fig. 8.38. Notice that the File Download dialog box 

displays the name and type of the fi le, and the website you are downloading from. The Open link/button 

downloads the fi le from the website in a temporary folder and opens it with an associated program, 

whereas the Save/Save As link/button downloads the fi le and saves it in a folder. For safety reasons, 

it is better to save the fi le to your computer and scan it with an antivirus (virus scanner) program 

before opening it. This may help catch a potentially dangerous fi le before it causes any damage to your 

computer.
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Fig. 8.38 Downloading a fi le in Internet Explorer

Note  If you are downloading an executable fi le (.exe), the File Download dialog box replaces the Open 

button with Run. Though you may click the Run button to directly download and run the program, it 

is recommended to save it to your computer, scan it with a virus scanner and then run it if everything 

is okay. 

Internet Explorer starts the download and when the download is complete, it displays the confi rmation 

box as displayed here. 

Now you may use the Open button to open the downloaded fi le. The Open Folder button displays the 

folder where the fi le has been downloaded. 

If you download a zip (compressed) fi le and view it in the folder where it is saved, it is shown as 

a compressed (zipped) folder icon ( ). A compressed (zipped) fi le contains one or more fi les and/

or folders. When you open a compressed fi le, Windows unzips it to reveal the fi les contained in it. 

Windows XP and newer operating systems contain a built-in program to unzip compressed (.zip) fi les. 

If you don’t have an unzipping program on your computer, you may get one for free from www.7-zip.

org/. 

8.28.2 Downloading Files in Firefox and Chrome 

Downloading fi les in Firefox and Chrome is similar to that in Internet Explorer. Figure 8.39 displays 

a fi le being downloaded in Firefox. Both, Firefox and Chrome have a default location for saving the 

downloaded fi les that you can change. To manage the downloaded fi les, press Ctrl+J, which also works 

in Internet Explorer. You can use it to view list of downloaded fi les, downloads in progress, open fi les, 

remove/delete downloaded fi les from the list, etc.
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Fig. 8.39 Downloading a fi le in Firefox

8.28.3 Downloading and Installing a Program

Besides offering documents, text, spreadsheet, PDF fi les, etc., fi les for download, websites also offer 

program fi les for download. There is a basic difference between the two types of fi les—you can directly 

open documents, text, spreadsheet, PDF fi les, etc., fi les after download with the corresponding program, 

whereas you need to install the program fi les. Downloading and installing a program typically requires 

the following steps: 

∑ Download the program fi le to your computer 

∑ Uncompress/unzip the fi le, if required

∑ Scan for viruses

∑ Install and confi gure the program 

Most of the programs which are offered for download for the Windows operating system usually have 

the extension .msi (Microsoft Installer or Windows Installer) or .exe (executable). These fi les are self-

installing, i.e., these do everything required, such us unzipping, extracting and installing the program—

all you need to do is just open (run) the downloaded fi le. On the other hand, if the downloaded fi le is 

offered as a zip fi le, you need to unzip (open) the zipped fi le and look for fi le to be used for installation. 

Look for a fi le named as Readme.doc or Readme.txt for instructions. 

8.29 UPLOADING FILES 

The Internet users are uploading various kinds of fi les in increasing numbers. Ordinary Internet users 

typically upload pictures, videos and music fi les to share with others. Web developers upload webpages 

and database tables to their web servers. To enable ordinary users to upload fi les, the webpage usually 

implements the required scheme on the webpage itself. A typical scheme involves the following steps: 

∑ Visit the webpage and log-in to your account 

∑ Choose fi les to be uploaded 

∑ Click a button/link to upload fi les
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To make the upload process user-friendly and quicker, some websites, e.g., Flickr (www.Flickr.

com) and Picasa (picasa.google.com) offer a special program. To use the special program, you may 

need to download and install it on your computer. 

8.29.1 Using FTP to Upload/Download Files 

Files for website design are normally uploaded by developers through FTP (File Transfer Protocol). This 

process requires running a program on the local computer and establishing a connection to the remote 

computer where the website is hosted. To establish a connection, you need to provide the URL address, 

username and password. (Username and password ensure that only authorized persons are permitted 

to upload/download fi les.) After establishing a connection, rest of the process is quite simple—you 

just need to select the fi le(s) to be transferred and click the corresponding Upload/Download button or 

choose the required command from a menu. 

As you might have guessed, to transfer fi les through FTP, you need a program. Several commercial 

and free FTP programs are available. One excellent free, open-source FTP program is FileZilla, which 

may be downloaded from http://sourceforge.net/projects/fi lezilla/. 

8.30 WATCHING AND UPLOADING VIDEOS 

As the Internet connection speeds are improving, websites are putting more and more video contents on 

webpages. The video content is used for product information, demo and advertisement by commercial 

companies. Advertisements usually keep running continuously on the webpage, whereas product 

information/demo normally runs when the user clicks a button/link. Some websites also offer short 

video clips or even full length movies for free or paid download. Once downloaded on your computer, 

you use the Windows Media Player or some other media player to watch the video clip. We will 

talk about media players in the next Section. For now, let us have a look the YouTube website that 

helps you to search and view videos, as well as to upload videos. The URL for the YouTube website

is www.youtube.com (See Fig. 8.40.) 

Fig. 8.40 YouTube—search, watch and upload videos
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Note YouTube has a special website for India at in.youtube.com

Searching, watching and uploading videos in YouTube are very simple. 

∑ To search for a video, enter the search keywords in the Search box and click the Search button (see 

Fig. 8.40), and the webpage displays brief description about the matching videos. 

∑ To watch a video, just click the video’s thumbnail graphic or the link, and the website launches the 

video in a video player displayed on the webpage. The video player has play, pause, and volume 

control buttons. You may even watch the video on full screen. 

If you have a video that you want to share with your friends or even the entire world, YouTube lets you 

do this with ease. 

∑ To upload a video, you need to log-in to YouTube with your Google account. If you have a 

Google Mail account, you already have a Google account, otherwise create a Google account (see

Section 9.1). 

∑ After successful login, click the Upload button and YouTube displays a form where you choose 

the fi le to upload and enter details such as, Title, Description, Video Category and Tags about 

the video. In addition to these, you may also provide additional optional details, such as date, 

location and whether the video is for private viewing or for public viewing. When the uploading is 

complete, YouTube displays a confi rmation and link for the video. 

Tip YouTube also lets you directly capture and upload a video using a webcam (Web Camera). 

8.31 AUDIO AND VIDEO ON THE WEB 

Lots of audio and video information is fl oating around on the web. You may listen/watch this in several 

different ways: 

∑ Connect to the website and listen the audio or watch the video

∑ Listen to live music and other contents on an Internet Radio

∑ Download free/paid music/video programs from an Internet website and listen to/watch it using a 

media player

Media Player is a program that can play different types of audio and video fi les. Some of the common 

media players are Windows Media Player (see Section 2.32.), RealNetworks’ RealPlayer and Apple’s 

iTunes. Digital media fi les are created in various formats, such as MP3, WAV, WMA, WMV, AVI, 

etc. Most media players are able to play fi les created in most common formats, however, some media 

player, e.g., Apple’s iTunes use custom formats that may not work on other media players. 

Apple’s iTunes media player is very versatile and is available for Mac as well as Windows PCs. 

You can download iTunes from www.apple.com/itunes/download/. iTunes can play audio and video 

digital fi les stored in most common formats. It has all the features of Windows Media Player and 

RealPlayer, including copying music from an audio CD into library, creating playlists, Internet radio, 

burning music into CDs, and of course buying music and other material from Apple’s iTunes Store. 

Another interesting feature of iTunes is free Podcasts that you download and listen on your computer 

or other portable devices. 
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Note  If you buy and download music from iTunes Store, you can play it in iTunes media player or transfer 

it to iPod/iPhone. However, you won’t be able to transfer it on a regular MP3 player, as Apple uses 

a different digital audio format (.m4p).

8.31.1 Listening to Music from a Website

Some websites enable you to listen to music. You can listen to the music; however, you cannot download 

it to your computer. The music is played on a special media player, which is either embedded on the 

webpage or is automatically opened in a separate window by the website. Since the website sends the 

music to the media player over the Internet, you have to be online and connected to the website in 

order to continue to listen to the music. The website providing the music or other audio content may 

be serving several users at a time, and the Internet traffi c may vary from time to time, therefore, it uses 

a streaming technology. In this technology, the media player that plays music on your computer has 

some memory (buffer). The website keeps delivering the audio content to the media player for storing 

into the buffer, while the media player plays audio from the buffer. This way, even if the content being 

delivered to your computer stops for a few seconds, you can continue to listen uninterrupted. However, 

if the site offering the audio content becomes too busy, or your Internet connection becomes slow, you 

may experience break in the audio. To listen to Indian music, you may try www.saregama.com and 

www.saavn.com. 

8.31.2 Internet Radio

Internet Radio websites bring live as well as previously broadcasted program to your computer. These 

websites provide program to your browser in the streaming mode. If you have broadband connection, 

you should be able to listen to Internet radio without any interruption most of the time.

Many public radio stations have links on their websites to listen to their programs. For a list of 

Internet radio stations, you may visit http://en.wikipedia.org/wiki/List_of_Internet_stations. Of 

course, if you search the web, you will fi nd many more sites offering the Internet radio. Many Internet 

radio stations are available only through Internet and not through regular broadcast, as it is much 

cheaper to set up an Internet radio station as compared to a broadcasting station. You may be able to 

play an Internet Radio station on a media player. While access to most Internet radio stations is free, 

some may require subscription. 

8.31.3 Podcast

Podcast enables digital media fi les to be distributed over the Internet. Podcast fi les, which are free, may 

contain audio as well as video content. One interesting feature of podcast is that if you like a program 

available through podcast, you can subscribe to it. Later, whenever the new episode of that program 

becomes available, the podcasting client automatically downloads it. The most popular podcasting 

client is Apple’s iTunes player, through other clients are also available. 

8.31.4 Download Music from a Website

Downloading music from a website is not much different from downloading any other type of fi le. 

If the website is offering the music for free, usually downloading involves clicking a link/button and 

saving the fi le in a folder on the computer. After the fi le has been saved in a folder, you can play the 

downloaded fi le using a media player of your choice. 
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8.32 SHOPPING ON THE WEB 

The Internet has become a huge market place, which allows users to buy all kinds of stuff, including 

books, music, gifts, clothes, electronics, train/bus/air tickets, etc., from the convenience of one’s home 

or offi ce. Online shopping has many advantages over a physical trip to the store:

∑ It saves you hassle of driving to the store. It also saves you travel time and driving cost.

∑ Online stores are open 24 hours a day, so you may shop whenever you have time.

∑ Prices at the online stores are fi xed, so there is no need to bargain to get the best prices. Besides, 

you can always check the price at more than one website to get the best deal. 

∑ The online store may be able to offer much wider selection. Usually the prices at the online stores 

are lower than those offered at regular shops. Online stores are able to offer better prices as they 

do not have pay high rents to set up shops in commercial areas. 

∑ Sometimes it may be very diffi cult to fi nd an item at a local store. For instance, once I needed a 

battery for an old cordless phone. I could not fi nd that battery in my neighborhood shops; however, 

it took me a quick search on the Internet to fi nd an online store that had it.

In spite of all these advantages, many people still have not started online shopping because

∑ One cannot physically see and try the stuff before buying. 

∑ Also, if the item bought from an online store becomes defective during shipping or needs repairs 

during warranty period, there is a hassle of sending it back for repairs/exchange.

∑ Some people still do not have 100% faith in paying by credit card on a website. 

∑ Some people enjoy bargaining, which they cannot do on an online store.

These days, almost anything is available for buying at the online websites. However, some items are 

more popular with online shoppers, which include books, CDs, computers, digital cameras, mobile 

phones, gifts, toys and clothes. Dell computers became the number 1 computer manufacturer in the 

world by selling their computers through online websites and phone. Two more categories—online 

tickets and hotel room booking—have captured a major share from traditional booking methods. 

Airlines particularly like the online booking and sale of tickets, as they save on man-power and improve 

their bottom line. 

8.32.1 How to do Online Shopping?

When you decide to buy something online, make sure that you know exactly what you want to buy. Do 

your research on the Internet to get as much details as possible. If you are buying an electronic item, 

try to get its model number. 

After you know what you want to buy, visit the online website. You may fi nd hundreds of websites 

selling the item you want, if you are buying a common item. You may do web search to fi nd online 

stores, or your friends/colleagues may recommend an online website. To buy items at an online store, 

you usually need to register and login. During the registration process, you provide your name, email 

address, password, billing address, etc., so that the online website can positively identify the buyer. The 

login process usually requires you to provide your email address/username and password to identify 

you.

After you have logged in to the online website, the actual buying process will be different for 

different sites. However, in a typical website, you search one item at a time and add it to an online 
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shopping cart. The website enables you to view your shopping cart, remove an item or change the 

quantity you want to buy for an item. Figure 8.41 displays a shopping cart with two items for an online 

website. Notice the Remove Item button on the right side of each item line, which may be used to 

remove an item from the shopping cart. As you remove an item or change the quantity, the website 

may automatically refresh the page to display the revised amounts, or you may need to click a button 

to manually refresh it. 

Fig. 8.41 Shopping cart for an online website

After you have fi nalized the items you want to buy and added these to the shopping cart, you typically 

click a button to proceed to check out. In this step, you provide the shipping and billing address and 

other instructions, and make the payment. In a typical payment process, either you provide the credit 

card details directly to the vendor’s website or it may take you to a third party payment gateway to 

accept payment. If your payment gets approved, the website displays a confi rmation message and also 

sends you a confi rmation email. Usually, the online website ships the items within a few days. 

8.32.2 Shopping on eBay

eBay (www.ebay.com) and eBay India (www.ebay.in) provide a different kind of online shopping 

experience. eBay is owned by eBay Inc., a USA company that manages online auction and shopping 

websites. The eBay website lets any individual or company to offer goods and services for sale by 

auction as well as at predetermined price. Similarly, the buyer can bid for items listed on the eBay 

website. If an item is available for outright purchase, the buyer can buy it immediately without going 

through the auction process. eBay is particularly useful for individuals who want to get rid of their 

unwanted items, as well as for small business companies who cannot afford to setup their own online 

websites. 
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8.33 INTERNET BANKING 

Most banks now offer Internet banking, which is also known by other names, such as online banking, 

net banking and NetBanking. Internet banking is a win-win situation for both banks as well as their 

customers. By offering services through Internet banking, banks can save costs, as it is much cheaper 

to serve customers through a website as compared to doing the same through bank employees, or even 

through Automatic Teller Machines (ATMs). For customers, it offers the convenience of doing banking 

24 hours a day from the comfort of their home/offi ce. Internet Banking saves customers time and 

money, as they do not have to visit the bank branch and wait in queue for their turn. 

The services offered for Internet banking by different banks varies; however, you can expect the 

following services from a typical bank: 

∑ View account balances, recent transactions and statements. If you maintain credit card and/or 

Demat account with the same bank, you may be able to view these accounts too. 

∑ Print/download account statements

∑ Transfer funds between accounts

∑ Transfer funds from an account to create a fi xed deposit 

∑ Request a demand draft

∑ Request stop payment for a cheque

∑ Order a cheque book

∑ Pay bills

∑ Learn about services offered by the bank 

To know more about the services offered by your bank for Internet banking, visit your bank’s website 

or branch. The website may also have a demo on Internet banking. 

Before you can use Internet banking, you need to register for it. Contact your bank branch for details. 

The registration process is usually cumbersome and may take a few days. You may have to physically 

visit the branch to complete the registration process and to collect username/user ID and password. 

To begin your Internet banking experience, you fi rst need to login to your bank’s website with your 

user name/ID and password. After a successful login, the website gives you access to your account(s) 

details. As each bank’s website for Internet banking is different, what you see after successful login 

signifi cantly differs from one website to another. Figure 8.42 displays the opening webpage of a typical 

bank’s website after successful login. 

The webpage shown in Fig. 8.42 displays the summary of all accounts held by the account holder 

with the bank. The left and top side of the webpage contains links to accomplish common activities, such 

as Pay Bills, Transfer funds, open accounts, etc. The webpage enables you to view detailed transactions 

for each account by clicking the link displayed on the page. The website can usually display account 

statement for the past few months. If you like, you can print the account statement, or download it to 

your computer for record keeping or analysis. 

8.33.1 Transferring Funds between Accounts

These days, many customers maintain more than one account at a bank. For instance, you may have 

savings, chequing, investment (Demat) and fi xed deposits accounts at your bank. Internet banking 

allows easy transfer of funds from one account to another. Whereas the exact steps one needs to follow 

to transfer funds would differ from one bank’s website to another, here are the typical steps: 

∑ Choose the Transfer Fund link/button. Your bank’s website may call it something different
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Fig. 8.42 Opening page of a bank’s website

∑ Choose the account you want to transfer money from 

∑ Choose the account you want to transfer money to

∑ Enter the amount you want to transfer

∑ Click the Submit/Continue button

∑ The website displays the transaction you want to perform and asks you to confi rm by clicking the 

Confi rm button 

∑ The website performs the transfer and may display you a confi rmation number 

Depending on the type of transfer and time of the day, the transfer may refl ect in your account 

immediately or after some time. Whereas the Internet banking websites of all banks allow transfer of 

funds from one account to another held at the same bank, some banks may also allow transfer of funds 

to a third party account. 

8.33.2 Online Bills Payment

Your bank’s website can let you pay bills online. You may be able to pay bills for most utilities companies, 

such as electricity, water, telephone and cable online. Most credit card and fi nancing companies also 

allow online payments of bills. Before you can pay a bill online, you need to register it, which typically 

involves selecting the payee (billing company) and your bill account number. This step ensures that 

the amount you pay to the billing company gets credited to your account. The banking website lets you 

register your bills. After you have registered the bill, a typical online bill payment is not signifi cantly 

different from transferring money from one account to another. You may be able to choose a future date 

for making the payment. 



Internet and Web Browsers    443 4 

8.33.3 Other Online Banking Services

Your bank may provide a number of other services through the online banking website, such as 

∑ Open a new account

∑ Create a fi xed deposit/PPF account 

∑ Pay taxes

∑ Buy mutual funds

∑ Request a demand draft/gift cards

∑ Recharge pre-paid mobile phones

∑ Request stop payment for a cheque

∑ Order a cheque book

8.34 INVESTING MONEY ONLINE 

If you want to invest money in Shares, Mutual funds, National Savings Certifi cates, etc., the Internet 

can help you get valuable information as well as to actually perform the transaction online. If your 

bank provides investment services, its regular Internet banking website may have links to do online 

investment. Some banks/fi nancial institutions may have a separate website for online investing. 

The investment banking website typically contains educational information that may help you to 

make an investment decision. For instance, if you want to buy a share, it may provide fi nancial reports 

for previous years, historical data for the share price, analysis reports from independent analysts, 

etc. The website typically also provides delayed/live quotes for shares. Similarly for mutual funds, it 

typically provides NAV (Net Asset Value), fund category, pay-out ratios, etc. 

Like a regular banking website, the online investment website too provides information about 

your holdings, and enables you to buy or sell your investment. Figure 8.43 displays shares holdings 

Fig. 8.43 The webpage displaying share holdings and their market value
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(portfolio) for an account and their current market value. The current market value is based on real-

time share quotes from the associated stock exchange for each stock. The buy/sell link takes you to a 

webpage where you can enter a buy/sell order. You may also click the Buy or Sell links located in the 

top portion of the webpage to buy/sell any stock. The buy/sell webpage displays real-time stock quotes 

to enable you to place your order. To pay for your order, you need money, and the website enables 

you to transfer money from your linked banking account. The investment website can send you order 

confi rmation via e-mail or SMS. Different investment websites have different features and capabilities. 

Refer to the help or demo link on the website for more details.

8.35 SECURITY CONSIDERATIONS FOR ONLINE FINANCIAL

 TRANSACTIONS 

While doing fi nancial transactions on an online website are very convenient for customers, it also opens 

doors for misuse and fraud by unauthorized users. You would not like others to see how much money 

you have in your bank account or which shares you hold in your investment account. And defi nitely, 

no one would even like to think about a situation where an unauthorized person transfers money out 

of your account. Therefore, you must take utmost care to protect your online accounts. Here are a few 

suggestions that may help to keep your accounts safe. 

∑ Do not share you username/ID and password with anyone. 

∑ Never use your name, date of birth or name of your family members as password.

∑ Do not use a short password, which is easy to crack. Make the password at least 8 characters 

long.

∑ Never use a word that can found in a dictionary as password. A typical password should consist of 

letters as well as numbers. Preferably, it should also include special characters, such as #, $, & and 

@, if allowed by the website. 

∑ Do not write down your password anywhere, defi nitely not in your wallet. Make an effort to 

remember your password. 

∑ Do not use the same password for every website. 

∑ Avoid using the banking/investment website on public computers, which may have hidden 

software to capture, store and send your username/ID and password to people who may then use 

that information to login to your account and misuse it.

∑ Similarly, avoid using your laptop PC to perform fi nancial transactions on public Wi-Fi networks 

in places like hotels and airports. If you have to use your computer at these places, make sure that 

your work only on secured websites (HTTPS). 

∑ Regularly check your account and if you notice any suspicious transactions, contact you bank 

immediately. 

∑ Be suspicious of any email that asks you to verify your account. 

8.36 USING INTERNET IN INDIAN LANGUAGES 

Though initially all Internet webpages were created in English, now webpages are being created in 

all languages, including Indian languages. Windows XP and later versions include built-in support 

for the devanagri script. If your computer is properly setup, you should be able to see devanagri text 

correctly in your browser window. To verify that your browser can display Hindi text properly, visit the 
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Government of India’s Hindi website at india.gov.in/hi or BBC’s Hindi website at www.bbc.co.uk/

hindi. Figure 8.44 displays a webpage from the National Portal of India website. If you can see the 

Hindi text correctly, you do not need to do anything. However, if you cannot see the Hindi text at all, 

perform the following steps: 

Fig. 8.44 A webpage displaying Hindi text

∑ In Firefox/Internet Explorer, open the View menu, choose Encoding/Character Encoding and 

then choose Unicode (UTF-8).

∑ In Chrome, click  and choose Tools, Encoding, Unicode (UTF-8).

8.37 INTERNET AUTOMATIC TRANSLATION SERVICE 

Some websites provide free translation service. These sites can translate a user entered text or the entire 

webpage. Two such free popular websites are translate.google.com and www.bing.com/translator.

The Google and Bing (Microsoft) translation services also support the Hindi. Figure 8.45 displays an 

English text translated into Hindi through Google Translate. 

∑ To perform a translation, type or paste the text in box, choose Translate From and Translate To

languages and then click the Translate button. 

The translation is done by a computer program; therefore, do not expect it to be perfect. 
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Fig. 8.45 Text translated by Google Translate

8.38 FINDING MAPS AND DRIVING DIRECTIONS ON INTERNET 

You can use the Internet to get free maps and driving directions. One of the best websites for this purpose 

is Google Maps (maps.google.com). The Google Maps site has maps for all countries, including India. 

To get the map, enter the full or partial address in the Search the Map textbox and click the Search Maps 

button. Other popular sites for maps and driving direction are Map Quest (www.mapquest.com) and 

Bing Maps (www.bing.com/maps). Other useful features available on the maps are street view, traffi c, 

weather and public transport information.

8.39 KEEPING YOUR PC SAFE 

To enjoy working on your computer and to keep the information stored in it safe, here are a few 

recommendations:

8.39.1 Install Anti-Virus Software 

Viruses and worms are software programs that can cause all sorts of problems on your computer—they 

can delete fi les, format your hard disk, make your computer slow, change fi les, or even make your PC 

unbootable. To protect your computer, you should be using a virus checking program all the time. That 

is, the virus program must be running all the time, scanning any fi le that you download or any program 

that you install. 

A number of antivirus programs are available—some require purchase (subscription) while others 

are free. Some of the popular commercial antivirus programs are McAfee VirusScan® Plus, Norton 

AntiVirus, Panda and NOD32 Antivirus. One good free antivirus program is AGV Free Anti-Virus 

which you can download from free.grisoft.com. When you install any antivirus software, make sure 

that you set it up for daily automatic updates. 
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8.39.2 Install Anti-Spyware/Adware Software 

Spyware programs get installed on your computer without your knowledge. The spyware does not 

spread like a virus; instead it usually gets installed when you download some free/shareware program 

from a website. Once the spyware gets installed on your computer, it can do a lot activities behind 

the scene, such as degradation of computer performance, report user’s web activity, redirect user to 

some other website, display pop-up advertisements, or even transmit sensitive information stored on 

the computer. Adware software, which also gets installed like spyware without the user’s knowledge 

automatically displays advertisements or downloads advertisements to the computer.

When you buy an anti-virus program, it usually contains anti-spyware and anti-adware programs. In 

addition, you may fi nd Spybot Search & Destroy, Spyware Doctor, SpywareGuard and Ad-Aware Free 

useful to detect and remove spyware/adware. 

8.39.3 Use Firewall 

As you know, through the Internet, you can connect to millions of computers located throughout the 

world. However, the reverse is also true, i.e., hackers, through those computers can also connect to 

your computer, and steal information from your computer, install virus, spyware, adware or malicious 

software on your computer, or even take the complete control of your computer. Once your computer is 

in the control of hackers or software installed by them, they can misuse its resources for sending spam

emails, spread virus, transmit your keyboard activities, etc. 

Firewall is a hardware and/or software that monitors and controls network traffi c passing through it. 

Thus, if you install a fi rewall between your computer and the Internet, it can block an attempt by other 

computers to gain access to your computer through the Internet. Similarly, a fi rewall may block the 

outgoing traffi c by a program (usually virus) running on your computer. 

For the safety of your computer and the information stored on it, it is highly recommended that you 

use a fi rewall. Recent Windows operating systems (Windows XP Service Pack 2, Windows Vista and 

Windows 7) include a built-in fi rewall. If you are not using any other fi rewall, you must turn on the 

Windows fi rewall. Besides the fi rewall included in Windows, a number of commercial as well as free 

fi rewalls are available. ZoneAlarm (www.zonealarm.com) offers a free fi rewall. Search the web of 

additional free fi rewalls. 

8.39.4 Avoid Using Administrative Account

Windows supports two types of accounts—administrative and standard. An administrative user can 

make all kinds of changes, such as changing security settings, installing and removing software, deleting 

system fi les, etc., which affects all users on the computer. Even a standard user can do almost anything 

an administrator user can do, except that Windows may ask for the password for an administrative 

account. Therefore, to keep the PC safe, it is recommended that each user account should be created 

as standard account. Besides, each user should use a password to prevent unauthorized access to the 

computer.
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E-MAIL AND SOCIAL 
NETWORKING

In this chapter, we will discuss the following topics:

Electronic Mail (E-mail)  �

Microsoft Outlook 2010 �

Setting up and Using Outlook  �

Yahoo! Mail �

Hotmail �

Outlook.com �

Google Mail (Gmail) �

Instant Messaging: Windows Live Messenger, Yahoo! Messenger  �

and Google Talk 

Social Networking Websites �

Microsoft Family Safety �

Google Drive �
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9.1 ELECTRONIC MAIL (E-MAIL) 

Electronic mail (e-mail or email) is one of the most common applications of the Internet. It enables 

you to send a message in electronic form to any user who has an e-mail address. E-mail works on the 

store and forward method, which may involve two or more mail-servers. The message is fi rst sent 

to the sender’s mail-server, which in turn sends it to the recipient’s mail server. The recipient’s mail 

server then delivers the message in the recipient’s mail box, and the recipient can read the message. 

Depending on the volume of messages being handled by the mail servers involved, the message may 

take just a few seconds to reach the recipient’s mail box, or it may take signifi cantly long time. Usually, 

most messages are delivered within a few seconds.

To send and manage e-mail messages, you need an e-mail program, which is also called e-mail client 

or Mail User Agent (MUA). Some of the popular e-mail programs are Microsoft Outlook, Microsoft 

Outlook Express, Windows Mail (for Windows Vista), Windows Live Mail, Mozilla Thunderbird, 

Eudora and Mail. These e-mail programs run on your computer to send, receive and manage e-mails. 

In addition to e-mail client programs, you can also perform e-mail functions through webmail (Web 

based e-mail) via a web browser. Some of the popular webmail service providers are Hotmail, Yahoo! 

Mail, Gmail, Outlook.com, AOL Mail and Rediffmail. 

9.1.1 E-mail Clients versus Webmail

The e-mail client runs on your computer to send, receive and manage your emails. All e-mails that you 

send and receive are stored on your computer. You need to connect to the Internet only to send and 

receive e-mail messages. After a message has been sent, you may disconnect from the Internet and still 

have full access to all sent and received messages. 

On the other hand, if you use a webmail program for your e-mailing needs, you need to be online 

to send/receive a message as well as to view messages sent/received previously. All your messages are 

stored by the webmail provider on its mail servers, and nothing is stored on your computer. Thus, if you 

are unable to connect to the Internet, you cannot view any of your e-mail messages. Also, the webmail 

service provider may limit the amount of space available to each user, and you may not be allowed to 

send attachments larger than a specifi ed limit.

Note  A few years ago, when Hotmail was the most popular webmail provider, a user was allowed only 

2 MB of space for the free account. However, as new players, particularly Gmail, emerged, space 

available to store e-mail messages has increased over 5000 times to 10 GB and more. Several 

webmail providers allow unlimited space to each user to store e-mails.

Since you can access your webmail account from any computer or device anywhere in the world 

that has access to the Internet, it is particularly useful for people who are on the move or want to access 

their e-mail messages from home as well as offi ce. 

Webmail services offer a lot of features to manage your e-mail messages, fi lter out unwanted 

messages and free virus checking of messages as well as attachments. You may not fi nd these features 

in e-mail client programs or these may not be so effi cient or user-friendly. Also, to use an e-mail client 

program, you need to set-up the program on your computer whereas no such setup is required for 

webmail programs. 

As you know, with webmail services, all your e-mail messages are stored at the service provider’s 

servers. Although they take all precautions to keep your messages safe, there is still some risk that 

any private information stored in these messages may fall in the hands of unauthorised users. On the 
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other hand, with e-mail client programs, all e-mail information is stored on your local computer, and 

therefore, considered safe. 

Due to all these considerations, most individual Internet users normally use webmail service 

for e-mails, however, most corporate users normally use e-mail client programs for their e-mail 

requirements. We would discuss Microsoft Outlook 2010, an e-mail client, as well as commonly used 

webmail programs in the following sections.

9.1.2 E-mail Address

Before you may send or receive an e-mail, you need an e-mail address. The e-mail address is like the 

postal address that is used to deliver a message to you. When you sign-up with an Internet Service 

Provider (ISP), it assigns you one or more e-mail addresses. For instance, if you sign-up with www.

rogers.com, you may get an address such as yourname@rogers.com. In this address, the fi rst part 

of the e-mail address (yourname) is username, and the second part (rogers.com) is domain. (For 

more information on domain, see Section 8.4). Similarly, if you use the webmail service, your e-mail 

address is yourname@domain, e.g., yourname@hotmail.com for Hotmail, yourname@outlook.com 

for Outlook.com, yourname@gmail.com for Gmail and yourname@yahoo.com for Yahoo!. Some 

webmail service provider also offer country specifi c domains, e.g., with Yahoo!, you may have an 

e-mail address yourname@yahoo.in.

All webmail service providers let you choose the username part of your email address. Most users 

prefer to use their fi rst name, last name or complete name as username in their email address. For 

instance, if your name is Raj Sharma, you may like to get an email address, such as raj@hotmail.com, 

rajsharma@hotmail.com or raj_sharma@hotmail.com. However, when you try to get an email 

address of your choice, if yours is a common name, you may fi nd that the e-mail address of your choice 

is already taken up by someone and you cannot have it. (After all, one email address can be allotted to 

only one person!) In that case, you may have to prefi x or suffi x some characters to the username part, 

e.g. rajsharma1971 or rajsharmaDelhi.

9.1.3 Getting a Webmail E-mail Address

To get a webmail e-mail address, you need to register with the corresponding webmail service provider. 

There are several webmail service providers, however, the most popular ones are Yahoo! Mail, Hotmail/

Outlook.com and Gmail. You may setup your account with any one of these. For an average user, any of 

these service providers will serve the purpose. To get an email address from a webmail service provider, 

you need to register with it. During the registration process, you provide some details about yourself 

and choose an email address. The details to setup an e-mail account with common webmail providers 

are given here. (As of mid 2013, Microsoft has replaced Hotmail with Outlook.com though you can still 

get the Hotmail address through Outlook.com).

SERVICE PROVIDER URL PROCEDURE

Yahoo! Mail (India) http://in.yahoo.com/ Click the Create Mail Account link located in the top right 

section.

Yahoo! Mail http://mail.yahoo.com/ Click the Create New Account button.

Outlook.com http://www.outlook.com Click the Sign Up Now link.

Gmail http://www.gmail.com Click Create an Account button located in the top right corner.

The registration process is quite similar in all cases. Typically you provide your name, choose an 

email address, password and other details. 



E-mail and Social Networking    451 4 

9.2 STARTING MICROSOFT OUTLOOK 2010 

Microsoft Outlook 2010 is a personal information manager program, which, besides the e-mail 

application includes other applications, such as calendar, task manager, contact manager and

note taking. Do not confuse Outlook with similar sounding Outlook Express, which is also an e-mail 

client but lacks several features supported by Outlook. Also Outlook 2010 should not be confused with 

Outlook.com, which is a web based email program. You start Outlook 2010 like any other Windows 

program. 

∑ If there is an icon for Outlook 2010 on your desktop, double click that icon to start Outlook. The 

Outlook icon normally looks like .

∑ If the Outlook 2010 icon is available on the taskbar, you can start Outlook by clicking that icon. 

Alternatively, you may start Outlook from Windows menu. The Outlook program may be located 

anywhere in the menu system, however, normally you will fi nd it in the All Programs, Microsoft 

Offi ce submenu.

On starting Outlook 2010, you see a window similar to Fig. 9.1. The Outlook window displays the 

familiar Ribbon interface at the top. It displays Navigation pane on the left and lists items from the 

selected folder in the Content pane, also known as Folder pane. The pane to the right of the Content 

pane is called the Reading pane, which displays the preview of the item (e.g., email) selected in the 

Content pane. On the right of the Reading pane, the Outlook window displays the collapsible To-

Do-Bar, which displays a calendar, appointments and tasks. Depending on Outlook setup on your 

computer, your Outlook window may look different from Fig. 9.1.

Fig. 9.1 The Outlook 2010 window
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Note  If Microsoft Outlook has never been setup on your computer, Outlook starts the Microsoft Outlook 

2010 Startup wizard. Refer to the next section for details. 

∑ Outlook uses folders to store messages. If you do not see any messages in your Outlook windows, 

click the Expand button located to the left of Outlook Data File in the Navigation pane and click 

the corresponding folder, e.g., Inbox. (On your PC, Outlook Data File may be called something 

different, e.g., Personal Folders or Local Folders.) 

∑ The layout of the Outlook windows is customizable. For instance, you can minimize the Navigation

pane by clicking the Minimize the Navigation Pane button (see Fig. 9.1). 

Similarly, you may minimize the To-Do Bar or resize any pane by dragging its left or right vertical 

border.

9.3 SETTING UP OUTLOOK 

If Microsoft Outlook has never been setup on your computer, Outlook starts the Microsoft Outlook 

2010 Startup wizard shown in Fig. 9.2. This wizard guides you through the process of confi guring 

Outlook to send and receive e-mails by linking it to an e-mail address.

Fig. 9.2 Microsoft Outlook 2012 Startup Wizard

∑ Click Next and the wizard displays the Account Confi guration window where the wizard asks if 

you want to confi gure Outlook. By default, the Yes option is selected. Click Next to proceed to the 

next step shown in Fig. 9.3. 

By default, the Startup wizard selects the Auto Account Setup mode. If your Internet Service Provider 

(ISP) supports Auto Account Setup, confi guring Outlook is quick and easy. As most ISPs support Auto 

Account Setup, let us continue with the Auto mode. 

∑ Type Name, e-mail address and password in the appropriate textboxes. Click the Next button. 
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Fig. 9.3 Auto Account Setup

∑ Outlook tries to establish a connection to the network and tries to communicate with the mail 

server. If it is successful, it displays a confi rmation message and you are done and Outlook has 

been confi gured. Click the Finish button to close the Wizard.

Note  If you are trying to setup a Hotmail account with Outlook, you fi rst need to download and install the 

Microsoft Outlook Connector for Windows Live Hotmail.

9.3.1 Manually Confi gure Outlook

∑ If Auto Account Setup is not successful, choose the Manually Confi gure option in the Auto 

Account Setup screen (Fig. 9.3) and click Next. 

∑ The Startup Wizard displays the Choose Service screen where the Internet E-mail option is selected 

by default. Click Next and the Internet E-mail Settings screen appears as shown in Fig. 9.4. 

Fig. 9.4 Internet E-mail Settings for Outlook Setup
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∑ Enter the relevant details in the left section of Internet E-mail Settings screen. In the User 

Information section, enter your name and e-mail address. Enter the mail server details in the 

Server Information section; contact your ISP if you do not know these details. Finally, enter Logon 

Information (provided by ISP) in the last section. 

∑ After you have entered all details, click the Test Account Settings button to test the connection 

and validate the logon information. Outlook performs some tests, including sending a test message 

and displays the results, as shown in Fig. 9.5.

Fig. 9.5 Test Account Settings dialog box

∑ If the Test Account Settings dialog box displays that all tests were successful, Outlook has been 

confi gured to use the e-mail account. Click Close to close the Test Account Settings dialog box. 

If all tests are not successful, click More Settings (see Fig. 9.4) and defi ne/edit additional settings 

and try Test Account Settings again. 

∑ After Outlook is successful in testing the account, click Next and the Startup Wizard displays the 

fi nal step shown in Fig. 9.6.

∑ Click Finish to close the Setup wizard and Outlook is ready for use.

Fig. 9.6 E-mail account successfully setup through Startup wizard
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9.3.2 Confi guring Additional Accounts

Outlook can be confi gured to work with more than one e-mail account. After Outlook has started, to 

confi gure additional account for use with Outlook:

∑ Click the File tab on the ribbon to display the Backstage view. Click Info in the left pane and then 

click the Add Account button. 

∑ Outlook displays the Auto Account Setup page shown in Fig. 9.3. Follow the same steps described 

earlier in this Section to confi gure the new account. 

9.4 SENDING E-MAIL WITH OUTLOOK 

∑ To send an e-mail in Outlook, click the New E-mail button on the Home tab or press Ctrl+N. 

Outlook displays a blank New Message window on your screen, as shown in Fig. 9.7.

Fig. 9.7 The New Message window

When you are writing an e-mail, you must know the e-mail address of the person you are writing to. 

You need to enter that e-mail address in the To: box. 

∑ Click in the To: box and type the recipient’s email addresses. To send the same e-mail message 

to more than one recipients, type their e-mail addresses separated by a comma or semicolon, e.g., 

raj@example.com; sunder@example.com.

Note  As you start typing the recipient’s e-mail address or name, Outlook usually starts displaying the 

matching e-mail addresses below the box from the contacts list it maintains, due to the AutoComplete 

feature. To use any address from the suggested list and insert it in the address box, click it or use the 

arrow keys to highlight the desired address and press Enter. If you don’t want to use any address 

from the suggested list, continue typing the e-mail address. 
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∑ You may also choose recipient(s) from the e-mail addresses available in the Address Book

maintained by Outlook. To do so, click  or  and Outlook displays the list of contacts 

available in your Address Book to choose from the Select Names dialog box, as shown in Fig. 9.8. 

Now click the desired contact (e.g., Raj Verma) to select and then click the To, Cc or Bcc, button 

as required. After you have selected recipients from the Address Book, click the OK button to 

close the Select Names dialog box.

Fig. 9.8 Using the address book to select recipients

Note  If you want to send the copy of the message to someone but do not want other recipients to know 

this, use Bcc (blind carbon copy).

∑ After you have typed/selected e-mail recipient(s), rest of the process of writing the e-mail message 

is similar to writing a regular mail. Type a suitable text in the Subject box and type the message in 

the Message box. Finally, click the Send message to send it. 

Note  If you have any Microsoft program, such as Word, Excel or PowerPoint, Outlook includes the spelling 

checking capability. To perform spelling checking on the message you are typing, press F7 (or click 

Spelling and Grammar button on the Review tab) prior to clicking the Send button.

∑ If your Outlook is setup properly and your computer is connected to the Internet, Outlook sends 

your message immediately. If your computer is not connected to the Internet, Outlook may try to 

connect to the Internet. If it is able to send the message successfully, it moves the message to the 

Sent Items folder. 

9.5 RECEIVING E-MAILS IN OUTLOOK 

Receiving e-mails in Outlook is simple. When you start Outlook, it automatically connects to the 

incoming mail server and downloads all new e-mail messages available there into the Inbox folder. It 

also checks for new messages every few minutes. 
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∑ To manually check for messages on the mail server, click the Send/Receive All Folders button on 

the Home or Send/Receive tab on the ribbon. Besides receiving e-mail messages, it also sends any 

pending e-mail messages.

9.5.1 Reading a Message

Outlook displays the preview of the item selected in the Content (Folder) pane in the Reading pane. 

Therefore, to read a message: 

∑ Click the corresponding folder, e.g., Inbox in the Navigation pane. Next, click the message you 

want to read in the Content pane and Outlook displays the preview of the message in the Reading 

pane, as shown in Fig. 9.9.

Fig. 9.9 Reading a message in the Reading pane

∑ You may use arrow keys to select another item in the Content pane, and as you select items, 

Outlook updates the Reading pane with the content of the selected message. 

∑ If your Outlook window is displaying the To-Do bar, you may collapse it (see Fig. 9.9) to make 

more room for the Reading pane. 

If the message is large, you may fi nd it easy to read it in a separate window. 

∑ To open a message in a separate window, double click the corresponding item in the Content pane, 

as illustrated in Fig. 9.9. Figure 9.10 displays a message open in its window. 

∑ While you are reading the message in its own window, you may click the Previous/Next buttons 

on the Quick Access toolbar to display the previous/next message, as illustrated in Fig. 9.10. 

9.5.2 Replying to a Message

After reading the message, if you want to reply to the message, Outlook can help you do so with ease 

in several different ways:

∑ If the message is open in its own window, click the Reply button (See Fig. 9.10.) or press 

Ctrl+R.
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Fig. 9.10 Reading a message in its own window

∑ If you reading the message in the Reading pane, press Ctrl+R keys or click the Reply button on 

the Home tab on the ribbon.

∑ Right click the message in the Content pane and choose the Reply command.

Outlook opens a new window to type your reply. It automatically fi lls the sender’s e-mail address in the 

To box. Usually, it also includes a copy of the message you received in the reply message. 

9.5.3 Reply to All

If the message was originally sent to several people and you want to send the reply to all those people, 

use the Reply All command/button instead of Reply/Reply to Sender command/button.

9.5.4 Forwarding a Message

If you feel that the message, you have received was intended for some other person or someone else 

may fi nd it useful/interesting, you may forward the received message. To do so, 

∑ Select the message and click the Forward button on the ribbon. Then Outlook opens a message 

window similar to the New Message window and inserts the original message in the message box. 

It also adds “Fw:” to the original subject and enters it for you in the Subject box. 

∑ You may type your comments and edit the message, if required. Finally, click the Send button to 

send the message. 

9.5.5 Printing a Message

The procedure to print a message in Outlook is same as in Microsoft Word, Excel and PowerPoint. 

∑ Select or open the message that you want to print.

∑ Press the Ctrl+P keys or click the File tab to open the Backstage view and then click Print in the 

left pane. Outlook displays the preview of the message. 

∑ Choose the usual option, such as the printer, number of pages, etc., and click the Print button in 

the middle pane to print the message.
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9.6 SENDING AN ATTACHMENT 

If you want to send a fi le with your message, you can do so by including it as an attachment with the 

following steps:

∑ In the New Message window, click the Attach File button on the ribbon on the Message tab (see

Fig. 9.11) or Insert tab. Outlook opens the Insert File dialog box as shown in Fig. 9.11. 

Fig. 9.11 Attaching a fi le to a message

∑ The Insert File dialog box operates like a typical File Open dialog box in Windows. Navigate to 

the folder that contains the fi le your want to insert. Then select the fi le and click the Insert button. 

Alternatively, double click the fi le that you want to attach.

∑ Outlook creates a new attached row above the message box and displays the name of the attached 

fi le in this box.

∑ Repeat the same steps to attach additional fi le(s).

∑ To send the message with attachments, click the Send button. 

Note  You can select multiple fi les in the Insert File dialog box followed by the Insert button to attach 

multiple fi les in one go. 

9.6.1 Saving Attachment(s)

If the message you received contains attachment(s), Outlook identifi es this by displaying the paper clip 

icon (see Fig. 9.12) with the message in the message list in the Content pane. Also when you preview 
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the message in the Reading pane or open it, Outlook displays fi lenames for the attached fi les in the 

message header, as shown in Fig. 9.12. 

Fig. 9.12 A message with attachment

∑ To preview the fi le, click the attachment fi lename. On clicking the attachment, Outlook also 

displays the Attachments tab in the ribbon which has commands, to open, quick print, save one 

or all attachments to your computer as well as to remove the attachment. You may also open an 

attachment by double clicking the attachment fi lename in the message header. 

Note  For security reasons, Outlook may prevent you from opening certain fi les that may contain virus. Also, 

for safety reasons, you should download a fi le to your computer, scan it for virus before opening. 

9.7 MANAGING MESSAGES 

Outlook puts all your incoming messages in the Inbox folder. If you do not do anything with the 

messages sitting in the Inbox folder, soon you may have so many messages in this folder that it may 

become diffi cult to go back to a particular message you received a few days back. To overcome this 

problem, here are some options.

9.7.1 Delete Messages 

After you have read the message and replied to, if required, if you think that you do not need to save it 

for future, delete it. Deleting a message is very simple:

∑ In the Outlook windows, select the folder that contains the message (e.g., Inbox) and click the 

message you want to delete in the messages list in the Content pane. To select multiple messages, 

use Shift Click or Ctrl Click. 

∑ To delete selected message(s), press the Del key, press Ctrl+D or click the Delete button on the 

ribbon on the Home tab. 
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When you delete a message, it is not gone for ever. Outlook puts the deleted messages in the Deleted 

Items folder. So if ever need to read or get back the deleted message, you can fi nd it in the Deleted 

Items folder. To clean-up the Deleted Items folder, you should periodically review this folder and 

delete messages from this folder. 

Tip  To permanently delete a message from any folder, select the message(s) in the messages list and 

press Shift+Del. 

9.7.2 Flag a Message for Follow Up

If you have received an important message, you can fl ag it for quick identifi cation and follow up.

Figure 9.13 displays two fl agged messages. 

∑ To fl ag message(s) for follow up, select the message(s) in the Content pane and click the Flag icon 

on the right side of the message, as illustrated in Fig. 9.13. An alternate way to fl ag a message

is through the use of the Follow Up button on the Home tab, which also lets you choose the type 

of fl ag. 

∑ To clear the fl ag, click the Follow Up button and click Clear Flag in the menu, as illustrated in

Fig. 9.13.

Fig. 9.13 Flagging a message

9.7.3 Assigning a Category to the Message

You can receive various types of messages from different sources. For instance, you may receive 

messages from your colleagues, boss, suppliers, clients, friends, and so on. Besides, some messages 

may be very important, some may be less important while others may be just for information. To help 

you differentiate different types of messages, Outlook can help you assign one or more categories to 

these messages. You can create any number of categories and assign a separate color to each category. 

When you assign a category to a message, Outlook displays the category color in the Category Block 

(See Fig. 9.13). 

∑ To defi ne new categories or customize predefi ned categories, click the Categorize button on the 

Home tab and click All Categories in the displayed menu. 

∑ To assign a category to the current or selected messages, click the Categorize button to display 

a menu containing defi ned categories and click the desired category. On applying a category, 
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Outlook displays the corresponding color in the Category block in the Content pane. Follow the 

same procedure to assign additional categories or clear applied categories.

9.7.4 Organize Messages in Folders

After deleting unwanted messages, you may still be left with a lot of messages. Keeping all these 

messages in the Inbox folder is not a good idea. Similarly, all messages that you send are stored in 

the Sent Items folder, and this folder will also keep growing as you keep sending messages. The 

best practice is to fi le these messages in appropriate folders, just like we fi le received/sent papers in 

respective fi le folders. To accomplish this, the fi rst step is to create new folder(s). Follow these steps to 

create a new folder. 

∑ Click the Folder tab on the ribbon and then click the New Folder button in the New group. 

Outlook displays the Create New Folder dialog box shown in Fig. 9.14. 

Fig. 9.14 Creating a new folder

∑ Type the name that you want to assign to the new folder, e.g., Sports or Production Planning in 

the Name textbox. 

∑ Click the location where your want to create the folder. For instance, if you want to create the new 

folder within Inbox, click Inbox. On the other hand, if you want to create the new folder at the 

same level as Inbox, click Outlook Data File or the parent of Inbox. Finally click OK.

Outlook creates the new folder Sports and displays it in the Navigation pane. Like Windows Explorer, 

Outlook lets you create folders within a folder. For instance, you can create Cricket, Hockey and Tennis 

folders under the Sports folder. After you have created the required folders, you can move or copy a 

message from one folder to another, just like you move or copy fi les in Windows Explorer with these 

basic steps:

∑ In the Outlook window, select the folder that contains the message (e.g., Inbox) and then select the 

message you want to move/copy in the Content pane. To select multiple messages, use Shift Click

or Ctrl Click. 

∑ To move the selected message(s) to another folder, drag these to the required folder. To make 

a copy of the selected message(s) into another folder, drag these while keeping the Ctrl key 

pressed. 
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9.7.5 Finding a Message

When you use several folders, sometimes you may not recall which folder you put a particular message 

in. And occasionally, you know that the message should be there in a particular folder, yet you cannot 

fi nd it. In that case, you may take the help of the Outlook’s fi nd feature. Outlook can fi nd messages in 

a specifi c folder as well as its subfolder. Follow these steps to use the Find command: 

∑ Click the folder that you want to search for in the Folders box, e.g., Inbox. 

∑ Click in the Search box located at the top of the Content pane (see Fig. 9.14). When you click in 

the Search box, Outlook displays Search Tools on the ribbon. 

∑ Type the text you want to search for in the Search box and Outlook refreshes the Content pane with 

the matching items. 

∑ If you do not see the desired results, you can change the scope of the search from the current folder 

to all folders by clicking All Outlook Items in the Scope group on the ribbon. 

9.7.6 Customizing Content Pane and Sorting Messages

Outlook displays some details about messages, such as From, Date, Subject, etc., in the Content pane. 

You can customize the Content pane by including additional details or removing any information that 

you do not need. Also, by default, the messages are displayed in the descending order of the received 

date, i.e., the latest messages are displayed at the top. 

∑ To change the sort order or customize the display of the Content pane, click the left side of the 

header and Outlook displays a context menu shown in Fig. 9.15.

Fig. 9.15 Customizing the Content pane and sorting messages

∑ In the menu, the current sort order is marked with the check mark, e.g., Date in Fig. 9.15. To change 

the sort order, click the corresponding item, e.g., click From to sort by the sender’s address. 

∑ To change the information displayed in the Content pane, click View Settings in the context menu 

to display Advanced View Settings dialog box. Then click Columns and choose the columns you 

want to include in the display. 
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9.7.7 Conversation View 

Outlook can link outgoing and incoming messages as conversations. For example, you send a message 

to someone, and then that person reads the message and clicks the Reply button to reply to it. And then 

you click the Reply button to reply to that message and so on. In regular view, all messages you send 

are available in the Sent Items folder and all messages you receive are available in the Inbox folder. 

However, it becomes diffi cult to link these messages together to know the sequence of communication. 

Since Outlook 2007, you can combine all these messages as a conversation, thus you see all sent and 

received messages on a subject at one place. Figure 9.16 displays Outlook operating in the Conversation 

view. Notice that Outlook displays “(Conversation)” in the header of the Content pane.

Fig. 9.16 Outlook displaying messages in the conversation view

∑ To collapse/expand a conversation, click the Windows Explorer type triangle icon displayed to the 

left of the message subject. To view individual message, click the corresponding message in the 

Content view. 

∑ To switch to Conversation view or from Conversation view to regular view, click the header in the 

Content pane to display the context menu and click Show as Conversation (See Fig. 9.15.)

9.8 HANDLING SPAM (JUNK E-MAIL) 

As you know that once you have the Internet connectivity and an e-mail account, sending e-mails is 

almost free. Accordingly, some marketing companies send unsolicited, bulk e-mails to promote their 

products or services. These kinds of e-mail messages are called spam or junk e-mail. You cannot hide 

your e-mail address from these spammers for long; eventually they will get hold of it. Therefore, you 

are bound to receive some amount of spam. However, you can use features available in Outlook to 

reduce spam. Outlook has a built-in junk email fi lter which sends junk emails to the Junk E-mail folder 

as per the Junk E-mail fi lter setting. 

∑ To view or change Junk E-mail fi lter setting, click Junk in the Delete group on the Home tab to 

display a menu and then click Junk E-mail Options.
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Outlook display the Junk E-mail Options dialog box. The default fi lter option is Low, which is good to 

catch obvious junk e-mails. You may change it to High or Safe List. 

9.8.1 Block Sender

You can block a sender, so that Outlook blocks any message sent by that sender. If you want to block a 

sender whose message is available in any of the folders, perform these steps: 

∑ Select the message in the Content pane. 

∑ Click Junk on the Home tab to display a menu and click Block Sender in the menu. 

Note  To remove a sender from the Blocked Senders List or to manually add a sender to the list, click 

Junk, Junk E-mail Options to display the Junk E-mail Options dialog box. Then add/remove the 

email addresses on Blocked Senders tab in the dialog box.

9.8.2 Delete Message through Rules

To precisely defi ne messages that you want to block, you can defi ne messages rules. You can defi ne 

any number of rules to take care of various situations. For instance, you can block messages that come 

from certain senders, contain certain words in subject or message body, TO or CC contains specifi ed 

people and so on. Next, you can ask Outlook to take specifi ed action for each message rule, such delete 

it, move to certain folder, fl ag the message, etc. 

∑ To defi ne a new rule, click Rules on the Home tab to display a menu and then click Create Rule 

in the menu. Outlook displays the Create Rule dialog box, as shown in Fig. 9.17.

Fig. 9.17 Creating a new rule

∑ Check the required checkboxes and enter the required details in the corresponding text boxes. 

Figure 9.17 displays a new mail rule being defi ned, which is “Move the mail message to the Junk 

E-mail folder if the subject line contains the word “Viagra”. 

Note  You may also use rules to organize the incoming e-mails, e.g., move e-mails coming from Sales@

example.com to the Sales folder. 
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9.9 USING SIGNATURES WITH MESSAGES 

If you are working for a company, you may like to include your name, designation, phone number, 

fax number, etc., at the bottom of all messages you send. Even if you use Outlook to send personal 

messages, you may like to put your name, phone number and other details at the end of each message. 

To defi ne a signature:

∑ Click the File tab on the ribbon to open the Backstage view. Then click Options in the Navigation 

pane on the left to display the Outlook Options dialog box. 

∑ Click Mail in the left side of the Outlook Options dialog box to display the Mail options. (See

Fig. 9.18) 

Fig. 9.18 Defi ning signature

∑ Click Signatures to open the Signatures and Stationery dialog box. To create a new signature, 

click the New button (see Fig. 9.18) and assign a name for the signature. 

∑ Type and format the signature text in the Edit Signature box. Finally click OK to close the 

Signatures and Stationery dialog box. Click OK again to close the Outlook Options dialog box. 

After you have defi ned the signature, Outlook automatically puts the signature text in the message box 

when you create a new message.
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9.10 MANAGING CONTACTS 

These days, most users communicate with so many people via e-mail that it is very diffi cult to remember 

all these e-mail addresses. To make your job simple, Outlook maintains an address book, which contains 

e-mail address and other details regarding your contacts. Address Book can store a lot of information, 

such as Name, e-mail address, Company, Home Address, Offi ce Address, Date of birth, etc., about each 

contact, however, for using with Outlook, you just need to have an e-mail address and Name (optional). 

You can copy with ease an email address from the e-mail message you have received. 

∑ Open the e-mail message you have received and right click the Name in the message header to 

display a context menu as shown in Fig. 9.19. 

Fig. 9.19 Creating a new contact

∑ Click Add to Outlook Contacts to create a new contact. 

∑ Outlook creates the new contact and displays it on the screen. Now you may add additional details 

for the contact, if available. Finally click Save and Close on the ribbon. 

∑ If you want to maintain your address book, you may click Address Book on the Home tab (See 

Fig. 9.19.) This displays all defi ned contacts in the form of a list and you can edit or delete existing 

contacts or create new contacts. 

∑ An alternate way to manage your contacts is by switching to the Contacts view by clicking 

Contacts in the Navigation pane. 
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9.11 YAHOO! MAIL 

Yahoo! Mail is one of the three big webmail service providers. It offers unlimited e-mail storage, so you 

do not need to delete any message. 

∑ To login to your Yahoo! Mail account, visit mail.yahoo.com . The webpage redirects you to the 

login page where you type your Yahoo! ID (e-mail address) and password and click the Sign In

button. 

Note  The login page has a checkbox – “Keep me signed in”. If you check this checkbox prior to clicking the 

Sing In button, Yahoo! Mail will keep you logged in. You should use this option only on your home or 

offi ce computer that is used exclusively by you.

After successful login to the mail account, Yahoo! Mail displays your mail account (see Fig. 

9.20). The left side of the page displays e-mail and other folders. Notice that Yahoo! Mail displays a 

personalized greeting and the number of unread messages in the Inbox folder. In the middle, it displays 

list of messages with unread messages in bold letters. Rest of the page displays other useful (and not so 

useful) information and advertisements. This is the price you pay for getting the free e-mail service. 

Fig. 9.20 Yahoo! Mail home page

9.11.1 Sending an E-mail Message

∑ To send a new e-mail message, click the Compose button. (See Fig. 9.21.)

Yahoo! Mail opens the New Message tab for composing the new mail message shown in Fig. 9.21. 

If you have used any other e-mail program to send a message, you would fi nd the process of 

composing and sending a message in Yahoo! Mail quite similar. 

∑ Type the recipient’s e-mail addresses in the To box. As you start typing the e-mail address in the 

To box, Yahoo! displays suggestions matching the entered characters. To display the CC or BCC 

box, click CC. Then click BCC if required.
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Fig. 9.21 Sending a new e-mail message

∑ Type a suitable subject in the Subject box.

∑ Type the message in the message box. 

∑ Use appropriate formatting buttons located below the message box to format the message. 

∑ To perform spelling checking, click the abc icon in the message’s formatting toolbar as illustrated 

in Fig. 9.21. Yahoo! Mail highlights the misspelled words with red underline. To view suggestion 

for a misspelled word, right click the word. 

∑ To attach a fi le with the message, click the Attach File button. (See Fig. 9.21.) Then choose the 

fi le from the Open dialog box displayed by Windows.

∑ Finally, click the Send button to send the message. 

∑ Yahoo! Mail puts all sent messages in the Sent folder. 

9.11.2 Reading Mail

∑ To read e-mail messages available in any folder, click the corresponding folder, e.g., Inbox in the 

Folders box on the left side of the window. 

∑ Click the message you want to read in the messages list (See Fig. 9.20). Notice that unread messages 

are shown in bold letters.

Yahoo! displays the message, as shown in Fig. 9.22. If the message contains any attachments, it displays 

the corresponding details below the message subject. Depending on the type of the attachment, it may 

also display its preview. In any case, it displays a links that you can use to save the attached fi le to your 

computer. 

∑ If you want to read the next message, click the Next Up or Next Down button, as shown in Fig. 9.22. 
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Fig. 9.22 Reading a message

9.11.3 Taking Action on the Message

After you have read a message, depending on the message, you may take some action on it, e.g., 

� Delete it

� Forward it

� Reply to it

� Print it

� Mark the message as spam 

� Move the message to a specifi ed folder 

� Do nothing, but read next/previous message

To perform these common tasks, Yahoo! Mail provides convenient buttons shown in Fig. 9.22. 

∑ To delete a message, click the Delete icon, and Yahoo! Mail moves the message to the Trash 

folder. It automatically removes messages from the Trash folder at regular intervals. To manually 

empty the Trash folder, click the Delete icon located on the right of the Trash folder in the left 

Navigation bar. 

∑ To reply to a message, click the Reply icon (See Fig. 9.22) and Yahoo! Mail opens a new tab, 

which is similar to sending a new message, except that it automatically fi lls sender’s e-mail address 

in the To box. It also prefi xes “Re:” to the original subject in the Subject box and puts the original 

message and other relevant details in the message box. To send the reply to all recipients included 

in the message, click the Reply All icon (See Fig. 9.22.) 

∑ Click the Forward icon to forward a message to an e-mail address. The process is almost similar 

to replying to a message, except that the To box is not fi lled and Yahoo! Mail prefi xes the original 

subject with “Fw:” instead of “Re;”
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∑ Printing a message is simple—just open the message or select it in the message list, click More 

to display a context menu and choose the Print command. You can also press Ctrl+P to print 

the message. On using the Print command, Yahoo! opens the message in a new window which 

contains the Print link.

∑ If you received a spam message, select or open the message and click the Spam button. It moves 

the message to the Spam folder and also alerts Yahoo! Mail about the message so that it may refi ne 

its spam fi lters.

9.11.4 Creating a Folder

To organize your messages, you may create new folders and move selected messages to these folder. 

For instance, you may create a Purchase folder to store messages related to online purchases you do on 

the Internet. To create a new folder: 

∑ Click the Folders button located on the right of Folders in the left Navigation bar. (See Fig. 9.22.) 

The left navigation displays the folders column which contains Add folder icon at the top. Click 

the Add folder icon to display a dialog box where you type the name you want to assign to the new 

folder. Click OK and the new folder is ready. 

9.11.5 Moving Messages to a Folder

You can move message(s) available in a folder to another folder with these steps:

∑ Click the folder (e.g., Inbox) that contains the messages in the left Navigation bar

∑ Click the checkbox to the left of the message (see Fig. 9.20) to select the message(s) you want to 

move. Select additional message(s), if required.

∑ Drag the selected message(s) to the required folder in the Navigation pane.

9.11.6 Managing Contacts List

Yahoo! Mail enables you to manage your contacts list. The easiest way to build your contacts list is by 

adding senders of the messages you receive to it. You can accomplish this with these steps:

∑ Open the message whose sender you want to add to the Contacts list.

∑ Click Actions to display a context menu and then click Add Sender to Contacts in the menu.

∑ If you want to manually add a contact to the Contacts list, click the Contacts tab and then click 

New Contact. 

9.12 MICROSOFT HOTMAIL 

Microsoft Hotmail, formally known as Windows Live Hotmail was a popular webmail service provided 

by Microsoft until April 2013 when this service was retired in favour of Outlook.com. It is estimated that 

there were close to 400 million active Hotmail users who were forcibly migrated to Outlook.com. All 

those users can still access their Hotmail e-mail account using the hotmail e-mail address and password 

on Outllok.com. If you prefer, you can even get a new hotmail e-mail addresses through Outlook.com, 

however, if you try to access the Hotmail website, www.hotmail.com, you are automatically redirected 

to Outlook.com. 

Note  Since Hotmail has completely retired by summer 2013, we are not discussing the Hotmail interface 

in this book.
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9.13 OUTLOOK.COM 

Outlook.com is Microsoft’s latest web based e-mail service, which replaces Hotmail with a new 

interface. All Hotmail users have been forcibly migrated to Outlook.com by April 2013. If you ever held 

a Hotmail e-mail address, you should still be able to access your messages on Outllok.com. You can 

continue to use your existing e-mail address with Outlook.com or get a new Outlook.com address.

∑ To login to your Outlook.com (or Hotmail) account, visit www.Outlook.com, enter your e-mail 

address and password, and click the Sign In button. Fig 9.23 displays the opening webpage of a 

sample Outlook.com account.

Fig. 9.23 Outlook.com displaying messages list

The Outlook.com interface is divided in three panes. The Navigation pane on the left displays 

folders, the middle pane displays the messages list or the opened message and the right pane shows 

different content depending on the context. At the top, it displays a Command bar which displays 

commands depending on the context. For instance, when you open a message for reading or select it 

by clicking the checkbox displayed at the left in the message list (see Fig. 9.23), it displays additional 

commands to act on the message. 

9.13.1 Reading a Message

∑ To read a message, click it in the messages list. Outlook.com displays the message in the middle 

pane and adds commands in the Command bar at the top to take an action on it, as shown in

Fig. 9.24. 

When Outlook.com displays a message, it displays the message header at the top which contains subject, 

sender’s details and the date/ time the message was received. If the message contains any attachments, 

it displays the fi le details and preview of the fi le(s), if applicable and links to download the fi le(s) 

to your computer. For instance, the message in Fig. 9.24 displays the preview of three picture fi les 

attachments and links to download the same. Notice the message also has a link to play the slideshow of 
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the attached picture fi les. After the messages header is displayed the message, which may also contain 

embedded pictures and web-links. 

∑ After reading the message, if you want to read the next message, click the Next Message button, 

as shown in Fig. 9.24. 

∑ To close the message and return to the message list, click the Close button located on the right of 

the Next Message button.

Fig. 9.24 Reading a message

9.13.2 Taking Action on the Message

While reading a message or after you have selected one or more messages in the message list, you can 

take several actions on a message. 

∑ If you want to reply to the message, click the Reply button on the Command bar. If you want to use 

the Reply All option or want to forward the message to someone, click the Down arrow located 

next to Reply to display a menu and click the appropriate command. 

∑ To delete the current or selected messages, click Delete on the Command bar. 

∑ To send the selected message(s) to the Junk folder, click Junk on the Command bar.

∑ Use Move to on the Command bar to move the message(s) to any folder. Of course, you may also 

drag the selected message(s) to any folder in the Navigation pane. 

∑ Click Archive to archive selected message(s). Archive moves the messages to a defi ned archive 

folder, thus helping to keep the number of messages in the Inbox within manageable limit. Use 

archive instead of delete if you feel that you may need to refer to a message in future.

∑ Use Categories to group your messages in different categories. You can assign one or more 

categories, such as Shopping, Personal, Sales, Offi ce, Family, etc., to any messages. Assigning a 

category is like assigning a label or tag to a message. To view messages belonging to any category, 

click the category name under Quick Views in the Navigation bar. 



474    Computer Course: Windows 7 and Offi  ce 2010  

9.13.3 Sending a Message

∑ To send a new message, click the New button on the Command bar (see Fig. 9.23) and

Outlook.com displays a form to compose the new message, as shown in Fig. 9.25. 

Fig. 9.25 A new e-mail message being created in Outlook.com

∑ Type the recipient’s e-mail address in the To box. Notice that as you start typing e-mail address 

in the To box, it suggests you e-mail addresses matching the entered characters and enables 

you to choose an e-mail address from the displayed list. You may also click the To link to pick 

addresses from the Contacts list. Follow the same step if you want to send the message to multiple 

recipients.

∑ If you send the Carbon copy (Cc) or Blind carbon copy (Bcc) of the message to someone, click the 

Cc & Bcc link to display corresponding boxes.

∑ Click Add a Subject and type a suitable subject for the message. Of course, if you wish, you may 

send a message without subject.

∑ To attach a fi le, click the Insert icon to display a menu with three options—Files as attachments, 

Picture inline and share from SkyDrive. Use the fi rst option to attach fi le(s) to the message. Use the 

second option (Pictures inline) to display picture, within the message. You may use the SkyDrive 

option to share fi les from your Microsoft SkyDrive service.

∑ Type and format the message in the message box. The message box displays common message 

formatting controls, as shown in Figure 9.25. You may format selected text in bold or italic style 

or pick the required font or size for your message—just select the text and click the corresponding 

formatting control.

∑ By default, Outlook.com sends the message in Rich Text format, which is good in most cases. 

However, if required, you may choose to send the message in Plain text or HTML by choosing 

appropriate options from Options in the Command bar. 
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∑ Finally, click the Send link to send the message. The sent messages are saved in the Sent folder. If 

you don’t want to send the message now, click Save draft to save the message in the Drafts folder. 

Later, you may open the Draft folder to edit and send the message. 

9.13.4 Searching E-mail

Outlook.com provides a convenient Search email box at the top of the Navigation pane to search for 

e-mail. 

∑ To search for e-mails, type the search text in the Search email box. As you type the search text, 

Outlook displays search options, as displayed in Fig. 9.26. 

∑ To perform the complete search, i.e., fi nd e-mails where the search text is found in the message, 

e-mail address, from, subject and to, press Enter or click the search icon in the search box.

Fig. 9.26 Searching e-mails

∑ If you want to perform specifi c search, e.g., fi nd e-mails containing the search text in subject, click 

the corresponding search option, as illustrated in Fig. 9.26. 

∑ For complex search requirements, click Advanced Search and defi ne the search conditions. 

9.13.5 Managing Contacts

Outlook.com maintains a contacts list to help you select recipients for sending e-mails. To build your 

contacts list, you can add e-mail addresses of the senders of the messages you receive with these 

steps:

∑ Open the message in any folder. 

∑ Click the Add to Contact link in the message header. Outlook.com automatically displays this 

link if the sender’s e-mail address is not found in the contacts list.

∑ To maintain the contacts list in interactive way, click the arrow to the right of the Outlook button 

(see Fig. 9.26) and choose People. Outlook switches to the People mode and the Command bar 

displays commands to add, edit, delete and group contacts as shown in Fig. 9.27. It also has options 

to import contacts from Google contacts, Facebook friends, LinkedIn contacts, Twitter contacts, 

etc. After you have edited/added contacts, click the arrow to right of the People button and choose 

Outlook.com to switch back to Outlook.com.
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Fig. 9.27 Managing contacts in Outlook.com

9.14 GOOGLE MAIL (GMAIL) 

Google Mail (Gmail) revolutionized the webmail scene in 2004 when it offered its service with 1 GB 

storage to users. This was signifi cantly more than few MB being offered by Hotmail and Yahoo! Mail 

at that time for the free accounts. The storage space allowed free of charge has since increased to over 

15 GB as of January 2014. 

∑ To create your Gmail account or to login (sign in) to your Google Mail account, visit mail.google.

com or www.gmail.com. Google also display the Gmail link on the Google home page (Google.

com/Google.co.in) and you may click this link to login to your account. During the login process, 

you may type your complete Google Mail address (e.g., rajkumar@gmail.com) or just the 

username part (e.g., rajkumar). Figure 9.28 displays a sample screen after login.

The left side of the Google Mail screen displays folders and labels (to be discussed) and contacts. 

At the top of the screen is the e-mail search box. On the right side of the search box are located links 

to switch to other Google services and applications; we will talk about these later. Below the search 

box are located controls to take action on e-mail messages. Gmail displays the list of messages below 

these controls. Notice that Gmail classifi es the messages in categories, such as Primary, Social and 

Promotions, and accordingly has separate tabs for these categories. To view the messages available 

in a category, click the corresponding tab name. If there is a new message in any category that you 

have not read, Gmail displays a suitable note in the tab header, as illustrated in Fig 9.28. Like a typical 

e-mail program, Gmail displays unread messages in bold letters. The checkbox displayed to the left 

of the message is used to select the message. On selecting a message, Gmail highlight it, as shown in

Fig 9.28. You can apply certain commands on the selected messages, as you will see soon. 
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Fig. 9.28 Opening screen of Google Mail

9.14.1 Reading a Message

∑ Like a typical e-mail program, to read a message, click it in the message list. Gmail replaces the 

message list with the message, as shown in Fig. 9.29. 

Fig. 9.29 Gmail displaying a message in conversation view

Google links outgoing and incoming messages as conversations. For example, in Fig. 9.29, three 

messages, one outgoing and two incoming are linked. In case of linked messages, Gmail displays the 

Expand all button to expand all messages, as illustrated in Fig. 9.29.

∑ To view the message in a new window, click the In New Window button, as illustrated in Fig. 9.29. 
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If the message contains any attachments, Gmail displays the fi le details and preview of the fi le(s), if 

applicable and links to view/download the fi le(s) to your computer. If the message contains embedded 

picture or video, usually Gmail is able do display or play these within the message window.

∑ To print the message, click the Print button located to the left of the In New Window button. 

∑ After reading the message, if you want to go back to the Inbox, click the Back to Inbox button 

located in the Commands bar or click Inbox in the folders list in the Navigation pane. 

9.14.2 Composing and Sending a New Message

∑ To create a new message, click the large Compose button located at the top of the Navigation pane, 

as shown in Fig 9.28. Gmail displays the New Message window superimposed on the Google Mail 

window to compose the message, as shown in Fig 9.30.

Fig. 9.30 A new e-mail message being composed in Google Mail

By default, the New Message window takes a small area of the Google Mail window. To quickly 

compose small messages, this window should be suffi cient, however, if you like to switch to full-screen 

mode, click  located near the top-right corner of the New Message window. If you always want to 

work in the full-screen mode, click the More Options button located near the bottom-right corner and 

choose “Default to full-screen”, as illustrated in Fig 9.30.

∑ Type the recipient’s e-mail address in the To box. As you start typing e-mail address in the To box, 

Gmail suggests you e-mail addresses matching the entered characters and enables you to choose an 

e-mail address from the displayed list. You may also click the To link to pick addresses from your 

Gmail Contacts list.  

∑ If you want to send the Carbon copy (Cc) or Blind carbon copy (Bcc) of the message to someone, 

click the Cc or Bcc link to display corresponding boxes.

∑ Type a suitable subject for the message in the Subject box. Of course, if you wish, you may send a 

message without subject.
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∑ To attach a fi le, click the Attach fi les link and choose the desired fi le(s). You may attach additional 

fi les by clicking this link again. Gmail displays the attached fi le(s) and their type and size in the 

message window. It also displays a remove button against each attached fi le, which you may use 

to remove an attached fi le, if required.

• Type and format the message in the message box. Google does not display the formatting controls 

in the small New Message window; to display these controls, click the Formatting Options button, 

as illustrated in Fig 9.30. You may format selected text in bold or italic style or pick the required 

font or size for your message—just select the text and click the corresponding formatting control. 

To perform spelling checking on the message text, click the More Options button located near the 

bottom-right of the New Message window and then click Check Spelling. 

• By default, Gmail sends formatted message which is good in most cases. However, if required, you 

may click choose Plain Text from More Options to send the message in plain text. 

• To send the message, click the large Send button located at the bottom-left of the message 

window. If you would like to send the message later, close the New Message window and Google 

automatically saves the message in Drafts folder. 

• After Gmail sends the message, it is moved to the Sent Mail folder. 

9.14.3 Taking Actions on Messages

You may take several to keep your Inbox and Sent Items folders tidy. If the message is not important or 

you don’t need it for reference in future, you may delete it. 

Deleting a Message

∑ To delete a message that you are reading, click the Delete button (See Fig. 9.29.) 

∑ If the Gmail window is displaying the list of messages in the selected folder, e.g., Inbox, click the 

checkbox to the left of the message to select the message (see Fig. 9.28.) You may select multiple 

messages. Gmail highlights the selected message(s). To delete the selected message(s), click the 

Delete button located above the message list. You can also access the delete command in the 

context menu that you get on right-clicking selected message(s). 

Note  Deleted messages are moved to “Trash”. Google Mail automatically permanently deletes the 

message from Trash after 30 days.

Archive a Message If you feel that the message you have received may be helpful in future, but 

you do not want it to overfi ll the Inbox, you can archive it. When you archive the message, it is removed 

from Inbox but it is not deleted. Instead, it is assigned a special label All Mail and you can access 

it through All Mail label. Besides Inbox, you can archive a message from Sent Mail and Important 

folders. 

Note In fact, Inbox, Sent Items, Drafts, Spam, Starred are not folders, but system labels.

What is a Label? To organize your messages into various categories, such as fi nance, personal, 

work, jokes, orders, etc., Gmail uses a technique call labels. Labels are like tags or categories that you 

can apply to a message. As a crude analogy, one can say that labels and folder are similar, however, 

labels are different from folders in many ways:

� You can apply more than one label to a message. 
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� You can quickly remove or add labels to message(s).

� You can ask Google Mail to display the list of messages that have applied a particular label. If 

a message has been applied multiple labels, that message appears with each label category it 

has been assigned to.

Figure 9.31 displays labels assigned to some messages. Notice that in Fig. 9.31 some messages have 

been applied multiple labels. 

Fig. 9.31 Labels assigned to messages in Gmail

∑ To display messages applied with a particular label, click the corresponding label link in the labels 

list. To display labels, move mouse on Inbox in the Navigation bar and move down the mouse. Use 

the More link at the bottom of the labels list to display additional labels, if required. 

Assigning a Label Assigning a label to a message is very simple: 

∑ Select the message by clicking the check box located to the left of the message in the messages list, 

as illustrated in Fig. 9.31. You may select multiple messages to apply a label at once.

∑ Click the Labels button to display the list of labels in a drop-down list, as shown in Fig. 9.32. To 

apply a label, click the corresponding Label name in the drop-down list. You may choose multiple 

labels. Finally, click Apply to apply labels to the selected message(s).

∑ You can assign a special label called “Starred” by clicking the star in the message list, as illustrated 

in Fig. 9.32. You may use the Select button to select starred, unstarred, read, unread messages, etc. 

(see Fig. 9.32.)
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Fig. 9.32 Applying a label or star to a message

Creating a Label To create a new label and assign it to the selected message, follow these steps: 

∑ Click the Labels button to display a menu and click the Create new command located near the 

bottom of the menu.

∑ Google Mail displays the New Label dialog box shown in Fig 9.33. Type the new label name in 

the fi rst box. 

∑ If you want to create the new label under an existing label, click the arrow in the Nest label under 

box and choose the desired parent label.

∑ Finally, click the Create button to create the label. 

Fig 9.33 Creating a new label in the New Label dialog box

If you want to manage labels, e.g. delete a label or place it under another label, choose the Manage 

labels command from the Labels menu.
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Contacts Google Mail automatically updates the contacts list when you send a message to a new 

e-mail address or receive a message from a new sender. Thus, you rarely need to manually add an 

e-mail address to your contacts list. As soon as you start typing an email address while composing a 

new message, Google Mail starts offering you suggestions. 

∑ If you need to maintain the Contacts list, click the Gmail button located in the top left corner of 

the window below the Google logo and choose Contacts.

Spam Filter Google Mail’s spam fi lter is very effective. Usually, most of the spam mail 

automatically bypasses Inbox and lands in the Spam box. 

∑ However, if you feel that a message should have been treated as spam, you can click the Report 

Spam button, located to the left of the Delete button to move it to the Spam box and to report this 

to Google Mail. Messages moved to the Spam box are deleted after 30 days. However, you may 

manually empty the Spam box whenever you like. 

∑ You should periodically review the Spam box, just in case a message has been marked as spam by 

mistake. If you fi nd such message, select it and click the Not Spam button. 

Mark a Message as Read/Unread All new messages that arrive in the Inbox are marked as 

unread and appear in bold letters in the message list for easy identifi cation. After you have read the 

message, its status changes to read and message appears in normal letters in the Inbox message list. 

However, you don’t have to read a message to change its status to read, you can also change its status 

to read without reading it. Follow these steps to do this: 

∑ Select the message(s) in the message list by clicking the check box located at the beginning of the 

message. 

∑ Click the More button to display the list of actions you can perform on the selected message(s). 

∑ Click the Mark as Read action. 

Follow similar steps to mark a read message as unread. 

Searching Messages Google Mail includes a powerful and user-friendly search feature that 

can fi nd your messages very quickly. (You know that Google is undisputed leader in the web search 

technology.) Searching for your messages in very simple: 

∑ Type search text in the text box located at the top of the page, to the right of the Google logo and 

click the Search button. And, Google displays the search results on your screen. 

Filtering Messages You may use Google Mail’s fi lters to manage your incoming messages. You 

can create unlimited fi lters. A fi lter may be used to automatically delete, label, archive, forward or star

a message based on the user-defi ned criteria. To create a fi lter based on a message you have received.

∑ Select the message, click the More button and choose Filter Messages like these from the menu. 

Google Mail displays a box for entering criteria for the fi lter, shown in Fig. 9.34. 

∑ The criteria box already contains sender’s email address. You may add additional criteria, such as 

To, From, Has the words, etc. 

∑ Click the Create fi lter with this search link and Gmail displays the next step where you choose 

what action you want to take on the messages matching the fi lter criteria, as shown in Fig. 9.35.
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Fig. 9.34 Defi ning criteria for creating a fi lter

Fig. 9.35 Defi ning actions on messages matching the fi lter criteria

∑ You may choose one or more actions. Gmail provides a number of useful actions, e.g., you can 

mark it as read, apply star or a label, forward it to a specifi ed e-mail address, delete it, etc., Google 

Mail performs these actions in the order these are listed. Therefore, it is possible to forward the 

message and also delete it. 
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∑ If you would like to apply the fi lter to the currently matching conversations, check “Also apply 

fi lter to ... conversations”. Finally click the Create Filter button. 

Changing Personal E-mail Settings Google Mail allows you to personalize various mail 

settings, such as signature, picture, vacation response, e-mail forwarding, downloading messages from 

other e-mail clients, language selection, etc. 

∑ To view or update you e-mail settings, click the Settings button located above the messages list 

(see Fig. 9.32) and click the Settings command in the menu.

∑ Google Mail can operate in many Indian languages, including Hindi, Gujarati, Marathi and Tamil. 

If you want to use Google Mail in Hindi, choose Hindi as Gmail display language on the General 

Settings page. 

∑ If you change any settings, click the Save Changes button located at the bottom of the page. 

9.15 INSTANT MESSAGING (CHATTING) 

Instant Messaging (IM), also known as chatting enables two or more users to communicate to each other 

in almost real time through typed text. The communication takes place between computers connected 

on a network, usually the Internet. Initially, all communication used to take place through typed text, 

i.e., text typed on one computer appears on the other, and vice versa. Later, Instant Messaging programs 

added other features, such as voice/video communication, fi le-sharing, e-mail and games. Some of the 

common Instant Messaging programs are MSN Messenger/Windows Live Messenger, Skype, Yahoo! 

Messenger, Google Talk, Jabber, ICQ, AIM (AOL Instant Messenger) and eBuddy. Usually, each of 

these Instant Messaging programs uses its own protocol, so both persons who want to communicate to 

each other using Instant Messaging need to use the same program. That is, if you are using Google Talk, 

other person must also use Google Talk. 

9.15.1 Windows Live Messenger

Microsoft Windows Live Messenger, formally knows as MSN Messenger was one of the most popular 

instant messaging program until April 2013, when Microsoft decided to retire it in favour of Skype. In 

2006, Microsoft updated its communication protocol to enable Windows Live Messenger and Yahoo! 

Messenger to communicate with each other. Besides the basic communication through typed characters 

(chatting), users could make PC-to-PC voice and video calls, games and offl ine messaging.

9.15.2 Yahoo! Messenger

Yahoo! Messenger is one of the most popular Instant Messaging program. It has all the capabilities of a 

typical messaging program, such as instant text messaging, PC-to-PC voice and video communication 

and share fi les. Yahoo! Messenger can also make PC to regular phone communication, or receive calls 

from regular phones.

∑ To use Yahoo! Messenger, start this program like any other Windows program and login to your 

account using your Yahoo! ID and password. Figure 9.36 displays a Yahoo! Messenger window.

∑ Yahoo! Messenger in Fig 9.36 displays contacts and their online status. To add a new contact, click 

Contacts at the top of the window and choose Add a Contact from the menu. During the add 

contact process, Yahoo! Messenger sends an invitation to the new contact, who must accept your 

invitation before you can communicate with the contact.
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Fig 9.36 Yahoo! Messenger

∑ To send an instant message (IM) to an online contact, click the contact in the contacts list and click 

the button to display a menu, as illustrated in Fig 9.36. Then click Instant Message in the menu 

and Yahoo! Messenger opens a Conversation window, as shown in Fig 9.37. 

Fig 9.37 Conversation in progress in Yahoo! Messenger



486    Computer Course: Windows 7 and Offi  ce 2010  

• Sending an instant message is simple—just type the message and click the Send button. Yahoo! 

Messenger can also help you to easily send emoticon (smiley). Here are some of the emoticon 

you can send  in with Yahoo! Messenger. To insert an emoticon, click the 

Emoticon button and choose the required emoticon, as illustrated in Fig 9.37.

• If you want to send a fi le, click Attach fi le icon, as illustrated in Fig 9.37.

The text you send appears in the conversation box in the Conversation window on your computer as 

well as on your contact’s computer. In the same way, the response typed by your contact appears in your 

Conversation window. The Conversation window also displays status of activity, e.g. “… is typing”. 

• If your contact is not online, you may send an offl ine instant message or send an e-mail by choosing 

the appropriate command from the menu.  

Depending on the hardware installed on your computer and the Yahoo! Messenger you are using, you 

may be able to make a video or voice call. Yahoo! Messenger has several other features, such as sending 

e-mails, share photos and play games.

9.15.3 Skype

The Skype service allows Skype users to communicate using instant messaging (IM) as well as free 

audio and video call over the Internet. For a charge, a Skype users can make calls to a landline or mobile 

phone number or send SMS to a phone. 

∑ To use Skype, you need to download and install the Skype program from www.skype.com. 

∑ Next, you need create an account which you can do at from www.skype.com. During the account 

creation process, you provide some basic details about you and choose a Skype name (username) 

and password. If you have a Microsoft or Facebook account you can use these accounts to login to 

Skype, so you need not create a new Skype account.

∑ After you have created the Skype account, start the Skype program on your computer and sign in 

using your Skype username and password. You may also sign-in using your Microsoft or Facebook 

account and you are ready to use Skype. If you have created a new account, Skype prompts you to 

setup a profi le picture and test microphone, speaker and webcam on the computer. 

Figure 9.38 displays Skype program in use. The left side of the window displays the list of contacts. 

On clicking a contact, Skype displays the online status. Depending on the hardware installed on your 

computer and the online status of the contact, it enables or disables Video Call and/or Voice Call buttons. 

∑ To send an instant message (IM), type the text in the textbox at the bottom of the window (see

Fig. 9.38) and press Enter. Similarly, to make a voice or video call, click the corresponding button. 

When you send a message or click a Voice or Video Call button, Skype displays the call request alert on 

your contact’s computer. If your contact accepts your request, the communication is established. 

To use the free IM, voice or video call, you need to add the contact to your contacts list. You can 

search the Skype’s users to fi nd a contact and send a contact request with these steps: 

∑ Click Add a Contact icon at the top of the left pane and type Name, Skype name or email address 

in the search box. Skype provides the list of Skype users matching the entered search text. 

∑ To send a contact request, click to select the Skype user and click Add to Contacts at the top-right 

of the window, as illustrated in Fig. 9.39.

∑ Skype sends the contact request to the Skype user. When the user accepts your request, you will be 

able to communicate with that user.
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Fig. 9.38 Instant messaging in Skype

To use the paid features, e.g., to make a phone call to a landline or mobile phone or to send an SMS 

message to a phone, you need to buy credit or pay monthly subscription. 

Fig. 9.39 Sending a contact request in Skype

9.15.4 Google Talk

Google Talk, Google’s Instant Messaging program, provides instant messaging as well as PC-to-PC 

communication capabilities. You can use Google Talk in several different ways, e.g., through the Google 

Talk application, chat capability in Gmail or Google Talk Gadget. Though if you download and install 
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Google Talk, it gives you the most features, most people use the Talk capabilities available in Gmail 

through the Google Talk plugin. 

∑ As shown in Fig. 9.40, Google Talk displays the list of contacts and their online status and 

availability in the left bar.

∑ When you hover the mouse on a contact name, Google Talk displays the online status and 

availability of a contact and the actions you can take in a side window. Some of the actions, e.g., 

video call or audio call depends on the hardware installed in your and your contact’s computer.

Fig. 9.40 Instant Messaging (chatting) within Google Mail

∑ If a contact is not online, Google disaldes some of the actions, e.g., voice call. If the contact is 

online click the desired action.

∑ When you initiate chat, Google Talk opens a small chat window overlapping the Gmail window. 

If you prefer, you can expand the window. 

∑ Google Talk displays icons for other available actions, such as voice or video call in the chat 

window. Thus, you may switch from chat to voice/video call if required from within the chat 

window. Of course, both computers must be equipped with the required hardware, such as 

microphone, speakers, webcam, etc. to use voice/video calling features.

Note  Google has introduced Hangouts which is similar to Google Talk with rich features. Google Talk may 

be replaced with Hangouts in future.

9.16 SOCIAL NETWORKING WEBSITES 

Social Networking websites can help you to create an online profi le about yourself and to communicate 

with your friends. These sites also let you upload photos/videos, create groups and events. Just adding 

stuff about yourself is not the complete fun, so you request other users on the same social networking 
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site to become your friends. After a user agrees to become your friend, you can view his/her profi le, 

postings, friends, etc., and similarly he/she can view your profi le, postings and friends. So, if you 

prefer, you can request a friend of your friend to become your friend. These websites also allow you 

to search existing users to fi nd your old friends. After you fi nd a user who you think is your old friend/

relative, you can send a request to include him/her as your friend on your profi le. Thus, these sites can 

help you to improve your social networking. Other services offered by most social service networking 

sites include e-mail, chat/voice chat, blogging and discussion groups. Social Networking sites are 

particularly popular with teens and young people.

There are several social networking websites; however the most popular ones are Facebook

(www.facebook.com), Twitter (www.twitter.com), LinkedIn (www.linkedin.com), Google+, Orkut 

and MySpace Figure 9.41 displays a webpage from Facebook. While specifi c details vary from one site 

to another, the basic operation of these sites is quite similar. All these sites allow you to create a free 

account, update your profi le, write notes (blogs), send e-mail to your friends, upload pictures, etc. 

Fig. 9.41 Social Networking through Facebook

∑ To use Facebook, you need have a Facebook account. Visit www.facebook.com to create an 

account; you just need to provide an email address and a few details about you. When Facebook 

creates an account, it gives you an option to fi nd friends on Facebook through the contacts list on 

your existing e-mail accounts and send friend request to all/selected contacts. Next, you create 

a profi le about you and add a profi le picture. Facebook can even use a webcam to take your 

picture. 

∑ If you already have a Facebook account, use www.facebook.com to log in to your account. If you 

check the Keep me logged in checkbox during the log-in process, Facebook will directly take to 

your account when you visit www.facebook.com time. 

∑ After you have logged-in to your account, you can post stuff about you—just type anything in the 

“What’s on your mind” textbox at the top of the page (see Fig. 9.41) and press Enter. 

∑ To upload photos or videos, use the Add Photos/Video link located above the “What’s on your 

mind” textbox. You can either upload individual photos or create an album. Then you may write 

some details about the photos and post these as private, public or friends. 
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∑ You can also comment about posts from your friends as well as view your friends’ profi les and 

posts. 

If you add too many users as your friends and start viewing activities of all those people, Social 

Networking can become a time-consuming affair and addictive. So, you should exercise caution in 

adding people as your friends. Also, do not post anything too personal on these websites, as anything 

you post becomes known to everyone in no time. 

9.17 MICROSOFT FAMILY SAFETY 

The Internet has all kinds of information, some of which may not be suitable for some users, particularly 

young children in home. Most computers in home are connected to the Internet, usually 24 hours a day. 

It is the moral responsibility of parents to ensure that children don’t access information not suitable 

for them. To help parents achieve this, Microsoft developed the Family Safety (formally Windows 

Live Family Safety) program. Family Safety, a free program, is a part of Windows Essentials which 

helps parents control and monitor the online and computer activities of children. If this program is not 

installed on your computer, you can download it from Microsoft’s download site. (Refer to Section 2.37 

for more information about Windows Essential.) Before you can monitor activity of a child, you need 

to setup Family Safety on your computer. Basically, Family Safety has three components: 

1. Family Safety Filter A software you install on each computer your children use at home. 

2. Family Safety Website This website maintained by Microsoft monitors and records activities of 

children on each computer where you have installed the Family Safety fi lter. 

3. Windows Parental Control Windows feature, which is turned on when you enable Family Safety, 

enables you to customize settings to monitor and control children’s activities on the computer. 

∑ Start the Family Safety program like any other Windows program. You may search for this program 

through the Programs and Files search box on the Start menu. The Family Safety program starts 

and prompts you to log-in to with your Windows Live ID as shown in Fig. 9.42.

Fig. 9.42 Log-in screen for Windows Live Family Safety
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∑ You can log-in to Windows Live Family Safety with your Hotmail/Outlook.com account. This 

should be the primary parent’s account and will be used to setup, monitor and control Family 

Safety. 

After successful sign-in, Windows displays a window that shows Windows user accounts set-up on the 

computer and a link to create additional user accounts, as shown in Fig. 9.43. 

Fig. 9.43 Family Safety displaying current user accounts set-up on the computer

∑ If you want to monitor an existing account, click the Monitor Account checkbox. To create a new 

standard account for monitoring, click the Create a new standard Windows account link, and 

Windows displays a dialog box to create the new account, as shown in Fig. 9.44.

Fig. 9.44 Creating a new standard Windows user account

∑ Type the account name in the Name textbox and click Create Account to create the new account. 

You may assign any name to the account, e.g., name of your child or call it ChildAccount. If you 

want to monitor activities of two children, you should preferably create a separate account for 

each child. Family safety window displays the new account name in the window. Click the Next 

button.

Family Safety creates a new windows user account and marks it as ChildAccount, the default setting 

for accounts created through Family Safety, as shown in Fig. 9.45. 
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Fig. 9.45 A new account created by Family Safety

∑ Click Save to save the new account. 

Family Safety starts setting up the new Windows user account. It displays a progress bar and when the 

account set-up is complete, it display the Family Safety window with the newly setup account under 

the Monitored Windows Accounts list, as shown in Fig. 9.46. 

Fig. 9.46 Family Safety displaying monitored accounts

∑ Click the Close button to Family Safety window. 



E-mail and Social Networking    493 4 

9.17.1 Monitoring an Account

After you have set-up an account for monitoring, the Family Safety website (familysafety.microsoft.

com), whose address is displayed in the Family Safety window (see Fig. 9.46) continuously monitors 

and records the online and computer activity of the account. If the account holder, e.g. your child tries 

to visit an inappropriate website, Family Safety displays a suitable message and does not allow visiting 

the website. At that point, the child can request for permission to the parent and the parent may allow 

or disallow the request. 

∑ To view the activities of a child (monitored) account, either visit the familysafety.microsoft.com

website directly, or open the Family Safety program on your computer and click the familysafety.

microsoft.com link displayed at the bottom of the Family Safety window. 

Family Safety opens the web browser, if required and prompts you to sign-in, as displayed in

Fig. 9.47. 

Fig. 9.47 Sign-in with you Microsoft account to monitor activities through Family Safety

∑ Sign-in with the username and password you used when you set up Family Safety. After successful 

sign-in, the Family Safety website displays the list of accounts being monitored under the username. 

Click an account and family safety displays overview of the account, as displayed in Fig. 9.48.  

∑ If there are any pending requests, click the corresponding link to view the request and take an 

action, e.g., allow or block the request. 

∑ To view the activity of a monitored account, click the Activity reporting link. Figure 9.49 displays 

the summary activity report for a sample account. Notice that it list websites visited, number of 

pages in each websites, blocked websites as well as applications used on the computer. To view 

detailed web or PC activity, click the corresponding tab, as illustrated in Fig. 9.49. 
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Fig. 9.48 The Family Safety displaying the Family Safety summary of a monitored account

Fig. 9.49 The Family Safety displaying the summary activity report 

9.17.2 Customizing the Monitored Account

You can customize the monitored account by changing the web fi ltering/lists, setting time limits and 

defi ning Game and App restrictions. You can do this by clicking the corresponding link while monitoring 

the activity of an account (see Fig. 9.49). 
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The default web fi ltering setting blocks adult sites, but you can make it more restrictive or even 

specify the websites the account holder can visit. Similarly, on the Web Filtering page, you may disable 

fi le downloads. 

Time Limits is a useful feature which does not allow the use of the PC during the specifi ed hours at 

all. This is particularly helpful if you want your children in bed during night time rather than browsing 

the web. To set time limits: 

∑ Click the Time Limits link (see Fig. 9.49) and then click Curfew, and Family Safety displays a 

grid representing 24 hours for the each day of the week. 

∑ Click the On/Off button at the left above the grid to turn on the Curfew option. Next click the time 

when you do not want to allow the use of the PC. Family Safety marks the blocked period in blue 

color, as illustrated in Fig. 9.50. 

Similarly, you may use the App Restrictions and Game Restriction links to block specifi c apps and 

games, respectively.

Fig. 9.50 Setting time limits for the PC use 

9.18 GOOGLE DRIVE 

Google Drive is a free web-based service offered by Google to create, edit and share word-processor, 

spreadsheet, presentation and drawing documents. The documents are created and saved on Google’s 

web servers. Besides hosting documents, Google Drive can also synchronize documents on your PC 

with those on Google Drive. Besides creating documents from scratch, you can also import/upload 

existing documents from your PC. 

To access your Google documents or create a new one, visit http://drive.google.com. If you are not 

already logged-in to your Google Account, Google Drive presents you the log-in page. You may also 
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access Google Drive by clicking the Apps icon on any Google page including the Google home page 

(see Fig. 9.51) After successful log-in, it displays a list of all documents you own or have access to. 

Figure 9.51 displays a Google Drive page for a sample account. 

Fig. 9.51 Google Drive

The Create button is used to create a new document or folder. Google Drive lets you manage your 

documents by moving these to folders of your choice. Editing a document in Google Drive is very 

simple and does not require any special learning. Another good feature of Google Drive is sharing of 

a document, which helps multiple users to edit a document. If you like to share your document with 

everyone, Google Drive lets you publish it on the Internet via Google+, Facebook, Twitter or Gmail.
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 database, 265

 Date/Time, 231

 fi nancial, 253

 inserting, 249

 math, 251

 statistical, 249

 text, 256

 trigonometry, 252



Index    503 5 

Future value (FV), 254

FV function, 254

G 
Gadgets, 53 

Gateway of Tally, 362

GB (Gigabyte), 24 

Giga Hertz (GHz), 11

Gigabyte (GB), 24 

Gmail, 476-484 

 archiving a message, 479

 compose a message, 478 

 contacts, 481

 conversation view, 477

 delete a message, 479

 fi ltering messages, 482

 Labels, 479

 spam fi lter, 482

Goal Seek, 258 

Google, 397 

 in Indian languages, 410

 maps, 446

 search, 405

Google Apps, 496 

Google Chrome, 397 

 getting, 401

 Incognito mode, 424

Google Drive, 495

Google Mail, see Gmail 

Google search, 405 

Google Talk, 487

Grammar checking, 164 

Graphical User Interface (GUI), 38

Gridlines, 246

Grow Font, 142 

GUI, 38

H 
Hanging paragraphs, 154 

Hard disk drive, 24

Hard page break, 167 

Hardware, 11 

Header (Excel), 247

Header (PowerPoint), 339 

Header (Word), 171 

Header margin (Word), 160 

Headphone, 31 

Help

 browser, 426

 Windows, 90

 Word, 131

Hexadecimal, 19 

Hibernate computer, 51 

Hidden format (Word), 147

High-level languages, 15

Hindi, 60, 410

Home page, 413 

 Chrome, 416

 Internet Explorer, 414

 Mozilla Firefox, 415

Hotmail, 471

HTML, 393 

HTTP, 396 

HTTPS, 429 

Hyperlink, 393

Hyperlink data type, 280

Hyperlinks, 402

 inserting in a workbook, 182

Hypertext Markup Language, 393 

Hypertext Transfer Protocol (HTTP), 396

I
I’m Feeling Lucky, 409

IBM PC, 6 

IC (Integrated Circuit), 5

Icon Sets, 231

Icons, 40

 arrange, 52

 copying to desktop, 50

 delete, 52

 hidden, 62

 rename, 52

 resize, 52

 system, 63

IF function, 258

Image hyperlinks, 402

Image search, 409 

Impact printers, 28

Incognito mode, Google Chrome, 424 

Indenting paragraphs, 152

Indexed, fi eld, 284

Indian format, 215

InkJet printer, 28

Input Mask, fi eld, 284

Input unit, 9

Insertion point, 135

Instant Messaging, 484-488 

Instruction set, 10

INT function, 251

Integrated Circuit (IC), 5

Intel 4004, 6

Intel Pentium microprocessor, 6
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Internal memory, 9

Internal rate of return (IRR), 256

Internet, 390

 applications, 393

 banking, 441

 browser, 393

 connection types, 391

 driving directions, 446

 fi les, temporary, 432

 history, 390

 in Indian languages, 410, 444

 maps, 446

 radio, 438

 shopping, 439

 telephony, 395

 translation service, 445

 USB Mobile Stick, 392

 via cable, 391

 via Satellite, 393

 wireless, 391

Internet Explorer, 397

Internet Protocol (IP), 390

Internet Service Provider (ISP), 391

Interpreter, 16

IP, 390

iPad, 26

IRR function, 256

ISP, 391

Italic (Ctrl+I), 142, 210

J
Joystick, 30

Justifi ed paragraph, 147

K 
KB (Kilo Bytes), 10

Keep Lines Together, 175 

Keep with Next, 175 

Keyboard, 21 

Keypunch machine, 33 

Kilobyte (KB), 10

L
Label, Gmail, 479

LAN, 18 

Landscape orientation, 161

Laptop PC, 19 

Large computer, 7 

Large-scale integration, 6

Laser Printer, 28

LCD, 22 

Leader character, 157

LED, 23 

Ledgers (Tally), 368

LEFT function, 257

Left margin (Word), 160

Left-aligned paragraph, 148

Left-aligned tab, 156

LEN function, 257

Libraries, 72

Line printer, 28

Line spacing, 151

Link external data to Access, 313

Linked tables, 294

LinkedIn, 489

Liquid-crystal display (LCD), 22

Live File System (UDF) format, 88

LN function, 251

Local area network (LAN), 18

Lock, Windows, 51 

LOG function, 251 

Log off, Windows, 51

LOG10 function, 251 

Long Term Evolution, 393

Lookup Wizard data type, 280, 285 

Lower case, 172 

LOWER function, 257 

LPT1, 94 

LSI, 6

LTE, 393 

M 
Mac, 6 

Machine language, 14 

Macintosh, 6 

Magnetic-ink character recognizer (MICR), 29

Mail Merge, 184-188 

 merge fi elds, 187

 printing envelopes, 188

 printing mailing labels, 188

 printing merged letters, 188

 using Access table/query as data source, 313

 Wizard, 184

Mail program, 120

Mail User Agent (MUA), 449 

Mailing labels, creating, 188

Mainframe, computer, 7 

MapQuest, 446 

Maps using Internet, 446

Margins (Excel), 245

Margins (Word), 160 

Margins, paragraph, 152

Mark I computer, 4
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Marqueeing, 224 

Master password, 431 

Mastered (ISO) format, 88

Match case, 163 

Math functions, 251-252

 ABS, 251

 EXP, 251

 INT, 251

 LN, 251

 LOG/LOG10, 251 

 MOD, 252

 RAND, 252

 ROUND, 252 

 SQRT, 252

 SUM, 251

MAX function, 249 

Maximize button, 44 

MB (Megabyte), 10 

Media Player, see Windows Media Player 

MEDIAN function, 249 

Medium-scale integration, 6

Megabyte (MB), 10 

Memo data type, 280 

Memory, 9 

Memory card, 10 

Menu bar, 44 

Merge and Centre, 228 

Message rule, 465 

Messenger, Windows Live, 484 

Messenger, Yahoo!, 484 

MFLOPS, 2

MICR, 29 

Micro fl oppy diskette, 23

Micro, computer, 7

Microphone, 31 

Microprocessor, 6

Microsoft Access, see Access 

Microsoft Excel, see Excel

Microsoft Family Safety, 490

 monitoring an account, 493

Microsoft PowerPoint, see PowerPoint 

Microsoft Word, see Word 

MID function, 257

MILNET, 390 

MIN function, 249

Mini computer, 7

Mini fl oppy diskette, 23

Mini toolbar, 142, 212

Minimize button, 44

MIPS, 2 

Mnemonics, 15 

MOD function, 252 

MODE function, 249 

Modem, 31, 391 

Monitor, 22

MONTH function, 233 

Mother board, 34

Mouse, 23 

 clicking, 41

 double-clicking, 42

 double-clicking speed, 60

 dragging, 42

 moving, 41

 optical, 23

 pointer, 41

 properties, 60

 scroll-wheel, 41, 43

 swapping buttons, 60

 wireless, 23

Movie Maker, 120 

Moving Data (Excel), 223

Mozilla Firefox, 399

 getting, 400

Mozilla Thunderbird, 449

MSI (Microsoft Installer), 435

MUA (Mail User Agent), 449 

Multiple monitors, using, 57

Multitasking, 66

Music on website, 438 

MySpace, 394 

N
Nanosecond, 11 

Narration, recording, 346

Navigating records, 289

Navigation pane, 72

Negative numbers display in Excel, 216

Net present value (NPV), 255

Netbook PC, 20 

Netscape Navigator, 397 

Network Adapter, 392 

Network card, 32

Networking concepts, 18 

Non-adjacent columns, selecting, 222

Non-impact printers, 28

Non-procedural languages, 16 

Notebook PC, 19 

Notepad, 103 

Notes Page view, 343 

Notifi cation area, 40, 62

NOW function, 232 

NPER, 253 
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NPV function, 255 

NTFS, 39 

Number data type, 280 

Number formatting, 214 

 Currency style, 215

 fi xed number of decimal places, 217

 Indian format, 215

 negative numbers, 216

 Percentage style, 217

 Scientifi c style, 217

Numbering paragraphs, 151 

Numbering system, 18 

O 
Object program, 16 

OCR (Optical character reader), 29

Octal, 19

Offl ine help, Windows, 90

OLE Object data type, 280 

OMR (Optical mark reader), 29 

Online banking, 441

 security consideration, 444

Online bills payment, 442

Online help, Windows, 90 

Online investing, 443

Online shopping, 439

Open source software, 18 

Operand, 200 

Operating system, 12 

 character based, 13

 for Personal Computers, 12

 GUI based, 13

Operators 

 arithmetic, 201

 comparison, 202

 order of precedence, 201

 text concatenation, 202

Optical character reader (OCR ), 29

Optical mouse, 23 

Organization chart (PowerPoint), 336

Orientation, page, 160

Orkut, 489

OS, 12 

Outline view (PowerPoint), 342

Outlook 2010, 451-467 

 address book, 467

 assign a category to a message, 461

 attachment, saving, 459

 attachment, sending, 459

 block sender, 465

 confi gure, manually, 453

 contacts, 467

 conversation view, 464

 deleting messages, 460

 fi nding a message, 463

 fl ag a messages, 461

 folders, 462

 forwarding a message, 458

 message rule, 465

 printing a message, 458

 reading a message, 457

 receiving e-mails, 456

 replying to a message, 457

 sending e-mail, 455

 setting up, 452

 signature, 466

 spam, handling, 464

Outlook.com, 472-476 

 managing contacts, 475

 reading a message, 472

 searching for e-mails, 475

 sending a message, 474

 taking action on a message, 473

Output unit, 10

Overtyping, 137

P 
Page background, 170 

Page break (Word), 167 

 soft/hard, 167

Page margins, 160 

Page number (Word), 166 

Page orientation, 160

Page setup (Excel), 244

Page setup (Word), 160 

Page size, 161 

Page, insert blank, 167

Paint, 111

Paragraph, 138 

 alignment, 147

 borders, 168

 bullets, 150

 centring, 148

 dialog box, 152

 dialog box launcher, 152

 drop cap effect, 154

 fi rst line indent, 153

 formatting, 151

 formatting options, 175

 hanging, 154

 indents, 152

 justifi ed, 147
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 line spacing, 151

 margins, 152

 mark, 138

 multiple-columns, 175

 numbering, 151

 shading, 168

 spacing before and after, 153

 splitting, 137

Password protecting a database, 319 

Password protecting a workbook, 269 

Password, master, 431 

Paste button, 226

Paste options (Excel), 226

Paste options, preview, 139

Paste Special, 226

Pasting text using clipboard, 141

Payroll (Tally), 380

PC, see Personal Computer 

PCI adapter card, 32

PDA, 26 

Percentage format, 217 

Period, 253

Personal computer, 19 

 hibernate, 51

 keeping safe, 446

 setting up, 34

 sleep, 51

 starting, 34

 types, 19

Personal Digital Assistant, 26

Photo Gallery, 120

Pie chart, 237

Pinch zoom, 427 

Pinning a program, 49

PivotChart, 288

PivotTable, 288

Playlist, 119

Plug and Play, 38

PMT function, 255 

Podcast, 438 

Point size, 142

Pointer (PowerPoint), 345

Popup, 427 

 blocking, 427

Portrait orientation, 160

POST, 35 

Power-on-Self-Test, 35

PowerPoint 

 advance slides, automatically, 346

 animation, 348

 audio, insert, 338

 chart, inserting, 334

 comment, inserting, 341

 edit/format slide, 332

 header/footer, 339

 introduction, 323

 look, changing, 351

 narration, recording, 346

 Notes Page view, 343

 Outline view, 342

 picture, inserting, 333

 pointer, 345

 presentation based on photo album, 349

 presentation, closing, 330

 presentation, creating, 326

 presentation, opening, 330

 presentation, opening options, 332

 presentation, packing in CD, 355

 presentation, saving, 329

 presentation, saving as media fi le, 355

 presentation, saving on web, 356

 presentation, sharing, 353

 printing a presentation, 353

 rehearse timings, 346

 running a slide show, 344

 shapes, inserting, 336

 Slide Master, 351

 Slide Sorter view, 342

 Slideshow, 344

 Spelling checking/correction, 340

 starting, 324

 table, 337

 template, 326

 transition effect, 347

 video, inserting, 338

 views, 342

 WordArt, inserting, 336

Present value (PV), 254

Presentation, see PowerPoint 

Primary key, 283 

Primary storage (memory), 9 

Print area, 244

Print preview (Excel), 243

Print preview (Word), 127

Printer, 28

 installing, 93

 multi-function, 29

 types, 28

Procedural languages, 16 

Processor speed, 11 
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Program 

 buttons, group on taskbar, 65

 downloading/installing, 92

 object, 16

 pinning to start menu, 49

 pinning to taskbar, 50

 searching for, 48

 source, 16

 uninstall, 91

Programming in Access, 317 

PROPER function, 257 

Protecting a workbook, 269

Public domain software, 17

Pull-down menu, 184 

Punched card, 33 

PV function, 254

Q
Query, 297 

 creating in design view, 299

 creating using Wizard, 297

 modify/save, 302

 running, 302

 using criteria, 301

Query Wizard, 297 

Quick Access toolbar, 105 

 customizing, 191

Quick Launch toolbar, 62

R 
RAM, 9, 34 

RAND function, 252 

Random Access Memory, 9 

Random number, 252

Range, 219 

 fi lling, 223

 merge and centre, 228

 naming, 248

 specifying by pointing, 220

Rate, 253

RATE function, 253 

RDBMS, 274

Read Only Memory, 9 

Record (Access) 

 delete, 290

 fi lter, 292

 insert, 289

 sort, 292

Recycle Bin, 86

Redoing changes, 140, 219 

Region and Language, changing, 60 

Register, 10

Rehearse timings, 346 

Relational Database Management System, 274 

Relational, establishing, 295

Relationship, 294

Relative addressing, 225

Renaming File/Folder (Windows), 78 

Replace text (Word), 163

Replacing text (Excel), 268

Reply to All, 458

Report (Access), 307 

 export to Word/Excel, 312

 printing, 311

 Tool, 307

 wizard, 309

Required, fi eld, 284

Resizing handles, 235

Restore button, 44

Restore, deleted items, 86

Ribbon, 105 

 customizing, 191

 interface, 125

RIGHT function, 257

Right-align paragraph, 148

Right-aligned tab, 156

Ripping, 118

ROM, 9 

ROUND function, 252 

Router, 32

 wireless, 32, 392

Row, 198 

 AutoFit, 223

 delete, 227

 height, changing, 222

 hide, 233

 insert, 227

 numbering, 198

 unhide, 233

Ruler bar (Word), 155

Run command, 115

S 
Scale to Fit, 245

Scanner, 29 

Scientifi c calculator, 110

Scientifi c format, 217

Screen resolution, 57

Screen Saver, 56 

Screenshot, capture, 111

Scroll bar, 43, 69

Scroll box, 69

Scroll button, 70
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Scroll wheel, 41, 43

Search, 151, 404 

 advanced, 408

 by voice, 411

 engine, 404, 411

 image, 409

 in webpage, 412

 programs, 48

Search box, 48 

Secondary Storage (memory), 9 

Security, database, 319

Selecting text (Word), 137

Semiconductor memory, 9

Sentence case, 172 

Shading, paragraph, 168 

Shadow effect (Word), 146 

Shareware, 17 

Sheet, 198, see also Worksheet 

Shopping, online, 439

Shortcuts, creating on Desktop, 113

Show Desktop, 64 

Show/Hide button, 138 

Shrink Font, 142

Shut-down, Windows, 50 

Signature, 466

Simple Mail Transfer Protocol (SMTP), 396

Single entry voucher, 373

Skype, 486 

Slide, 323

Slide Master, 351

Slide show, 344

Slide Sorter view, 342

Slide, inserting, 327

Small Caps, 146 

Small-scale integration, 6

SmartArt, 180 

Smartphone, 27 

SMTP, 396 

Snipping tool, 111

Social networking websites, 488

Soft page break, 167

Software, 11

 application, 17

 custom-built, 17

 freeware, 17

 open source, 18

 public domain, 17

 shareware, 17

Sort button (Excel), 260

Sort database (Excel), 259

Sort dialog box (Excel), 261

Sorting, query output, 301

Sounds Like, 163 

Sounds, insert in PowerPoint, 338

Source program, 16 

Spacing, line, 151

Spacing, paragraph, 153 

Spam, 464 

Sparklines, 239

Speaker, 31 

Spelling checking (Access), 315

Spelling checking (Excel), 268

Spelling checking (PowerPoint), 340

Spelling checking (Word), 164

Spreadsheet, see Worksheet 

Spyware, 447 

SQRT function, 252 

SSI, 6

Start button, 40, 46

Start menu, 46

Statistical functions, 249

Status bar (Excel), 198

Status bar (Word), 125

STDEV function, 249 

Sticky Note, 112

Storage unit, 9

Streaming, 438 

Strikethrough, 145

Styles (Word), 191

Subscript, 145

SUM function, 219 

Superscript, 145

Surfi ng, 402

Surge-protector, 35

SVGA, 22 

Symbols, inserting, 180

Syntax rules, 14

System clock, 12 

System icons, 63 

System Information, 98

System Restore, 100 

System tools, 97 

System tray, 62 

System Unit, 20 

System/360, 5 

T
Tab, 155

 bar, 156

 button, 156

 centred, 156

 decimal, 156

 defi ning using ruler bar and mouse, 156
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Tab,  (Contd.)

 defi ning using Tabs dialog box, 157

 deleting, 156

 fl ush-left, 156

 leader character, 157

 left-aligned, 156

 right-aligned, 156

 standard, 156

 types, 156

Tab (Excel), 198

Tabbed browsing, 416 

Table (Access) 

 creating in Datasheet View, 278

 creating in Design View, 281

 data types, 280

 delete fi eld, 293

 delete record, 290

 editing data, 289

 export as Word/Excel document, 312

 fi lter records, 292

 fi nd/replace data, 314

 freeze fi eld, 292

 hide fi eld, 291

 insert record, 289

 introduction, 277

 Mail Merge Data Source, 313

 navigate records, 289

 opening, 287

 relation, 294

 rename fi eld, 291

 reposition fi eld, 290

 resize fi eld, 290

 sort, 292

 spell check, 315

 unfreeze fi eld, 292

 unhide fi eld, 291

 view, changing, 288

Tables (Word), 157

 numbering, automatic, 182

Tablet computer, 26

Tally

 account group, 366

 Accounts Information masters, 366

 backup/restore, 383

 creating a company, 362

 delete company, 383

 double, entry, 373

 downloading, 359

 educational mode, 361

 Gateway of Tally, 362

 Groups, 366

 installing support for Hindi, 386

 introduction, 359

 Inventory Information masters, 376

 Ledgers, 368

 migrating data, 386

 multilingual capabilities, 384

 Payroll, 380

 remote access, 361

 reports, 379

 security control, 364

 single entry, 373

 split company data, 384

 starting, 361

 stock group, 376

 stock items, 377

 unit of measure, 377

 voucher entry, confi guring, 373

 Vouchers, 370

Tally.EPR.9, 359

Tally.Net, 360

Taskbar, 40, 45

 auto-hide, 64

 customizing, 64

 group program buttons on, 65

 notifi cation area, 62

TB, 24

TCP/IP, 390 

TDL, 396 

Template (Access), 276 

Template (Excel), 206

Template (PowerPoint), 326 

Template (Word), 129 

Temporary Internet Files, 432

Terabyte (TB), 24

Text

 copying, 139

 deleting, 140

 effects, 145

 fi nding, 161

 formatting, 141

 moving, 139

 pasting, 141

 replacing, 140

 selecting, 137

Text alignment in cell, 208

Text Box (Word), 180 

Text concatenation operators, 202

Text data type, 280

Text editing, see Document (Word) 

Text editor, 103

Text functions, 256
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 CLEAN, 257

 CONCATENATE, 257

 LEFT, 257

 LEN, 257

 LOWER, 257 

 MID, 257

 PROPER, 257 

 RIGHT, 257

 UPPER, 257

Text orientation in cell, 208

Text, data type, 280

Themes, Windows, 55

Third generation computers, 5

Third generation languages, 16

Thunderbird, Mozilla, 449

TIME function, 233

Time sharing, 12

Time, enter in cell, 233

Time-stamping, 12 

Title bar, 44, 72

Title case, 172

Title columns, 242

Title rows, 242

TODAY function, 232 

Toggle case, 172 

Tooltip, 41

Top Level Domain, 396 

Top margin (Word), 160 

Top/Bottom Rule, 230 

Touchpad, 23 

Trackball, 30

Tracking changes, 183 

Transistor, 5

Transition effect, 347

Translation, Internet, 445

Trigonometric functions, 252

Twitter, 489

U 
UDF, 88 

Underline (Ctrl+U), 142, 210

Underline styles, 142, 146

Undo button, 140 

Undoing changes, 140, 219 

Uniform Resource Locator (URL), 395 

Uninterruptible power supply (UPS), 35

Unit of measure (Tally), 377

Unit of measurement (Word), 153 

UNIVAC, 4 

Unzip, 85

Uploading fi les, 435

 using FTP, 436

Upper case, 172 

UPPER function, 257 

UPS, 35 

URL, 395 

USB, 35 

USB Devices, installing, 91

USB Ethernet Adapter, 392 

USB Flash Drive, 27 

 copy fi les to, 82

 create fi le/folder on, 87

 Format, 77

USB Mobile Stick, 392 

User Accounts, 101 

 creating new account, 102

V
Vacation response, 484 

Vacuum tube, 4 

Validation rule, fi eld, 283

Validation text, fi eld, 284

VAR function, 249 

VBA, 317 

VDU, 22 

Video camera, 30 

Video Display Unit, 22

Video, on web, 437 

Video, watching/uploading, 436

Virus, 446

Visual Basic for Applications (VBA), 317

VLSI, 6

Voice over Internet Protocol, 395

VoIP, 395 

Volume name, 77 

Vouchers, 370 

W 
Wallpaper, 54

WAN, 18 

Watermark, 170 

Web, 393 

 address, 395

 audio/music, 437

 browser, 393, 397

 cookies, 432

 exploring, 401

 search, 404

 shopping, 439

 surfi ng, 393, 402

Web crawler, 404 

Web Page, see webpage
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Web pages, creating from worksheet, 271 

Web robot, 404 

Web spider, 404 

Web surfi ng, 393

Webcam, 30 

Webmail, 449 

Webpage, 393 

 Forms, 428

 loading issues, 424

 moving back/forward, 402

 printing, 420

 recently visited, 403

 refresh/reload, 425

 saving, 420

 saving image, 420

 saving text, 419

 secure, 428

 stop loading, 425

 text size, controlling, 426

 visiting, specifi c, 404

 zoom, 426

What-if analysis, 202, 258

Wi-Fi, 392

Wi-Fi hotspot, 392

Wide area network (WAN), 18 

Wikipedia, 412

Window(s), 43 

 active, 66

 cascaded, 66

 closing, 45

 control menu, 44

 introduction, 43

 manage multiple, 66

 maximizing, 44

 minimizing, 44

 moving, 46

 resizing, 46

 restoring, 44

 scroll bar, 69

 title bar, 44, 72

Window/orphan control, 175 

Windows 

 automatic updates, 97

 creating new folder, 70, 79

 date and time, 65

 desktop, 39

 help, 90

 history, 38

 lock, 51

 log off, 51

 log on, 39

 region and language, 60

 remove programs, 91

 restart, 51

 running DOS commands, 115 

 search for fi les/folders, 83

 shut down, 50

 start, 39

 Start menu, 46

 theme, 55

 updates, 95

 user accounts, 101

Windows 2000, 38 

Windows 3.1, 38 

Windows 7, 39 

Windows 95, 38 

Windows 98, 38 

Windows Essentials, 120 

Windows Explorer, 71-84 

 collapsing/expanding items, 76

 content pane, 73

 copying fi les to fl oppy/USB, 82

 copying fi les/folder, 81

 copying, using mouse, 81

 creating fi le/folder, 79

 deleting fi les/folders, 78

 details pane, 74

 fi les/folders, searching for, 83

 formatting disk/USB Flash Drive, 77

 libraries, 72

 moving fi les, 83

 navigation pane, 72

 preview pane, 75

 properties, 77

 rename fi le/folder, 78

 selecting multiple fi les/folders, 80

 view, changing, 74

Windows Flip, 66 

Windows Flip 3D, 67 

Windows for Workgroup, 38 

Windows keys, 22, 46 

Windows Live Hotmail, 471 

Windows Live Messenger, 484 

Windows Media Player, 116 

 playlist, 119

 ripping music from CD, 118

Windows NT, 38 

Windows Parental Control, 490 

Windows Vista, 39 

Windows XP, 39 
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Wireless router, 32

Word, 123 

 customizing, 190

 Help system, 131

 starting, 124

Word document, see Document (Word) 

Word processing, 123 

Word wrap, 126 

WordArt, 177 

WordPad, 104 

 document, editing, 107

 document, saving, 106

 document, typing, 105

 formatting, 108

 printing, 109

Workbook(s) 

 closing, 203

 creating a new, 205

 creating, based on template, 206

 export data, 271

 fi nd and replace data in, 268

 import data, 271

 multiple sheets, 240

 opening, 204

 opening options, 205

 password protecting, 269

 printing, 243

 printing title rows/comments, 246

 protecting, 269

 saving, 203

 saving, as PDF, 271

 saving, as template, 271

 sending as email attachment, 271

Worksheet 

 area, 197

 background, 241

 delete, 241

 entering information in, 200

 erase, 228

 fi nd and replace data in, 268

 formatting, 209

 frame, 197

 hide, 241

 insert, 241

 introduction, 195

 move, 241

 moving data, 223

 multiple, 240

 organization, 198

 protecting, 270

 sorting, 259

 titles, 242

 unhide, 241

Workspace area, 197 

World Wide Web, 393 

Worm, 446 

Writer, 120

Y 
Yahoo! Mail, 468-471

Yahoo! Messenger, 484 

Yahoo! Search, 411 

YEAR function, 233 

Yes/No data type, 280 

YouTube, 436 

Z
Zip drive, 30

Zip, fi les/folders, 84

ZoneAlarm, 447 

Zoom, document, 172, 248 
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